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Welcome to GIFTS Online 

GIFTS Online is a web-based grants management system based on decades of best-in-class 
grants management technology from MicroEdge, the leading provider of solutions for the giving 
community. 

With more than 2,400 clients worldwide, MicroEdge software and services empower 
organizations to be more strategic and focused with their giving. 

GIFTS Online helps accomplish this by putting the information most important to you right up 
front on a tailored home page, and then allowing you to drill down to the details you need. 

Images in the Online Help 

Some of the larger images in the Online Help topics are minimized.  

Simply click the image to expand it to full size and click again to return to normal. 
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System Requirements for GIFTS Online 

While GIFTS Online is a hosted solution, there are some requirements for the client workstation. 

Microsoft Silverlight 

The GIFTS Online interface is based on Microsoft's Silverlight technology and requires all GIFTS 
Online users to have it installed. 

If your computer does not currently have Silverlight installed, you may pre-install it on your 
workstation(s) using this link: http://www.microsoft.com/getsilverlight/Get-
Started/Install/Default.aspx. 

NOTE: Grantee applicants using online applications DO NOT require Silverlight. 

Installing Silverlight 

NOTE: The following procedure assumes use of IE 10. Use of another browser may result in 
slightly different prompts. You must have sufficient administrative privileges to install Silverlight 
on the workstation. 

1. If the computer does not have Silverlight installed, the first time you attempt to login to 
GIFTS Online the browser will prompt you to Update and Launch GIFTS Online. 

2. Click the Update and Launch GIFTS Online button to begin the direct download of 
Silverlight from Microsoft. 

3. If you get a Security Warning, click Run to continue. The download progress will be 
displayed. 

4. When the download is complete, the system may prompt for confirmation to install. Click 
Run. 

5. When the Silverlight Install prompt is displayed, click Install now. 
6. Once the Installation Successful message appears, click Close. 
7. The GIFTS Online login screen will be displayed. Login to go to the homepage. 

The Document Template Manager  

The new Document Template Manager requires a quick install the first time you use it. A prompt 
will ask for confirmation and the installation should be very quick. You will then be taken to the 
GIFTS Online login screen. 

For more details, please see About the Template Manager. 

IMPORTANT: The Document Template Manager will only work on a Windows OS workstation. 

Accessing the Document Template Manager After Install 

After the initial install you will use the Document Template Manager icon placed on your 
desktop to start the Template Manager. 

NOTE: If you attempt to use the menu option Admin > Template Manager again, a message will 
be displayed prompting you to use the icon on your Windows desktop instead. 

Technical Support 

For technical assistance please refer to the link below: 

MicroEdge Maintenance and Support Program 

http://www.microsoft.com/getsilverlight/Get-Started/Install/Default.aspx
http://www.microsoft.com/getsilverlight/Get-Started/Install/Default.aspx
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Understanding and Customizing GIFTS Online 

GIFTS Online pages are the Web pages used to view and work with your giving data. 

Types of user pages include the home page, search pages, and edit forms. 

  

The GIFTS Online basic look and feel can be customized depending on your user group.  

Some options include: 

 Manage which dashboard parts you want displayed on your homepage and arrange them 
to your liking  

 Manage the number of columns displayed on the home page  

 Manage the number of items displayed in search results 

 Change your password 

For more details about GIFTS Online, see the following topics: 

The GIFTS Online Homepage 

GIFTS Online Basics 

  

MicroEdge Support Program 

As a GIFTS Online subscriber, you receive unlimited telephone consultation on the use of the 
software, assistance in error isolation and correction, and prompt furnishing of any available 
problem solutions relating to GIFTS Online. 

Our toll-free Technical Support hotline is available Monday through Friday, 8:00 A.M. to 8:00 
P.M. Eastern time.  

You may contact MicroEdge’s Technical Support Team as follows: 

Phone 

(877) 704-3343 

Fax 

(212) 757-1784 

Email 

helpdesk@microedge.com 

  

For details about our support policies, please refer to the GIFTS Online Support & Service 
Guidelines document. If you have any questions regarding the Maintenance and Support 
Program, please contact our Client Administration Representative at 1-800-899-0890, option 6, 
then 2, who will be happy to assist you. 
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GIFTS Online Basics 

This section introduces some basic concepts and ideas you will work with when using 
GIFTS Online. 

GIFTS Online Modules 

GIFTS Online uses a modular approach to functionality: separate modules can be linked, 
allowing each client to build a system that meets their specific needs. 

Some features discussed require an optional module to be purchased separately and enabled by 
MicroEdge. To read more about GIFTS Online Core applications and optional Modules, please 
see  About GIFTS Online Modules. 

Searching for Data 

Before you can work with your grant making data or run reports, you need to find the relevant 
information. The GIFTS Online search features allow you to create a set of search criteria that 
tell the system exactly what you are looking for. 

 Quick Find 

 Full Search 

 Recent Searches 

 Saved Searches 

 The Search Results Page 

Editing Data in GIFTS Online 

Once you've found the record you want to work with, your next step may be to update or edit it. 
GIFTS Online edit forms are similar for all record types such as Organizations, Requests, or 
Affiliations. 

 

Branch Security 

Branch Security allows grantmakers with multiple sites to capture all of their information in a 
centralized database, while preventing users from different branches from editing (or viewing, if 
desired) each other’s data. 

NOTE: This is an optional feature; your GIFTS Online system may not use Branch Security. 

Understanding Branch Security 
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Batch Updates 

Batch updates are actions that can be performed on more than one record. They are available 
from both the Search Results page and Related Records grids. 

GIFTS Online supports several batch update features from the Actions menu.  

These include: 

Record Type Action 

Organization Update Coding Sheet 

Contact Update Coding Sheet 

Request Update Coding Sheet 

Request Update Request Type/Status 

Request Update Meeting Date 

Request Update Staff Assignments 

Request Update Project Assignments 

Payments Update Codes 

  

Privacy Policy Link on Login Page 

The MicroEdge Privacy policy is accessible by users from the footer of the login page.  

 

When the user clicks on the link, the user will be taken to the following page in a new browser 
tab: http://www.microedge.com/Special/Privacy.aspx. 

The login page will remain open in the previous tab. 

  

http://www.microedge.com/Special/Privacy.aspx
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Inactivity in GIFTS Online 

Please note that for security purposes GIFTS Online will time out after 30 minutes of inactivity.  

When a GIFTS Online user’s activity for the session has been idle and is 2 minutes from expiring, 
a popup message will show alerting them to this. This popup will appear above all open browser 
windows. 

It will allow users to continue the session by clicking the OK button in the message. Clicking OK 
will refresh the session. 

 

The following GIFTS Online modules will have their own session timers. 

 The Document Template Manager 

 The Forms Manager 
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About GIFTS Online Modules 

GIFTS Online uses a modular approach to functionality: separate modules can be linked, 
allowing each client to build a system that meets their specific needs. In keeping with this 
approach, some modules are standard with every GIFTS Online system, and others are available 
for purchase separately. 

Below is an overview of the features of the GIFTS Online core, and each of its optional modules. 

  

The GIFTS Online Core 

The core system includes all of the functionality necessary for online grants management. With 
a few noted exceptions, the features described in the following topics are available in all 
GIFTS Online systems: 

Working with Organizations 

Working with Requests 

Working with Payments 

Working with Contacts 

Working with Affiliations 

Working with Activities and Requirements 

Managing Documents 

Generating Reports and Correspondence 

 

The Accounts Payable (A/P) Module 

The optional GIFTS Online Accounts Payable (A/P) Module allows you to process your payments 
in two ways: 

1. A/P Link: Exchange payment information between GIFTS Online and your accounting 
system using import/export functionality. 

2. Check Writer: Select pending payments to merge into a check template and print directly 
to your own check stock. 

Click here for more details on the A/P Module. 

  

The Blueprint Module 

GIFTS Online Blueprint is a comprehensive set of tools which have been built using the new 
GIFTS Online interface to help create custom fields and forms which can be used to personalize 
your GIFTS Online system using your own language and terminology through the system and 
tailoring of the experience of each of your users. 

Click here for more details on the GIFTS Online Blueprint Module. 
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The Budget Module 

This optional module is for grant makers who wish to track their giving against a pre-defined 
annual budget. A budget is established at the beginning of the fiscal year and all grant Payments 
for that year are appropriated from the budget. This enables you to compare your spending 
against your budget and produce statistical and summary reports. 

Click here for details on the features of the Budget. 

  

Internal and External Reviews Modules 

Internal and External Reviews modules are designed to give reviewers access to your proposals. 
They can then provide instant feedback on new proposals by editing and submitting Review data 
online. 

These two optional modules are sold separately; which you need depends on who you seek 
feedback from: 

 Internal reviewers are staff members whom you rely on for regular feedback during your 
grant workflow. 

 External reviewers are outside consultants, subject-matter experts, and other people you 
want occasional feedback from. 

Click here for details on working with Reviews and reviewers, both internal and external. 

  

The Online Applications and Requirements Module 

The Online Applications and Requirements Module enables you to post grant applications and 
requirements online, then receive completed applications and requirements in GIFTS Online. 
Applications can either be rejected or converted to pending Requests for further review. 
Requirements are automatically transferred to GIFTS Online. 

Click here for details on working with grantees online using Online Applications and 
Requirements. 

  



GIFTS Online 5.1 User’s Guide 

23 
 

Understanding Branch Security 

NOTE: Branch Security is an optional feature; your GIFTS Online system may not use it. 

Branch Security allows grant makers with multiple sites or branches and separate giving 
programs to capture all of their information in a centralized database, while preventing users 
from different branches from editing (or viewing, if desired) each other’s data. 

Users cannot edit or view data from other branches unless they are granted permission to do so. 
In addition, reports and searches generated by users only include data for the branches for 
which they have “view” rights. 

To accomplish this, you can enter a code for each of your branches into the system. Each 
Request and its associated Activities, Payments, and Requirements are then stamped with a 
primary branch. Each group’s access can then be restricted to records based on the branch 
stamp. 

NOTE: Access to Organization and Contact information is not limited to specific branches. This 
ensures that you maintain an accurate giving history for Organizations that are funded by more 
than one branch. 

When you set up Branch Security for your system, you must choose one of two ways Requests 
(and thus their associated Activities, Payments, and Requirements) can be stamped with a 
primary branch: 

 A Request can be automatically stamped with the primary branch of the user creating it. 

 The Request form can include a branch field, allowing a user to enter a specific branch 
him- or herself. 

The option you chose to have MicroEdge implement depends upon which of two different data 
entry models you use.  

  

Centralized Data Entry Model 

The centralized data entry model is most likely to be used by organizations that manage several 
different, wholly separate funds. 

In this case, a single user group is accepting, entering, approving, and declining grant requests 
for many various funds. However, you also want representatives of the individual funds to be 
able to view the data for their fund (and their fund only). 

In this case, you want your users to enter the branch for each Request manually. This allows a 
single user to enter Requests for several different branches. 

For example, you could create a “Headquarters” branch that has access to all data; these users 
would be employees of your central organization. Then you can create a branch for each fund 
you represent, adding the fund’s representatives to the appropriate branch. 

Your users will then assign a branch to each Request they enter, depending on the specific fund 
being appealed to. Representatives for each fund (or “branch”) will then be able to access data 
concerning their fund only. 
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When following this model, the branch must be entered in each new Request manually. You will 
not be allowed to save a new Request without entering a branch. The branch field appears in 
the Request form only if you choose this Branch Security option. 

The branch field may also appear on the following forms when using this Branch Security option: 

Activities If you are creating a new Activity not associated with a Request, the branch field will 
appear. 

If you create an Activity associated with a Request or Payment, the Activity is 
automatically stamped with the Request’s (or the Payment's Request's) branch, and 
the branch field is unavailable. 

Budget Items 
(Categories, 
Line Items, 
and Reserve 
Funds) 

NOTE: The Budget Module is an optional feature; your GIFTS Online system may not 
include the Budget. 

In the Budget, an editable Branch field will appear on new budget items, if those 
items are children of first-level Categories. (You can also select the branch for top 
level Reserve Funds.) 

Children of each second-level Category will all have the same Branch, which cannot 
be edited. 

 

Decentralized Data Entry Model 

This data entry model is appropriate if members of your various branches or divisions are 
receiving, entering, approving, and declining grant requests more or less independently of one 
another. Your GIFTS Online data is all stored centrally; however, each branch or division works 
almost exclusively with Requests and grants that they have entered themselves. 

For most foundations and corporations with branches or divisions, this is the model they follow. 

In this case, you would want Requests to be automatically stamped with the primary branch of 
the user creating it. This allows members of each branch to enter Requests (and other 
associated GIFTS Online records) that can only be viewed or edited by other members of the 
same branch. 

IMPORTANT: If your GIFTS Online system includes the optional Annual Budgets feature, budget 
items must still be stamped with a branch manually, as described for the centralized data entry 
model above. 
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Multiple Site ID (SID) Support 

Many users have different foundations or entities that have different branding and/or other 
institutional differences that require that not only different forms be used but different My 
Account and Account Login pages as well. 

To meet this requirement, GIFTS Online clients are now allowed multiple SIDs upon request.  

IMPORTANT: To add more SIDs, the Online Applications server must first be configured by 
MicroEdge to support the number desired for your organization.  

The retrieval process for Online Applications and submitted Requirements will not change. 
When a retrieval is triggered, applications or submitted Requirements from all SIDs will be 
retrieved and processed together. 

Multi-SID functionality will be supported in GIFTS Online through a number of small changes to 
several pages in the GIFTS Online system. 

For those who have multiple sites enabled, the following changes will be noticeable: 

 A new Site column will be visible in several locations throughout GIFTS Online. 

 Several entry forms will also now display a Site selection menu. 

 Site will be available as a search filter on the Query Builder form for Requests and 
Requirements. 

  



GIFTS Online 5.1 User’s Guide 

26 
 

The GIFTS Online Homepage 

 GIFTS Online has been designed using Microsoft Silverlight technology to improve not only the 
look of the interface but the functionality of many of the tools, forms, and menu options. 

Header Area 

 

Each page or form will have a common header area with the following elements: 

 The GIFTS Online logo is located in the upper left corner of all pages and serves as a 
home link, navigating back to the Dashboard from whatever other page you happen to be 
on. When on the Dashboard itself, clicking the logo refreshes the content of the 
Dashboard. 

 The User Menu is located in the upper left-hand corner below the current user's name. 
To open the menu, click the down arrow next to the user name. This menu includes 
standard options such as Logout, Change Password, Views, Searches, Quick Find, and 
Help. 

 The Quick Find field is located in the middle of the header area and allows you to quickly 
locate a record by simply typing in some text, selecting the appropriate record type radio 
button, and then clicking the Find button or pressing Tab/Enter.  
The default record types are Request, Organization, or Contact. However, other options 
such as Requirements, Activities, or Payments can also be configured. The user can 
determine which types of records to make available, and choose which fields to search 
from a list of the most likely fields. 
To access the Quick Find options form, click Quick Find in your user’s menu under the 
GIFTS Online logo. 

 The Full Search link gives you access to the Search form where you can access Recent 
Searches, Saved Searches, or create a new search using the Query Builder. 

 The New menu allows you to create new records for most of the major record types from 
'scratch'. You will need to provide the necessary relationships when you create the new 
record. 

 The Launch menu provides access to Reports, Job Status, Budget, Applications, Tax Status 
Lookup and Import A/P Data. NOTE: Some choices may not be available depending on the 
options you have installed. 

 The Admin menu provides Grant Managers with access to the Template Manager, 
Manage Dashboards, Manage Watchlists, and Classifications forms. 

 The Action menu will be visible on all Edit Forms. The options available will change 
according to the type of record currently being viewed. 

NOTE: The available options on the menus sometimes exceeds the space available to 
display them. When this occurs, a blue arrow button will be visible on the right side of the 
ribbon menu. Clicking this will slide the menu options to the left revealing the additional 
options. 
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The User Menu 

This menu is located in the upper left-hand corner below the current user's name. To open the 
menu, click the down arrow next to the user name.  

 

This menu includes the following options: 

 Logout - logs you out of GIFTS Online. 

 Change Password - Opens the Change Password popup. 

 Views - Takes you to the Manage Saved Views page.  

 Searches - Takes you to the Manage Saved Searches page.  

 Quick Find - Displays the Setting Up Quick Find options window. 

 Help - Opens the GIFTS Online Help. 

  

Change Password 

Clicking Change Password will open the Change Password form. 

 

Simply enter your existing password in the Old Password field and then enter your new 
password in twice. 

All fields are required and the OK button will not be enabled until all fields are filled. 

TIP: By Request to MicroEdge Services (Services@Microedge.com), an option can be turned on 
to restrict the number of passwords a user has used from being reused. This may be required by 
some organizations who need to have their users change passwords on a regular basis and want 
to prevent reuse of recently used passwords. 

mailto:services@microedge.com?subject=GIFTS%20Online%20Password%20Reuse%20Limit%20Request
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Views 

The Views option in the User Menu opens the Manage Views form.  

This page allows you to access any of your saved views according to record type. 

A Record Type can be chosen on the left panel and available saved views will be displayed on 
the right side listing.  

Column headings for Name, Description, or Last Updated can be clicked to sort in ascending or 
descending order.  

Edit, Save As, and Delete options are available on the right side column for existing Views. 
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Creating a New View 

Clicking the New View button will take you to the New View form where you can create a view 
manually and Save the view to your saved views list. 

 

1. Select a category of columns from the drop-down menu in the top left of the form. 
2. Highlight columns you desire and click the Include button to move them to the right. 

You can also use the Find field to look for a specific field in the category. 
3. Once on the include list, you can click on a field to select it and then use the up/down 

arrows in the Move column to reorder fields. 
4. Click Save View to open the Save View form. 
5. Enter a Name and Description. 
6. Check the Allow others to use this View box if you want to allow other users to use the 

view. 
7. Click OK when done to return to the Manage Saved Views list. 
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Saved Searches 

Clicking on the Searches option in the User Menu takes you to the Manage Saved Searches form. 

This page allows you to access any of your saved searches according to record type. 

A Record Type can be chosen on the left panel and available saved searches will be displayed on 
the right side listing.  

Column headings for Name, Description, or Last Updated can be clicked to sort in ascending or 
descending order.  

Edit and Delete options are available on the right side column.. 

 

New searches must be created using Quick Find or the Query Builder. 

  



GIFTS Online 5.1 User’s Guide 

31 
 

Setting Up Quick Find 

To configure Quick Find, click the Quick Find link in the User menu. 

NOTE: Some users may not have this option depending on their permissions. 

This will open the Quick Find Options form. 

 

 On this form you can: 

 Specify the data fields to be searched when a specific record type is selected. 

 Enable other record types to be available under the Quick Find field by checking the 
Include box. 

The table below specifies all the available record types and search fields available for each: 

NOTE: Some fields are set to <do not search> by default to improve search performance. They 
can easily be enabled by accessing the Quick Find Options and changing the setting. 
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Record Type Field Search Option Default 

Requests Organization Name contains 

  Include Payee No (unchecked) 

  Request ID/Reference No. is 

  Project Title <do not search> 

  Docket No. <do not search> 

Organizations Organization Name contains 

  Tax ID is 

  Vendor No. <do not search> 

  Organization ID <do not search> 

Contacts Last Name contains 

  Contact ID <do not search> 

  E-mail <do not search> 

  Primary Organization Name  <do not search> 

Payments Organization Name contains 

  Check No. is 

  Request ID/Reference No. <do not search> 

  Payment ID <do not search> 

Requirements Organization Name contains 

  Request ID/Reference No. <do not search> 

  Requirement ID <do not search> 

Reviews Reviewer Last Name (External) begins with 

  Reviewer (Internal) begins with 

  Organization Name contains 

  Request ID/Reference No. <do not search> 

  Review ID <do not search> 

Documents Organization Name contains 
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  Request ID/Reference No. <do not search> 

  Document ID <do not search> 

Activities Organization Name contains 

  Request ID/Reference No. <do not search> 

  Activity ID <do not search> 

  

Using Quick Find 

The Quick Find field is designed to help you quickly and easily search for records.  

To use Quick Find to locate a record, enter a search value in the field, select a record type from 
the radio buttons displayed, and click the Find button.  

 

You can also press Tab or Enter to begin the search. 

The Quick Find tool will initially only offer Requests, Organizations, and Contacts searches by 
default. 

Each record type is also limited to the most commonly searched fields as described in the table 
below. 

Some fields are also set to <do not search> by default to optimize performance.  

To enable other record types and fields, you must access the Quick Find settings through the 
User Menu > Quick Find option. 

TIP: To use other fields as filters, the Query Builder in the Full Search option must be used. 

Record Type Field Search Option Default 

Requests Organization Name contains 

  Include Payee No (unchecked) 

  Request ID/Reference No. is 

  Project Title <do not search> 

  Docket No. <do not search> 

Organizations Organization Name contains 

  Tax ID is 
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  Vendor No. <do not search> 

  Organization ID <do not search> 

Contacts Last Name contains 

  Contact ID <do not search> 

  E-mail <do not search> 

  Primary Organization Name  <do not search> 

Payments Organization Name contains 

  Check No. is 

  Request ID/Reference No. <do not search> 

  Payment ID <do not search> 

Requirements Organization Name contains 

  Request ID/Reference No. <do not search> 

  Requirement ID <do not search> 

Reviews Reviewer Last Name (External) begins with 

  Reviewer (Internal) begins with 

  Organization Name contains 

  Request ID/Reference No. <do not search> 

  Review ID <do not search> 

Documents Organization Name contains 

  Request ID/Reference No. <do not search> 

  Document ID <do not search> 

Activities Organization Name contains 

  Request ID/Reference No. <do not search> 

  Activity ID <do not search> 

 



GIFTS Online 5.1 User’s Guide 

35 
 

Full Search 

 

The Full Search link on the header opens the GIFTS Online - Full Search form which gives your 
access to: 

 The  Query Builder to create a new search or Ad Hoc report 

 Recent Searches to access a list of recent searches in chronological order 

 Saved Searches to access a list of saved searches by record category type 

 

NOTE: The Full Search form will initially open with the Query Builder selected. However, it will 
remember which of the three options you used last and open to that option the next time you 
open the Full Search form. 

  

The Basic Query Builder 

The Query Builder can be access in one of two ways: 

1. Click Full Search at the top. 
2. Perform a Quick Find, Recent Search, or Saved Search and then click the Change this 

search link. 
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The Query Builder allows you to enter specific search criteria based on the Record Type 
selected.  

NOTE: If you used option one above to access the Query Builder, the Filters area will be blank. If 
you used option 2, the Filters area will be pre-populated with the last search criteria used. 

This is an example of what the initial Query Builder page may look like: 

 

 

Building a New Search 

The following section provides information on how to build and to run your searches from the 
Query Builder. 

1. Make sure the Query Builder radio button option is selected on top. 
2. The Filters section should be clear. If not, click the Reset link on the bottom left of the 

form. 
3. Select a Record Type from the list on the left panel. 
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4. Click the Add Filters link on the bottom left of the form to open the Filter options form. 

 
5. Scroll down the list as needed and check the boxes for the desired filters.  
6. If you would like the filters you've selected to become the default for the specific record 

type, click the Set as Defaults link above the OK button. 
7. Click OK when done selecting filters and return to the main Full Search form which will 

now be filled with the filters you selected.  
TIP: Most filters will have an X and a + next to them on the Query Builder. Clicking the X 
removes the filter. Clicking the + adds another instance of the same filter to the query so 
you can further refine your search criteria. 
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8. Use the various filter fields to enter your search criteria.  

 
9. Click Search. Your results appear in the Search Results page. 
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Advanced Query Builder 

The Advanced Search feature allows you to 'plug in' or edit a SQL type query for a search.  

Only Grant Managers will have access to this link on the bottom. Other users will not see the link 
on the form.  

Clicking Advanced link will open the Advanced Query form.  

 

At the bottom of the Advanced Query Builder are the following control links and buttons: 

 Filters - takes you back to the basic Query Builder form. 

 Test - checks your current SQL query code for any syntax errors. 

 Search - runs the query as displayed in the Advanced field. 

 Cancel - closes the Query Builder without running the query. 

Advanced Criteria 

This text box contains the search criteria. It defaults to a database syntax “translation” of 
any search criteria in the Search form when it was opened. 

Users can type directly in this field and also be able to select, select all, cut, paste, and so 
on.. 

Criteria Editing Buttons 

This row of buttons represents different ways (other than typing or pasting clipboard 
text) to add things to the search criteria above. 
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The Insert Expression button opens the Create Expression popup which allows you to add 
another search expression, based on the category and field selected below. 

NOTE: Double-clicking the field on the list will also open the Create Expression popup. 

 

The Not checkbox can be used to create a negative expression. 

The parentheses, And, Or, and Not buttons can be used to insert conjunctions to group 
expressions for the desired effect. Once familiar with these options, you can easily type 
them in manually into the Search criteria field.  

Search Categories and Fields 

Users who want to add expressions to their advanced search first select the category and 
field here and click Insert Expression, or double-click on the field. 

The left side lists categories of fields. These represent record types or more complex 
database tables with multiple fields an advanced user might want to search. 

The Category selected in the left list determines the fields which will be listed on the 
right. 
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Recent Searches 

The Recent Searches feature provides access to your most recent searches. The system currently 
stores the 10 most recent searches for each record type. 

 

The list can be sorted by Description of Last Run simply by clicking the column header. 

Record Type can be selected using the list on the left panel. 

Searches can be run by clicking on the Search icon (magnifying glass). 
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Saved Searches 

The Saved Searches option functions just like the recent searches, except that only saved 
searches are listed here.  

For each record type, the saved searches are listed in alphabetical order by Name with favorites 
listed first and then the remaining, non-favorite searches. 

 

NOTE: To delete a Saved Search, you must go to the Saved Search Library option located in the 
User Menu. 

The saved searches list can be sorted by Favorite, Name or Description simply by clicking the 
column headers. 

To set a search as a favorite, click the star to the left of the name to turn it orange. To remove 
the favorite status, click the star again. 

To run a saved search, click the Search icon (magnifying glass). 

To change a saved search, click the Modify icon (pencil). 

Choosing to modify a saved search will display its current filters in the Query Builder. You can 
then choose to add or remove filters as needed before running the search again. 

Notice when accessing the Query Builder in this manner, an additional Save As link option is 
available at the bottom next to Advanced. This allows you to save your modified search with a 
new name. 
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The Ribbon Menus 

GIFTS Online employs ribbon menus to provide you with various action options depending on 
your location in the system. 

Instead of opening vertically, these menus open horizontally as additional options become 
available. 

 

If the number of options available exceeds the number allowed to be displayed at one time, an 
scroll button will be displayed on the right. 

Click this to slide the menu to the left to reveal the other options. 

 

  

The New Menu 

This menu allows you to quickly create new records for most of the major record types from 
'scratch'. You will need to provide the necessary relationships when you create the new record. 

 

By default, it is included on the home pages for Grants Managers and Program Officers. 

Possible options on this menu include: 

 Request 

 Organization 

 Contact 

 Requirement 

 Review 

 Document 

 Activity 
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The Launch Menu 

 

The Launch Menu on the right of the header gives you access to the following possible options 
depending on how your site is configured: 

 Reports - allows you to access all of the standard reports available through GIFTS Online 

 Job Status - if installed, displays the status of any ad-hoc/custom reports that are 
scheduled to run 

 Budget - Budget module required 

 Applications - Online Applications and Reporting Module required 

 Tax Status Lookup - opens the Tax Status Lookup utility to search for organizations 

 Import A/P Data - Account Payable Module required. Allows you to import A/P data for 
paid grants. 

  

The Admin Menu 

The menu provides Administrators and Grant Managers with access to the following tools: 

 

 Template Manager 

 Manage Dashboards 

 Manage Watchlists 

 Classifications 

For more information on each tool, please click the links above. 
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The Action Menu 

This menu will be visible on all Search Result pages and Edit Forms. The options available will 
change according to the type of record currently being viewed. 

 

NOTE: The available options on the Action menu sometimes exceeds the space available to 
display them. When this occurs, a blue arrow button will be visible on the right side of the 
ribbon menu. Clicking this will slide the menu options to the left revealing the additional 
options. 

The Dashboards 

The main area of the homepage is called the Dashboard and houses all of the dashboard parts 
assigned to a user's account.  

Default dashboard parts on the Dashboard depend on the role each user is assigned for GIFTS 
Online. Users assigned to the Grant Manager role will have the ability to modify their own 
dashboard parts as well as the Dashboards of other users. 

Up to 10 different dashboards can be created by Grants Managers and assigned to other users 
as needed. 

NOTE: Other user groups will not be able to add or delete dashboard parts. 

Drilling Down Through a Dashboard Part 

Some of the dashboard parts allow you to drill down to see individual records by either double-
clicking on a listed record or part of a chart. When you click on a value on the dashboard part, 
the record type that is associated with the dashboard part search filter will determine the 
record that opens for view/edit. 

For example: If the dashboard part displays Request search results, double-clicking on a 
displayed record in any column will open the Request edit form. Once the edit form is displayed, 
Organization and Contact information can be accessed through the Primary Relation Cards on 
the right panel of the edit form. 
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Refreshing the Dashboard 

In GIFTS Online, the current dashboard is refreshed using the Refresh Dashboard icon located 
just below the ribbon menu. The dashboards will also refresh as you tab from one to the next, or 
return from the workspace. 

 

  

Adding a New Dashboard 

To add a new dashboard, do the following: 

 

Click Add a Dashboard [+] button to the right of the last dashboard tab. 
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With the Add Dashboard form open: 

1. Enter a Name for the dashboard. 
2. Select the number of Columns of dashboard parts allowed. 
3. Check the box to Allow Scrolling, if desired. 
4. Click OK. 

You will notice a new dashboard tab has been created with the name you provided. The main 
area will be blank until you add some dashboard parts. 

 

  

Dashboard Layout Examples 

In GIFTS Online, each dashboard can be set to have up to four “columns”. Dashboard parts will 
expand to fill the “columns” equally based on how many parts are in the row. 

Example: 

If a user sets up a dashboard with two columns and adds four dashboard parts, they are 
arranged in two rows of two parts, in order as if reading from left to right: 
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If a fifth part is added, it will appear on a third row, and span from left to right across the page: 
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However, if the dashboard were to allow three “columns,” the parts would move to this 
configuration: 

 

  

  

Managing Dashboards 

Dashboard parts on each dashboard can be managed in several ways. 

Resizing Parts 

A user can resize the parts on his or her dashboard, using the mouse to drag the divider 
between parts up, down, left, or right. 

NOTE: Changing the height of a part will automatically change the other parts in the same row 
to match. Parts on the same row will always remain the same size vertically. 

Moving Parts 

Any user can move parts around within a dashboard simply by using the mouse to drag one part 
over another. When dropped, the parts switch places in order. 

Maximizing and Restoring Parts 

While the panel look shown above is the default view, users can maximize any given part by 
clicking the Maximize icon in the part’s title bar: 
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This will expand the selected dashboard part so it takes up the majority of the viewing area. The 
other dashboard parts will be minimized along the right. 
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This is especially useful for Table parts which list many records. This functionality allows the user 
to see more of the information in a part while still providing a minimized view of the other parts. 

To return to the normal view, the user must click the Restore icon seen in the title bar of the 
maximized part. 

Note that the original order of parts is preserved after leaving maximized part mode. 

NOTE: Only Grants Managers will have access to the dashboard menus and dashboard part 
actions (gear) menu. 
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The Dashboard Menu 

The dashboard tabs across the top will display the dashboard’s name and (for Grants Managers) 
have a menu for dashboard-related actions. 

The menu on each dashboard tab will have the following options: 

 

Menu 
Option 

Description 

Add Part A new part can be added to a dashboard by selecting Add Part in the dashboard 
menu to open the Add Part form. 

Edit After a Dashboard has been added, its name, number of columns, and scrolling 
setting can be changed by opening the dashboard menu and clicking Edit. 

Share Users may share one of their dashboards with another user by selecting Share from 
the dashboard menu. 

Copy This action adds a copy of the current dashboard to the same user’s site so that the 
same data can be displayed for a different purpose. For example, a user may want the 
same data for three different Program Areas. 

Remove Removes the current dashboard after the user confirms the action. 

Reorder 
Dashboards 

Allows the order of dashboards to be rearranged as needed. 
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Assigning Dashboards 

In GIFTS Online, users associated with the Grants Manager role are given the ability to “alias” 
another user and make changes to their Dashboard, as well as assign a Dashboard from one user 
to another. 

To access the Manage Dashboards page, go to Admin > Manage Dashboards.  

 

The Manage Dashboards popup is only visible to users associated with the Grants Manager Role. 

 

User – Users will be listed in alphabetical order. Below each user’s name will be the Role(s) with 
which they are associated. 

Modify Dashboard – Clicking this link closes the popup and navigates to the Dashboard in 
“alias” mode.  
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The following message/dialogue will display at the top of the Dashboard: 

You are currently modifying the dashboard for the user {Aliased User Name}. To stop 
modifying this dashboard. Click here. 

The user’s name in the header will not change. 

 If the aliased user is “locked”, then only the options to edit the dashboard part properties 
options will be available. You will not have the option to Add or Remove dashboard parts. 

 If the aliased user is “unlocked”, the options to add and remove dashboards and parts will 
be available in addition to those described above. 

The changes to the dashboard will be reflected on the target user’s dashboard the next time 
they refresh. 

When the user clicks the click here link, the current user’s normal dashboard will re-display, 
without the “aliasing” message. 

Copy from Another – copies the entire dashboard from one user to another. This includes all 
dashboards, dashboard parts and their properties, and dashboard settings. 

 

The drop-down will be filtered to include only users with the same Role as the user whose 
dashboard is being assigned. 

NOTE: Only one user be assigned at a time. 

Close – closes the popup without copying any dashboards. 
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About Dashboard Parts and the Dashboard 

Dashboard parts are areas on the GIFTS Online dashboards that provide you with a means of 
viewing and interacting with data from your GIFTS Online database and the Internet.  

NOTE: Some dashboard parts may be unique to your system. These unique dashboard parts are 
added by MicroEdge Services during your setup process. 

The dashboard parts look like mini windows and may be customized for appearance and content 
as needed. 

There are a number of different uses for dashboard parts, including: 

 Displaying GIFTS Online data 

 Viewing saved GIFTS Online documents 

 Searching for GIFTS Online data 

 Creating reports from your GIFTS Online data 

 Creating and editing GIFTS Online records 

 Displaying Activities, Requirements, or Payments due  

Adding Dashboard Parts 

To add a dashboard part do the following: 

1. Click on the tab for the specific dashboard you want to add the part to. 
2. Click on the menu arrow on the dashboard's tab. 
3. Select Add Part. 

 

4. On the Add Part form, select the dashboard part you wish to add. 
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5. Fill in the selected part's configuration form as needed and click Save. 

 

The part will now be added to the current dashboard. 

Edit Dashboard Part Settings 

To edit the settings for a dashboard part: 

1. Click the Configure menu icon in the top right corner of a dashboard part, and then select 
Edit. 

2. Make any necessary changes to the settings, then click OK.  

The dashboard part configuration forms will contain various fields specific to the dashboard 
part.  
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Grant Manager Dashboard Options 

In GIFTS Online, users associated with the Grants Manager role have the ability to “alias” 
another user and make changes to their Dashboard, as well as assign a Dashboard from one user 
to another. 

This allows you to set up the dashboard parts on multiple dashboards for one user and simply 
copy them to several other users at once. 

For more details, see Assigning Dashboards. 

  

Available Dashboard Parts 

The following dashboard parts are available: 

Dashboard part Notes 

Budget Summary Budget Module required 

Chart Chart tool with many formatting options 

Image Display images.  

In-Progress Reviews Reviewers Module required 

Note Add notes for yourself in this part. 

Online Applications and Reporting   Online Applications and Reporting Module required 

Submitted Reviews Reviewers Module required 

Summary Displays Grant and Payment information. 

Table Displays records as a list. 

Web Clipping Displays the contents of a specified webpage. 

  

The Budget Summary Dashboard Part 

NOTE: This dashboard part is only available with the optional Budget module installed. If your 
GIFTS Online system does not include the Budget module, you may disregard this information. 

NOTE: These dashboard parts let you see the status of all of an open budget, or just a part of it. 
For example, if you are Program Officer, your Budget Summary dashboard part might be set to 
show only your program's part of the budget. 

You can quickly see the progress toward your giving goals by comparing the budgeted amounts 
to be paid vs. committed amounts, and see the remaining balance of each budget item. 
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If your Budget Summary dashboard part includes the Budget Meter, you can get a visual 
representation of your progress toward paying out the budget totals. Each budget item listed is 
a link, allowing you to drill down and see commitments and balances at the next level of the 
budget hierarchy. 

 

TIP: Hover your mouse pointer over the red or blue part of the budget meter on the left to see 
the percentage and amount committed or paid, respectively. 
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Add a Budget Summary Dashboard Part 

To add a Budget Summary dashboard part: 

 

1. On the Dashboard, click the dashboard menu and select Add Part. 
2. On the Add part form, select the Budget Summary. 
3. Enter a Title for the part. 
4. Select a fiscal year. 
5. Select a Top Level Category, if desired. 
6. All options will be checked except "Show Original Budget Amount". Check it if you would 

like to see that as well. 
7. Click Save to continue to finish the Budget Summary settings. 
8. You will return to the current dashboard with your new dashboard part displayed. 

Budget vs Actual Report 

You can generate a Budget vs Actual Report for any branch in the budget hierarchy to which you 
have access by clicking the blue View report icon next to the budget year. 

 

The report - which can be printed, exported to Word or Excel, or saved as a PDF - presents 
budget versus actual figures for the selected budget Category and its children. 
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The Chart Dashboard Part 

The Chart dashboard part allows a MicroEdge Product Specialist or a Grant Manager to place 
charts on the GIFTS Online home page of any user. 

Add A Chart 

To add a Chart dashboard part: 

1. On the Dashboard's menu, click Add Part 
2. On the Add part form, select Chart. 
3. There are actually two pages to the chart configuration process: 

 
a) The first page lets you set up search parameters and grouping requirements. 
 

 
 
b) The second page is where you set up visual aspects such as Title, Chart type, 
Header/Footer text, etc. 
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See Chart Options below for details regarding all the settings available. 

4. Make changes as necessary on the settings forms. 
5. Click Next on the first page to go to page 2. 
6. On page 2, a preview area will show you what your chart will look like as you make 

changes. 
7. To complete your chart and place it on the dashboard, click Save. 

Chart Options 

This section discusses the configuration options in the Chart Settings form. 

 

Option Description 

Page 1: 

Filter This field will be gray and read-only. It will either show the name of the current 
Saved Search assigned or the search logic defined. 

Clicking the Modify link below will open the standard Search form where you 
can choose to use the Query Builder to create/edit a search, or select from a 
Recent Search or Saved Search. 

If an ad hoc search is already associated with the part when the user clicks the 
Modify link, the search form will display with the existing criteria loaded into the 
query builder, so the user can make changes. 

Clicking the Select button will save any changes and return you to the 
Configuration form. 
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Option Description 

NOTES: 

 If a Saved View or ad hoc View is associated with a Saved Search, this 
read-only prompt will be populated with the name of that search, and the 
Modify link will be disabled. 

 If a Saved Search associated with a View is selected and no View 
parameters have been defined, the part View will automatically default to 
that View. (But the option to modify it will still be available.) If View 
information has already been defined, the user will be asked if they wish 
to overwrite it. 

 If the user changes the Record Type of the Filter, any associated View 
information will be cleared automatically. 

Value Charted 
NOTE: Hidden if no Filters are defined. 
The calculation to be done when plotting the records on the chart. Options 
include Count, Sum, Average, Min and Max.  

If Sum, Average, Min, or Max is selected, Category/Column fields will give you 
more options. Only the numeric and currency values that can be summarized are 
available. 

Group By NOTE: Hidden if no Filters are defined. 
Lets you group the data returned by Category and Column. 

If the chart is one of the bar-type charts, a secondary Group By set of prompts 
will also display. This provides the user with the ability to group at a sub-level as 
well. 

Page 2: 

Title  Enter the title as you want it to appear on the Dashboard. 

Header Optional text that appears above the Dashboard part content just below the 
title. 

Footer Optional text that appears at the bottom of the part. 

Chart Type The following chart types are available: Bar, Stacked Bar, Horizontal Bar, 
Horizontal Stacked Bar, Line, Step Line, Spline, Area, Pie, Donut, 3D Bar, 3D 
Stacked Bar, 3D Line, 3D Area, 3D Pie, 3D Donut.  

Drill down with 2D charts will open the Search Results for the record set. 

NOTE: Drill down is not supported for 3D charts. 

Formatting Height - Controls the default overall height of the chart dashboard part. 

Width - Controls the default overall width of the chart dashboard part. 
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Option Description 

X Axis Label – the label across the bottom of the chart. 

Show X Axis Item Labels - uncheck this box to turn off labels for the x axis of Bar 
and Line charts.  

X Axis Item Label Rotation – An angle to tilt the labels that appear with the 
values going across the chart 

Y Axis Label – a label across the side of the chart 

Legend Position – top, bottom, left and right 

Legend Label – a label that appears above the legend bar 

Show Item Tooltips – with this enabled, hovering over an item on the chart 
shows the values in a tooltip 

Show Item Labels – shows labels for the items on the chart. 

Show Item Label Connectors- draws a line from the item label to the item 

Item Label Distance – the distance between the item label and the chart 
segment it represents. 

 

Viewing Chart Details 

You can click on a section of a chart to view the list of records represented and then drill-down 
to individual records. 

NOTE: 3D charts do not have the drill down feature. 

To return to the Dashboard, click the GIFTS Online logo. 
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Exporting Charts to Excel 

Chart parts displayed on a dashboard can now be exported to Excel with a simple click of your 
mouse. 

Right-clicking anywhere on a chart part will display an Export Chart option in the lower left 
corner. 

 

Clicking on Export Chart will open a Windows browse window allowing you to name the export 
file and Save it to a location of your choice. 

Clicking on Export Chart will open a Windows browse window allowing you to name the export 
file and Save it to a location of your choice. 

Available Export formats include: 

 MS Excel 

 PNG (Portable Network Graphic format) 

 BMP (Bitmap image format) 

 XPS (XML Paper Specification) 

NOTE: If exported to Excel, when you open the saved file a warning message may be displayed. 
Simply click Yes to continue. It’s OK to open the file. You may need to Enable Editing if 
modifications are required. 
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The Image Dashboard Part 

This dashboard part lets you add an image to your Dashboard.  

You can add your own Title, Header, or Footer. 

 

Click the Browse button to search for the image file. 

Click Save to load the image into GIFTS Online. 

When done uploading, you will return to the current dashboard where the image will be 
displayed. 

CAUTION: Try to select small images that will not take up all your workspace.  

  

In-Progress Reviews Dashboard Part 

NOTE: This part is only available with the Reviews module installed. 

This part displays all Reviews that not yet completed. 

The configuration form allows you to enter a Title, Header, Footer, and select a Saved Search if 
available.  

 

The dashboard part will look similar to the example below: 
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Link List Dashboard Part 

NOTE: This part can only be created and configured by MicroEdge Services.  

This part is used to list one or more links at once. The links could be to other websites or other 
pages on your own website. 

To add the part: 

1. Select Add Part from the dashboard submenu. 
2. Click on Link List part button. 

 

3. Enter a Title, Header, and Footer if desired. 
4. Click the [+] icon in the middle to add a nee URL entry. 
5. Fill in the URL address, Label, Rollover Text, and Description. 
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6. If there are multiple links entered, you can use the arrows in the Actions column to move 
a link up or down. 

7. Clicking the X in the Actions column will remove the link. 
8. Click Save when complete. 

 

  

The Note Dashboard Part 

The Note dashboard part provides you with a space on your Dashboard to enter and save brief 
notes. 

To add it to your Dashboard: 

1. Click the Add Part menu option from the Dashboard submenu to open the Add Part form.  
2. Select Note from the dashboard part menu. 
3. Select Title, Note, Alignment, and Margins as desired. 
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4. Click Save when done to go to Note edit form. 

 

5. If you did not add a note in the configuration form, you can click the Click here link to 
enter a note directly into the dashboard part. 
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Online Applications and Reporting 

This new dashboard part allows users to see on an ongoing basis if they have any pending 
applications or requirements which need to be retrieved and reviewed for consideration.  

 

Default Title – Online Applications and Reporting 

Applications – The applications line has the following content: 

 The count of applications waiting to be retrieved since the last refresh 

 Label “Applications waiting to be retrieved” 

 A retrieve now link – is disabled if the count is zero. Clicking this link will navigate to the 
Retrieve and Manage Applications page and will automatically begin the download. 

Reports – Similar to Applications above, however, the retrieve now link will go to the Retrieve 
Submitted Requirements page. 

Last Refresh Date/time – The date and time the counts were last refreshed 

Refresh button – Refreshes the counts for both the applications and the reports 

  

When on the Dashboard, the counts will only be refreshed when you first log in to GIFTS Online. 

Unlike other dashboard parts that display data from the database, the counts will not be 
refreshed each time the dashboard itself is refreshed as this could negatively impact IGAM 
server performance. 

NOTE: In GIFTS Online, access to the Retrieve and Manage Applications or the Retrieve 
Submitted Requirements pages is through the Launch > Applications menu. 
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Submitted Reviews Dashboard Part 

NOTE: This part is only available with the Reviews module installed. 

This part lists all Reviews that have been submitted. 

To create a Submitted Review part, do the following: 

1. Select Add Part from the dashboard submenu. 

 

2. Fill in the Title, Header, Footer and select a Saved Search as needed. 
3. Click Save when done. 
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The Summary Dashboard Part 

This dashboard part provides a summary of the records resulting from a saved search.  

The saved search must be of a Request or Payment type. 

Adding a New Summary dashboard part 

To add a new Table dashboard part: 

1. Click Add Part on the Dashboard. 
2. Select Summary from the dashboard part menu and modify the Title, Header, Footer, 

Summary Type (Requests or Payments), and apply a Saved Search. 

 

3. Select the Summary Type. 
4. Select the desired Saved Search to apply using the menu and then click OK. 
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The Table Dashboard Part 

The Table dashboard part is a new generic dashboard part that will use a Saved Search or View 
to construct the table. You will be able to use all of the content options that can be seen in the 
Search Results. 

Adding a New Table Dashboard Part 

To add a new Table dashboard part: 

1. Click Add Part on the Dashboard. 

2. Select Table from the dashboard part menu and modify the Title, Header, Footer, Filter, 
and View assigned. 

 

3. The Filter field will at first be blank, so click the Modify link below it to open the Search 
form. 

4. On the Search form, select a Saved Search or use the Query Builder to create a new 
search. 

5. The View drop-down can be used to select a standard view or a saved view, if available. 
6. Click Save when done to return to the Dashboard. 
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Dashboard Part Properties 

Filter: All table dashboard parts are associated with filters that determine the data to be 
displayed. The user can associate a Saved Search, or create a new query just as they would do 
from the standard Search popup. 

 The field will display the name/criteria of the current search. 

 The Modify link will open a version of the Search popup. 

 This version of the popup differs from the standard in the following ways: 

o There is no access to Recent Searches 
o The Search button is relabeled Select. 

 If you choose a Saved Search or click Select, the search popup will close and the Filters for 
the dashboard part will be updated accordingly. 

o Note that if the user changes the Record Type here, then the View selection 
(described below) will be reset to “(defaults)”. 

View: This drop-down determines the columns and sort order for the table. 

The user will have the option of using the system defaults (the default option) or choose a 
Saved View. There is no link here to create or modify a saved view. 

If the dashboard part has been created from the Search Results, it will use whatever 
columns and sorts were in place on the Search Results page at that time. In this case, the 
drop-down will be set to “(search results)”. The user can choose a saved View instead, 
but will have no other way of changing the columns and sorts except by removing the 
dashboard part and recreating it. 

Display 

The Table dashboard part will include the following options: 

 Printer-friendly version 

 Export to Excel 

 Open in Workspace 

 Configure menu 

 Minimize/Restore 

 Navigation controls on the bottom 
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The Web Clipping Dashboard Part 

The Web Clipping dashboard part displays the contents of a specified webpage.  

NOTE: For security reasons, if you would like this part hidden please contact MicroEdge Support. 

Click Add Part on the dashboard. 

 

The configuration form will have settings for Title, Header, Footer, URL, and Margins. 

The contents of the chosen URL (webpage address) will be displayed on the dashboard part just 
like it if it was in a mini-browser window. 

NOTE: None of the fields are required. However, if the URL field is left blank, the part will display 
on the dashboard with the message “Please specify a URL for this part.” 

There is no limit to the number of times you can add the Web Clipping dashboard part to the 
dashboard. Each Web Clipping dashboard part will refer to a specific URL and all links displayed 
will be functional. 
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CAUTION: Web Clippings is recommended only for sites that may be embedded in iFrames or 
otherwise displayed in web pages. For security reasons, some websites do not support iFrames. 
If such a webpage is used for the web clipping dashboard part, browser issues may occur.  
For example, using www.nytimes.com will cause an issue. However, using the RSS feed for 
content from the NY Times site will work: http://feeds.nytimes.com/nyt/rss/Americas. 
If you experience this issue with your web clipping dashboard part, please contact MicroEdge 
Support for assistance. 

  

The Search Results Page 

Whenever you run a search using either Setting Up Quick Find, Full Search, Recent Searches, or 
Saved Searches, the results will be displayed in what is known as the Workspace.  

This page is composed of a grid detailing the records returned by the search. Here you can 
review the matching records, double-click each to see its details, or select a batch of records for 
which to generate emails, letters, or write-ups. 

NOTE: The Workspace also displays if you double-click a section of a 2D chart. 

TIP: If you run a Saved Search that is associated with a Saved View, the view will be applied to 
the search results on the Workspace. Otherwise, your search results will display in the default 
view. You can also apply a Saved View to this page by simply selecting from the View drop-
down menu on the bottom of the page. 
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Links in the Search Results Page 

There are a number of links within the Workspace that you can use to locate data, to configure 
your personal viewing preferences, or to print or export your search results: 

Element Description 

A In addition to the existing New, Launch, Admin, and Actions menus, a new Options menu 
will be added with the following options: 

• Export – Exports the current results to Excel 

• Print – Opens a new browser window with the search results ready for printing. 

• View Summary – Only available for Requests and Payments. This displays a summary of 
all the records in the search results, regardless of records which may be selected. 

For Requests – A bar chart displays Granted, Declined, Pending total amounts and a pie 
chart displays Paid and Balance totals. 

For Payments – A pie chart displays number of Payment records, Total Scheduled 
Payments, Total Paid and Balance to be Paid. 

• Add to Dashboard – Adds the current search results to a selected dashboard as a table 
part. 

    

B Related Records Panel 

This panel provides links to view the records related to the selected record(s). The count 
beside the record type indicates the number of related records of that type. 

Clicking a related record type with a count will open a new GIFTS Online page on the 
workspace to display the associated records. A new workspace taskbar tab will be created 
for each list you open. 

TIP: See the Related Records section on next page for more details. 

    

C Search Results 

Search results title and sub-title will show the record type searched and summarize the 
search criteria. 

• Magnifying Glass icon (Change this search) to modify and rerun the search. 

• Disk icon (Save this search) to Save the search. 

• Keep these results – Check this box if you want to keep the search results available as a 
separate tab. 

• Select All – selects all records (up to 1000). 
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• Clear All – clears all records selected 

• # items selected – shows the current number of records selected. 

    

D This is the search results grid itself. Columns displayed will vary according to the current 
view selected. 

• Select All/Clear All Checkbox – this checkbox on the left column will select all or clear all 
records on the page. 

• Column Sort – to the right of some column headers(not all columns are sortable from the 
column header) is a double arrow sort icon which can be used to sort all results in 
ascending or descending order by that column. 

This grid also allows users to adjust column width by mouse. 

    

E Also found in the area below the search results grid are the page options for number of 
records per page, previous/next, first/last, jump to a page, and refresh the page. 

F The View menu lists applicable views. 

Also to the right of the menu are options for Change Display and Save View.  

 

NOTE: The Save View option is only available if the current view has been changed. 

    

G Search results tabs along the bottom allow you to switch between record sets from 
multiple searches, and the dashboard if you check the Keep these results box for each 
search. 
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Search Results: Change Display 

The Change Display option allows you to change the columns that are displayed for the selected 
View in the Workspace and edit the formatting for each column heading.  

To access the Change Display window, click the Modify icon, to the right of the View menu on 
the bottom. 

 

The following image displays the Change Display form: 

 

From this section, you can: 

 Add columns to the View 

 Edit the column headings 

 Specify the format—such as font, font color or justification—of the data in each column  

 Change the order (from left to right) in which the columns are displayed 

 Remove columns 

 Combine columns, displaying the data they contain in a single column 

 Sort columns 

 Reset the default columns 
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Adding Columns 

You can choose columns from the Available Columns list and add them to the View grid. Each 
available column displays a specific piece of information; the available columns are divided into 
the categories of information that they represent. 

You can use Select available columns from drop-down menu to choose a category of 
information. Note that the Defaults category always lists the default columns provided with 
GIFTS Online. 

To add a column to the View grid: 

1. Choose a category of information from the Select available columns from drop-down 
menu. The available columns for that category appear. 

2. Highlight a column and click Include to add it to the View grid. It appears in the column 
list on the right of the screen.  

NOTE: The column name is preceded by the name of its category. For instance, 
"Organization: Legal Name." 

3. Click Apply.  

Editing Column Headings 

To edit any column: 

 

1. In the View grid on the right side of the screen, select the column whose heading you 
wish to change.  

2. Edit the heading in the Heading field.  

TIP: You can click the right mouse button to access standard Windows editing functions 
like cut and paste. 
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Formatting a Column 

Each column displayed in the View grid on the right side of the screen can be customized with its 
own font, font color, alignment, and other formatting options. To format a column: 

 

1. In the View grid, select the column you wish to format. The buttons in the formatting 
toolbar become available. 

2. Use the formatting toolbar to customize the column. You can select font, font size, and 
font color. Text within the column can be aligned to the left, right, or center. You can also 
format column text to be bold, italicized, and/or underlined. 

Changing the Column Order 

To determine the order (from left to right) of the columns in the View grid, you can click the 
Move icon on the right side of the column to drag the column to a new position within the View 
grid.  
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Removing Columns 

To remove a column: 

1. In the View grid, select the column you wish to remove.  
2. Click Remove. The column is removed from the list, and will not be displayed in the View 

grid. 

 

Combining Columns 

Combining columns allows you to maximize the amount of data displayed in the View. When 
columns are combined, data from each column is listed line by line in a single column.  

Combined columns can be edited, formatted, moved, and resized like regular columns. You can 
also separate one or more (or all) columns after combining them. 

To combine columns: 

1. In the View grid, select the columns you wish to combine.  

TIP: Press CTRL to select more than one column. 

2. Once all columns you wish to combine are highlighted, click Combine. The columns are 
combined. 
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Each element in the combined column maintains a row of its own in the View grid. Note, 
however, that each element in the combination shares the same column number. This indicates 
the column in which the combined information will appear. 

 

To separate elements from a combined column: 

1. In the View grid, select the element you wish to remove from the combined column. If 
you are removing more than one, press CTRL as you click them. 

2. Click Separate. The column is separated and placed in order just below the combined 
column. The Column numbers change accordingly. 
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Sorting Columns 

By default, records in Views are sorted either alphabetically or by date. For example, 
Organizations are sorted alphabetically and Payments are sorted according to their Schedule 
date. You can sort records based on a number of properties—such as the Program Area of 
Requests—and choose whether the sort order is ascending or descending. 

In case two or more records have the same value in the sorting property—for instance if you are 
sorting Requests by Grant Amount and several of your grants are for $5,000—you can set as 
many as four secondary sort properties. 

To change the sort order for the View: 

 

1. Click the Sorting button on the Change Display page. 
2. Choose the primary sort category. The available columns are divided into the categories 

of information that they represent. 

The View will sort records according to the values in the column that you choose. For 
example, if you choose the Request Amount column and enable the Descending 
checkbox, the Request with the largest amount would be listed first, and the one with the 
smallest would be listed last. 

To choose a sort column, first choose the category to which it belongs; only the columns 
that belong to the category you choose are available in the Column list. Note that there is 
always a Defaults link, which lists the default column that GIFTS Online uses to sort 
records. Then, choose whether you want the sort order to be ascending or descending. 

NOTE: If you want the records to display in ascending order, you do not have to do 
anything. However, if you want the records to display in descending order, enable the 
Descending checkbox. 
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3. Choose secondary sort columns, as desired, and specify whether they are ascending or 
descending sorts. Groups of records that have the same value in a sort column will be 
sorted according to the next secondary sort column. 

EXAMPLE: If you chose Coding Sheet. Program Area as the primary sort column for 
Requests, GIFTS Online uses the next secondary sort column to sort all of the Requests 
that share the same Program Area. 

4. Click OK to save the new sort order. 

Resetting the Default Columns 

While working with the columns and their headings, you may decide that you want to start from 
scratch, or that the default settings are the most appropriate for your needs. At any time, you 
can revert the columns, column headings, and column formatting to the defaults by clicking 
Defaults. 

  

Search Results: Save View 

Once you have modified the View of the Workspace and click Apply, a Save View icon will be 
available to the right of the Modify icon. 

 

Clicking the Save View icon opens the New View form which allows you to save the current view 
under a new name. 

 

Editing the Name and Description and Sharing the View 

You can edit the Name and Description of the saved View. If you want to allow others in your 
organization to access this View, enable the Allow others to use this View checkbox.  
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Working with Related Records 

The Workspace is designed to give you the easiest access to as much information as possible. 
One of the main ways it does this is with the Related Records panel which is available on the left 
side of all search results pages and record edit forms. 

 

 

Working with Related Records on a Search Results Page 
When you select records on a search results page, the system displays a Refresh icon next to the 
RELATED title. Clicking the Refresh icon will make the Workspace automatically locate all of the 
information related to the records currently selected and display counts next to each record 
type. 

For example: 

If you perform a search for Organizations and then select 2 or 3 of them, the Refresh icon will be 
displayed next to the RELATED title. 
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Clicking the Refresh icon will display counts for all of the related records. This could include 
Contacts, Requests, Payments, Requirements, Activities, and so on. 

 

You can click one of the Related Record types with a count next to it to display all those related 
records in a new GIFTS Online page. 

 

Here is the new related Requests page: 
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Notice on the bottom Workspace taskbar, a new tab is available for the Related Requests list 
page. 

The original Organizations Quick Find search results page is also represented by a tab. 

You can simply click back and forth between the different record type tabs, viewing and 
accessing information as necessary. 

  

  



GIFTS Online 5.1 User’s Guide 

88 
 

About GIFTS Online Edit Forms 

The edit form allows the user to view and edit the information in the record. It also provides 
access to the other types of records related to the current record. 

After doing a search, double clicking a record will open the edit form for the selected record.  

 

You can click Save or Save and Close to save your changes when finished. Save,  Save and Close 
and Cancel buttons appear at bottom of all edit forms. 

NOTE: Depending on your permissions, some GIFTS Online fields may be read-only or hidden 
from view entirely.  

Section # Content 

Header 1A The left portion of the header displays the record type icon and form title, and 
for some records, read-only status information about the record. 

The header also displays the Alert message, if one exists. 

  1B The right portion includes ribbon menus that allow you to take actions on the 
record. Most forms will have menus for New and Actions. 

Left Panel 2A The data entry fields are divided into sections, which are represented by the 
buttons in the top portion of the left panel. Clicking on a button ‘jumps’ to the 
first prompt at the beginning of that section. 

  2B The lower portion shows the other types of records to which the current record 
may be related, and counts of each. Clicking one of these links replaces the 
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center section of the form (where the data entry fields are displayed) with a 
grid showing the related records. 

  2C A minimize/maximize feature allows you to control whether or not the panel 
displays. 

A splitter between the top and bottom sections allows you to resize as desired. 

Data Entry 
Fields 

3 The center section of the form includes the data entry fields. In general, fields 
are arranged in a single, vertical column, but some exceptions (such as for the 
related phone number/extension fields, or city/state/zip) are arranged 
horizontally. 

Groups of fields are divided into sections by headers that can be used to 
collapse or expand a section. 

By default, all sections are displayed expanded when an edit form is opened. 

NOTE: If you are experiencing slow loading times due to a large number of 
custom fields or sections, you can do the following to improve load times: 

1. Click the Collapse All link in the lower left corner. 

2. Expand only the sections you prefer to display most often. 

3. Click the Remember link. 

In the future, any edit form opened of the same record type will be displayed 
the same way.  

Right Panel 4A The upper section displays ‘cards’ that provide information on the record’s 
‘primary’ (1:1) relationships. You can search for and associate an existing record 
for this relationship, create and associate a new record, or open the edit form 
for the current record. 

  4B The bottom portion of the right panel automatically displays any image files 
associated with the current record. If more than one image is available, the user 
can scroll through them. If no images are available, the section will display as 
collapsed. 

Footer 5A The footer contains the command buttons for Save, Save & Close, and Cancel. 

  5B When multiple related records are opened, the Edit Form Task Bar will display 
buttons to directly jump to those records. 
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Resolving Conflicting Changes 

Since it is possible for multiple users with correct permissions to edit a record at one time, GIFTS 
Online checks for conflicts before saving any changes. Once you click Save or Save and Close in 
an edit form, GIFTS Online compares your changes to the current record in the database. If 
there are no conflicts, the record is saved and you are returned to the record’s edit form.  

If you have changed a field that has also changed in the database since you last accessed the 
record, the edit form will reopen with a message at the top warning you of the conflict. You can 
then decide whether you wish to overwrite the record with your changes, or leave the current 
record unchanged. You may also choose to edit the record further and resubmit your changes. 

When you receive a conflict message: 

 Click Save or Save and Close to overwrite the record with your changes. If you have made 
any new changes, the record is checked again for conflicts with the current database. 

 Click Cancel to ignore your changes. 

Validating Changes 

If the changes you make to a record affect other GIFTS Online records, GIFTS Online re-displays 
the edit form with a list of issues at the top. 

For example, if you change the address of an Organization, this change impacts the Contact 
records affiliated with that Organization. GIFTS Online displays a message giving you the option 
of changing the address for the Contacts as well. 

 

Select the affiliated Contacts whose address you would like to change, then click Save or Save 
and Close to apply your selections. Click Cancel to save the record without the changes. 
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Classifications Administration 

In previous versions of GIFTS Online, the configuration of code tables for each client’s site was 
done by MicroEdge staff. With GIFTS Online, a new Admin menu option called Classifications 
will allow you to access and modify your Classification code table settings directly. 

NOTE: This option will only be visible to Grant Managers initially but can be made available to 
other roles by submitting a request to MicroEdge. 

Clicking this option will open the Classification Tables window. 

 

All existing tables will be listed alphabetically along with the table/sheet type and can be clicked 
to open an edit form for modifying settings. 

NOTE: For the G/L Accounts table only, if Branch Security is enabled, you may first need to 
indicate which branch you wish to work with. 
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GIFTS Online divides classification tables into two broad categories – “System” tables, which 
have some specific purpose in the business logic, and “Coding sheet” tables, which can be 
included in the Coding Sheet sections of the Organization, Request, and Contact data entry 
forms. 

Add New Table 

This link will open a new classification table edit form similar to the one shown above with the 
Name and Levels fields enabled. 

Coding Sheet Configuration 

This link opens the Coding Sheet Configuration form allowing you to re-order the coding sheets 
which appear on the Request, Organization, or Contact edit forms. 

 

Note that red dots mean a required code selection. 

For Requests only, a menu on the bottom lets you choose whether to make the selected 
required coding sheet mandatory at time of creation or approval of a Request. 
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Printer-friendly Version 

Clicking Printer-friendly Version link on the main Classification Tables form will display a 
summary report of the Coding Sheets currently in use on your Organization, Request, and 
Contact edit forms. 

 

Editing a Coding Sheet 

Clicking on a coding sheet link will open the Classification edit form. 

 

 Left Panel: The left panel includes navigation links for the two sections of the form, 
Coding and Values. 

 Action Menu: 
o New – create a new code in the table 
o Change Branch - this option only appears on the G/L Accounts table if it is 

configured for branch security 
o New Sub – create a new sub-level code to the table 
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o Sort – sort the codes listed in the Values section by Code or Description 
o Delete - removes the entire table from the database. This option will only be 

available for custom tables. 

 Coding: Settings which affect the behavior of the whole code table. 
o Set the maximum number of codes which can be selected 
o Require entry at lowest level of a branching code table 
o Track percentages on Requests 

 Values: This section lists all of the classification codes within that table. For tables with 
many values you can use the Find field. Simply enter the value you are looking for and 
click either the Previous(Down) or Next(Up) arrow buttons. 

 

To edit a value, hover the mouse cursor over it and click the Pencil icon. 

 

The popup form gives you access to the following fields and options: 

Parent - displays the code value and description of the next level up for 2nd and 3rd level 
values. Hidden if the current level is 1. 
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Code - (optional) a short version of the code (20 chars max). Only available on 1st and 
2nd level values. 

Description - (required) the actual name of the code value. (255 chars max) 

Disposition – Only available on 3rd level values. This field lets you define which 
disposition to make the value available for. Pending, Approved, Declined, or All(default). 

 

Deactivate/Activate- toggles the status of the code value. 

Delete - deletes the specific code value. 

OK - closes the popup and refreshes the display to reflect the new value. 

Add Another - only displayed creating a New/New Sub code value. Saves the current 
value and clears the popup form so you can add more values. 

Cancel - Closes the popup without saving. 

Printer-friendly Version: Clicking the Printer-friendly Version link on the edit form will 
open a new window displaying the classification table’s Description, Code, ID number, 
and Active status for all values. 
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Expand All/Collapse All: Expands or Collapses all levels of the value tree to the top level. 

 Right Panel: Options here allow you to choose to include the coding sheet in your 
Request, Organization, or Contact edit forms. You can also make some required, if 
necessary. Clicking the Pencil icon will allow you to select a default value from a popup 
form. 

 

NOTE: The configuration options available will depend on the type of coding sheet selected. 
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Working with Organizations 

An Organization record in GIFTS Online is similar to a file folder for an organization that you are 
considering for funding. Organization records include all your information about an 
Organization, including its background, tax status, mailing and web addresses, and telephone 
numbers. 

The Organization record is also linked to the other records that apply to it, such as Request 
records for its proposals and Contact records for the people affiliated with the Organization. 

This section contains the following topics: 

Adding an Organization 

Changing the Organization’s Primary Contact 

Organization Available Actions 

The Organization Edit Form 

  

Adding an Organization 

Grants Managers and Program Officers can add a new Organization record; the process begins 
on the home page. 

NOTE: A new Organization record may also be created by considering an application submitted 
by a grant seeker not already in your system. 

1. In the New menu, click the Organization button.  

 

2. If configured by your administrator, the Duplicate Checking page opens. Before adding 
the new organization, you will search your current records to ensure you aren't adding a 
duplicate record. Type in part of the organization name and click Search. Search results 
open. 

3. If you see the organization you want to add already listed, you can select the radio button 
next to it and click Select to go to its Organization edit form. 

If your new organization is not listed, click New. An Edit Organization form opens. 

NOTE:  The partial name you searched by defaults into the Name field. 

4. Enter the organization data and click Save & Close to save the new Organization. The 
Organization detail page opens. 

../../../Content/33-Module-Online%20Applications%20and%20Requirements/04-Accessing%20the%20Applications%20Menu.htm
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The Organization Edit Form 

The Organization edit form displays details on an Organization and provides an overview of your 
history with it. An Organization's edit form is shown when you click a link to the organization 
anywhere in GIFTS Online. 

The main data entry area of the form includes: 

Organization: Contact information such as Name, address, phone number, and email address. 

Legal Status: Legal data such as Tax ID, Tax Status, and Charitable Organization. 

Background: Includes background history, aka name, vendor number, and annual budget. 

Wire Transfer: Bank information 

Coding: Default Organization Type. Click the link to change the code value. 

Staff Info 

For a details on working with each area of the Organization's edit form, please see About GIFTS 
Online Edit Forms. 

  

Organization Available Actions 

A combination of the following Actions may be included on the Organization Edit Form: 

Edit Organization The standard Organization edit form is displayed in the center of the 
screen where you can make changes to any fields that you have 
permission to edit. 

NEW   

Request Displays a standard Request edit form where you can create a new 
Request for the Organization. 

Requirement Displays an edit form where you can create a new requirement and 
relate it to an existing Request or Payment. 

Document Displays an edit form where you can create a new Document 
Activity by uploading an external document to GIFTS Online. 

Activity Displays a standard Activity edit form where you can create a new 
Activity for the Organization. 

Affiliation Allows you to affiliate a Contact with the Organization. Click here for 
details. An Affiliation is a record that describes the relationship 
between a Contact and an Organization or Request. 
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ACTIONS   

Set Alert If you have permission to edit Organization alerts, you can use the 
Alert section of the edit form to change, add, or remove alert 
information. 

Research Guidestar Opens the Guidestar Advanced Search webpage. 

Delete Deletes the Organization. (You are prompted for confirmation 
before the deletion is completed.) Be sure you want to delete the 
Organization, as there is no way to undo the deletion. 

Generate Email Displays a Generate Email page where you can create a new email. 

Generate Letter Displays a Generate Letter page where you can create a new letter. 

    

Primary Contact The Primary Contact Card have four icons that allow you to: 

 Search for a contact 

 Add a New Contact 

 Open the Edit form for the Primary Contact 

 Remove the Relationship 

View Related Records Links on the lower left panel will display any related records. 

  

Changing the Organization’s Primary Contact 

To change an Organization’s Primary Contact: 

1. Open the Organization Edit Form. 

NOTE: If GIFTS Online is configured to automatically search for duplicate Contacts, 
the New button is not displayed until you have searched for an existing Contact. 

2. Click the spy glass icon under the current Primary Contact for the organization. 
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2.  When the Select Primary Contact search form opens, type the last name of the Contact 
you wish to assign as the new Primary Contact for the Organization, and then click the 
arrow button. The search results display. 

 

2. To choose a Contact from search results, double click it from the list. 
3. If no existing Contact records match your search, you can run another search or click New 

to create a new Contact record. 

Duplicate Consolidation 

Over time, it is quite common to end up with duplicate records in your database, particularly 
Organizations and Contacts. These can lead to inaccurate reporting and embarrassing mistakes. 

In order to help identify duplicate organizations and contacts, Crystal Report templates were 
created. 

 Duplicate Organizations (by Name) 

 Duplicate Contacts (by Last Name) 

 Duplicate Contacts (by Social Security Number) 

These reports are included in the Reports Library. 

Once you have identified the possible duplicates, the option to Consolidate Duplicates on the 
Actions menu of Search Results page for both Organizations and Contacts can be used. 
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To consolidate duplicate Organizations or Contacts, do the following: 

1. Perform a Quick Find or Full Search for Organizations or Contacts which you know are 
duplicates from the above reports. 

2. Select the duplicate Organizations on the search results page. 
3. Go to Actions > Consolidate Duplicates to open the Consolidate Duplicates form. 

 

The first record selected will be placed in the Valid Record side of the form and all others 
will be displayed on the right side as Duplicates. 

4. To make an Organization on the right side the valid record, click the arrow icon on the top 
right corner of its card. The current record on the valid side will be moved to the 
duplicates side. 

5. Click the Consolidate button. 
6. A confirmation message will ask if you wish to delete all duplicate records.  

 Yes - moves all related data to the valid record and deletes the duplicates. 

 No - moves all the related data to the valid record without deleting the duplicates. 

 Back - takes you back to the Consolidate Duplicates form. 
7. Click OK at the next message to continue. 
8. Click OK at the success message. 
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Working with Requests 

The term “Request” is the term GIFTS Online uses for all requests for funding, regardless of their 
status or disposition. Grants, proposals, and declinations are all considered Requests. 

Whenever you need to edit an existing Request record, you should access the Request edit form 
by either running a search or clicking on a link to the Request in any part of GIFTS Online. Then 
locate the Actions menu and click on the appropriate link. 

This section contains the following topics: 

Adding a Request 

Request Detail Pages 

Request Available Actions 

Approving a Request 

Declining a Request 

Changing the Request's Primary Contact 

  

Adding a Request 

If you receive a grant seeker's proposal offline, you can enter it yourself. 

NOTE: New Requests are also created by considering applications submitted by grant seekers 
online. 

1. In order to create a Request, you must first identify the Organization submitting the 
proposal. Once you have searched for and found the Organization, go to its Organization 
edit form and click New > Request in the Actions menu. The New Request page opens. 

NOTE: If the organization is not yet saved in your system, create a new Organization 
record for it for it first, then continue with these steps. 

2. The Request edit form for the pending Request opens. Enter the request data and click 
Save & Close 

You can enter Request coding information directly in the edit form. 

  

Request Edit Form 

The Request Edit Form displays details on a Request and provides an overview of its payment 
and requirement schedules. A Request's edit form is shown when you click a link to the proposal 
or grant anywhere in GIFTS Online. 

At any given time, each Request has a Disposition and a Status. You can use these two indicators 
to keep track of which stage in your workflow a particular Request has reached. There are three 
Dispositions, which give a general indication of a Request’s place within your workflow: Pending, 
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Approved, or Declined. The three Dispositions are permanently defined by the system because 
these general classifications can apply to all Requests in any workflow. 

This overview describes the different dashboard parts seen on the Request edit forms. Note that 
the edit forms are a bit different for each Request disposition (pending, approved, or declined). 
Those differences are noted below. 

  

Title 

Across the top span of the page, the Title dashboard part shows key information about the 
Request.  

The number after the Request title is always the Request ID number unless it is a new request 
that has not been saved yet. 

 

The information is different for each disposition. 

Pending Requests Title is labeled Proposal, and shows the Request amount and Request 
date, followed by the Recommended Amount. 

Approved Requests Title is labeled Approved, and shows grant Amount and the Award 
Date. 

Decline Requests Title is labeled Declination, and shows the Declination Date and 
Reason. 

  

Edit Form Categories 

The following categories may be available on your Request form depending on : 

 General 

 Approval 

 Request 

 Coding: This section allows you to keep track of any code table values assigned by your 
administrator. 

NOTE: The code sheet is now built into the Request edit form instead of being a separate 
form. 

 Meeting 

 Evaluation 

 Renewal 

 Wire Transfer 
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Working with Request Coding Sheets 

The Request Coding section is used to classify proposals and grants for reporting and queries. 

While you may not use all these categories, the following classifications are included by default 
in GIFTS Online Requests: 

 Age Group 

 Fund 

 Geographical Area Served 

 Internal Program 

 Population Served 

 Program Area 

 Type of Support 

The codes themselves - the classifications you enter for each of the categories listed above - are 
set up specifically for your grant-making activities. These codes serve as consistent terms 
tailored to your grant-making to make consistent reporting easier. 

  

Editing the Coding Sheet 

You can add, edit, or remove coding from a Request from its Edit Form: 

1. Open the Request Edit Form and scroll down to the Coding Sheet section or click the 
Coding details link. 

 

For code tables that allow more than one value, you must click the link to open the code 
table form. 

For code tables that allow only one value, a drop down menu will be available.  

 

2. Once code values are selected, they will be displayed on the Coding section.  

For code tables with multiple values, a + or X symbol will be available. The plus sign 
allows you to add additional values if the code table allows it. If not, a red warning 
symbol will appear and you will need to use the X to delete values until you have the right 
amount. 
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3. To remove a code, click the X next to the value or change the menu selection to <No 
Selection>.  

4. If a category allows multiple codes, the value selected first becomes the primary; the 
other codes are secondary codes. 

TIP: Most GIFTS Online reports use primary codes to group records. The use of primary 
codes also ensures that records are not repeated within the report, which would “inflate” 
the total information for the report. 

To modify a primary code, click on the code table's link to open the code selection form 
and clear all the values. Select the value you want as primary first and then add the other 
values back in.  

6. Once you have finished adding, removing, or re-prioritizing, click Save. 

IMPORTANT: No changes you made to the Coding Sheet will be saved until you click Save 
or Save & Close. Make sure you complete this step. You can click Cancel to cancel your 
changes and return to the Request detail page. 

  

  

Request Available Actions 

Aside from the edit form categories described in Request Edit Form, the following menu actions 
will be available. 

 NEW   

Payment Displays a standard Payment edit form where you can create a new 
Payment for the Request. 

Requirement Displays an edit form where you can create a new requirement and 
relate it to an existing Request or Payment. 

Document Displays an edit form where you can create a new Document 
Activity by uploading an external document to GIFTS Online. 

Activity Displays a standard Activity edit form where you can create a new 
Activity for the Request. 

Affiliation Allows you to affiliate a Contact with the Request. An Affiliation is a 
record that describes the relationship between a Contact and an 
Organization or Request. 

ACTIONS   

Set Alert If you have permission to edit Organization alerts, you can use the 
Alert section of the edit form to change, add, or remove alert 
information. 
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Approve Approve the request. 

Decline Decline the request. 

Lock Lock the request. 

Create Grantee Account Only with Online Applications and Requirements module. 

Write-Up Displays a Generate Write-Up page where you can create a write-up. 

Generate Letter Displays a Generate Letter page where you can create a new letter. 

Generate Email Displays a Generate Email page where you can create a new email. 

Assign Reviewers Assign reviewers to the request. 

Transfer to Another 
Branch 

NOTE: This link is only seen if you have Branch Security, an optional 
feature; your GIFTS Online system may not use Branch Security. 

You can transfer a Request (and its Payments, Activities, 
Requirements, and Reviews) to another branch for future handling. 

For users of the optional Budget Module: 

If any Payment(s) for this Request have appropriated funds from 
your Annual Budget, you cannot transfer this Request to another 
branch without first deleting the appropriated Payment(s). 

Primary Relationship 
Cards 

  

Organization The Organization Card has three icons: 

 Search for an organization 

 Add New Organization 

 Open the Organization record 

Contact 
The Contact Card have four icons that allow you to: 

 Search for a contact 

 Add a New Contact 

 Open the Edit form for the Contact 

 Remove the Relationship 

    

View Related Records Links on the lower left panel will display any related records. 
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Approving a Request 

Each new Request is automatically created with a disposition of Pending, meaning that it is 
awaiting a decision on whether it will be approved or declined. When you approve a Request, 
you can record the grant amount, the grant date, and other important information. You can 
have the system automatically schedule payments as well. 

1. In order to approve a Request, you must first go to the Request's edit form. Once you 
have searched for and found the Request, go to its Request edit form and click Approve 
in the Actions menu. 

The Request Approval page opens: 

 

2. The Grant Amount defaults to the Recommended Amount of the Request and the Date 
defaults to the current date. 

3. The Term of the project in months should fill in automatically. 
4. The Start Date and the End Date should fill in automatically. 
5. Enter Meeting Minutes and a Reference Number if desired. 
6. For New Status, select Active Grant if you wish to designate the number of payments. If 

Closed Grant is selected, the payments will default to one time. 
7. Click Next to continue to the Payments form. 
8. Initially, the Number of Payments is set to 1. This can be changed if you would like 

multiple payments. 

NOTE: You can add Payments later if you do not want to schedule them now. 

 If you keep the “1”, a single Payment for the full grant amount is scheduled for the 
Award Date. 
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 If you enter two or more, the system splits the grant amount evenly over the 
number of payments specified. 

 If there is an open budget or budgets for the new Payments' fiscal years, you will 
be required to appropriate funds for the payments before proceeding. 

9. If you would like to set up multiple payments, modify the Number of Payments and click 
the arrow button. Confirm the change by clicking Yes when prompted. Notice the number 
of payment lines below will change to match. 

 

10. Once you have the number of payments set, you can select the Type and G/L account to 
use for each. 

11. Click Next to continue. 
12. If you have the Budget module, the next page will require you to select a fund to 

appropriate funds for the grant's payments. This is done by select the payment(s) 
checkbox in the Appropriation window and then selecting from the available funds listed 
below. 
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NOTE: If you have the Budget module and do not appropriate funds, you will be 
reminded that these payments will need to be appropriated before the payments can be 
marked as paid when you click Done. 

 

13. Click Done to complete the approval and then click OK. 

 

14. The grant edit form will now refresh and the new Payment(s) will be accessible through 
the Related list. 
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Declining a Request 

When you decline a Request, you can record the declination date, a declination reason, and 
other pertinent information. 

In general, only pending Requests are declined. However, in some cases, if a grant was approved 
prematurely or a similar error was made, you may wish to decline an approved Request. GIFTS 
Online allows you to do so. 

1. In order to decline a Request, you must first go to the Request's edit form. Once you have 
searched for and found the Request, open to its Request edit form and click  Decline in 
the Actions menu. The Request Declination page opens. 

 

2. Enter the declination information, including Date and the Declination Reason, which are 
required.  

TIP: If you select the Close Affiliations check box, the current date will be entered as the 
end date of all Contacts' Affiliations with this Request, effectively closing those 
Affiliations. 

3. Click OK to complete the process. 
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Amending a Grant 

Occasionally, the award amount of a grant may change. The amount originally awarded to the 
grantee may increase, or a future Payment may be canceled, decreasing the total Grant 
Amount. When you amend the amount of a grant, GIFTS Online maintains the original amount 
as historical data. 

NOTE: Only Grants Managers have permission to amend grants. 

Grant Amendments are triggered when you make changes to a grant’s Payment Schedule that 
affect the total Grant Amount, such as the addition of a new Payment. You are automatically 
prompted to by GIFTS Online to perform a Grant Amendment to accommodate the change. 

  

If you open an approved Request record (a Grant), you will notice that the Granted field is 
disabled and Read-Only. 

1. To make a change, you must choose  Amend from the Actions menu.  

 

2. Enter the new Grant amount in the Amended field. (If you're here because you're adding 
a Payment, the new grant amount will reflect that Payment.) 

3. You can also update the Terms, Start/End Dates, Activity Date, Fiscal Year, and add a 
Note, if desired. 

4. Click OK to save the amendment 
5. Click Save & Close to save the record. 
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Changing the Request’s Primary Contact 

To change a Request’s Contact: 

1. On the Primary Contact Card, click the Search icon. 

2. Type the last name of the Contact you wish to assign as the new Primary Contact for the 
Request, and then click Search. The search results appear. 

3. To choose a Contact from search results, double click it on the list. 
4. If no existing Contact records match your search, you can run another search or click New 

to create a new Contact record. 
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Percentage Coding 

Percentage Coding allows the assignment of percentages to code values selected from Request 
type code tables. The percentages are then used to calculate corresponding Request/Grant 
dollar amounts. These allocations can then be displayed in Views, Ad-Hoc reports, Charts, and 
the Request record where they are assigned. They may also be assigned in Online Applications. 

  

Tables That Can Be Enabled 

The following standard Request Coding Tables can be enabled for percentages: 

 Age Group 

 Ethnicity 

 Fund 

 Gender 

 Geographical Area Served 

 Population Served 

 Program Area 

 Type of Support 

Maximum Number of Selections Per Table 

To enable percentages for a code table, ME Support must set the maximum number of 
selections to greater than one. 

Please consider the maximum number of codes (2 to 20) you want to allow per table so you can 
advise ME Support. 

The current GIFTS Online maximum is 20 for each table. 

  

IMPORTANT: Please contact ME Support if you wish to enable Percentage Coding for specific 
code tables.  
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Percentage Coding in Requests 

If at least one code table is enabled for percentage coding, the Coding section of a Request will 
display two additional columns. One column will be for Percentage and the other for Amount. 
Only enabled code tables will display values in these columns. 

 

You can enter a value in either column and the system will automatically calculate the 
associated value when you Tab or click out of the field.  

IMPORTANT: An exclamation mark next to the primary amount means you are over or under 
100% allocation. 

Two icons are available next to each value selected.  

Clicking the flag icon will make the value become the Primary. Clicking the X icon will remove 
the value from the record. 

To select code values, click one of the displayed Code table classifications. 

If percentage coding is enabled, the Coding Sheet form will also have columns displayed for any 
percentage coding. 
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Percentage Coding Validation 

The following validation rules apply when saving and closing the Request: 

 The first code specified within a category will be set to 100% with the full request/grant 
amount. 

 The second code selected will be assigned 0% initially. The fields will become editable 
from this point onwards. 

 If only two codes are specified, changing one will automatically recalculate the other. 

 If more than two are set, no automatic adjustments will be made. 

 Percentages only support whole numbers. 

 If a category’s subtotal is not 100% of the Request/Grant amount, you will not be able to 
Save & Close. 

Percentage Coding with Request Approval or Rollback to 

Pending 

When a Request is approved or rolled back to Pending, and the Grant amount changes, the 
system will automatically adjust the amounts in the Coding section. 

Percentage Coding for Grant Amendments 

Amending a Grant will prompt the user to amend the allocations by opening a form entitled 
Grant Amendment - Adjust Percentage Coding. 

In order to proceed, percentages will have to be manually adjusted to account for the new Grant 
amount. 
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Percentage Coding in Request Views 

Percentage Coding can be displayed in custom Request Views by doing the following: 

1. In the GIFTS Online Search Results page, select Change Display in the Options menu. 
2. Under Available Columns, select Coding Sheet. 

 

3. Add the percentage coding enabled table to the Show list on the right. 
4. Click on the new table on the right to display its options below. 
5. It is recommended to set the column display to Primary and Secondary if you have 

multiple percentage codes for each request. 
6. Check the box for Display percentages. 
7. Click Save and then click Apply to see your new View. 

  

Percentage Coding in Search Results 

Percentages can also be displayed on the Search Results pages and saved Views by enabling a 
new option under the column’s Formatting settings. 

1. From the Search Results page, select Options > Change Display. 

2. If not currently in the Include list on the right, add a Coding Sheet table with percentages 
enabled. 
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3. Select the Coding Sheet column, and then click the Formatting button. 

4. In the Formatting window, check the box to Include percentages. 

5. Click OK and then Apply. 

 

When this box is checked, the percentage amount will appear alongside the value. 

Note that this will also apply to Table dashboard parts added to the Dashboard for Search 
Results, and to a table dashboard part associated with a saved View. 

  

Percentage Coding in Online Applications 

Requirements: 

 Must have the Online Applications module configured. 

 Must have Percentage tracking enabled for Coding Sheet tables desired. 

 Must have Percentage enabled fields inserted in your applications forms by MicroEdge 
Support or Services. 

Percentage coding can be used in Online Applications to allow applicants the opportunity to 
enter percentages, but not the corresponding amounts. 

 

The retrieval process will bring in the percentages when creating or updating a Request, and 
calculate or recalculate the associated amounts. 
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Percentage Coding in Correspondence 

Percentage Coding can be enabled to appear in letter or email correspondence through the 
GIFTS Online Document Template Manager. 

TIP: Before accessing the Document Template Manager, make sure to take note of the tables 
that are currently enabled on your GIFTS Online site for percentages. 

  

To Add Percentages to a New Template: 

1. Open the Document Template Manager on a Windows OS computer. 
2. Select a Correspondence Category on the left panel. 
3. To create a new template, Go to New > New Template. 
4. Enter the Template Name, Description, and select a Template Type. 
5. Click OK to continue to the Merge Fields form. 

 

6. For the Select available fields from menu, select Coding Sheet or Requests Coding Sheet. 
This may vary depending on the Correspondence Category you initially selected. 
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7. Highlight the table in the list on the left that you want to include in the template and click 
Include. 

8. Repeat for other tables as necessary. 
9. In the included list on the right, select a table you want to have percentages enabled in 

the correspondence. 
10. The options for the table will be displayed in the bottom right section. 
11. Primary/Secondary Codes: This should be set to Primary & Secondary if you want all 

codes to be displayed in the correspondence. 
12. Delimiter between codes: Leave as default or pick a delimiter from the menu. 
13. Display Coding Percentages: check this box to enable percentages to be displayed in 

correspondence. 
14. Click OK to save the new template. 

To Modify Existing Templates for Percentages: 

1. Open the Document Template Manager on a Windows OS computer. 
2. Select a Correspondence Category on the left panel. 
3. Select an existing template from the ones listed. 
4. Go to Actions > Open Merge Fields to open the Merge Fields form. 
5. Follow steps 6 to 14 above. 

When the correspondence is generated by a user, the percentage will appear following the 
description value in parenthesis. 

Example: West \ Arizona (50%) 

  

Percentage Coding in Charts 

The Charts dashboard part in GIFTS Online has also been enhanced to be able to reflect 
percentages when you choose to group on a classification table where percentages are tracked. 

To include percentages in a chart: 

1. Access the chart’s configuration form. 

2. For Value Charted – 

• Set Aggregate to Sum, Average, Min, or Max (Count cannot be used with percentages.) 

• Set Category to Request 

• Set Column to Grant Amount or Request Amount 

3. For Group By – 

• Set Category to Coding Sheet 

• Set Column to the percentage enabled table desired 

• Check the box to Use Percentages. 

4. Click OK to save the configuration and go to your dashboard to see the chart. 
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If you choose this option, then both primary and secondary classifications will be represented in 
the chart, and the value for each classification will represent the appropriate % of either the 
Grant or Request amount. 

If you do not choose to enable the option, then the full Request or Grant Amount will be 
reflected in the “slice” for the classification flagged as the primary. 

NOTE: When charting the number of records (rather than some amount), GIFTS Online will chart 
a record only once by its (or its related Request’s) primary code only. 
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Working with Reviews 

Requests can be assigned to staff members or external experts for review. A GIFTS Online record 
called a Review tracks the Request being reviewed, the person performing the review, dates 
associated with the Review (such as the due date), and the reviewer’s feedback. 

NOTE: Internal Reviews (for staff members) and External Reviews (for outside reviewers) are 
optional GIFTS Online modules; your GIFTS Online system may include either, neither, or both 
internal and external Reviews. This and the following help topics will note which optional 
module you need for the topic to be relevant.  

The tasks which comprise this review process fall under two responsibilities: 

 Assigning and managing Reviews - The staff member responsible for the proposed 
Request (the “proposal owner”) assigns and manages Reviews. This could be a Grants 
Manager or Program Officer. 

 Completing Reviews - If you have been assigned a proposal to review, you can view the 
Request, enter your feedback, and submit it. External reviewers may also perform this 
task. 

The following is an overview of the review process: 

1. Assigning Proposals to Reviewers 

First, you as the proposal owner assign one or more reviewers to a proposal.  

2. Setting Up Required Review Sequences (Optional) 

If you as the proposal owner choose to set one up, a required review sequence sends the 
proposal to your internal staff reviewers one a time, based on the order of Reviews established 
in the proposal. If a reviewer accepts a proposal, it is sent on to the next reviewer. 

NOTE: Non-required internal Reviews and all external Reviews are sent to different reviewers 
concurrently.  

3. Notifying Reviewers 

GIFTS Online automatically sends each reviewer an email notification when it is his or her turn 
to review the proposal.  

4. Reviewing and Approving/Declining Proposals 

You as a reviewer then review the proposal. You may be asked to decline a proposal you 
recommend against, or approve a proposal you review favorably. This is the case only when you 
as a reviewer complete a required Review. 

If this is not the case, the proposal owner can still view and weigh your (and others') feedback 
when making his or her decision. 
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Assigning and Managing Reviews 

NOTE: This help topic describes features found in the optional Internal and External Reviews 
modules. If your GIFTS Online system does not include Reviews, you may disregard this 
information. 

Acting as a proposal owner, you will assign and manage Reviews for proposals. The topics below 
describe how to set up Reviews and review sequences.  

Assigning Proposals to Internal Reviewers 

Assigning Proposals to External Reviewers 

Setting Up Required Review Sequences 

Changing the Review Sequence 

  

Assigning Proposals to Internal Reviewers 

NOTE: This help topic describes features found in the optional Internal Reviews module. If your 
GIFTS Online system does not include Reviews, or is limited to using only External Reviews for 
non-staff reviewers, you may disregard this information. 

You can add one or more internal reviewers to a proposal. If you desire (and if the option is 
available for your organization), you can make reviews required and place them in a specific 
sequence.   

To assign a staff member to a proposal, first search for and find the Request you want to add a 
Review to and open its Request edit form to start. 

1. From the proposal edit form, click Assign Reviewers on the Action menu. The Assign 
Reviewers form appears. 
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2. Go down to the Internal Reviewers section and use the drop-down menu to select an 
internal reviewer, enter a Due Date, and then click Add. The reviewer will be added to the 
list below. Repeat this step for additional reviewers. 

 

3. Click Done. The reviewer is added to the proposal, and the proposal appears. To add an 
additional reviewer, click Add and repeat this process. 

IMPORTANT: If the Review is not required, or it's the first required Review you've added 
to the Request, the reviewer will receive email notification immediately. 
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Assigning Proposals to External Reviewers 

NOTE: This help topic describes features found in the optional External Reviews module. If your 
GIFTS Online system does not include Reviews, or is limited to using only Internal Reviews for 
staff members, you may disregard this information. 

You can add one or more external reviewers to a proposal. To assign a proposal to an outside 
expert, first search for and find the Request you want to add a Review to and open its Request 
edit form to start. 

  

To assign a staff member to a proposal, first search for and find the Request you want to add a 
Review to and open its Request edit form to start. 

1. From the proposal edit form, click Assign Reviewers on the Action menu. The Assign 
Reviewers form appears. 

 

2. Go down to the External Reviewers section and enter the last name of the reviewer you 
seek. Click the arrow button to begin the search.  

3. The Select External Reviewer screen will appear. Select a name on the list by double 
clicking on it. The External Reviewer window will open. 

4. On the External Reviewer form, enter an Acceptance Date and a Due Date then click Add 
Reviewer to go back to the Assign Reviewers form with the new name on top. 
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NOTE: The fields here are customized for your organization. If you want to make the 
Review part of a review sequence, select the Required checkbox, if available.  

4. Click Done. The reviewer is added to the proposal, and the proposal appears. To add an 
additional reviewer, click Add and repeat this process. 

  

Setting Up Required Review Sequences 

NOTE: This help topic describes features found in the optional Internal Reviews module. If your 
GIFTS Online system does not include Reviews, or is limited to using only External Reviews for 
non-staff reviewers, you may disregard this information. 

  

What Are Review Sequences? 

Required Review sequences allow you to follow your proposal workflow online, gathering 
feedback and recommendations from staff members one at a time, in the order you want.  

NOTE: Review sequences cannot include external reviewers. 

 If the first required Review is marked with a “yes”, the proposal is then sent to the next 
required reviewer. 

 If anyone at any point in the required review sequence marks his or her Review with a 
“no,” the sequence is suspended and the reviewer will be asked to decline the Request. 

 If the proposal gets a “yes” vote from all reviewers in the required review sequence, the 
last reviewer in the sequence will be asked to approve the Request. 

  

Working with Review Sequences 

There are two phases to setting up a review sequence: 

1. Add two or more Reviews to the proposal, marking all required. 

IMPORTANT: The first Reviewer you add will be notified immediately, and you will not be 
able to move him or her in the sequence order. 

2. If necessary, change the required review sequence. If you added Reviews in the order you 
want them done, you can skip this step. 

  

Changing the Review Sequence 

NOTE: This help topic describes features found in the optional Internal Reviews module. If your 
GIFTS Online system does not include Reviews, or is limited to using only External Reviews for 
non-staff reviewers, you may disregard this information. 

After you have set up a review sequence of internal Reviews, you can change that sequence, if 
necessary.  
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To change a review sequence, first search for and find the Request you want to add a Review to 
and open its Request edit form to start. 

1. In the Actions menu, click Assign Reviewers. The Assign Reviewers form opens.  

2. Click the up or down arrow next to the Reviewer you want to move. 

 

NOTE: Reviews which have already been completed, and the Review currently "in 
review," cannot be moved. 

3. Click Done. The review sequence has been changed.  

  

Completing Reviews 

NOTE: This help topic describes features found in the optional Internal Reviews module. If your 
GIFTS Online system does not include Reviews, or is limited to using only External Reviews for 
non-staff reviewers, you may disregard this information. 

If you have been set up to serve as a reviewer, newly assigned proposals will appear on your 
GIFTS Online home page. You can see Reviews you've completed in the past as well. 

From the home page you can then review the Request, enter your feedback, and submit your 
Review.  

Review Dashboard Parts 

Entering and Submitting Your Feedback 

Review Dashboard Parts 

NOTE: This help topic describes features found in the optional Internal Reviews module. If your 
GIFTS Online system does not include Reviews, or is limited to using only External Reviews for 
non-staff reviewers, you may disregard this information. 

If you have been set up to perform Reviews in GIFTS Online, you should see these two 
dashboard parts on your home page. 
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In Progress Reviews 

This dashboard part lists Reviews you have not yet completed . They may be new Reviews, or 
Reviews you've started but not yet submitted. 

 

The links to the right of each proposal summary allow you work with Reviews: 

 Click View Grant Request to open the Request edit form for the proposal. You can read 
details about the proposal and view attached documents. 

 Click Edit/Submit Review to enter your feedback on the proposal. 

  

Submitted Reviews 

This dashboard part lists Reviews you completed and submitted in the past.  

 

The links to the right of each proposal summary allow you work with Reviews: 

 Click View Grant Request to open the Request edit form for the proposal. You can read 
details about the proposal and view attached documents. 

 Click View Review to see the feedback you provided. Note that you can't change your 
answers after you've submitted the Review. 
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Entering and Submitting Your Feedback 

NOTE: This help topic describes features found in the optional Internal Reviews module. If your 
GIFTS Online system does not include Reviews, or is limited to using only External Reviews for 
non-staff reviewers, you may disregard this information. 

To fill out your Review, click the Edit/Submit Review link in the In Progress Reviews dashboard 
part. The Edit Review dashboard part opens, containing two sections: 

 The first part contains the Proposal Summary, which includes the proposal's Organization, 
Primary Contact, email address, Project Title, Request Amount, Recommended Amount, 
among other information. 

 The second part contains all of the feedback fields that must be completed by the 
reviewer in a section labeled Your Review.  

To edit and submit a Review: 

1. Complete the data entry fields in the Your Review section of the Edit Review page. 

IMPORTANT: The Yes/No field - if it appears - is used to indicate whether you feel the 
Request you are reviewing should be approved. For details on this field, and the potential 
ramifications of an internal reviewer's selection, please click here. 

2. Once you have completed the Review by filling in all the feedback fields that appear, click 
Submit to begin the submission review process. A submission confirmation page appears.  
TIP: If you begin your review but are not able to complete it for any reason, you may save 
the incomplete Review and return to it later. Simply click Save to save the Review without 
submitting it at this time.  

3. Check your Review information to make sure it is accurate, and then click Submit Review. 
A submission acknowledgement page appears.  

4. Click Submit Review a second time to complete the Review submission. You may also 
click Edit to return to the Edit Review page and make additional changes to your Review. 

5. Click Continue to return to the GIFTS Online home page. 

IMPORTANT: You (or another internal reviewer) may need to approve or decline the 
Request you have reviewed, depending on your position in the review sequence and your 
selection in the “Yes/No” feedback field. For details, see Voting Yes or No, Declining a 
Proposal, and Approving a Proposal. Note that external reviewers are not afforded the 
chance to approve or decline Requests in any circumstances. 

  

Approving a Proposal 

NOTE: This help topic describes features found in the optional Internal Reviews module. If your 
GIFTS Online system does not include Reviews, or is limited to using only External Reviews for 
non-staff reviewers, you may disregard this information. 

When you are the final reviewer in a sequence and you submit a Review with a “Yes” vote (or 
you are a Grants Manager and click Approve Proposal in the proposal's Actions menu), you will 
need to approve the Request you reviewed. After clicking Submit Review on the submission 
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confirmation page (or Approve Proposal in the proposal's Actions menu), the Request Approval 
page appears. 

 

Complete the fields available on the Request Approval dashboard part, and then click Approve 
to complete the approval.  

NOTE: If you do not want to approve the Request for any reason, you may click Cancel on this 
page.  

  

Voting Yes or No 

NOTE: This help topic describes features found in the optional Internal Reviews module. If your 
GIFTS Online system does not include Reviews, or is limited to using only External Reviews for 
non-staff reviewers, you may disregard this information. 

Your vote in the Yes/No field on the Edit Review page indicates your decision on whether or not 
the Request should be approved. The following scenarios are possible: 

 You vote “No”—Once you submit your Review, the review sequence is ended and you 
are asked to process a Request declination. For details on declining a proposal, please see 
Declining a Proposal. 

IMPORTANT: If you do not have permission to decline Requests, you will not be able to 
submit a Review with a “No” vote. 
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 You vote “Yes” and you are the last reviewer in the sequence—Once you submit your 
Review, you will be asked to process the Request approval. For details on approving a 
proposal, please see Approving a Proposal. 

IMPORTANT: If you do not have permission to approve Requests, you will not be able to 
submit a final Review with a “Yes” vote. You will only be able to submit your Review once 
another reviewer has been added to the sequence, either by the proposal owner or by 
you (if you have the appropriate permissions). For details on how to add another 
reviewer, please see Assigning Reviewers to Proposals. 

 You vote “Yes” and you are not the last reviewer in the sequence—Once you submit 
your Review, the next reviewer in the sequence is notified. 

Declining a Proposal 

NOTE: This help topic describes features found in the optional Internal Reviews module. If your 
GIFTS Online system does not include Reviews, or is limited to using only External Reviews for 
non-staff reviewers, you may disregard this information. 

If you are a Grants Manager and click Decline Proposal in the proposal's Actions menu, the 
Request Declination page appears. 

 

Complete the fields available on the Request Declination page, and then click Decline to 
complete the declination.  

NOTE: If you do not want to decline the Request for any reason, you may click Cancel on this 
page.  
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Working with External Reviewers 

NOTE: This help topic describes features found in the optional External Reviews module. If your 
GIFTS Online system does not include Reviews, or is limited to using only Internal Reviews for 
staff members, you may disregard this information. 

External reviewers are non-staff people, often experts in the type of endeavor you're 
considering funding, who advise grant makers by reviewing specific proposals. 

In GIFTS Online, these outside or external reviewers are saved as Contact records. Proposal 
owners such as Program Officers and Grants Managers may add external reviewers and request 
their review of a specific proposal. 

This section covers the following topics: 

Adding an External Reviewer 

The External Reviewers' Interface 

  

Adding an External Reviewer 

NOTE: This help topic describes features found in the optional External Reviews module. If your 
GIFTS Online system does not include Reviews, or is limited to using only Internal Reviews for 
staff members, you may disregard this information. 

External reviewers are saved as Contact records in GIFTS Online. Adding an external reviewer 
means adding a new Contact. If a Contact record for the person already exists, you can edit the 
record to grant reviewer access. 

Grants Managers and Program Officers can add new Contact records; the process begins on the 
home page. 

1. On the homepage , go to New > Contact on the Ribbon menu. The Contact (new) edit 
form opens. 

2. Begin entering the new Contact's name in the fields provided. When you tab out of the 
Last name field, the system will automatically check for any existing contacts with the last 
name provided and open the Checking for Duplicates window. 



GIFTS Online 5.1 User’s Guide 

132 
 

 

If the contact already exists, simply double click on the listed contact to open their edit 
form. 

 If you see the person you want to add already listed, you can double click it to go 
to his or her Contact edit form.  

 If your new contact is not listed, click the X in the upper right corner to close the 
window and continue filling out the New Contact form.  

3. Enter or edit data as needed. Note that when granting a new or existing Contact review 
access, you must: 

 Select the External Reviewer Access check box. 

 Enter a valid email address. Note that this email address must be unique among 
Contacts' email addresses in your GIFTS Online system.  

4. Save the new or updated Contact record.  

The next time you add a Review for that Contacts, GIFTS Online will send an email with login 
information to the Contact; he or she may then log in to GIFTS Online and complete reviews. 
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The External Reviewers' Interface 

NOTE: This help topic describes features found in the optional External Reviews module. If your 
GIFTS Online system does not include Reviews, or is limited to using only Internal Reviews for 
staff members, you may disregard this information. 

After you grant Review access to an outside reviewer, he or she will be able to review proposals 
using GIFTS Online. Their access is limited to those proposals you've asked they review. 

This section describes the interface external reviewers use when they log in to GIFTS Online. 

External Reviewer Home Page 

When external reviewers log in, they start from the home page, similar in look to other 
GIFTS Online home pages. The following dashboard parts are available to the reviewers: 

Welcome This dashboard part contains welcoming and/or instructional 
text for the reviewer. The content is set by MicroEdge to your 
specifications. 

Invited Reviews The Invited Reviews dashboard part shows a listing of all 
proposals the Reviewer has been asked to provide feedback 
on. When you add a Review for an external reviewer, it first 
appears to the reviewer here.  

 If s/he clicks the option to accept the invitation, the 
Review moves to the In Progress Reviews dashboard 
part. 

 If s/he clicks the option to decline, the Review status is 
changed to Will Not Review and the proposal owner 
receives an email noting the declination. The Review will 
no longer appear to the external reviewer. 

In Progress Reviews Once a user has agreed to Review a proposal, the Review will 
move to the In Progress Reviews dashboard part. 
External reviewers may click View Grant Request to see the 
Request edit form specific to them (see below). 
Another link in this dashboard part allows the reviewer to enter 
and submit his or her feedback. 

Submitted Reviews This dashboard part lists Reviews the reviewer has completed 
and submitted in the past. 
From here, external reviewers may open and re-read the 
proposals or their Reviews. 

Request Details for External Reviewers 

External reviewers have access to a different Request edit form than other GIFTS Online users. 
Some details are hidden, and the page doesn't have links allowing the user to drill down to other 
records. 
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Working with Payments 

What Are Payments? 

After you approve a Request for funding, it is important to plan how and when the grant 
payments are made. Do you want to pay the grant with a single payment, or schedule a series of 
payments with periodic reviews to ensure that the project is meeting its goals? 

In either case you will want a record of the payment that includes the payee organization, the 
amount paid, the date it was paid, and other information about the payment. The Request’s 
Payment Schedule can help you to manage individual payments and track their progress through 
your workflow. You can generate the Payment Schedule automatically when you approve the 
grant. You can also manually create a Payment record for each scheduled payment, either 
before or after you approve the Request. 

When you create a Payment, it has a status of Scheduled—meaning that it is waiting to be paid. 
When you pay it, you change the Payment Status to Paid and record the Paid Date, check 
number, and other accounting information. 

  

Working with Payments in GIFTS Online 

Whenever you need to edit an existing Payment record, you can access the Payment edit form 
by either running a search or clicking a link to the Payment elsewhere in GIFTS Online. Then 
locate the Actions menu and click on the appropriate link. 

TIP: Some links to Payment records are indicated by the status (Scheduled, Paid, Contingent, 
Void, Hold, Refund, or Canceled) of each Payment. On your home page and in search results, 
you will often be able to click the Payment Amount to open the Payment edit form. 

This section contains the following topics: 

Adding a Payment 

The Payment Detail Page 

Payment Available Actions 

Paying a Payment 

Voiding a Payment 

Canceling a Payment 

Reissuing a Payment 
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Adding a Payment 

Payments may be added to pending or approved Requests. In GIFTS Online, search for and find 
the Request you want to add a Payment to and open its Request edit form to start. 

1. In the Request's Actions menu, go to New > Payment. The Payment Edit Form opens. 
2. Enter the relevant Payment data, including Schedule Date and Amount, which are 

required. 

 

3. Click Save & Close. 

When Payments Exceed the Request Balance 

A Request's Balance is its amount (Request Amount for pending, Grant Amount for approved) 
minus the sum of all Payments. If you add a Payment which is greater than its Request's balance, 
the system will require you to reconcile this difference. 

 If the Request is pending, you will be allowed to add a Payment greater than the 
Request's balance. However, when and if you try to approve the Request, you will be 
unable to do so: 
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You must either edit the Grant Amount field to at least match the sum of all scheduled 
Payments - or cancel the approval process and change the Payment Amount(s). 

 If the Request is approved, the system asks you to amend the grant - or cancel the new 
Payment: 

  

The Payment Edit Form 

The Payment edit form displays details about a Payment. It is shown when you click a link to the 
payment anywhere in GIFTS Online. 

This overview describes the different dashboard parts seen on the Payment edit form.  

 

  

Title 

Across the top span of the page, the Title dashboard part shows the Scheduled Payment Date.  

NOTE: This scheduled Payment shows the date when it's due; a paid Payment would display the 
paid date, a voided Payment the date on which it was voided, and so on. 
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Actions menu 

This dashboard part lists the actions you may take on the Payment record displayed.  

NOTE: The actions listed will change based on the current Status of the Payment. For example, a 
paid Payment would not show the action to pay; instead, links to voiding or canceling the 
Payment would be shown. 

  

Related Records 

If the Payment had related records such as Requirements, Documents, or Activities, they would 
be displayed here in the lower left panel.  

  

Payment Information 

The main edit form contains the details of the payment.  

  

Primary Related Record Cards 

Along the right panel will be listed all the payments related primary records such as the Request, 
Payee, Payee Contact, and Address. 

Payment Available Actions 

A combination of the following actions may be taken on the Payment edit form. 

  

Edit Payment Data 

Once the Edit form is open, if you have the proper permissions, you can edit the payment data 
directly in the form's fields. Be sure to Save or Save & Close. 

Change Payee or Payee Contact 

To change the Payee or Payee Contact, you must click the Search magnifying glass on the Payee 
or Payee Contact Card. 

This displays a search page where you can specify the name of a new Payee or Contact for the 
selected Payment.  

  

By default, a new Payment will have the same Organization as its Request. In cases when the 
payee is not the same as the grantee, use this option.  

NOTE: If the Organization does not yet exist in GIFTS Online, you must first go to New 
> Organization on the home page to create an Organization record. 
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Menu Options 

The following actions may not appear for all users (depending on your permissions, and whether 
you use the GIFTS Online Budget module): 

New >    

Requirement Displays a standard Requirement edit form where you can create a new 
Requirement for the selected Payment.  

If you want the Payment to be contingent upon the Requirement, 
enable the Contingency checkbox under the Long Notes field on the 
Requirement edit form. 

Document Attach a related document to the Payment. 

Actions >   

Set Alert Set an Alert message that displays in an orange bar across the top of the 
edit form. 

Pay Scheduled Payments only. 

Displays the Pay Payment form where you can complete the fields 
relevant to paying the selected Payment.  

For editing any other data fields for a Payment, click Edit Payment at 
the top of the Available Actions list. 

Void Paid Payments only. 

Voiding a paid Payment creates a new Payment record for the negative 
amount. This undoes the paid Payment, but keeps a record and date for 
both actions. 

You will be asked whether or not to reissue this Payment during the 
void. 

If you choose not to reissue, you will be sent to the Payment edit form 
to make any necessary changes to the voided Payment. 

If you choose to reissue, you will be sent to the Reissue Payment page.  

For details on voiding and reissuing Payments, please see the Voiding a 
Payment and Reissuing a Payment. 

Hold Scheduled Payments only. 

Click this link to change the Payment’s status to Hold.  

NOTE: This prevents you or another user from paying the Payment until 
the hold is removed. 

Activate Hold Payments only. 
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Removes the Hold status on a Payment. Click this link to change the 
Payment’s status back to Pending, and update the detail page to reflect 
the new status. 

Cancel Click here to cancel the Payment. If the Request associated with the 
Payment is Pending or Approved, you will be asked whether or not to 
reissue this Payment during the cancellation. 

 If you choose to reissue, you will be sent to the Reissue Payment 
page. 

 If you choose not to reissue, or if the Request is Declined, the 
Payment is canceled and you are returned to the Payment edit 
form.  

NOTE: Only Payments that have not been paid may be canceled. If a 
Payment has been paid, it must be Voided instead. 

Reissue 
Displays the standard Payment edit form where you can create a new 
Scheduled Payment record. 

Delete Deletes the Payment. You are prompted for confirmation before the 
deletion is completed. Be sure you want to delete the Payment, as there 
is no way to undo the deletion. 

Generate Letter  Displays a Generate Letter page where you can create a new letter. 

Generate Email Displays a Generate Email page where you can create a new email. 

  

Paying a Payment 

When a grant payment is made in the "real world," you can log in to GIFTS Online and mark the 
Payment record Paid. It can reflect the Payment information and be removed from reports and 
queries for open items. 

You can pay any Scheduled Payment. You cannot, however, pay Payments with a Status of 
Contingent, Canceled, Void, or Hold. To pay a Contingent or on Hold Payment, you first need to 
mark the contingency (i.e., the Requirement) done or Activate the hold. If you want to pay a 
Payment that has been voided or canceled, you must reissue it. 

IMPORTANT: Once the Payment is Paid, the Payment Amount and Payment Schedule Date are 
locked and cannot be modified. Make sure the information in these fields is accurate before you 
pay the Payment. 

  

To pay a Payment: 

1. Click a link to the Payment anywhere in GIFTS Online to open the Payment edit form. 

2. Confirm that the Amount, Schedule Date, and Fiscal Year are correct. 
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If they are not correct, edit the Payment and Save it before paying it. 

3. Click Pay on the Actions menu to open the Pay Payment form. 

 

3. Enter the Payment Date (required) and other Payment data. 
4. Click OK. Returning to the Payment edit form, you will notice the title now reflects a Paid 

Payment Status with the date. On the Edit Form itself, the Amount field is now read only. 

NOTE: Budget appropriation is required now if: 

 Your GIFTS Online system includes the optional Budget Module; 

 There is an open Annual Budget for the Payment Fiscal Year, and; 

 Funds from the budget have not been previously appropriated for the Payment. 

Voiding a Payment 

You might want to void a Payment that is inadvertently marked as Paid, or when a payment 
check is lost.  

Once you void a Payment, you can reissue it or amend the total Grant Amount. 

  

When you click Void in the Actions menu on the Payment edit form, you will be asked whether 
or not the Payment should be reissued. Creating a reissued Payment allows you to inherit the 
data fields and Requirements from the original Payment without having to reenter them.  

If you choose not to reissue the Payment right away, the following will occur: 

 A new voided Payment record is created, and a new Activity record is created for the 
void. 

 You are automatically sent to the standard Payment edit form for the voided Payment 
record. Use the edit form to make any appropriate changes, and then click Save. 

 All open Requirements associated with the Payment are deleted. 
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If you choose to reissue the Payment at the same time you are voiding it, the following will 
occur: 

 A new voided Payment record is created, and a new Activity record is created for the 
void. 

 You are automatically sent to the standard Payment edit form to create a new reissued 
Payment record. Use the edit form to make any appropriate changes, and then click Save 
to create the reissued Payment. 

 A new Activity record is created for the reissue, if completed. 

  

Reissuing a Payment 

You may reissue a Payment when you initially void or cancel the Payment, or you may choose to 
do so later. However you initiate the reissue process, you will be taken to the standard Payment 
edit form to create a reissued Payment record. 

Once you finish making changes and click Save, GIFTS Online checks for any open Requirements 
associated with the original Payment. If any are found, you will be asked whether these 
Requirements should be transferred to the reissued Payment or deleted. 

NOTE: When you finish reissuing a Payment, the original Payment record is updated to reflect 
the new Payment ID of the reissued Payment. A new Activity record is also created for the 
reissue. 

  

Appropriating Funds for a Single Payment 

NOTE: This help topic describes features included only with the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

While appropriating funds for a payment may be triggered by different actions, each time the 
Budget Appropriation page looks the same:  
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Your task is to find the appropriate Reserve Fund or Line Item from which to appropriate funds 
to cover the Payment. To find your best option, you should understand the different elements 
of the budget appropriation interface. 

Title 

The title summarizes the Request/Grant which the Payment is for, showing Request ID and 
Project Title, then identifying the payee Organization Name and ID. 

Payment Summary Table 

Below the OK and Cancel buttons, the Payment we are appropriating funds for is summarized. 
Key data includes ID, Schedule Date, Amount, Fund, and G/L Account.  

The Appropriated from column isn't populated until you pick a Reserve Fund or Line Item; then 
it is listed. 

Filter By: 

The page shows Reserve Funds and Line Items from the annual budget with the same Fiscal Year 
as the Payment. There are many filters here which determine which items are shown. For 
example, if Authorized Users are in use, a Reserve Fund or Line Item will be listed only if you are 
authorized to use it. Line Items are only shown if they are linked to the payee Organization. 

In the Filter By section, you have the opportunity to apply additional filters, in order to narrow 
down the list of budget items and find the right one. The filters are applied/removed 
dynamically: as you select or clear a filter, the list of budget items below updates automatically.  

For example, the G/L account for the Payment we're working with is 0011001. if were to select 
the Payment G/L Account check box in the Filter By section, only budget items coded with the 
same G/L Account would be listed. 

Annual Budget Items 

Here you select the Reserve Fund or Line Item to appropriate funds from. In the left panel, 
budget Categories show you the structure of available budget items. To find the right budget 
item, select a Category. On the right, and Reserve Funds and Line Items matching the filters 
we've chosen are listed. 

To finish budget appropriation: 

1. Find and select the budget item you want to appropriate funds from. The item will appear 
in the Appropriated from column of the Payment summary table. 

2. Click OK. 

The following changes are saved in GIFTS Online: 

 If the Payment is Scheduled, Contingent, or Hold, the selected Reserve Fund or Line Item 
sees its Committed Amount increase by the Payment Amount. 

 If the Request is Paid, the budget item's Paid Amount increases by the Payment Amount. 

 The available Balance of the budget item is decreased by Payment Amount. 

 Payment record is updated to be linked to the budget item from which funds were 
appropriated. 
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Budget Transfers While Resolving Payments 

When resolving a Payment against a Line Item, that item may either not have sufficient funds to 
cover the amount of the Payment or have surplus funds that you’d like to transfer to another 
Budget item. You can transfer funds as necessary while resolving Payments. 

 Click here for information on dealing with Reserve Funds or Line Items with insufficient 
funds - that is, you've chosen an item with a balance less than the Payment amount. 

 Click here for information on dealing with Line Items which have surplus funds after the 
Payment is covered. 

  

Appropriating Funds for Multiple Payments 

NOTE: This help topic describes features included only with the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

If you approve a Request and choose to have Payments automatically scheduled, you may be 
required to appropriate all Payments first:  

 

Your task is to find the appropriate Reserve Fund or Line Item from which to appropriate funds 
to cover the Payments. Note you can use different budget items to cover different Payments for 
the same Grant. In fact, as you can see above, your multiple Payments may fall in two different 
fiscal years, requiring payments to be covered by funds from two different annual budgets. 
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Title 

The title summarizes the Request/Grant which the Payment is for, showing Request ID and 
Project Title, then identifying the payee Organization Name and ID. 

Payment Summary Tables 

Below the OK and Cancel buttons, the Payments we are appropriating funds for is summarized. 
Key data includes ID, Schedule Date, Amount, Fund, and G/L Account. The Appropriated from 
column isn't populated until you pick a Reserve Fund or Line Item; then it is listed. 

In cases where two different Annual Budgets are in play, you must select Payments from one 
year and find budget items for them, then move to the next year, and so on. The Annual Budget 
for the selected fiscal year will appear below. 

After selecting the fiscal year you want to deal with first, you must select which Payments you 
want to designate Reserve Funds or Line Items for.  

Filter By: 

The page will show Reserve Funds and Line Items from the selected fiscal year's budget. There 
are many filters here which determine which items are shown. For example, if Authorized Users 
are in use, a Reserve Fund or Line Item will be listed only if you are authorized to use it. Line 
Items are only shown if they are linked to the payee Organization. 

In the Filter By section, you have the opportunity to apply additional filters, in order to narrow 
down the list of budget items and find the right one. The filters are applied/removed 
dynamically: as you select or clear a filter, the list of budget items below updates automatically.  

Annual Budget Items 

Here you select the Reserve Fund or Line Item to appropriate funds from. In the left panel, 
budget Categories show you the structure of available budget items. To find the right budget 
item, select a Category. On the right, and Reserve Funds and Line Items matching the filters 
we've chosen are listed. 

To finish budget appropriation: 

1. Find and select the budget items you want to appropriate funds from for each Payment. 
The items will appear in the Appropriated from column of the Payment summary table or 
tables. 

2. Click OK. 

The following changes are saved in GIFTS Online: 

 If the Payment is Scheduled, Contingent, or Hold, the selected Reserve Fund or Line Item 
sees its Committed Amount increase by the Payment Amount. 

 If the Request is Paid, the budget item's Paid Amount increases by the Payment Amount. 

 The available Balance of the budget item is decreased by Payment Amount. 

 Payment record is updated to be linked to the budget item from which funds were 
appropriated. 
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Budget Transfers While Resolving Payments 

When resolving a Payment against a Line Item, that item may either not have sufficient funds to 
cover the amount of the Payment or have surplus funds that you’d like to transfer to another 
Budget item. You can transfer funds as necessary while resolving Payments. 

 Click here for information on dealing with Reserve Funds or Line Items with insufficient 
funds - that is, you've chosen an item with a balance less than the Payment amount. 

 Click here for information on dealing with Line Items which have surplus funds after the 
Payment is covered. 

 

About Appropriating Budget Funds for 

Payments 

NOTE: This help topic describes features included only with the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

Each time you approve a Request or schedule a Payment, GIFTS Online requires you to 
appropriate funds for the Payment's annual budget. 

 Appropriating funds for an unpaid Payment adds the funds to the “Committed” amount 
tracked in the Budget. (Unpaid Payments may have a Status of Scheduled, Hold, or 
Contingent.) 

 Appropriating funds for a paid Payment adds the funds to the “Paid” amount tracked in 
the Budget. (Paid Payments may have a status of Paid or Void.) 

In either case, the amount of the Payment is subtracted from the available budget balance.  

When Payments Need to Have Funds Appropriated 

Budget appropriation is required when you: 

 Attempt to pay a Payment for which funds have not been appropriated.  

 Create a Payment for an approved Request in an open Annual Budget year - including 
when creating Payments during Request approval. 

 Approve a Request with unappropriated Payments during an open Annual Budget year. 

 Change the amount of a Payment. 

 Reschedule a Payment, changing its Fiscal Year to another which also has an open Annual 
Budget. 

In addition, you can choose to appropriate funds for a Payment created for a pending Request, 
but it is not required until you want to pay the Payment. 

Single or Multiple Payments 

In most cases you will be appropriating funds for a single payment. If you are approving a 
Request and having GIFTS Online schedule multiple payments for you, you need to appropriate 
funds for all. 
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Transferring Funds from a Line Item 

NOTE: This help topic describes features included only with the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

If you choose to appropriate funds for a Payment from a Line Item with a balance greater than 
the Payment amount, you are offered a chance to transfer the funds to a Reserve Fund.  

You can decide to leave the apparent surplus in the Line Item, or transfer the balance to a 
Reserve Fund. 

 

You can either select No and keep the Line Item balance, or use the following procedure to 
transfer the surplus funds: 

1. Select "Yes, allow me to select a reserve fund" and click OK. The Transfer Funds window 
opens: 

 

NOTE: The entire surplus amount is the Transfer Amount. You cannot enter a different 
amount. 

2. Click the binoculars to search for the Reserve Fund you want to transfer funds to. The 
Select a Reserve Fund window opens: 
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The top panel shows the budget hierarchy. Select a Category and its child Reserve Funds 
are listed in the lower panel. Click the link for the Reserve Fund there to send funds to it. 
The Reserve Fund is shown in the To field on the Transfer Funds window. 

3. Enter any Notes you want and click Next. The effect of the transfer is summarized and 
you are asked to confirm: 

 

4. Click Previous to go back and make changes, or Cancel to cancel. If you want to proceed, 
click Transfer Funds. The Transfer Amount is taken from the Line Item and transferred to 
the Reserve Fund. 
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Transferring Funds to a Budget Item 

NOTE: This help topic describes features included only with the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

If you choose to appropriate funds for a Payment from a Reserve Fund or Line Item with 
insufficient funds to handle the amount, you are prompted to transfer the funds needed from a 
Reserve Fund to the budget item in question. 

NOTE: If you are appropriating funds from a Reserve Fund which allows a negative balance, you 
have a third option of letting the fund go negative. 

You can decide to try another budget item with a larger balance, or you can transfer funds: 

 

You can either select No and choose another budget item, or use the following procedure to 
transfer the needed funds: 

1. Select "Yes, allow me to select a reserve fund" and click OK. The Transfer Funds window 
opens: 

 

2. Enter the Transfer Amount. 

NOTE: The minimum required to cover the Payment is the default value. You cannot 
enter a lower amount. 

3. Click the binoculars to search for the Reserve Fund you want to transfer funds from. The 
Select a Reserve Fund window opens: 
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The top panel shows the budget hierarchy. Select a Category and its child Reserve Funds 
are listed in the lower panel. Click the link for the Reserve Fund there to take funds from 
it. The Reserve Fund is shown in the From field on the Transfer Funds window. 

4. Enter any Notes you want and click Next. The effect of the transfer is summarized and 
you are asked to confirm: 

 

5. Click Previous to go back and make changes, or Cancel to cancel. If you want to proceed, 
click Transfer Funds. The Transfer Amount is taken from the source Reserve Fund and 
transferred to the Reserve Fund or Line Item you are trying to appropriate funds from. 
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Canceling a Payment 

When you cancel a Payment, the Payment record is not deleted, but its status is changed to 
Canceled. The difference between cancelling and voiding is that Payments may be cancelled up 
until the time when they are paid, after which they must be voided. 

When you click Cancel Payment in the Actions menu on the Payment edit form, if the associated 
Request has a Declined disposition, the Payment is canceled immediately. Otherwise, you will be 
asked whether or not the Payment should be reissued. If the Request is Declined or you choose 
not to reissue the Payment right away, the following will occur: 

 The Payment record is updated to reflect a Canceled status, and an Activity record is 
created for the cancellation. 

 All open Requirements associated with the Payment are deleted. 

If you choose to reissue the Payment at the same time you are canceling it, the following will 
occur: 

 The Payment record is updated to reflect a Canceled status, and an Activity record is 
created for the cancellation. 

 You are automatically sent to the standard Payment edit form to create a new reissued 
Payment record. Use the edit form to make any appropriate changes, and then click Save 
to create a new reissued Payment. 

 A new Activity record is created for the reissue, if completed. 
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Working with Contacts  

In Contacts, you record the name, address, telephone numbers, and biographical data of all of 
your contacts.  

You can then use Affiliations to link Contacts to as many Requests and Organizations as you 
wish. In essence, the Affiliations allow you to build a Rolodex™ for each Organization and each 
Request in your system.  

People can also be specified as Contacts for Activities, Requirements, and Payments. 

  

This section contains the following topics: 

Adding a Contact 

The Contact Detail Page 

Contact Available Actions 

Changing the Primary Organization for a Contact 
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Adding a Contact 

Grants Managers and Program Officers can add a new Contact record; the process begins on the 
home page. 

NOTE: New Contacts may also be created by considering an application submitted by a grant 
seeker not already in your system. 

1. On the homepage , go to New > Contact on the Ribbon menu. The Contact (new) edit 
form opens. 

2. Begin entering the new Contact's name in the fields provided. When you tab out of the 
Last Name field, the system will automatically check for any existing contacts with the 
last name provided and open the Checking for Duplicates window. 

 

If the contact already exists, simply double click on the listed contact to open their edit 
form. 

 If you see the person you want to add already listed, you can double click it to go 
to his or her Contact edit form.  

 If your new contact is not listed, click the X in the upper right corner to close the 
window and continue filling out the New Contact form.  

3. Enter or edit data as needed. Note that when granting a new or existing Contact review 
access, you must: 

 Select the External Reviewer Access check box. 

 Enter a valid email address. Note that this email address must be unique among 
Contacts' email addresses in your GIFTS Online system.  

4. Save the new or updated Contact record.  

../../../Content/33-Module-Online%20Applications%20and%20Requirements/04-Accessing%20the%20Applications%20Menu.htm
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The Contact Detail Page 

The Contact edit form displays details on a Contact and provides an overview of your history 
with him or her. A Contact's edit form is shown when you click a link to the contact anywhere in 
GIFTS Online. 

  

This overview describes the different parts of the Contact edit form. 

  

Title 

Across the top span of the page, the Title shows the Contact ID Number and full name.  

  

Actions menu 

The Actions menu displays the Available Actions you may take on the Contact record displayed.  

  

Detail Categories 

These buttons allow you to jump quickly to the various parts of the edit form. 

 Contact 

 Office Address 

 Home Address 

 Alternate Address 

 Coding 

 Biographical 

 More 

  

Related Links 

These links let you quickly view a list of the related records(if any) for this contact. 

 Requests 

 Payments 

 Requirements 

 Reviews 

 Documents 

 Activities 

 Affiliations 
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Contact Available Actions 

A combination of the following Available Actions may be included on the Contact edit form. 

Edit the Contact Information 

You can directly make changes to the Contact’s edit form fields.  

If you have permission to edit Contact alerts, you can use the Alert section of the edit form to 
change, add, or remove alert information. 

Change Primary Organization 

To change the contact's primary organization please see Changing the Primary Organization for 
a Contact.  

Available Menu Options 

Depending on the permissions set for your user account, you may have a combination of the 
following actions available: 

New >   

Request Create a related new Request record. 

Organization Create a related new organization 

Requirement Create a related new Requirement 

Review Create a related new Review 

Document Create a related new Document 

Activity Create a related new Activity 

Affiliation Create a related new Affiliation 

Actions >   

Set Alert Set an Alert Message on this contact record that will appear as an 
orange message bar directly under the header area. 

Generate Email 
Correspondence 

Displays a Generate Email page where you can create a new email. 

Generate Letter 
Correspondence 

Displays a Generate Letter page where you can create a new letter. 

Delete Contact  Deletes the Contact record. You are prompted for confirmation before 
the deletion is completed. Be sure you want to delete the Contact, as 
there is no way to undo the deletion. 
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Changing the Primary Organization for a 

Contact 

Each Contact has only one Primary Organization, which is usually his or her employer. Most 
grantmakers use the Primary Organization Affiliation to specify a Contact's employer. 

To change a Contact's Primary Organization: 

1. Open the Contact's edit form and click the Search magnifying glass on the Primary 
Organizations Card on the right panel. 

 

2. On the Select Primary Organization search form, enter the name of the new organization 
and click the arrow button to begin the search. The search results will be displayed below. 

3. If the organization you require is listed, double click it to have it set as the new Primary 
Organization and return to the Contact edit form. 

NOTE: If no existing Organization records match your search, you can run another search 
or create a new Organization. 

4. Click Save. You are prompted to specify whether you want to change the Contact’s 
telephone and fax numbers. 

5. Select Yes or No, and click Save. The Contact updates with the new Primary Organization 
information. 

Duplicate Consolidation 

Over time, it is quite common to end up with duplicate records in your database, particularly 
Organizations and Contacts. These can lead to inaccurate reporting and embarrassing mistakes. 

In order to help identify duplicate organizations and contacts, Crystal Report templates were 
created. 

 Duplicate Organizations (by Name) 

 Duplicate Contacts (by Last Name) 

 Duplicate Contacts (by Social Security Number) 

These reports are included in the Reports Library. 

Once you have identified the possible duplicates, the option to Consolidate Duplicates on the 
Actions menu of Search Results page for both Organizations and Contacts can be used. 
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To consolidate duplicate Organizations or Contacts, do the following: 

1. Perform a Quick Find or Full Search for Organizations or Contacts which you know are 
duplicates from the above reports. 

2. Select the duplicate Organizations on the search results page. 
3. Go to Actions > Consolidate Duplicates to open the Consolidate Duplicates form. 

 

The first record selected will be placed in the Valid Record side of the form and all others 
will be displayed on the right side as Duplicates. 

4. To make an Organization on the right side the valid record, click the arrow icon on the top 
right corner of its card. The current record on the valid side will be moved to the 
duplicates side. 

5. Click the Consolidate button. 
6. A confirmation message will ask if you wish to delete all duplicate records.  

 Yes - moves all related data to the valid record and deletes the duplicates. 

 No - moves all the related data to the valid record without deleting the duplicates. 

 Back - takes you back to the Consolidate Duplicates form. 
7. Click OK at the next message to continue. 
8. Click OK at the success message. 
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Working with Affiliations 

What Are Affiliations? 

An Affiliation record details the relationship between a Contact and an Organization or Request. 
Information describing the affiliation such as the Start Date and End Date of the relationship and 
a Role that describes the nature of the relationship is also stored in the record.   

Records are linked to other records in a number of ways. For example, a Payment is linked to 
the approved Request from which the paid amount comes. However, a Payment can play only a 
single “role” for its Request—you don’t need another record detailing this relationship. 

On the other hand, a single Contact—one person—may play any number of different roles 
within one or more Organizations, or have a part in any number of different Requests. Each 
Affiliation record links the Contact to an Organization or Request, while at the same time noting 
the specific relationship between the two. This allows you to maintain one Contact record per 
person, while also allowing you to link that person to any number of different Organizations or 
Requests. Each Affiliation record includes From and To dates, noting the beginning and ending 
dates of the relationship it records. 

  

There are two types of Affiliations -- Primary Affiliations and Secondary Affiliations. While both 
types of Affiliations have the same fields, and are accessed and displayed in the same manner, 
they represent different types of relationships. 

Primary Affiliations describe a unique relationship between a Contact and an Organization or 
Request and are created automatically by the system. These include: 

 Organization Primary Contact 

 Contact Primary Organization 

 Request Primary Contact Affiliation 

Secondary Affiliations are manually created by the user to represent a relationship that is not 
covered by a Primary Affiliation. 

EXAMPLE: Nathaniel Smith has a Contact Primary Affiliation to the Model Foundation, but he 
also serves as a consultant to the UNICEF Foundation. A Secondary Affiliation can be created to 
describe his consultancy role with the UNICEF Organization. 

  

Affiliations in GIFTS Online 

Affiliations can be accessed and edited online using GIFTS Online. You can add additional 
Affiliations to document relationships between Contacts and Requests or Organizations. In 
addition, you can create Affiliation correspondence.  

This section contains the following topics: 

Affiliation Available Actions 

Adding Secondary Affiliations 
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The Affiliation Edit Form 

The Affiliation edit form displays details on the relationship between a Contact and a Request or 
Organization. An Affiliation's edit form is shown when you click a link to the Affiliation any 
where in GIFTS Online. Usually this means you clicked on the Role the person plays with an 
Organization or Request, as shown in this Request edit form Affiliation Contacts dashboard part: 

 

This overview describes the different parts of the Affiliation edit form.  

TIP: You can enter a different email address or phone number for someone in each of his or her 
Affiliations. For example, if a Contact were consulting with an Organization for a three month 
period, you could enter an Affiliation for those dates, and specify a different email address 
where to reach your Contact during that time. 

  

Title 

Across the top span of the page, the Title area shows the Affiliation ID and branch.  

The Status will display one of the following: 

 Request Primary Contact Affiliation 

 Organization Primary Contact Affiliation 

 Contact Primary Organization Affiliation 

 Request Affiliation 

 Organization Affiliation 
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Actions menu 

The Actions menu displays the Available Actions you may take on the Affiliation record 
displayed.  

  

Detail Categories 

These buttons allow you to jump quickly to the various parts of the edit form. 

  

Related Links 

These links let you quickly view a list of the related records(if any) for this contact. 

 Documents 

Affiliation Available Actions 

A combination of the following Available Actions may be included on the Affiliation edit form: 

Edit Affiliation  Opens the Edit Affiliation form, where you can edit the 
Affiliation currently shown on the edit form. 

Close Affiliation Allows you to close an affiliation record from the workspace or 
related records. 

Generate Letter 
Correspondence 

Displays a Generate Letter page where you can create a new 
letter. 

Generate Email 
Correspondence 

Displays a Generate Email page where you can create a new 
email. 

Delete Affiliation Deletes the Affiliation record. You are prompted for 
confirmation before the deletion is completed. Be sure you 
want to delete the Affiliation, as there is no way to cancel the 
deletion. 
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Adding Secondary Affiliations 

Affiliations in GIFTS Online can be created from the edit form of the Request or Organization to 
which you want to affiliate a Contact. To create an Affiliation: 

1. In the New menu of a Request or Organization edit form, click Affiliation. The Search for 
Contact page appears. 

NOTE: The New button is not displayed until you have searched for an existing Contact. 

2. Enter the first few letters of the Contact’s last name and click Search. The search results 
appear. 

3. To choose a Contact from search results, select it from the list by double clicking it. 
4. You are prompted to edit the Affiliation. 

NOTE: If no existing Contact records match your search, you can run another search or 
create a new Contact record. If you are creating a new Contact record, enter the Contact 
information and click Save. Restart from step 1.  

5. Select the Contact’s Role, Affiliation term dates, the title of the Contact, and so on. 
6. Click Save to save the new Affiliation. 
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Working with Activities and 

Requirements 

  

What Are Activities? 

During your day-to-day work, you need to track various actions and pieces of information like 
notes from phone conversations and write-ups from site visits. In addition, you may need to 
know when a certain letter was sent or when material was received from a grantee. Activities 
help you keep track of these events.  

Some Activities are logged automatically—such as when you send a merged letter. Other 
Activities can be logged in manually as they are needed. ‘Activities’ are, in a sense, a catch-all 
category for the recording of several different kinds of events. Each class of activity serves either 
to audit your actions, or to remind you of appointments and deadlines. 

  

What Are Requirements? 

GIFTS Online allows you to track two kinds of Requirements that are due from your grantees as 
conditions of the grant: 

1. Proposal/Grant Requirements are attached to a specific grant due as part of the 
proposal-tracking or grant-tracking process, and usually entered as a schedule, such as a 
series of progress reports followed by a final report. Some grant makers require site visits 
or review meetings during the life of a grant. Any required activity that you place on your 
grantees can be a Grant Requirement. 

2. Payment Requirements are attached to a specific Payment and—if you make the 
Payment Contingent upon the Requirement—prevent it from being paid until the 
Requirement is met. For instance, if you fund challenge grants, a Payment on a challenge 
grant should not be paid until the Organization has met the challenge. 

Activities and Requirements in GIFTS Online 

Whenever you need to edit an existing Activity or Requirement record, you should access the 
record’s edit form by either running a search or clicking a link to the Activity or Requirement. 
Depending on your system settings, you may find Activity and Requirement links on your home 
page, or on the edit forms for Organizations, Payments, Requests, and Contacts. 

TIP: GIFTS Online links to Activity and Requirement records are indicated by the specific type of 
Activity. You may see links like Phone Call, Office Visit, or Final Report. When the edit form 
displays, locate the Actions menu and click the appropriate link. 

This section contains the following topics: 

Adding an Activity 

Adding a Requirement 

The Activity and Requirement Detail Pages 

Activity Available Actions 
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Requirement Available Actions 

  

Adding a Requirement 

To add a new Grant or Payment Requirement: 

1. Navigate to the Request or Payment edit form for the record you want to associate the 
Requirement with. 

2. On the New menu, click Requirement. The Edit Requirements page opens: 

3. Enter the Type and other details about the requirement you're recording here. 

TIP: You can assign the Requirement to a different GIFTS Online user, or enter a Done 
Date if the Requirement is already completed. 

4. Click Save to save the new Requirement. You are returned to the edit form where you 
initiated the action. 

  

Publishing a New Requirement to a Grantee 

NOTE: The following requires the optional GIFTS Online Applications and Requirements module. 

If you are using online grantee reporting to complete Requirements, you can publish the 
Requirement to the grantee as you add it. 

After clicking Save, go to Actions > Publish to Web. 

If the grantee does not have an online account, the system will ask if you wish to create one.  

Otherwise the Requirement will be published to the grantee's account page and an email 
notification will be sent to the grantee. 

  

Adding an Activity 

To add a new To Do Activity: 

1. Navigate to the Request, Organization, or Contact edit form for the record you want to 
associate the Activity with. 

2. On the New menu, click Activity. The Edit Activity page opens: 

3. Enter the Type and other details about the event or activity you're recording here. 

TIP: You can assign the Activity to a different GIFTS Online user, or enter a Done Date if 
the Activity is past. 

4. Click Save  to save the new Activity. You are returned to the edit form where you initiated 
the action. 
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The Activity and Requirement Detail Pages 

The Activity and Requirement edit forms display information about your Activities and 
Requirements. An Activity and Requirement edit form is shown when you click a link anywhere 
in GIFTS Online.  

Click the popup links below to see samples of Activity and Requirement edit forms. 

Activity Edit Form 
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Grant Requirement Form 

 

Payment Requirement Form 
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Requirement Available Actions 

A combination of the following Available Actions may be included on the Requirement edit 
form: 

Delete  On existing requirements, this option deletes the Requirement. You are 
prompted for confirmation before the deletion is completed. Be sure you 
want to delete the Requirement, as there is no way to undo the deletion. 

Change Contact Use the Search icon on the Contact Card to open the search form where 
you can specify the name of a new Contact for the selected Request. If the 
Contact does not yet exist in GIFTS Online, you can create a Contact record 
on the homepage from the New menu. 

Publish to Web Once a requirement is saved, it can be posted to the grantee's account 
webpage to be completed. Click this to posts an online Requirement form 
which the grantee can then log in, complete, and submit. 

Mark as Done Once the requirement is saved, this option can be used to mark it as done. 

Mark as Not Done Click this to reopen a Requirement already marked as Done. 

Generate Letter 
Correspondence 

Displays a Generate Letter page where you can create a new letter. 

Generate Email 
Correspondence 

Displays a Generate Email page where you can create a new email. 

Activity Available Actions 

A combination of the following Available Actions may be included on the Activity edit form: 

Delete  On existing activities, this option deletes the Activity. You are prompted 
for confirmation before the deletion is completed. Be sure you want to 
delete the Activity, as there is no way to undo the deletion. 

Change Contact Use the Search icon on the Contact Card to open the search form where 
you can specify the name of a new Contact for the selected Request. If the 
Contact does not yet exist in GIFTS Online, you can create a Contact record 
on the homepage from the New menu. 

Mark as Done Once the activity is saved, this option can be used to mark it as done. 

Mark as Not Done Click this to reopen an Activity already marked as Done. 

Generate Letter 
Correspondence 

Displays a Generate Letter page where you can create a new letter. 

Generate Email 
Correspondence 

Displays a Generate Email page where you can create a new email. 
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Transfer to 
Another Branch 

NOTE: This link is only seen if you have Branch Security, an optional 
feature; your GIFTS Online system may not use Branch Security. 

You can transfer certain types of Activities to another branch for future 
handling. The Activity must not be linked to a Request. 

TIP: Those Activities need to keep the same branch as the related Request. 
You can transfer them by transferring the Request; all affiliated records 
will go to the new branch with the Request. 

Examples of Activities you can transfer are To Do Activities created for 
Organizations or Contacts, or Document Activities created when you 
generated letters or emails for Organizations or Contacts. 

Automated Email Reminders 

The new GIFTS Online Automated Email Reminders feature allows users to do the following: 

 Schedule automated reminders: You can schedule a reminder to be sent for any GIFTS 
Online Activity or Requirement type that does not have a Done date or Received date, 
respectively. For example, you can set up a reminder on Progress Reports to be sent one 
week prior to the due date and GIFTS Online will automatically send out emails to the 
recipient/s you select. 

 Send reminders to multiple recipients: You can select an unlimited number of recipients 
for your reminders, specifying To, Cc, or Bcc for each. In addition to grantee contacts and 
staff from your GIFTS Online system, you can manually enter additional email addresses.  

You also have the ability to exclude staff contacts on an individual level. 

 Keep a record of sent reminders: You can choose to create an Activity for each reminder 
sent. Activity notes include the recipient names and addresses and also the body text of 
reminders, providing a full record of all correspondence. 

NOTE: Only Grant Managers and Program Officers will have access to the Launch>Reminders 
and New>Reminder features. 

  



GIFTS Online 5.1 User’s Guide 

167 
 

The Main Reminders Page 

To access the Reminders tool, go to Launch>Reminders. 

 

The following options will be available in the Actions ribbon menu while on this page if a 
reminder is currently selected: 

New>Reminder: Displays the Edit Reminder form with all options blank 

Action> Open Reminder: Displays the Edit Reminder form with the selected Reminder’s options 

Action>Manual Retry: Displays a dialog box which allows a user to manually retry the reminder. 
Individual reminders can be selected for the retry. 

Action>View Last Run:  This option presents a grid of the results from the last run date of the 
selected reminder(s).  

The grid will display results of data from Reminders Log Table and be grouped by Reminder.  

Right clicking on the Error notes column allows a user to copy the error messages presented by 
this View Last Run screen. 

  

Creating a New Reminder 

To create a new reminder: 

1. Launch>Reminders. 
2. Go to New>Reminder. 
3. Fill in the fields as needed. 
4. Save and Close your new reminder. 

NOTE: The options available on the form will vary depending on the Record Type selected. 



GIFTS Online 5.1 User’s Guide 

168 
 

 

Once saved, the reminder will be listed on the main Reminders page. 

  

Sections of the Reminders Page 

The table below describes the major sections of the Reminders page. 

Section Label Description 

General Name Name of reminder 

  Create Activity Defaults to unchecked. If checked, upon generation of a reminder, 
and activity record is created.  

  Is Enabled Defaults to checked. If checked, reminder is active when generation 
tool is run. If unchecked, reminder criteria will not be checked. 

  Reminder 
Manager 

Required field. Defaults to create user. When a reminder fails, an 
email notification is sent to this user. User must have an email input 
in the users table. 

Execution 
Criteria 

Record Type Choices are “Activity” and “Requirement”. Depending on selection, 
different options are shown in the Criteria Type section. 

  Criteria Type Radio button allows selection of either Requirement or Activity Type 
as search criteria or use of the Advanced Search Criteria. This should 
be populated with a list of checkboxes labeled with the type of 
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activities available for the Record Type selected above. Multiple 
selections can be chosen. 

  Advanced 
Search Criteria 

Radio button allows selection of either Requirement or Activity Type 
as search criteria or use of the Advanced Search Criteria. A Modify 
link is available that opens the standard search box for an activity 
record. Text box shows read only text for the search criteria entered. 

  Occurs Displays label “Occurs”, integer box, dropdown box, radio button, 
label “Before Due Date”, radio button, and label “After Due Date” in 
this order. 

Integer box allows for positive 1 or 2 digit integers [0-99] 

Dropdown box allows Days or Weeks as selections 

Radio buttons allow selection of “Before” or “After” 

Email 
Content 

Subject Prefix Prefix that should be appended to the beginning of the Email 
Template subject. 

Default is “GIFTS Online Reminders:”  

  Email Template List of email templates available for the record type chosen. 

  Attachment 
Template 

List of printed letter templates available for the record type chosen. 
The template will be generated and attached to the email. 

Recipients Request Staff 
Email Option 

Dropdown selections are “To:” “CC:” and “BCC”.  Composed email will 
send using option selected to the staff member on the related 
request record. 

    

Request 
Secondary Staff 
Email Option 

Dropdown selections are “To:” “CC:” and “BCC”.  Composed email will 
send using option selected to the secondary staff member on the 
related request record. 

    

Activity Staff 
Email Option 

Depending on record type selected, label displays either Requirement 
or Activity. Dropdown selections are “To:” “CC:” and “BCC”.  
Composed email will send using option selected to the staff member 
assigned to the Requirement/Activity 

    

Request 
Primary 
Contact Email 
Option 

Dropdown selections are “To:” “CC:” and “BCC”.  Composed email will 
send using option selected to the primary contact record on the 
related request record. 
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Activity Contact 
Email Option 

Depending on record type selected, label displays either Requirement 
or Activity. Dropdown selections are “To:” “CC:” and “BCC”.  
Composed email will send using option selected to the contact record 
assigned to the Requirement/Activity 

    

Payment 
Contact 

Email Option 

Dropdown selections are “To:” “CC:” and “BCC”.  Composed email will 
send using option to the contact record to the related payment 
record (e.g. payment requirements) 

  Additional 
Recipients 

Dropdown selections are “To:” “CC:” and “BCC”.  Text box allows user 
to enter any email address. Validation should be done so that it 
follows the x@x format. An “Add” button will add to the list of emails. 
Selecting a record in the list allows you to remove it by clicking the 
“Remove” button. Composed email will send to emails entered in this 
list. 

  Excluded Users List of staff members appears in a checkbox list. Multiple selections 
can be chosen. When a staff member is chosen, they will be excluded 
from the reminder email if they match with the Staff on Request, 
Secondary Staff on Request, or Staff on Requirement/Activity options. 

  

Reminder Sender Settings 

To access Reminder Sender Setting, go to Admin>Preferences. 

NOTE: This option will only be available to Grant Managers. 

A global setting can be set for From Display Name and Reply To Email Address.  

The display name and email address set here will be used as the Sender name and email in all 
reminder generated emails. Note that when the email is generated, the ‘from’ email address will 
actually be mail@grantapplication.com.  

However, if the recipient chooses to ‘reply’ to the email, the ‘from’ address in the Reminder 
Sender Settings will automatically populate into the ‘To’ field in the reply email. 
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The Report Manager 

The goal of the Report Manager is to unify Standard and Ad Hoc report types into a consistent 
interface. In order to improve usability, all reports will be generated in tabs within GIFTS Online. 

The Report Library will be accessed through the Reports Manager button in the Launch ribbon 
menu.   

 

Report Types 

The user can switch between different report type lists using the Report Types panel on the left. 

An option is also available to show only All Favorites. 

GIFTS Online includes more than 100 Standard Reports that have been designed to meet the 
needs of most grant makers. This manual describes how to run these reports and includes 
sample reports that you can use to find the GIFTS Online reports that best meet your needs. 

In addition, Ad Hoc Reports can now be generated and saved to the Report Library for future 
use. They will be listed in the Report Library as Ad Hoc type instead of Standard in the listing 
table. 
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Report Manager Actions 

Once a report is selected several Action menu options become available: 

 

 

Action Menu 
Option 

Description 

Generate Opens the Generate Report form so the user can run the report selected.  

Two subtitles can be added.  

The query filter can also be modified by clicking the Modify link. 
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Edit Takes you to the Report Designer page where the look of report can be modified.  

NOTE: Options available will vary by report type. 

Add to Favorites Selecting a report and then clicking this button will make the report a Favorite. 
The favorite star will turn yellow and the report will be moved to the top of the 
reports listing with any other existing favorites. The report will also now show if 
the All Favorites report type is selected. 

Remove (from) 
Favorites 

Selecting a report currently flagged as a favorite and then clicking this button will 
turn off the favorite flag. The report will no longer appear at the top and will go 
back to its alphabetical spot in the normal list. 

Copy Only available for Ad-Hoc reports. Select a report and click the Copy button to 
copy the report to be saved as a new report. 

Delete Only available for Ad-Hoc reports. Delete the selected report. Confirmation 
required. 

Finding Reports 

Users can enter text into the Find text field, which (when user tabs out of the field) will perform 
a text search within the current report table and filters all matches.  

Search will match strings in Name and Description. Note that there are certain wildcard 
characters that are supported by the search, as they are in the quick find search. Things like an 
underscore which will return any results which contain a single character.   

  

Report Table 

Classic and Saved Reports for the selected record type will be listed in a scrollable table to the 
right of record types. The list of columns is as follows: 

Column Name Description Sorting Resize 

Checkbox  Allows user to select records which will show the 
‘Actions’ in the ribbon menu 

No Yes 

Favorites Reports marked as Favorites will be indicated by a 
gold star. Regular reports will be indicated by a gray 
star. 

Favorites on 
top/bottom 

  

Yes 

Name Name of the report Alphabetical Yes 

Description Description of the report Alphabetical Yes 

Last Updated Displays the Login ID of user who last performed  By Date Yes 
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the update and the date of the update. Format: 

Last updated by {Login_ID} on {MM/DD/YYYY} 

Type  Shows whether the report is an Ad Hoc or a 
Standard report 

Yes Yes 

Each table row will resize vertically to fully fit the report’s Name, Description, and Last Updated 
fields. Favorite and action icons will be aligned with the row’s top line of text. 

Resizing Columns 

The user will be able to click and drag the separators between all of the columns in the Report 
Manager table to resize them.  

Column Sorting 

The user will be able to sort on Favorites, Name, Description, and Last Updated columns.  

Sorting will behave similar to Manage Saved Views and Manage Saved Searches. The first click 
will sort by ascending order and indicated by highlighting the column’s up arrow. Clicking on a 
column sorted by ascending order will change the sort to Descending, which will be indicated by 
highlighting the column’s down arrow. Clicking on a column sorted by Descending order will 
change the sort order to Ascending. 

Generating Reports 

Users can generate a report by either clicking the Generate Report button for a report or 
double-clicking on a listed report. This will display a popup allowing the user to set the various 
options for the report such as Title and Subtitles, as well as review and modify the query Filter. 

 

The Filter Field 

Behavior of the Filter will differ depending on whether the report being generated is a Standard 
report or a saved Ad Hoc report. 

Standard Reports 
The Filter section will load empty, and users will define additional filters using the Modify 
link below. These user-defined criteria will be added to the search filter defined within 
the standard report file, and the combined filter will be used to generate the report. 
Thus, users will be able to add additional restrictions to the report, but they will not be 
able to remove existing standard search constraints. 
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Ad Hoc Reports 
The Filter section will load the search filter associated with the report template. The users 
will then be able to modify or add to these filters using the Modify link below. The final 
filter in this box will be used to generate the report. Thus, users will have complete 
freedom to modify the report filters. 

  

Saved Searches 
If a saved search is used for report creation, the filter in the report settings will reflect the 
saved search filters. The report will be linked to that saved search going forward. If a user 
updates the filters of the saved search, the filters of the report will update.  

However, if a user modifies the filter in the report settings and then saves the report, the 
filter changes will not alter the original saved search. The link between the original saved 
search and the report will be broken. From that point forward updates to the saved 
search will not update the report filters.   

  

Creating Ad-Hoc Reports 

GIFTS Online allows users to create Ad-Hoc reports from any search results and save them to the 
Reports Library for future use. 

 

Run a search/query, select the records desired, and then go to Options>Report.  

The Report Designer page will be opened with the default report design displayed. 
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Users can modify the font style, size, and color of any of the elements in the following sections:  

 Page Header 

 Column Headers 

 Records 

 Grand Totals 

To select all the elements in a specific section, click the section heading in the left panel. 

To select one specific element on the page, simply click on it. 

Options available for the element(s) selected will be displayed on top. 

Make any modifications desired and then save your report. 

Click Save to save report. Saved reports can be accessed through the Reports Manager. 

If the changes made are unsatisfactory, the user can click the Actions>Reset to Default button 
to revert to the original report settings. 
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Reporting at a Glance 

To access the GIFTS Online Reports Library click Launch > Report Manager in the main ribbon 
menu. 

The following are the basic steps for choosing and running a report: 

1. Choose a Report 
From the list of available reports on your system, choose a report. For example, the “Grants – 
Alpha List.” 

2. Specify Search Criteria 
In most cases, you want to limit the amount of data included in your report. For example, you 
might want to show only grants that were approved during the current quarter instead of all the 
grants in your database. 

You can use Quick Find, an Advanced search, or your saved searches to specify the search 
criteria that limit the data included in the report. 

3. For Financial Reports, specify an 'As of' Date 
Many financial reports produce information specific to the date in which they are run. For 
instance, the “Schedule of Appropriations and Payments” reports are used to generate year-end 
tax reports. To run these reports for the year 2013, you would run them ‘as of’ December 31, 
2013. 

4. Edit the Report Title 
Each report has a default title that is displayed at the top of the report. You should edit the title 
to ensure that it properly reflects the search criteria and, if applicable, the ‘as of’ date you have 
used to generate the report. 

5. Run the Report 
The report is displayed in the report viewer. You can print it or export the report data in a 
variety of data formats. 
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Choosing a Report 

The first step in running a report is to choose the report that provides the information you need. 
You can use the list of reports in “GIFTS Online Standard Reports” section to find the reports 
that best suit your needs or select an existing Ad Hoc report in the Report Library. 

The standard reports are organized into separate Categories, each of which is represented by a 
button in the REPORT TYPE panel on the left. 

NOTE: The reports and report titles in this publication may not necessarily match those on your 
system. Your site may have been configured to omit the reports that your Organization doesn’t 
use, or other reports may have been added to your library. 

To begin running the report selected, go to Actions>Generate or double-click on it. 

 

  

Specifying Filter Criteria 

Many report templates have fixed search criteria that select only specific records to include in 
the report. For instance, the “Alpha List of Grants” report only selects Requests that are 
Approved. By providing additional search criteria, you can further limit the scope of a report. 

The Filter criteria tell GIFTS Online that out of all the records in your database, you only wish to 
see a specific subset. For instance, only the grants with a Grant Amount greater than $50,000. 

NOTE: Some of your reports may have been configured by ME Support to include saved 
searches. When you select a report, the Search Criteria area will display any Saved Searches or 
filters which may have already been assigned. 

If you do not want to use the search criteria shown, you can choose Modify and then click Reset 
in the Full Search window. 
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About Filter Criteria 

To create Filter criteria for reports, you can click the Modify link under the Filter section. The 
principles are the same—the only difference is that instead of choosing the records to be 
displayed in search results on screen, you’re choosing the records to be included in the report. 

TIP: The search criteria do not modify the format or structure of Standard Reports; they 
determine which records appear in the report. 

If you use branch security, your reports do not include data that you do not have permission to 
see. 

  

About Financial Reports and Search Criteria 

Many Financial reports display a summary of the payment history for your grants. To be 
accurate, these reports must include the entire history of the grant’s payments. 

If your search criteria limit the report to payments within a specific date range or within a Fiscal 
Year—and only part of a grant’s payments fall within your search criteria—GIFTS Online includes 
the grant’s entire payment history in the report even if not all of the grant’s payments meet 
your search criteria. 
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EXAMPLE: The Five Year Payment History report shows, for each grant in the report, the 
Payments made within the last five years. If you use the 2012 Fiscal Year as your search criteria 
and a grant is included in the report because you made payments on it in 2012, payments made 
in prior years are also included in the report. Therefore, the payment history is accurate even 
though not all of the grant’s payments were made in the 2012 Fiscal Year. 

The following Financial reports, which summarize payment information by grant, are designed 
to work in this manner; in contrast, reports that list individual payments instead of a grant’s 
payment history only include payments that meet your search criteria. 

 Cash Flow Analysis 

 Five Year Payment History Report 

 Grant Commitment Schedule 

 Grant Payment Summary 

 Grant Planning Worksheet 

 Schedule of Appropriations and Payments 
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Choosing the Search Criteria for a Report 

To create or edit the search criteria for a report, click Modify below the Filter field. The Search 
form is displayed. 

 

Click Add Filters to pull up the basic filters list and select one or more criteria.  
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Clicking Advanced will take you to the Query Builder view to create your filter query.  

 

This view should only be used by users with advanced knowledge of database query building. 

For an overview of the Query Builder and Advanced search facilities, please refer to the Full 
Search section of the GIFTS Online User’s Guide. 

When you are finished creating your search criteria, click OK to return to the Generate Report 
form. 

Note that the Query Builder filters available for each record type are different. 

If you select another report in the same Report Library record type, the search criteria you 
created are not cleared; this allows you to run more than one report without having to re-enter 
your search criteria. You can clear the search criteria at any time by choosing Reset from the Full 
Search form. 

  

Setting the 'As of' Date for Financial Reports 

Many financial reports produce information specific to the date in which they are run. For 
instance, the “Schedule of Appropriations and Payments” reports present a picture of your 
financial history for the current year. 

In many cases, you may want to produce financial reports of this kind after you have closed out 
a particular year. For instance, in the first few months of any new year, you may wish to produce 
reports on last year’s giving for the IRS. 

For this reason, an ‘As of’ date setting is available for all of the Standard Financial reports in the 
Report Library. 
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When you set ‘As of’ date to a date other than the current date, your reports are affected in the 
following ways: 

 If the report automatically selects information relevant in the “Current Year,” the current 
year is based on the ‘as of ‘ date, not the current date. 

 If the report includes columns for future or past years, or future or past months, these 
columns are automatically adjusted based on the ‘as of’ date. 

 Reports that include ‘Scheduled’ Payments include payments that have a Status of Paid, 
but for which the Payment Date is after the ‘as of’ date. 

 Reports that include ‘Paid’ and ‘Refund’ Payments exclude these Payments if their 
Payment Date is after the ‘as of’ date. 

 Payments for Requests that were approved after the ‘as of’ date are excluded from the 
report, regardless of their actual Schedule or Paid dates. 

 Payments that were voided after the ‘as of’ date are reported as being ‘Paid.’ 

The financial reports have been designed to recreate your data based on the ‘as of’ date, but 
some data—once it is altered in GIFTS Online—cannot be restored to its past condition; 
therefore, the results of reports run with the ‘as of’ date may not completely represent a 
version of the financial data as of that date. The following data cannot be accurately recovered 
based on ‘as of’ date. 

 Payments that have been deleted are not reflected. 

 Payments for which the amount changed between the ‘as of’ date and the current date 
report the current amount, not the previous amount. 

IMPORTANT: Custom reports created by MicroEdge, Ad Hoc Reports, or any third-party report 
writer may not have been designed to take advantage of the ‘As of’ date functionality. 

  

Editing the Title of the Report 

The GIFTS Online reports have three-line titles: a large heading in bold and two subheadings, as 
shown in the following sample. 

 

GIFTS Online provides a default Title for the report based on its title in the Report Library, and—
if your site is set up to do so—defaults the first subtitle to the search criteria you have chosen. 

The Generate Report form allows you to alter the main Title and enter the Subtitles necessary to 
reflect the search criteria that you use when running the report.  
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Therefore, anyone who reads the report will know exactly what he or she is looking at. 

  

Running the Report 

Before you Begin 

Be sure that you have completed the preceding four steps, and that the report title properly 
reflects your search criteria. 

 

Viewing the Report 

To view your report after you have specified the necessary options, click OK. The report is 
generated and displayed in the report viewer. 

You can use the viewer’s toolbar to navigate the report: 
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Icon/Field 
Name 

Description 

Export Export the report to Crystal Report (RPT), PDF, Word, Excel, or RTF formats. 

Print Print the report. 

Show/Hide 
Group Tree 

If the supported by the report. 

First Go to the first page of the report. 

Previous Go to the previous page. 

Next Go to the next page. 

Last Go to the last page of the report. 

Pages Current/Total Pages 

Go to Jump to the specific page entered. 

View History If drill-down is enabled for the report, this will keep track of viewing history and 
allow you to jump to specific report levels listed. 

Find Use this field to search for a keyword in your report. 

Zoom Set the percentage of the zoom. 
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Exporting the Report 

When the report has finished processing, you can export it to a variety of file formats 
appropriate for word processors, spreadsheets, Internet browsers, and other applications. 

To export a report, click the Export button on the report viewer toolbar. You are prompted to 
choose an export format and a filename for the exported data. 

 

NOTE: Reports that are exported to Microsoft Word® may require extensive reformatting. If this 
is the case, consider exporting your report to another format, such as Microsoft Excel, that may 
retain more of the formatting that you need. 
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Time Saving Tips 

Use the following GIFTS Online features to make reporting fast and easy: 

Save Your Searches 

If you frequently use the same search criteria for your reports, don’t forget to save your 
searches for later use. You can then easily attach a Saved Search to a standard report. 

Attach Saved Searches 

If you always run a report with the same Saved Search, add an Ad Hoc report to your library that 
has the saved search attached to it. Then, you won’t have to choose the saved search when you 
run the report. 

  

Default Report Settings 

To modify the default report settings, to go Admin>Report Settings. 

This page displays the default look of all Ad-Hoc reports. When a user clicks the Reset to Default 
action after modifying a report, the report will revert to the settings shown here.  

 

In the example below, the page header title color has been changed to blue and the date text 
has been selected for modification. 
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The menu options available on this page are discussed below: 

Actions Menu   

Generate To run your report, click the Generate button from the Actions menu. 

The Generate Report form will pop up with options to modify the title, add 
subtitles, and/or modify the Filter if desired. 

Click OK to run your report.  

 

Reset to Default Click this button to reset changes made to the form back to default. 

Delete Only available for saved Ad-Hoc reports.  
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The Options Menu 

The actions available on the Options menu are discussed below: 

Settings 
The Report Settings popup contains options to set the Report Type, Name, Description, sharing, 
read-only status, set the Grand Total and Record Count inclusions, modify the report’s Filter and 
set the ‘Add to Favorites’ setting. 

 

Header/Footer 
The Header & Footer popup allows users to set values that will display in the header and footer 
of the report.  

Each element has a checkbox option to have the value repeat on each page.   

Note that some of these settings such as the ‘repeat on each page’ and the date and page 
number Alignment and Formats can also be set in the main report designer page but are 
repeated here as they also affect the header and footer. The settings that are set in one place 
are reflected in the other. 
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Columns 
The Report Columns popup allows users to modify column selection and order, as well as set 
special column formatting options. 
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Sorting/Grouping 
This popup allows the user to modify sorting and grouping options for the report. The 
functionality of this popup varies based on the selected Report Type. 

 

Page Setup 
This popup allows the user to modify page settings. These changes will be reflected in the 
interactive report designer. The default values come from the Report Settings. 
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About GIFTS Online Standard Reports 

One of the most important functions of any database system is the ability to arrange and 
present the data you have entered in useful ways. GIFTS Online includes an extensive set of 
standard reports. 

GIFTS Online includes two types of reports: 

Standard Reports — More than 100 pre-built standard reports designed to meet the 
needs of most grant making organizations are installed with your system. These reports 
have been designed to complement the functionality of GIFTS Online in a way that is 
beneficial to the largest number of users. Standard reports answer common queries, 
some of which are general in nature and some of which are more specific. 

EXAMPLE: The “Alphabetical List of Grants” report lists grants in alphabetical order to 
answer the query “Which projects have we funded?” When you run this report, you can 
further define it to answer a more specific query, such as “Which projects have we 
funded in Arts and Culture?” You can choose the specific data you wish to see for all 
reports. 

Custom Reports — If you need help customizing specific reports or creating new reports, 
you can retain MicroEdge to accomplish this. The cost of this service varies depending on 
the level of complexity of the required reports. For more information, please contact ME 
Support. 

In order for you to make the best use of your data, it is helpful to have a thorough 
understanding of the available standard reports and how the data you enter is reflected in these 
reports. Reviewing the sample reports may provide you with ideas about using areas of GIFTS 
Online that you haven’t yet explored. It will also allow you to determine what types of custom 
reports you may want to request ME Support to create for your site in the future. 

How to Use the Sample Standard Reports 

The sample Standard reports in this document are divided into the categories in which they 
appear in the GIFTS Online Reports Library. You can browse through the list of reports to find 
the ones that meet your needs. 

Each sample report includes information about the fixed criteria that apply to the report and, if 
the report belongs to a series, the available variations of the report. Series and fixed criteria are 
described in the following sections. 

About Series of Reports 

For many reports, there are several variations that comprise a series of reports. For example, 
the ‘Declinations - Alpha List’ series of reports includes the following reports: 

 Declinations - Alpha List 

 Declinations - Alpha List by Fund 

 Declinations - Alpha List by Geographical Area 1 

 Declinations - Alpha List, by Program Area 1 

 Declinations - Alpha List by Reason 

 Declinations - Alpha List by Staff 

 Declinations - Alpha List by Type 
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These reports include identical information; the only difference is the way in which the records 
are grouped. For report series, this document includes one variation of the report as an example 
and lists the other variations in the series. 

About Report Names 

 The report names in this document are the names shipped with the GIFTS Online product; the 
names in your system may be different if you have requested ME Support to edit them. 

ME Support can help you to add and remove reports from GIFTS Online, so not all of the reports 
in this document may be available. If you would like to use a report and cannot find it in your 
system, please contact ME Support. 

About Fixed Criteria 

Many reports have been designed to include only specific information. For example, the 
‘Declinations - Alpha List’ reports only include Requests with a Disposition of Declined. Pending 
Requests and Approved Requests are not included in the report. 

These fixed criteria always apply to the report, regardless of the search criteria that you choose 
when you run the report. If a report has fixed criteria, they are noted in the sample report. 

About Saved Search Criteria 

You can customize the standard reports by attaching saved searches. On the Generate Report 
form, simply click the Modify link and then click Saved Searches to view a list of available saved 
searches.  

The standard reports library includes an “Alpha List of Grantee Organizations” report that lists 
all Organizations in the GIFTS Online database that have received funding. By attaching a saved 
search for Organizations coded as ‘Arts & Culture’ to this report, you can create an “Alpha List of 
Arts Grantees” report. 

NOTE: These customized reports cannot be saved for future use in GIFTS Online. 

How Records are Sorted 

Unless otherwise noted, all reports sort records alphabetically by Organization Sort as Name. 

Currency and Date Formats 

The currency and date formatting of the reports is determined by Regional Settings Control 
Panel of Microsoft Windows. The sample reports in this document were produced on a system 
with the Regional Settings set to “English (United States).” 

NOTE: GIFTS Online does not currently support multi-currency. 
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About Report Categories 

In order to provide the most intuitive access to reports, the standard reports are divided into 
Record types. You should note that not all categories will be available to all users, as some 
depend on your system configuration. 

Some report Categories will have no reports defined for them in the Report Listing. Affiliations, 
Documents, and Reviews, for instance, have no reports available because they contain no 
standard reports. 

Any combination of the following categories may be available from your Run Reports form: 

Category Description 

Activities To-do and scheduling reports. 

Affiliations No standard reports.   

Custom Affiliation reports can be created by ME Support per your request. Custom 
Affiliation reports can provide details about your contacts’ relationships with 
various organizations and grant requests. 

Applications For Online Applications module users only. Used to access reports regarding Online 
Applications, Requirements, and Quiz results. 

Contacts Detailed information about your contacts, and special reports for printing 
comprehensive lists of contacts for projects or organizations. 

Documents No standard reports.  

Custom reports can be created by ME Support per your request. 

Organizations Organization reports are designed to provide information on the organizations in 
your database. These reports are useful for displaying address, tax status, and 
other details about Organizations. 

Since organizations are attached to the funding requests they have made, 
information about an Organization’s funding history is also available on several 
Organization reports. 

Payments A variety of ways to look at your financial data. Most reports detail Payment 
information that you can use to review your financial history or plan future 
commitments. 

Requests Reports about the requests for funding in your system. Some reports display 
detailed information on each Request, while others summarize Request 
information in meaningful ways. 

Request reports include information on grants, declinations, and proposals—
though many Request reports are designed to include only specific information. 
For instance, the ‘Declinations by Reason’ report only lists Requests that have been 



GIFTS Online 5.1 User’s Guide 

195 
 

Declined. 

Requirements Reports on requirements due from grantee organizations. 

  

About Fixed Criteria 

Many reports have been designed to include only specific information. For example, the 
‘Declinations - Alpha List’ reports only include Requests with a Disposition of Declined. Pending 
Requests and Approved Requests are not included in the report. 

These fixed criteria always apply to the report, regardless of the search criteria that you choose 
when you run the report. If a report has fixed criteria, they are noted in the sample report. 

  

Activity Reports Listing 

The following standard Activity reports are included in GIFTS Online: 

Report Name Description 

Activities Verification 
Report 

  

A report showing all of the Activities for each request, including audit 
trail information such as who created, last changed, and marked the 
activity as complete. 

To Do Completed by Date 

To Do Completed by Staff 

A list of completed To Do Activities, sorted by the done date. 

Fixed Criteria: Activities with a Class of To Do and a Status of Done. 

To Do Listing by Staff 

To Do Listing by Date 

A list of all outstanding To Do Activities for specific staff members, 
including pertinent information on related Requests. 

Fixed Criteria: Activities with a Class of To Do and a Status of 
Scheduled. 
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Applications Reports Listing 

NOTE: Online Applications module must be configured on your GIFTS Online site to access these 
reports. 

There are several reports are available for Online Applications.  

Many of the reports are available in two varieties, Detailed or Summary.  

Detailed Reports:  
These reports list the details of each application/requirement grouped by application form. They 
include form name, organization, email, project title, submit/create date, ID number, number of 
attachments, and total attachment size. 

Summary Reports: 
These reports list only the Form, Stage, Number of Applications/Requirements, Number of 
Attachments, and Total Attachments Size. 

The following standard Applications reports are included in GIFTS Online: 

Report Name Description 

Eligibility Quiz Report to view responses from all eligibility quizzes, or only those 
quizzes for specific application forms. 

In-Progress Applications These reports include all of the following types of applications: 

 Any application started but unfinished by online applicants 

 Applications specifically saved by the user (by clicking the 
Save & Finish Later button) 

 Applications left unfinished by users who simply left your 
site without saving 

NOTE: In certain cases, these unfinished applications are saved by 
the system for a certain length of time before being purged. 

In-Progress Requirements 
These reports include requirements that have been accessed by the 
applicant but have not been submitted. 

Outstanding Requirements These reports include requirements that have not been accessed or 
submitted by the applicant. 

Submitted Applications These reports include applications that have been completed and 
submitted by the applicant. 

Submitted Requirements These reports include requirements that have been filled out and 
submitted by the applicant. 
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Contacts Reports Listing 

The following standard Contact reports are included in GIFTS Online: 

Report Name Description 

Contact Labels 5160  

  

Mailing Labels addressed to the contact at their Primary 
Organization formatted for Avery #5160 labels. 

Contact Labels 5162  

  

Mailing Labels addressed to the contact at their Primary 
Organization formatted for Avery #5162 labels. 

Contact Phone Book Report  

  

A simple listing of Contacts by last name, with telephone, fax, and 
e-mail information for each Contact. 

Contacts - Alpha List  

  

An alphabetical list of Contacts by name, including full address 
information 

Duplicate Contacts by Last 
Name 

Duplicate Contacts by Zip 
Code 

  

A report that shows Contacts with the same last name, to help 
identify duplicates for data cleanup. 

  

Organization Reports Listing 

The following standard Organization reports are included in GIFTS Online: 

Report Name Description 

Alpha List of Grantee 
Organizations 

An alphabetical listing of all organizations associated with grants, 
including the total amount granted to the organization and the 
grant year span. 

Alpha List of Organizations An alphabetical listing of all organizations, including Request 
information 

Duplicate Organizations (by 
Name) 

Identifies duplicate organization entries to assist with data cleanup. 
Only organizations with the exact same name are included. 
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Organization Mailing Labels 
#5160 

This report prints mailing labels for Avery’s #5160 label template to 
the Primary Contact of each Organization at the Organization’s 
mailing address. Two versions of this report are available: one sorts 
the labels by the author’s last name and the other by the 
Organization’s postal code 

Organization Mailing Labels 
#5162 

This report prints mailing labels for Avery’s #5162 label template to 
the Primary Contact of each Organization at the Organization’s 
mailing address. Two versions of this report are available: one sorts 
the labels by the author’s last name and the other by the 
Organization’s postal code 

Organization Profile Report 

Organization Profile Report 
(with Graph) 

A summary sheet for each organization, displaying their address 
and background information, and both the detail and summary 
information of their funding history as entered in the Requests file. 

Simple Organization Listing A simple list of all organizations in your GIFTS Online database, with 
no request information included. 

Top 20 Organizations by 
Total Grant Amount 

This report lists the organizations receiving the top 20 highest 
cumulative grant amounts within the search criteria specified. 

Top 20 Organizations by 
Total Number of Grants 

This report lists the organizations receiving the top 20 highest 
number of cumulative awards within the search criteria specified. 

  

Payments/Financial Reports Listing 

The following standard Payments/Financial reports are included in GIFTS Online: 

Report Name Description 

Cash Flow Analysis  

Cash Flow Analysis by 
Program Area 

A listing of Scheduled Payments for the next six months, including 
the Organization Name, total amount granted, and remaining 
balance at the end of six months.  

Fixed Criteria: Payments for Requests that have any outstanding 
Payments. 

Check Request Report by 
Fund 

  

A listing of Scheduled Payments, including the legal name and 
address of the payee Organization, for the purpose of providing 
information for cutting checks. Grouped by Payment Fund.  

Fixed Criteria: Payments with a Status of Scheduled. 

Contingent Payments by 
Staff  

Contingent Payments by 

A listing of payments with a Status of Contingent, grouped by the 
Staff person assigned to the contingency. The type of contingency, 
due date, and notes are included.  
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Date Fixed Criteria: Payments with a Status of Contingent. 

Current Year Paid and 
Future Commitments  

Current Year Paid and 
Future Commitments - by 
Program Area 

A listing of payments with a Status of Contingent, grouped by the 
Staff person assigned to the contingency. The type of contingency, 
due date, and notes are included.  

Fixed Criteria: Payments with a Status of Contingent. 

Deferred Payments 

  

A listing payments with a Status of “deferred” (payments which 
have been placed on Hold).  

Fixed Criteria: Payments with a Status of Hold. 

Five Year Payment History 
Report  

Five Year Payment History 
Report by Program Area 

A summary report per organization, showing the total amount paid 
to that organization in each of the last five years, including the 
current year.  

Fixed Criteria: Payments with a Status of Paid, Refund, or Void. 

Grant Amendment Report 

  

Provides detailed information on all of the amendments for each 
grant, and includes both the Original Grant Amount and the 
Current Grant Amount.  

Fixed Criteria: Approved Requests that have amended Grant 
Amounts. 

Grant Commitments 
Schedule 

  

A summary of payment information by Request, for those Requests 
with any outstanding payments. Information shown includes the 
grant amount, the amount paid in the current year and prior years, 
payments scheduled in the next three years, and any remaining 
balance.  

Fixed Criteria: Payments for Requests with an unpaid balance. 

Grant Commitments 
Schedule (6 years)  

Grant Commitments 
Schedule (6 Years) by 
Program Area 

  

Shows payments scheduled in the next six years, including the total 
of any payments remaining after that time.  

Fixed Criteria: Payments for Requests with an unpaid balance. 

Grant Payment 
Confirmation by Staff 

  

A list of Payments with a Status of Scheduled, Contingent, or Hold, 
grouped by the staff member associated with the Request, and 
including information on any Requirements due for the Payment or 
Request.  

Fixed Criteria: Payments with a Status of Scheduled, Contingent, or 
Hold, and Requirements with a Schedule Date in the current year. 
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Grant Payment Summary  

Grant Payment Summary - 
by Payee 

A comprehensive summary of Payment information for Approved 
Requests, including the total number of Payments, the amount 
granted, the amount scheduled (payments with a Status of 
Scheduled, Hold, or Contingent), paid, and any unscheduled 
balance. It also includes the Payment Schedule Date and amount of 
the next payment due.  

The “by Payee” variation summarizes the data by the payee 
Organization instead of the grantee. Since grants that include 
Payments to more than one payee are listed more than once (one 
listing per payee), this report does not include totals for the Grant 
Amounts and Grant Balances.  

Fixed Criteria: Payments for Approved Requests. 

Grant Planning Worksheet 

Grant Planning Worksheet 
by Grant Fund  

Grant Planning Worksheet 
by Program Area 

  

For year-end planning, this report displays in worksheet format the 
giving for the current year, any commitments for the next year, a 
space to write in the proposed amount for next year, per 
organization.  

Fixed Criteria: Organizations with Requests Approved in the 
current Fiscal Year, payments Paid in the current Fiscal Year, or 
Payments Scheduled for the coming Fiscal Year. 

In-Kind Payments Made 

In-Kind Payments Made by 
Payment Fund Donor 

In-Kind Payments Made by 
Program Area 

  

A report of paid payments including fields specific to in-kind 
payments: fair market value, tax value, book value, and in-kind 
notes. Payments are grouped and subtotaled by the Payment Fund 
Donor.  

Fixed Criteria: Payments with a Status of Paid or Void. 

Payment Status Summary - 
by Payment Fund 

Payment Status Summary - 
by Program Area  

 Payment Status Summary - 
by Year 

A summary of all payments entered in GIFTS Online, totaled by 
their respective Payment Status. Includes columns for the total 
amount scheduled, and then breaks this out by Paid, Scheduled, 
Hold, Contingent Payments. 

Payments Due Schedule, by 
Grantee Organization  

Payments Due Schedule, by 
Month 

Payments Due Schedule, by 
Payment Fund 

Payments Due Schedule, by 

A listing of outstanding Payments, including the Grant Amount, 
Project Description and Reference Number, the Payment Due Date 
and Amount, and the Payment Fund. If the Payment has a Status of 
Contingent or Hold, a column displays this information, along with 
notes entered for the Payment.  

Fixed Criteria: Payments with a Status of Scheduled, Hold, or 
Contingent. 
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Payment Support Type 

Payments Due Schedule, by 
Program Area 1  

Payments Due Schedule, by 
Payment Area 1 & 2 

Payments Made - by Month  

Payments Made - by 
Grantee Organization  

Payments Made - by 
Payment Fund 

Payments Made - by 
Payment Support Type 

Payments Made - by 
Program Area 1  

Payments Made - by 
Program Area 1 & 2 

Payments Made - by State  

A listing of payments which have been marked as paid in the 
system, including the payment date and check number, if available.  

Fixed Criteria: Payments with a Status of Paid, Refund, or Void. 

Payments Made - Charitable 
vs. Non Charitable 
Deductions 

  

For those organizations that capture “Quid Pro Quo” information, 
this report lists the deductible and non-deductible amounts as 
entered for each payment. Also included is the check number and 
the payment date.  

Fixed Criteria: Payments with a Status of Paid or Void. 

Payments Made - OBRA 
Report 

  

This report shows whether or not a receipt is required on each 
Payment, and the Schedule Date and Done Date of the receipt. The 
full name and address of the payee Contact is included for easy 
follow-up. The report also includes the deductible and non-
deductible amount for each Payment and the Organization’s tax 
status.  

Fixed Criteria: Payments with a Status of Paid or Void, and 
Requirements associated with Payments that have been specified 
as “Receipt Required.” 

Payment Reconciliation 
Report 

Lists Payments by status, and then by Check Number, including the 
payee’s legal name, the Payment Fund, the Payment Type, and Paid 
Date.  

Fixed Criteria: Payments with a Status of Paid, Refund, or Void. 

Schedule of Appropriations 
and Payments  

This is a new version of the old Schedule of Appropriations and 
Payments.  
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Schedule of Appropriations 
and Payments, by Program 
Area   

For Approved Requests, this report lists the balance as of the 
beginning of the current Fiscal Year, any money newly allocated in 
the current Fiscal Year (which will include grants made in the 
current year), the amount paid in the current Fiscal Year, and the 
amount outstanding for the current Fiscal Year.  

Fixed Criteria: Approved Requests with an unpaid balance or for 
which appropriations were made during the Fiscal Year. 

Schedule of Appropriations 
and Payments (OLD) 

Schedule of Appropriations 
and Payments, by Program 
Area  

Schedule of Appropriations 
and Payments showing 
Population Served 

For Approved Requests, this report lists the balance as of the 
beginning of the current Fiscal Year, any money newly allocated in 
the current Fiscal Year (which will include grants made in the 
current year), the amount paid in the current Fiscal Year, and the 
amount outstanding for the current Fiscal Year.  

Fixed Criteria: Approved Requests with an unpaid balance or for 
which appropriations were made during the Fiscal Year. 

Summary of Paid Payments - 
by Geo. Area 1 

Summary of Paid Payments - 
by Payment Fund 

Summary of Paid Payments - 
by Payment Type 

Summary of Paid Payments - 
by Payment Support Type 

 Summary of Paid Payments 
- by Prog. Area  

Summary of Paid Payments - 
by Staff  

A summary of payments paid, including number of items and 
percentages.  

Fixed Criteria: Payments with a Status of Paid, Refund, or Void. 

Top 20 Payments by 
Payment Amount 

The largest 20 Payments in the search criteria provided, in 
descending order by amount.  

Fixed Criteria: Payments for Approved Requests. 
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Request Reports Listing 

The following standard Request reports are included in GIFTS Online: 

Report Name Description 

Board Meeting Agenda 

Board Meeting Agenda by 
Docket Number  

Board Meeting Agenda by 
Program Area 1 

Organization name, long project description, requested amount 
and recommended amount, designed for an agenda for a Board 
Meeting. 

Board Meeting Minutes  

Board Meeting Minutes by 
Docket Number  

Board Meeting Minutes by 
Program Area 1 

Requests with their current Disposition and Status, showing the 
action taken by the board. 

Contact Affiliations by 
Request 

A list of Requests, grouped by Organization, that shows the 
affiliated Contacts for each Request. 

Data Entry Edit Report by 
Organization  

Data Entry Edit Report by 
Date 

A comprehensive summary of individual Requests, including all 
classifications, for data entry verification. 

Declinations - Alpha List  

Declinations - Alpha List 
(Portrait)  

Declinations - Alpha List by 
Fund  

Declinations - Alpha List by 
Geographical Area 1  

Declinations - Alpha List by 
Internal Program  

Declinations - Alpha List by 
Program Area 1 

Declinations - Alpha List by 
Staff  

Declinations - Alpha List by 
Grant Type 

A detailed listing of Declined requests, including the reason for 
declination and the staff person assigned. The “Portrait” variation 
of this report is printed with the Portrait paper orientation; all 
other variations are Landscape reports.  

Fixed Criteria: Requests with a Disposition of Declined. 
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Declinations - Alpha List by 
Fund (including Request 
Amount)  

Declinations - Alpha List by 
Program Area (including 
Request Amount) 

A detailed listing of Declined requests, including subtotals of the 
amount requested.  

Fixed Criteria: Requests with a Disposition of Declined. 

Declinations - Summary by 
Reason 

A summary of declinations by the reason declined, including totals 
for each reason and the corresponding percentage of the total, 
both for the number of declines and the amount requested.  

Fixed Criteria: Requests with a Disposition of Declined. 

Foundation Center Export 
Report 

A data export for the Foundation Center. Please contact MicroEdge 
Technical Support for detailed information. 

Grant Profile Report A summary of a single grant, including payment and grant 
amendment information.  

Fixed Criteria: Requests with a Disposition of Approved. 

Grant Summary - by Fund  

Grant Summary - by 
Geographical Area  

Grant Summary - by Grant 
Type  

Grant Summary - by 
Program Area 1  

Grant Summary - by 
Program Areas 1 and 2  

Grant Summary - by 
Program Areas 1, 2 and 3  

Grant Summary - by Support 
Type 

Grant Summary - by Staff 

A summary of approved requests showing the total amount 
granted and the percentage of the total for each item.  

Fixed Criteria: Requests with a Disposition of Approved. 

Grant Summary - Granted 
and Paid by Program Area 

For each Program Area, this report shows the total amount granted 
and the amount and percentage of Payments made for that 
Program Area.  

Fixed Criteria: Requests with a Disposition of Approved. 

Grants - Alpha List 

Grants - Alpha List by Fund  

Grants - Alpha List by Geo. 

Alphabetical listing of grants, including Reference Number, amount 
granted, and amount paid. Grants are listed in alphabetical order 
by organization name.  
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Area Level 1  

Grants - Alpha List by Geo. 
Area Levels 1 to 5  

Grants - Alpha List by Grant 
Type  

Grants - Alpha List by 
Internal Program  

Grants - Alpha List by 
Population Served  

Grants - Alpha List by 
Program Area 1  

Grants - Alpha List by 
Program Area 1 & 2  

Grants - Alpha List by 
Program Area 1, 2, & 3  

Grants - Alpha List by 
Program Areas 1 through 5  

Grants - Alpha List by 
Primary Contact  

Grants - Alpha List by Staff  

Grants - Alpha List by 
Support Type 

Fixed Criteria: Requests with a Disposition of Approved. 

Grants - Alpha List (Portrait) Same as the Alpha List of Grants report, but with the paper 
orientation designed to print portrait rather than landscape.  

Fixed Criteria: Requests with a Disposition of Approved. 

Grants - Alpha List, by 
Geographic Area Served 
including Secondary Codes  

Grants - Alpha List, by 
Program Area Served 
including Secondary Codes 

Alpha list of grants, grouped by all levels of the Geographic Area 
Served or Program Area table. These reports include both primary 
and secondary coding, so that one grant may appear several times 
(once for each code). Thus, the totals in this report may not reflect 
the actual amount granted.  

Fixed Criteria: Requests with a Disposition of Approved, and which 
have been assigned a classification in the table on which the report 
groups. 

Grants - Chronological List  

Grants - Chron. List by Fund  

Grants - Chron. List by 
Geographical Area 1  

Grants - Chron. List by Grant 

Listing of grants, including Reference Number, amount granted, 
and amount paid. Grants are listed in date order by Grant Date.  

Fixed Criteria: Requests with a Disposition of Approved. 
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Type  

Grants - Chron. List by 
Program Area 1  

Grants - Chron. List by 
Program Area 1 and 2  

Grants - Chron. List by 
Program Area 1, 2, & 3  

Grants - Chron. List by Staff  

Grants - Chron. List by 
Support Type 

Grants - Detail List by Staff A listing of all grants grouped by Staff member. 

Incomplete Proposals   

Incomplete Proposals by 
Date 

A listing of Pending items which are marked as incomplete, 
including the current Status of the Request and the 
Complete/Incomplete Notes.  

Fixed Criteria: Requests with a Disposition of Pending that are also 
marked as ‘incomplete’ on their Request record. 

Proposals - Alpha List  

Proposals - Alpha List, by 
Staff  

Proposals - Alpha List, by 
Fund  

Proposals - Alpha List, by 
Geographical Area 1  

Proposals - Alpha List, by 
Grant Request Type  

Proposals - Alpha List, by 
Internal Program  

Proposals - Alpha List, by 
Program Area 1  

Proposals - Alpha List, by 
Program Areas 1 and 2  

Proposals - Alpha List, by 
Primary Contact  

Proposals - Alpha List, by 
Status 

A listing of Pending items, including Project Title, Request and 
Recommended Amounts, Request Type and Status.  

Fixed Criteria: Requests with a Disposition of Pending. 

Proposals - Alpha List 
(Portrait) 

Same as the Alpha List of Proposals report, but with the paper 
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orientation designed to print portrait rather than landscape.  

Fixed Criteria: Requests with a Disposition of Pending. 

Proposals - 
Complete/Incomplete 

A listing of Pending items, including Project Title, Request Date, and 
Staff, and whether the Request is complete, along with any 
relevant notes.  

Fixed Criteria: Requests with a Disposition of Pending. 

Recommendations by 
Organization 

This report shows the approved amount for the previous year, and 
the approved amount for the current year per organization, and 
the Project Description (Long).  

Fixed Criteria: Requests for Organizations that have at least one 
Pending Request in the current calendar year. 

Renewable Grants Lists basic grant information about grants that have been flagged as 
renewable.  

Fixed Criteria: Approved Requests that have been flagged as 
renewable. 

Repeat Grants For each Organization with repeat grants, this report shows the 
granted and paid figures for the current and previous calendar 
years.  

Fixed Criteria: Organizations that have received grants in both the 
current year and the previous year. 

Request History by 
Organization 

The Request History by Organization report is very similar to the 
Organization Profile report listed in the Organization report library. 
The key difference is, the Request History by Organization report is 
sensitive to Request criteria. 

Request Labels (All Affiliated 
Contacts) 

This series of reports prints mailing labels to all affiliated Contacts 
for each Request included in the report. The Organization’s 
mailing address is used. 

Request Labels (Primary 
Contact) 

This series of reports prints mailing labels to the Primary Contact 
of each Request included in the report. The Organization’s mailing 
address is used. 

Request Statistics A report showing statistical information such as the total number 
of Approved, Pending, and Declined Requests and the minimum, 
maximum and average grant amounts. 

Requests by Sponsor A list of Requests, grouped by the Contact identified as the 
“Sponsor” of each Request. Includes the Disposition, Grant 
Amount, and Paid Amount of each Request.  
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Fixed Criteria: Requests that have an affiliated Contact with the 
Role of “Sponsor.” 

Status of Requests Received 
by Staff, Including Sponsor  

Status of Requests Received 
by Staff 

A comprehensive listing of Requests grouped by staff, including the 
contact designated as the Sponsor (using the system-defined 
“Sponsor” Contact Role) 

Summary of Requests by 
Type, Disposition, and 
Status 

A summary of Requests grouped by Type, Disposition, and then 
Status; includes subtotals of the requested and granted amounts 
for each Request. 

Tax Status Verification Shows tax status information for organizations associated with 
Requests, and displays a warning message for organizations with no 
tax status on file.  

Includes: Organizations associated with Requests. 

Top 20 Grants by Grant 
Amount 

The largest 20 grants in the search criteria provided, listed in 
descending order by grant amount. 

  

  

Requirement Reports Listing 

The following standard Requirements reports are included in GIFTS Online: 

Report Name   

Pending Proposal Checklist A report listing the requirements due on Pending Requests only. 
The Project Title, Request Date and the Meeting Date are included 
for each Request. 

Fixed Criteria: Requirements associated with Requests with a 
Disposition of Pending. 

Requirements Completed - 
by Staff 

 Requirements Completed - 
by Date  

Requirements Completed - 
by Organization  

Requirements Completed - 
by Program Area 

A list of completed Requirements, grouped by the staff member 
assigned to the Requirement. 

Fixed Criteria: Requirements with a Status of Done. 
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Requirements Due by Date 

 Requirements Due by 
Organization  

Requirements Due by Staff  

Requirements Due by 
Program Area 

A chronological list of Requirements with a Status of Scheduled. 

Fixed Criteria: Requirements with a Status of Scheduled. 

Requirements Received by 
Date 

A chronological list of Requirements that have been marked as 
received from the grantee, but have not yet been marked as done. 

Fixed Criteria: Requirements with a status of Received. 

  

About Activity Reports 

This chapter describes the standard Activities reports included with GIFTS Online. 

  

Activities Verification Report 

A report showing all of the Activities for each Request, including audit trail information such as 
who created the Activity, who last modified it, and who marked the Activity as complete. 
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To-Do Completed 

list of completed To Do Activities, sorted by their Done Date. 

Variations: 

 by Date 

 by Staff 

Fixed Criteria: 

Activities with a Class of To Do and a Status of Done. 

 

  

To-Do Listing 

A list of all outstanding To Do Activities for specific staff members, including pertinent 
information on related Requests. 

Variations: 

 by Date 

 by Staff 

Fixed Criteria: 

Activities with a Class of To Do and a Status of Scheduled. 
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Online Application Reports 

NOTE: You must have the Online Applications module configured on your site to access these 
reports. 

There are several reports are available for Online Applications. They can be used to present 
totals from applications, online requirements, as well as responses from eligibility quizzes. 

 Reports on Applications can be run on In Progress or Submitted forms. 

 Reports on Online Requirements can be run on In Progress, Submitted, or Outstanding 
forms. 

 There is one Eligibility Quiz report. 

Many of the reports are available in two varieties, Detailed or Summary.  

Detailed Reports:  
These reports list the details of each application/requirement grouped by application form. They 
include form name, organization, email, project title, submit/create date, ID number, number of 
attachments, and total attachment size. 

Summary Reports: 
These reports list only the Form, Stage, Number of Applications/Requirements, Number of 
Attachments, and Total Attachments Size. 
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Eligibility Quiz Information 

You can run a report to view responses from all eligibility quizzes, or only those quizzes for 
specific application forms. 

  

Fixed Criteria 

 Date Range 

 Application forms to report on 

 

  

In Progress Applications 

These reports include all of the following types of applications:  

 Any application started but unfinished by online applicants 

 Applications specifically saved by the user (by clicking the Save & Finish Later button) 

 Applications left unfinished by users who simply left your site without saving 

NOTE: In certain cases, these unfinished applications are saved by the system for a certain 
length of time before being purged. 

  

Fixed Criteria 

 Date Range 

 Application forms to report on 
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Variations 

 Detailed 

 Summary 
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In Progress Requirements 

These reports include requirements that have been accessed by the applicant but have not been 
submitted. 

Fixed Criteria 

 Date Range 

 Application forms to report on 

Variations 

 Detailed 

 Summary 
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Outstanding Requirements 

These reports include requirements that have not been accessed or submitted by the applicant. 

  

Fixed Criteria 

 Date Range 

 Application forms to report on 

  

Variations 

 Detailed 

 Summary 

 

 

  



GIFTS Online 5.1 User’s Guide 

216 
 

Submitted Applications 

These reports include applications that have been completed and submitted by the applicant. 

Fixed Criteria 

 Date Range 

 Application forms to report on 

Variations 

 Detailed 

 Summary 
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Submitted Requirements 

These reports include requirements that have been filled out and submitted by the applicant. 

Fixed Criteria 

 Date Range 

 Application forms to report on 

  

Variations 

 Detailed 

 Summary 
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About Contact Reports 

This chapter describes the standard Contact reports included with GIFTS Online. 

Contact Labels 5160 

Mailing Labels addressed to the contact at their Primary Organization formatted for Avery #5160 
labels. 

Variations 

A version of this report groups by Zip Code. 

 

Contact Labels 5162 

Mailing Labels addressed to the contact at their Primary Organization formatted for Avery #5162 
labels. 

Variations 

A version of this report groups by Zip Code. 
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Contact Phone Book Report 

A simple listing of Contacts by last name, with telephone, fax and e-mail information for each 
Contact. 
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Contacts - Alpha List 

An alphabetical list of Contacts by name, including full address information. 
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Duplicate Contacts 

A report that shows Contacts with the same last name, to help identify duplicates for data 
cleanup 

Variations: 

 by Last Name 

 by Zip Code 

Fixed Criteria: 

Contacts with the same last name. 
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About Organization Reports 

This chapter describes the standard Organization reports included with GIFTS Online. 

Alpha List of Grantee Organizations 

An alphabetical listing of Organizations that are associated with grants (Approved Requests). 
The report includes the total amount granted by the Organization and the grant year span. 

Fixed Criteria: 

Organizations that have Approved Requests. 
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Alpha List of Organizations 

An alphabetical listing of Organizations that are associated with Requests of any Disposition. The 
report includes the total amount granted by the Organization and the grant year span. 
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Duplicate Organizations (by Name) 

This diagnostic report identifies Organizations with the exact same name, and should be run 
without any selection criteria so that all duplicates will be listed. 
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Organization Labels 5160 

This report prints mailing labels for Avery’s #5160 label template to the Primary Contact of each 
Organization at the Organization’s mailing address. Two versions of this report are available: one 
sorts the labels by the author’s last name and the other by the Organization’s postal code. 

 

  

Organization Labels 5162 

This report prints mailing labels for Avery’s #5162 label template to the Primary Contact of each 
Organization at the Organization’s mailing address.Two versions of this report are available: one 
sorts the labels by the author’s last name and the other by the Organization’s postal code. 
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Organization Profile Report 

The Organization Profile (with Graph) report generates a summary sheet for each Organization 
that includes the Organization’s address, background and both detailed and summary 
information about its funding history 

Variations: 

 with Graph 
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Simple Organization Listing 

A list of all Organizations in GIFTS Online. This report includes the Organization Name, Primary 
Contact, address, and tax status information. No Request information is included. 
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Top 20 Organizations by Total Grant Amount 

A list of Organizations in GIFTS Online with the 20 highest cumulative Grant Amounts. As with all 
reports, keep in mind that your search criteria also determine which Organizations—and which 
grants—are included in the report. 
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Top 20 Organizations by Total Number of Grants 

A list of Organizations in GIFTS Online with the 20 highest number of Approved Requests. As 
with all reports, keep in mind that your selection criteria also determine which Organizations—
and which grants—are included in the report. 
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About Payment / Financial Reports 

This chapter describes the standard Payments and Financial reports included with GIFTS Online. 

  

Cash Flow Analysis 

A listing of Payments due for each Request that has Payments due, including the Organization 
name, total amount granted, and the remaining balance at the end of six months. 

Variations: 

 by Program Area 

Fixed Criteria: 

Payments for Requests that have any outstanding Payments. 
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Check Request Report by Fund 

A list of Scheduled Payments, including the legal name and address of the payee Organization, 
for the purpose of providing information for cutting checks. Grouped by Payment Fund. If no 
legal name is on file for the payee, its Organization Name is shown. 

Fixed Criteria: 

Payments with a Status of Scheduled. 
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Contingent Payments 

A listing of Payments with a Status of Contingent, grouped by the Staff person assigned to the 
contingency or the contingency date. The type of contingency, due date, and notes are included. 

Variations: 

 by Date 

 by Staff 

Fixed Criteria: 

Payments with a Status of Contingent. 
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Current Year Paid and Future Commitments 

Comprehensive report including the Organization’s legal name, the total amount paid on the 
grant to date, future commitments by year for the next three years, and the remaining balance. 
If no legal name is on file for an Organization, it’s Organization Name is shown. 

Variations:  

 by Program Area 

Fixed Criteria: 

Approved Requests with a balance or a Payment Paid within the current Fiscal Year. 
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Deferred Payments 

A listing of Payments with a Status of Hold, including the payee Organization, Grant Amount, 
Request ID and/or Reference Number, Payment Amount, and any notes for the Payment. 

Fixed Criteria: 

Payments with a Status of Hold. 
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Five Year Payment History Report 

A summary report per Organization, showing the total amount paid to that Organization in each 
of the last five years, including the current year. 

Variations: 

 by Program Area 

Fixed Criteria: 

Payments with a Status of Paid, Refund, or Void. 
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Grant Amendment Report 

Provides detailed information on all of the amendments for each grant, and includes both the 
Original Grant Amount and the Current Grant Amount. 

Fixed Criteria: 

Grants that have been amended. 
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Grant Commitment Schedule 

A summary of Payment information by Request, for those Requests with any outstanding 
Payments. Information shown includes the grant amount, the amount paid in the current year 
and prior years, Payments scheduled in the next three years, and any remaining balance. 

Fixed Criteria: 

Requests with an unpaid balance. 
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Grant Commitments Schedule (6 Years) 

Shows Payments scheduled for the next six years, including the total of any Payments remaining 
after that time. 

Variations:  

by Program Area 

Fixed Criteria: 

Requests with an unpaid balance. 
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Grant Confirmation by Staff 

A list of Payments with a Status of Scheduled, Contingent or Hold, grouped by staff member, 
and including information on any requirements due for the current year, on the specific 
Payment or the grant in general. 

Fixed Criteria: 

Payments with a Status of Scheduled, Contingent or Hold, and Requirements with a Scheduled 
Date in the current year. 
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Grant Payment Summary 

A comprehensive summary of Payment information for Approved Requests, including the total 
number of Payments, the amount granted, the amount scheduled (including held and 
contingent Payments), the amount paid, and any unscheduled balance. It also includes the next 
Payment’s Schedule Date and the amount of the next Payment due. 

Variations: 

 by Payee 

NOTE: The “by Payee” variation of this report lists grants by the payee Organization instead of 
the grantee. Grants with Payments to more than one payee are listed more than once (once per 
each payee), so the Grant Amount and Balance Amount totals are not included. 

Fixed Criteria: 

Scheduled, Contingent and Hold Payments for Approved Requests. 
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Grant Planning Worksheet 

For year-end planning, this report displays in worksheet format the giving for the current year, 
any commitments for the next year and a space to write in the proposed amount for next year, 
per organization. 

Variations:  

 by Grant Fund 

 by Program Area 

Fixed Criteria: 

Organizations with Requests Approved in the current year, Payments Paid in the current year or 
Payments Scheduled for the coming year. 
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In-Kind Payments Made 

A report of paid payments including fields specific to in-kind payments: fair market value, tax 
value, book value and in-kind notes. Note that the report does not automatically exclude 
Payments without in-kind giving information. You can use search criteria, such as the Payment 
Type or Support Type, to restrict the report to your in-kind Payments. 

Variations: 

 by Payment Fund Donor 

 by Program Area 

Fixed Criteria: 

Payments with a Status of Paid or Void. 
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Payment Reconciliation Report 

Lists Payments by Status and then by Check Number. Includes the payee’s legal name, the Grant 
Amount, Payment Fund, Payment Type, and Paid Date. If no legal name is on file for the payee, 
it’s Organization Name is shown. 

Fixed Criteria: 

Payments with a Status of Paid, Refund, or Void 
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Payment Status Summary 

A summary of all Payments entered in GIFTS Online, totaled by their respective Payment Status. 
Includes columns for the total amount scheduled, and then breaks this out by Paid, Refund, 
Canceled, Voided, Scheduled, Hold and Contingent Payments. 

Variations: 

 by Fiscal Year 

 by Payment Fund 

 by Program Area 1 
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Payments Due Schedule 

A listing of outstanding Payments, including the Grant Amount, Project Description, Reference 
Number, Schedule Date, Payment Amount, and the Payment Fund. If the Payment Status is 
Contingent or Hold, a separate column displays this information along with any Payment notes. 

Variations: 

 by Grantee Organization 

 by Month 

 by Payment Fund 

 by Payment Support Type 

 by Program Area 1 

 by Program Area 1 and 2 

Two versions of this report include Payment local/other currency amounts, for those engaged in 
international grant-giving: 

 Payments Due Schedule, including Other Currencies 

 Payments Due Schedule - by Country, including Other Currencies 

Fixed Criteria: 

Payments with a Status of Scheduled, Hold, or Contingent. (Includes Payments for Approved 
Requests only.) 
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Payments Made 

A listing of Payments that have been marked as Paid; includes the Payment Date and Check 
Number, if available. 

Variations: 

 by Month  

 by Grantee Organization  

 by Payment Fund 

 by Payment Support Type 

 by Program Area 1  

 by Program Area 1 and 2 

 by State  

Two versions of this report include Payment local/other currency amounts, for those engaged in 
international grant-giving: 

 Payments Made, including Other Currencies 

 Payments Made - by Country, including Other Currencies 

Fixed Criteria: 

Payments with a Status of Paid, Refund, or Void. 
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Payments Made - Charitable vs. Non Charitable Deductions 

If your organization tracks “quid pro quo” information for Payments, this report lists the 
deductible and non-deductible amounts entered for each Payment. Also includes the Check 
Number and Payment Date. 

Fixed Criteria: 

Payments with a Status of Paid or Void. 
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Payments Made - OBRA 

This report shows whether or not a receipt is required on each Payment, and the Schedule Date 
and Done Date of the receipt. The full name and address of the payee Contact is included for 
easy follow-up. The report also includes the deductible and non-deductible amount for each 
Payment and the Organization’s tax status. 

Fixed Criteria: 

Payments with a Status of Paid or Void, and “Receipt Required” Activities associated with these 
Payments. 
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Schedule of Appropriations and Payments 

This version of the Schedule of Appropriations and Payments report is also sometimes called the 
IRS 990 report. The previous version of the report is still available. 

This current version of the Schedule of Appropriations and Payments report offers the following 
improvements and changes: 

 The report runs much faster now. 

Previously, clients with large databases often found that the Schedule of Appropriations 
and Payments report could take several hours to run. This newer report significantly 
reduces report run time. 

 Calculation methods have been changed to provide more accurate reporting. 

If you are going to be running or reading the new Schedule of Appropriations and 
Payments report, you need to understand the calculations that went into the data within 
it. For details, please see “About the Report Data” below. 

 The report uses a new report control, ActiveReports. 

Other standard reports are generated using Crystal Reports. This new report uses a new 
reporting control, ActiveReports from Data Dynamics, Ltd. This reporting tool is also used 
for ad hoc reporting. 

About the Report Data 

In order to understand the data found in the new Schedule of Appropriations and Payments 
report, you should understand the calculations used in each column of the report: 

Column Contents 

Recipient 
and/or 
Purpose 

This column draws from a number of GIFTS Online fields to provide data about the 
grantee Organization and the Request for which Payments were made: 

 First is the Legal Name of the grantee Organization. (If the Legal Name is 
blank, the Organization Name is used.) This is followed by the grantee 
Organization’s Address, City, State, Zip code, and Country. 

 Information about the grant follows: the approved Request’s Project Title, 
Grant Amount, and Fiscal Year. 

Tax Status The Tax Status of the grantee Organization. 

Beginning 
Balance 

This column shows the unpaid balance of the approved Request at the beginning of 
the “current” fiscal year (based on the “as of” date). It is calculated as follows: 

 If the Request was approved during the current fiscal year, the beginning 
balance is zero ($0.00). (The grant amount will be included in the next 
column, Newly Allocated.) 

 If the Request was approved before the “current” fiscal year, the beginning 
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balance is the original grant amount plus the amount of any grant 
amendments made before the current fiscal year minus the total amount of 
any Payments made before the current fiscal year. 

(The total amount of any grant amendments made during the current fiscal year 
will be included in the Amended column (see below).) 

Newly 
Allocated 

If the Request was approved during the current fiscal year, the original grant 
amount is shown here. Otherwise, the Newly Allocated amount is zero ($0.00). 

Amended The sum of the amounts of all grant amendments made during the current fiscal 
year. 

If the Request had no grant amendments made during the current fiscal year, the 
Amended amount is zero ($0.00). 

Amount 
Paid 

The sum of the amounts of all paid, refunded, and voided Payments that meet the 
following criteria: 

 The Fiscal Year of the Payment is the current fiscal year. 

 The Payment Date falls before the report’s “as of” date. 

Ending 
Balance 

The Beginning Balance plus the Newly Allocated amount plus the Amended column 
amount minus the Amount Paid. 

Population 
Served 

The Population Served indicated in the Request Coding Sheet. If no Population 
Served code is included, the column is blank. 

NOTE: This column appears only if you run the Schedule of Appropriations and 
Payments Showing Population Served version of the report. 

 

Running the Report 

When you run this report, setting the “as of” date is key to reporting data correctly. When you 
set “as of” date to a date other than the current date, your report is affected in the following 
ways: 

 When the report selects information relevant in the “current year,” the current year is 
based on the “as of” date, not the current date. 

 To be included in the report, the Request must have been approved on or before the “as 
of” date during the “current” fiscal year. 

 For the report to consider a Payment paid (rather than scheduled), the Payment Date 
must be on or before the “as of” date. 

 Report calculations that consider void and refunded Payments exclude these voids and 
refunds if their Payment Dates are after the “as of” date. 
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This report has been designed to recreate your data based on the “as of” date, but some data—
once it is altered in GIFTS Online—cannot be restored to its past condition; therefore, the results 
of reports run with the “as of” date may not completely represent a version of the financial data 
as of that date. The following data cannot be accurately recovered based on “as of” date. 

 Payments that have been deleted are not reflected. 

 Payments for which the amount changed between the “as of” date and the current date 
report the current amount, not the previous amount. 

Which Grants Are Included in the Report? 

Only Requests that were approved on or before the “as of” are included in the report. In 
addition, those Requests are included only if they also meet at least one of the following criteria: 

 The approval date (i.e., the Disposition Date of the approved Request) falls within the 
current year. (Note that the “current year” is the fiscal year within which the “as of” date 
falls.) 

 The Request was amended in the current year. (That is, it is associated with at least one 
Grant Amendment Activity with a Done Date within the current year.) 

 The Request has at least one Payment within the current year. (That is, the Request has 
at least one Payment with a status other than Canceled with a Budget Fiscal Year within 
the current year.) 

 The Request still had some unpaid balance at the beginning of the current fiscal year. 

As noted in the report instructions, you can further refine these criteria by selecting or creating 
a Payments search before running the report. 

The cumulative effect of these criteria is to find only those approved Requests (grants) that saw 
decreases (i.e., payments) or increases (i.e., original grants and/or grant amendments) in their 
balances during a given fiscal year. The report then calculates the amounts of these payments 
and appropriations. 

To view your report after you have specified the necessary options, choose File ‰ Run Report 
from the Report Library menu. The report is generated and displayed in the Active Report 
Viewer: 

Variations: 

 Population Served 

 Program Area 1 

The new Schedule of Appropriations and Payments report, uses ActiveReports from Data 
Dynamics, not Crystal Reports, to render your results. The navigation options in ActiveReports 
are a little different. 
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Schedule of Appropriations and Payments (OLD) 

You can use the Schedule of Appropriations and Payments reports to generate your IRS 990 
reports. These reports show your commitments at the beginning of the year, the amount 
appropriated during the course of the year, the amount paid during the year, and your 
outstanding commitments at the end of the year. 

About the Report Data 

The report includes the following information for grants within a given year. 

Column Description 

Recipient The legal name and address of the recipient Organization, the Project Title 
of the grant, the total Grant Amount, and the grant’s Fiscal Year. (In GIFTS 
Online, a grant’s Fiscal Year is based on the date on which it was 
Approved.) If no legal name is on file for the Organization, it’s 
Organization Name is shown. 

Tax Status The tax status of the recipient, as indicated on the Tax Status tab of its 
Organization record. 

Beginning 
Balance 

The amount that you have committed to pay for the grant as of the 
beginning of the year. For grants made in previous years, this is the 
remaining balance. For grants made during the current year, this amount 
is always zero. 

Newly 
Allocated 

The amount appropriated to the grant during the current year. If the grant 
was approved in the current year, this value is the total grant amount. 

Amended If the grant was amended during the current year, this value reflects the 
amount of the amendment. 

Amount Paid The amount paid during the current year. Note that this amount is 
calculated based on the Fiscal Year specified in the grant’s payments, not 
on the Scheduled Date or Paid Date of the Payments. 

NOTE: If you “pre-pay” grants when you have extra funds in your budget 
at the end of a year, be careful to ensure that the Fiscal Year indicated in 
the Payment record properly reflects the year in which you wish to report 
it to the IRS. 

If you pay a Payment that was scheduled for February 2012 in December 
2011 because you have available funds, this report reflects the Fiscal Year 
assigned to the Payment, not the Paid Date. 

  

Ending Balance The remaining commitments for this grant, including Payments scheduled 
in future years and Payments scheduled for the current year that have not 
been paid. 
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Running the Report 

When you run this report, you should set the ‘as of’ date of the report to the end of the year on 
which you wish to report. If you want, for example, to generate a report for your 2010 IRS 
reporting, set the ‘as of’ date to December 31, 2010. Thus, the report generates data for 2010—
even if you are running the report while you prepare your taxes in April 2011. 

You should always set the ‘as of’ date to December 31 of the year on which you want to report. 
The ‘as of’ date ensures that the report reflects only what you have done up to that date. With 
an ‘as of’ date of 12/31/10, Payments that your organization paid in 2011 would be shown as 
outstanding in the report because they were outstanding as of 12/31/10. 

Which Grants are Included in the Report? 

The report includes grants that have an open balance or for which appropriations were made 
during the year. Specifically, the report includes: 

 Grants that are approved or amended within the year. 

 Grants with Payments that have been scheduled or paid within the year. (Reminder: the 
reported date of the Payment is based on the Payment’s Fiscal Year, not its Paid Date.) 

 Grants with a balance as of the beginning or end of the year. Only grants with Scheduled 
Payments are included. 

NOTE: The report uses Payment data to make its calculations. If a grant does not have any 
Payments, it is not included in the report—even if it has an open balance within the year. 

Note that future grants are not included. If you run the report ‘as of’ December 31, 2000, grants 
approved in 2001 or later are not included 

Variations: 

 by Population Served 

 by Program Area 

Fixed Criteria: 

Requests that have an unpaid balance or for which appropriations were made during the year. 
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Summary of Paid Payments 

A summary of Payments that have been marked as Paid, including number of items and 
percentages. 

Variations: 

 by Geographical Area 1 

 by Payment Fund 

 by Payment Type 

 by Payment Support Type 

 by Program Area 1 

 by Staff 

Fixed Criteria: 

Payments with a Status of Paid, Refund, or Void. 
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Top 20 Payments by Payment Amount 

The largest 20 Payments in the search criteria provided, in descending order by Payment 
Amount. 

Fixed Criteria: 

Payments for Approved Requests. 
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About Request Reports 

This chapter describes the standard Request reports included with GIFTS Online. 

  

Board Meeting Agenda 

You can use this report to generate an agenda for a Board meeting. For each Request, the report 
includes the Organization Name, Long Project Description, Requested Amount, and 
Recommended Amount. 

To limit the contents of this report to the agenda for your meeting, you can use the Meeting 
Date or other date fields as your search criteria. 

Variations: 

 by Docket Number 

 by Program Area 
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Board Meeting Minutes 

You can use this report to review minutes from a Board meeting. For each Request, the report 
includes the Organization Name, Project Title, Recommended Amount, the amount awarded, 
and Meeting Minutes. 

To limit the contents of this report to the agenda for your meeting, you can use the Meeting 
Date or other date fields as the search criteria. 

Variations: 

 by Docket Number 

 by Program Area 1 
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Contact Affiliations by Request 

A list of Requests, grouped by Organization, that shows the affiliated Contacts for each Request. 
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Data Entry Report 

This report displays basic information about each, and is intended to help you review and verify 
the accuracy of your data entry. 

Variations: 

 by Organization 

 by Date 
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Declinations - Alpha List 

A detailed listing of Declined Requests that includes the applicant name, Project Title, Primary 
Contact, the Declination Reason, and the staff person assigned to the Request. 

Variations: 

 by Fund 

 by Geographical Area 1 

 by Grant Type 

 by Internal Program 

 by Program Area 1 

 by Staff 

Fixed Criteria: 

Requests with a Disposition of Declined. 
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Declinations - Alpha List (including Request Amount) 

A detailed listing of Declined Requests that includes the applicant name, Project Title, Primary 
Contact, the Declination Reason, Request Amount, and the staff person assigned to the Request. 

Variations: 

 by Fund 

 by Program Area 1 

Fixed Criteria: 

Requests with a Disposition of Declined. 
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Declinations - Summary by Reason 

A summary of declinations grouped by their Declination Reason. For each reason, the report lists 
the number of declinations, the percent of the total declination count, as well as the total and 
percentage of the requested amounts. 

Fixed Criteria: 

Requests with a Disposition of Declined. 

 

  

Foundation Center Export Report 

You can use this report to export your grants information to an electronic file for submission to 
the Foundation Center. 

NOTE: An updated version of this export known as hGrant Reporting can be enabled by 
contacting MicroEdge Services. services@microedge.com. For more information, please refer to 
the hGrant Reporting section. 

  

What Data is Exported to the Foundation Center? 
This report is formatted according to the center's requirements, and includes the following 
information about each grant (Approved Request) included in the report. For each grant, the 
following information is exported about the grantee Organization: 

Organization Name Organization A.K.A. Name 

Organization Mailing Address   

(Note: This includes Street Address, City, 
State, and Postal Code. Country is included 

Organization telephone number 
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if Organization is located outside of the 
U.S.) 

Organization Type Organization Tax ID 

Organization WWW Address   

The following information is exported about each grant: 

Request Project Title Request ID 

Grant Fiscal Year Grant Amount 

Grant Term (in months) Whether or not the grant is renewable 

The Department or Division of the grantee 
Organization to which the grant was made 
(as indicated in the Subdivision field of the 
grant's Request record). 

Payee Organizations 

In addition, the export includes all levels from each of the following classifications on the 
Request's Coding Sheet: 

Program Area Population Served 

Geographic Area Served Type of Support 

Gender Age 

Ethnicity   

To Run the Foundation Center Export Report 

To create an export file for the Foundation Center: 

1. Go to Launch > Reports. 
2. Click on Requests. 
3. Choose the Foundation Center Export Report. 
4. If necessary, specify the grants you wish to include in the export using the New Search or 

Select Search buttons. 
5. Click the Run selected report icon. The report is generated and displayed using the Crystal 

Reports viewer. Please note that since this file is intended for export, it is not formatted 
for printing. 

6. When the report has finished processing, click the Export Report button on the Crystal 
Reports viewer toolbar located at the top of the report. You are prompted to choose a file 
format and destination for the export. 

7. Choose ‘Tab Separated Text (TTX)’ as the format, and ‘Disk file’ as the destination. Click 
OK. You are prompted to provide the file name and location for the export file. 

8. Enter the file name and location, and click Save. The export file is saved, and you can 
transmit it to the Foundation Center. 
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Grant Profile Report 

A profile of a grant that includes coding, payment, grant amendment, and requirements 
information. 

Fixed Criteria: 

Requests with a Disposition of Approved. 
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Grant Summary 

A summary of Approved Requests showing the total amount granted for each item. 

Variations: 

 by Fund 

 by Geographical Area 

 by Grant Type 

 by Population Served 

 by Program Area 1 

 by Program Areas 1 and 2 

 by Program Areas 1, 2, and 3 

 by Staff 

 by Support Type 

Fixed Criteria: 

Requests with a Disposition of Approved. 
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Grant Summary - Granted and Paid by Program Area 

For each Program Area, this report shows the total amount granted and the amount of 
Payments made for that Program Area. The Payment data included in this report is based upon 
the Requests that meet the search criteria that you use when running the report. 

Fixed Criteria: 

Requests with a Disposition of Approved. 

 

  

Grants - Alpha List 

An alphabetical listing (by grantee Organization name) of grants, including their reference 
numbers, project description, grant amount, amount paid to-date, and grant date. 

Variations:  

 by Fiscal Year 

 by Fund 

 by Geographical Area 1 

 by Geographical Areas 1 to 5 

 by Grant Type 

 by Internal Program 

 by Population Served 

 by Primary Contact 

 by Program Area 1 

 by Program Area 1 & 2 
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 by Program Area 1, 2, & 3 

 by Program Areas 1 to 5 

 by Staff 

 by Support Type 

Fixed Criteria: 

Requests with a Disposition of Approved. 
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Grants - Alpha List (Portrait) 

An alphabetical listing (by grantee Organization name) of grants, including their reference 
numbers, project description, grant amount, amount paid to-date, and grant date. 

Fixed Criteria: 

Requests with a Disposition of Approved. 
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Grants - Alpha List including Secondary Codes 

The “Program Area Served with Secondary Codes” and “Geographical Area Served with 
Secondary Codes” variations of the “Grants - Alpha List” report include both primary and 
secondary coding for all levels of the Program Area or Geographical Area Served table. 

A grant may be listed in the report several times—once for each code. Note that since reports 
may be listed more than once, the totals in this report may not reflect the actual amount 
granted. 

Variations:  

 by Geographical Area Served 

 by Program Area Served 

Fixed Criteria: 

Requests with a Disposition of Approved and which have classifications in the tables on which 
the report groups. 
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Grants - Chronological List 

A chronological listing of grants, including their reference numbers, Project Description, Grant 
Amount, amount paid to-date, and grant date. 

Variations: 

 by Fund 

 by Geographical Area 1 

 by Grant Type 

 by Program Area 1 

 by Program Area 1 & 2 

 by Program Area 1, 2, & 3 

 by Staff  

 by Support Type 

Fixed Criteria: 

Requests with a Disposition of Approved. 

 

  



GIFTS Online 5.1 User’s Guide 

274 
 

Grants - Detail List by Staff 

Provides a detailed listing of grants by staff member. 

Fixed Criteria: 

Requests with a Disposition of Approved. 
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Incomplete Proposals 

A list of Pending Requests that have been marked as ‘incomplete.’ Includes the grantee 
Organization Name, Project Description, Request Date, Staff member, Requested Amount, 
Status, and any notes regarding the reason that the Request has been marked as incomplete. 

Variations: 

 by Date 

Fixed Criteria: 

Requests with a Disposition of Pending that are also marked as ‘incomplete’ on their Request 
record. 
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Proposals - Alpha List 

A listing of Pending Requests that includes the Project Title, Request Amount, Recommended 
Amount, Staff member, Request Type, and Request Status for each proposal. 

Variations:   

 by Fund 

 by Geographical Area 1 

 by Grant Request Type 

 by Internal Program 

 by Program Area 1 

 by Program Area 1 & 2 

 by Primary Contact 

 by Staff 

 by Status 

Fixed Criteria: 

Requests with a Disposition of Pending. 
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Proposals - Alpha List (Portrait) 

An alphabetical listing (by grantee Organization name) of Pending Requests that includes the 
Project Title, Request Amount, Recommended Amount, Staff member, Request Type, and 
Request Status for each proposal. 

Fixed Criteria: 

Requests with a Disposition of Pending. 
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Proposals - Complete/Incomplete 

An alphabetical listing (by grantee Organization name) of Pending Requests that includes the 
Project Title, Requested Amount, Request Date, Staff member, and an indication of whether the 
Request is complete, including any relevant notes. 

Fixed Criteria: 

Requests with a Disposition of Pending. 
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Recommendations by Organization 

By Organization, this report shows the total amount granted in the previous year and the total 
recommended amount for the current year. It also includes the Long Project Description of the 
latest Request. 

Fixed Criteria: 

This report includes Organizations that have at least one Pending Request in the current 
calendar year. 
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Renewable Grants 

A listing of renewable grants, by each grant’s renewal date, that includes the renewal date (the 
date on which the grant is eligible for renewal), grantee Organization, Project Description, 
Request ID or Reference Number, Grant Amount, Type, Status, and Grant Date. 

Fixed Criteria: 

This report includes Approved Requests that have been flagged as renewable. 

 

  



GIFTS Online 5.1 User’s Guide 

281 
 

Repeat Grants 

An alphabetical listing of Organizations that have received grants both the current and the 
previous calendar year. Includes the Organization name and the total granted and paid figures 
for the previous and current calendar year. 

Fixed Criteria: 

This report includes Organizations that received grants in both the previous and current 
calendar years. 
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Request History by Organization 

The Request History by Organization report is similar to the Organization Profile report. It’s the 
same except for one key difference: The Request History by Organization report is sensitive to 
Request criteria. For example, the report below was limited to matching and volunteer gifts. 
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Request Labels - All Affiliated Contacts 

This series of reports prints mailing labels to all affiliated Contacts for each Request included in 
the report. The Organization’s mailing address is used. 

Variations 

Versions of this report sort the labels either by the Contact’s last name or the Postal Code in the 
address, and print labels for the following Avery templates: 

 5160 

 5162 
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Request Labels - Primary Contact 

This series of reports prints mailing labels to the Primary Contact of each Request included in 
the report. The Organization’s mailing address is used. 

Variations 

Versions of this report sort the labels either by the Contact’s last name or the Postal Code in the 
address, and print labels for the following Avery templates: 

 5160 

 5162 
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Request Statistics 

This report includes the following statistics for the Requests included in the report: total, 
minimum, maximum, and average Grant Amount; the total number of Approved, Declined, and 
Pending Requests; and the percentage of Requests that are Approved, Declined, and Pending. 
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Requests by Sponsor 

A list of Requests, grouped by the Contact identified as the “Sponsor” of each Request. Includes 
the Disposition, Grant Amount, and Paid Amount of each Request. 

Fixed Criteria: 

Requests that have an affiliated Contact with the Role of “Sponsor.” 
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Status of Requests Received 

A comprehensive list of Requests grouped by the Staff member to which they are assigned. 

Variations: 

 by Staff 

 by Staff including Sponsor 
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Summary of Requests by Type, Disposition, and Status 

A summary of Requests grouped by their Request Type, Disposition, and Request Status, 
including subtotals of the Requested Amount and Grant Amount for each group. 
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Tax Status Verification 

Shows tax status information for charitable Organizations that are associated with Requests. If 
no tax status is on file, “Tax status not on file!” is shown in the Tax Status and Date column of 
the report. 

Fixed Criteria: 

Organizations that are flagged as Charitable and associated with Requests. 
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Top 20 Grants by Grant Amount 

Lists the top 20 grants, according to their Grant Amount, in descending Grant Amount value. As 
with all reports, keep in mind that your search criteria also determine which grants are included 
in this report. 
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About Requirements Reports 

This chapter describes the standard Requirement reports included with GIFTS Online. 

  

Pending Proposal Checklist 

A report listing the Requirements due on Pending Requests. The Project Title, Request Date and 
the Meeting Date are included for each Request. 

Fixed Criteria 

Requirements associated with Requests with a Disposition of Pending. 
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Requirements Completed 

Produces a list of completed Requirements. 

  

Variations: 

 by Date 

 by Organization 

 by Program Area 

 by Staff 

  

Fixed Criteria: 

Requirements with a status of Done. 
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Requirements Due 

A chronological list of Requirements with a Status of Scheduled. 

Variations: 

 by Date 

 by Organization 

 by Program Area 

 by Staff 

Fixed Criteria: 

Requirements with a status of Scheduled. 

 

  

Requirements Received by Date 

A chronological list of Requirements that have been marked as received from the grantee, but 
have not yet been marked as done. 

Fixed Criteria: 

Requirements with a status of Received. 
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About hGrant Reporting 

The optional hGrant reporting tool allows GIFTS Online customers the ability to participate in 
the Foundation Center’s Grantsfire project. 

  

What is hGrant? 

hGrant was developed as part of the Grantsfire project to help foundations: 

• Publish their grants information to the Web so it is easier for nonprofits to find grant 
information 

• Access timely information about what projects and areas of focus are being funded in the 
nonprofit sector, and 

• Create an online vehicle that will enable them to be more transparent about their grant 
making 

Publishing using hGrant allows third-party software to read grants information and aggregate it 
on a central database.  

Grant feeds published by any foundation using the Foundation Center’s hGrant Reporting 
program are available to the public, for free, at www.glasspockets.org, the Center’s online portal 
that champions transparency in the philanthropic sector. 

To find out more about the Foundation Center’s Grantsfire project and consider joining go to: 
http://foundationcenter.org/grantmakers/hgrant.html. 

For more information, contact hgrant@foundationcenter.org. 

  

Enabling the hGrant Feature 

To enable the hGrant feature, you must email a request to MicroEdge at 
services@microedge.com. 

  

Configuring Classification Codes 

For compatibility with Foundation Center’s hGrant format, your geographical code levels must 
be arranged in a specific way as shown below. If your levels are not currently set up this way 
they can be changed using the Admin > Classifications tool. 

NOTE: Country is taken from the Organization Country on the Request. 

 

Geographical Area Served 

Level Description Name Example 

1 Intra Country Region Northeast US, Northern Canada etc. 

2 State or Province New York 

3 County Kings County 

http://www.glasspockets.org/
http://foundationcenter.org/grantmakers/hgrant.html
mailto:hgrant@foundationcenter.org
mailto:services@microedge.com?subject=GIFTS%20Online:%20Enabling%20hGrant%20Request
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4 City Brooklyn 

5 Neighborhood Park Slope 

 

hGrant Report Requirements 

The following conditions are required to run the hGrant Report: 

• The hGrant Report XML can only be generated for Approved grants. 

• There are required fields specified by hGrant. 

o City and State in both the grantor organization and grantee organization 

o Project Description in the Request 

o Grant Amount in the Request 

  

Running the hGrant Report 

Accessing the hGrant Report 

NOTE: If this feature is enabled, the menu option will only be visible to Grant Managers and 
Administrators. 

This new functionality will be access through the Actions menu with a new option named hGrant 
Reporting on Request search result pages and Related Requests lists. 

 

When you select one or more Requests in the search results and then select Actions > hGrant 
Report, the following form opens: 
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Field Name Description 

File Name [Required] This file will contain the hGrant data and will be uploaded to 
the hGrant site.  

Click the Browse button to open a Windows browse form in order to 
specify: 

• The location you wish to save the XML file 

• The name of the new XML file 

NOTE: The location of the file must be on your local workstation or 
network. These files cannot be stored on the GIFTS Online servers. 

The system will create an XML file with the name and location indicated. If 
a file with the same name is found in that location, you are prompted to 
confirm overwrite or cancel. 

The generated XML file can then be uploaded to Foundation Center to 
make the information public. 

Grantor Organization 
Card 

A grantor organization must be defined for inclusion in the vCard* block of 
the XML file. 

For this reason, you should create an Organization record for your 
organization. If multiple entities are involved, multiple Organization 
records should be created so the options will be available when the hGrant 
Report is run. 

Clicking the magnifying glass lookup icon will open an hGrant Organization 
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search form allowing you to find other organizations in your database to 
assign as the Grantor. 

NOTE: *vCard is a file format standard for electronic business cards. vCards are often 
attached to e-mail messages, but can be exchanged in other ways, such as on the World 
Wide Web or instant messaging. They can contain name and address information, phone 
numbers, e-mail addresses, URLs, logos, photographs, and audio clips. 

Number of Requests 
and Total Amount 

Below the File Name will be displayed the number of Requests selected 
and the total grants amount. 

Process Monitor The process monitor area serves to list any ‘pre-processing’ warnings or 
errors. After creating the XML file, this area will list all successful exports 
with the Request ID and the status of Exported. 

Create Click this button to create the XML file containing the selected Request 
data. 

This button will be disabled if: 

No File Name is entered 

The Grantor Organization is not set 

The Process Monitor shows errors that must be addressed 

Cancel Closes the hGrant Reporting form without creating the XML file. 

 

Successful XML Creation 

Once a File Name is entered and a Grantor Organization is set, if there are now errors listed, you 
can click Create to generate the XML hGrant file. 

The Process Monitor will look similar to the sample below: 

 

  

Activity History 

For every hGrant Reporting export, one activity record will be created. 
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Note that Organization, Contact, Request, and Payment will be blank because this activity record 
represents the entire batch. 

If a particular request is re-exported, the Export_ID will be replaced with the new Activity.ID. For 
that request, the Export_ID will only reference the latest export. Reference to the old Activity.ID 
is lost. 

  

Setting Up News and Social Media Feeds for hGrant 

If your organization has established News and Social Media sites or an RSS feed available for 
sending out updates and alerts to subscribers, they can be entered in www.glasspockets.org 
when you set up your foundation profile. 

 

Potential applicants or other people involved in charity can then subscribe by accessing the 
Foundation Transparency 2.0 list and clicking on your appropriate link. 

 

NOTE: MicroEdge does not provide support for the updating of your social media pages, RSS 
feeds, or similar features. Please contact your internal IT department or glasspockets.org 

  

http://www.glasspockets.org/
http://www.glasspockets.org/inside/whgp/submit_form.html
http://maps.foundationcenter.org/glasspockets/transparency.php
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About Batch Updates 

In GIFTS Online, batch update processes are available from both the Search Results page and 
from the Related List grid. 

This allows you to check/select multiple records on the list and perform the same action on 
them. 

There are several actions currently available in GIFTS Online: 

Record Type Action 

Organization Update Coding Sheet 

Contact Update Coding Sheet 

Request Update Coding Sheet 

Request Update Request Type/Status 

Request Update Meeting Date 

Request Update Staff Assignments 

Request Update Project Assignments 

Payments Update Codes 

 

Processing Batches 

In GIFTS Online, a window with a “Processing” bar will display indicating the progress of the 
action. This window includes a Cancel button. If you click Cancel before the process is complete, 
the remaining records will remain unprocessed, the summary will display indicating the counts 
for the records processed so far. 

 

The process monitor displays the type and ID of each record, followed by a message in the log. 
The process monitor will have Print and Save options. 
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Batch Update for Organizations 

From the Organizations search results page the Actions menu allows you to Update Coding 
Sheet. 

 

To perform this action: 

1. Do a Quick Find or Full search for Organizations. 
2. Select more than one organization record from the search results page. 
3. Go to Actions > Update Coding Sheet. (You may need to slide the menu over to see the 

option.) 
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4. Make changes to the Update Organization Coding Sheets form as necessary. (See table 
below for description of options.) 

 

 

Option Description 

Update Mode Required. The user must choose one of the following options. 

 Add a code – this will add the selected code to any other codes 
already specified. When this radio button is selected, the 
associated “Add as primary” option will be enabled (default 
unchecked.) 

 Remove a code – this will remove the value from the Coding 
Sheet. When this radio button is selected, the associated 
“Remove all subcodes” option will be enabled (default 
unchecked.) 

 Make an existing code primary – this will take the selected value 
and set the Primary flag to true, while changing the primary flag 
to false for the value that is currently the primary 

 Replace a code – when this option is selected, the user will 
supply both a current code, and another code to replace it with. 
Clicking this radio button also makes visible the Replacement 
Code prompt. 

 Add as primary - adds the selected code value as the primary. 
Only enabled if Add a code is selected. 

 Remove all subcodes - removes all subcodes leaving only the 
primary code value. Only enabled is Remove a code is selected. 
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Category 
Required. The Coding Sheet category to be addressed. Includes all of 
the Categories defined for the record type being updated. 

The value chosen here will determine the options available in the Code 
and Replace Code drop-downs. 

Code Select the desired value(s) in the chosen Category by clicking the Select 
a Code button.  

 If the mode is Add, inactive codes are excluded. Otherwise, inactive 
codes are included, and the descriptions of the inactive codes are 
followed by“ (inactive)”.  

  

5. Click Update to begin processing the update to the Organization records you selected. 
6. You will be prompted with a confirmation message. Click Yes to continue or No to cancel. 

 

7. Once complete, the progress monitor will display the number of Successes, Warnings, 
and Errors along with the ID of each record and a short result message. Click OK to return 
to the search results page. 
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Batch Update for Contacts 

NOTE: A custom code table must be assigned to the Contact edit form before this option can be 
utilized. By default the Contact edit form does not have any table assigned to the Coding 
section. 

From the Contacts search results page or Related List grid the Actions menu allows you to 
Update Coding Sheet. 

 

To perform this action: 

1. Do a Quick Find or Full search for Contacts or display a Related list of Contacts. 
2. Select more than one Contact record from the list. 
3. Go to Actions > Update Coding Sheet. (You may need to slide the menu over to see the 

option.) 
4. Make changes to the Update Contacts Coding Sheets form as necessary. (See table below 

for description of options.) 
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Option Description 

Update Mode Required. The user must choose one of the following options. 

 Add a code – this will add the selected code to any other codes 
already specified. When this radio button is selected, the 
associated “Add as primary” option will be enabled (default 
unchecked.) 

 Remove a code – this will remove the value from the Coding 
Sheet. When this radio button is selected, the associated 
“Remove all subcodes” option will be enabled (default 
unchecked.) 

 Make an existing code primary – this will take the selected value 
and set the Primary flag to true, while changing the primary flag 
to false for the value that is currently the primary 

 Replace a code – when this option is selected, the user will 
supply both a current code, and another code to replace it with. 
Clicking this radio button also makes visible the Replacement 
Code prompt. 

 Add as primary - adds the selected code value as the primary. 
Only enabled if Add a code is selected. 

 Remove all subcodes - removes all subcodes leaving only the 
primary code value. Only enabled is Remove a code is selected. 

Category 
Required. The Coding Sheet category to be addressed. Includes all of 
the Categories defined for the record type being updated. 

The value chosen here will determine the options available in the Code 
and Replace Code drop-downs. 
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Code Select the desired value(s) in the chosen Category by clicking the Select 
a Code button.  

 If the mode is Add, inactive codes are excluded. Otherwise, inactive 
codes are included, and the descriptions of the inactive codes are 
followed by“ (inactive)”.  

  

5. Click Update to begin processing the update to the Contact records you selected. 
6. You will be prompted with a confirmation message. Click Yes to continue or No to cancel. 
7. Once complete, the progress monitor will display the number of Successes, Warnings, 

and Errors along with the ID of each record and a short result message. Click OK to return 
to the search results page. 

  

Batch Updates for Requests 

From the Requests search results page or Related links grid the Actions menu allows for the 
following batch updates: 

 Update Coding Sheet 

 Update Request Type/Status 

 Update Meeting Date 

 Update Staff 

 Update Project Description 

Update Coding Sheet 

To perform a batch Request Coding Sheet Update: 

1. Do a Quick Find or Full search for Requests or display a Related list of Requests. 
2. Select more than one Request record from the list. 
3. Go to Actions > Update Coding Sheet. (You may need to slide the menu over to see the 

option.) 
4. Make changes to the Update Request Coding Sheets form as necessary. (See table below 

for description of options.) 
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Option Description 

Update Mode Required. The user must choose one of the following options. 

 Add a code – this will add the selected code to any other codes 
already specified. When this radio button is selected, the 
associated “Add as primary” option will be enabled (default 
unchecked.) 

 Remove a code – this will remove the value from the Coding 
Sheet. When this radio button is selected, the associated 
“Remove all subcodes” option will be enabled (default 
unchecked.) 

 Make an existing code primary – this will take the selected value 
and set the Primary flag to true, while changing the primary flag 
to false for the value that is currently the primary 

 Replace a code – when this option is selected, the user will supply 
both a current code, and another code to replace it with. Clicking 
this radio button also makes visible the Replacement Code 
prompt. 

 Add as primary - adds the selected code value as the primary. 
Only enabled if Add a code is selected. 

 Remove all subcodes - removes all subcodes leaving only the 
primary code value. Only enabled is Remove a code is selected. 

Category 
Required. The Coding Sheet category to be addressed. Includes all of the 
Categories defined for the record type being updated. 

The value chosen here will determine the options available in the Code 
and Replace Code drop-downs. 
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Code Select the desired value(s) in the chosen Category by clicking the Select 
a Code button.  

 If the mode is Add, inactive codes are excluded. Otherwise, inactive 
codes are included, and the descriptions of the inactive codes are 
followed by“ (inactive)”.  

  

5. Click Update to begin processing the update to the Contact records you selected. 
6. You will be prompted with a confirmation message. Click Yes to continue or No to cancel. 

7. Once complete, the progress monitor will display the number of Successes, Warnings, 
and Errors along with the ID of each record and a short result message. Click OK to return 
to the search results page. 

Update Request Type/Status 

To perform a batch Request Type/Status Update: 

1. Do a Quick Find or Full search for Requests or display a Related list of Requests. 
2. Select more than one Request record from the list. 
3. Go to Actions > Update Type and Status. (You may need to slide the menu over to see 

the option.) 
4. Make changes to the Update Request Type and Status form as necessary. 

NOTE: The Change Type to field is required. 

 
5. Click OK to continue. 
6. You will be prompted with a confirmation message. Click Yes to continue or No to cancel. 
7. Once complete, the progress monitor will display the number of Successes, Warnings, 

and Errors along with the ID of each record and a short result message. Click OK to return 
to the search results page. 
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Update Meeting Date 

To perform a batch Meeting Date Update: 

1. Do a Quick Find or Full search for Requests or display a Related list of Requests. 
2. Select more than one Request record from the list. 
3. Go to Actions > Update Meeting Date. (You may need to slide the menu over to see the 

option.) 
4. Make changes to the Update Request Meeting Date form as necessary. 

Clear - Removes the current meeting date. 
Update to - changes the meeting date to the one selected. 

 
5. Click Update to continue. 
6. You will be prompted with a confirmation message. Click Yes to continue or No to cancel. 
7. Once complete, the progress monitor will display the number of Successes, Warnings, 

and Errors along with the ID of each record and a short result message. Click OK to return 
to the search results page. 

Update Staff Assignment 

To perform a batch Request Staff Assignment Update: 

1. Do a Quick Find or Full search for Requests or display a Related list of Requests. 
2. Select more than one Request record from the list. 
3. Go to Actions > Update Staff Assignment. (You may need to slide the menu over to see 

the option.) 
4. Make changes to the Update Staff Assignments form as necessary. 

Change Staff to - Select a new staff member to assign the records to. 
Update Activities/Requirements: 
Open - select this option to update Open related Activities and Requirements of the staff 
change. You can specify to update records that are Overdue, Due, or Both. 
Closed - Select this option to only update closed Activities and Requirements with the 
new staff change. 
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5. Click Update to continue. 
6. You will be prompted with a confirmation message. Click Yes to continue or No to cancel. 
7. Once complete, the progress monitor will display the number of Successes, Warnings, 

and Errors along with the ID of each record and a short result message. Click OK to return 
to the search results page. 

Update Project Description 

To perform a batch Request Project Description Update: 

1. Do a Quick Find or Full search for Requests or display a Related list of Requests. 
2. Select more than one Request record from the list. 
3. Go to Actions > Update Project Description. (You may need to slide the menu over to see 

the option.) 
4. Make changes to the Update Project Description form as necessary. 

Clear - to clear the project description on all records. 
Overwrite - to replace the current project description with the new content. 
Append - to add the new content either Before or After the current description. 
Separated by a - Only enabled if Append is selected. Allows you to select how to separate 
the old from the new content. (blank Line, Carriage Return, Space, or Tab) 
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Description field - Enter the new project description information here. 

 
5. Click Update to continue. 
6. You will be prompted with a confirmation message. Click Yes to continue or No to cancel. 
7. Once complete, the progress monitor will display the number of Successes, Warnings, 

and Errors along with the ID of each record and a short result message. Click OK to return 
to the search results page. 

  

Batch Updates for Payments 

From the Payments search results page or Related List grid the Actions menu allows you to 
Update Codes. 

 

To perform a batch Payment Codes Update: 

1. Do a Quick Find or Full search for Payments or display a Related list of Payments. 
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2. Select more than one Payment record from the list. 
3. Go to Actions > Update Codes. (You may need to slide the menu over to see the option.) 
4. Make changes to the Update Payment Codes form as necessary. (See table below for 

description of options.) 

 

Option Description 

Category Required. The Coding Sheet category to be addressed. Includes all 
of the Categories defined for the record type being updated. 

The value chosen here will determine the options available in the 
Update to drop-down. 

Update to Select the desired value(s) in the chosen Category by using the 
drop-down menu.  

5. Click OK to begin processing the update to the Contact records you selected. 
6. You will be prompted with a confirmation message. Click Yes to continue or No to cancel. 

7. Once complete, the progress monitor will display the number of Successes, Warnings, 
and Errors along with the ID of each record and a short result message. Click OK to return 
to the search results page. 
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Percentage Coding in Batch Updates 

The following rules to functionality apply to GIFTS Online Batch Updates to support percentage 
codes. 

Add Code 

When a code is added, the following rules apply: 

 If a code is added as a secondary code, it will be set at 0%. 

 If a code is added as a primary code, the following will apply: 
o If there are no existing codes, it will default to 100% with full Request/Grant 

amount. 
o If a primary code already exists at 100%, the new primary code will be set to 100% 

with full Request/Grant amount. The old primary code will be set to 0%. 
o If the request has an existing code at less than 100%, the new primary code will be 

added at 0% and the user will need to adjust the value manually. 

Remove a Code 

When a code is removed, the following rules will apply: 

 If the code is secondary, its allocation will be added to the primary code. 

 If the code is primary, its allocation will be added to whichever code becomes the 
primary. 

Make a Code Primary 

When a secondary code is made primary, the following rules apply: 

 If the existing primary code is allocated at 100%, the new code will be set to 100% and 
the old one will be set to 0%. 

 If the existing primary code is not set at 100%, only the primary flag will change and the 
percentages will remain the same. 

Replacing a Code 

When a code is replaced, the allocation amount of the new code will be the same as the one it 
replaced. 
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Managing Documents  

Through GIFTS Online, you can view and edit documents associated with Organization, Request, 
Contact, and Affiliation records.  

Documents are displayed in Organization, Request, Contact, and Affiliation edit forms. 

This section contains the following topics: 

About Documents 

Viewing Documents 

Editing and Replacing Documents 

Uploading External Documents 

Working with Document Activities 

  

About Documents 

This topic covers basic elements of understanding how to work with documents in GIFTS Online. 

  

Documents in GIFTS Online 

Documents found in GIFTS Online can originate three different ways: 

 From online grant seekers and grantees attaching files to grant applications and online 
report forms. 

 From users at your organization generating emails, letters, and write-ups which they save 
to the system. 

 From users uploading external documents to attach to Requests or Organizations already 
in the system. 

Once in the system, however, they can all be viewed, edited, replaced, and deleted the same 
way. 

  

Documents and Document Activities 

When discussing documents in GIFTS Online, it's helpful to keep in mind that each "document" 
is really comprised of two elements: 

 The document file itself - an MS Word file of a letter you generated, or a PDF submitted 
by an online applicant. 

 The Document Activity - an GIFTS Online record which captures information about the 
document file. For example, the date it was created, or the name of the document's 
author. 

Working with documents in GIFTS Online means working with both documents (the files) and 
Document Activities. 
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Related Documents 

A link to related Documents is found on the edit forms for Organizations, Requests, and 
Contacts. 

The Document edit form contains the following information:   

 What/When: Where the document originated from. 

 Title/Subject: The document title and related record ID.   

 Author: The document author, if one has been provided. 

 Reference: Displays related Contact information. 

 File Name/Notes: Displays any notes entered and the filename. 

 Status: Checked In, Checked Out, etc. 

 Audit: Information regarding who created or modified it. 

You can also use the three filters on top to narrow down the list by Type, Title, or Keywords. 

Viewing Documents 

You can view documents affiliated with Organizations, Requests, or Contacts by going to the 
desired record's edit form and then clicking on the related Documents link. Once the list of 
documents is displayed, you can double click on the desired document to open its edit form. 

  

Click the filename to open the file for viewing. 
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NOTE: You can also find a document by searching for it through the related Activities link.   

NOTE: You can save a local copy of the file once it is open, but your changes will not be reflected 
in the copy in GIFTS Online. Click here for information on making and saving changes in an 
online document. 

To view a file, you must have software capable of opening the file type on your computer. For 
example, you can only view a PDF if you have Adobe Reader installed. 

You can still view documents even if another user has it checked out. However, you cannot see 
that user’s changes until he or she checks the document back in. 

  

Editing and Replacing Documents 

Whether a document was submitted by a grantee, uploaded by you or another user, or 
generated as a letter or write-up, you can make changes by editing or, if need be, replacing the 
file. 

Whether you can edit a document directly in GIFTS Online depends on meeting both of the 
following criteria: 

 The document is a Microsoft Office file - e.g., Word, Excel, PowerPoint. 

 You are using Internet Explorer 9 or later. 

Otherwise, to make changes, you have to save a copy locally, then upload it as a replacement. 

  

Editing Microsoft Office Documents with Internet Explorer  

If you are using Internet Explorer as your GIFTS Online web browser, you can edit a Microsoft 
Office document by doing the following: 

1. Navigate to the Request, Organization, or Contact edit form and click the related 
Documents link. 

2. In the Action column, click Check Out. The document is checked out. The Status column 
will alert other users who checked the file out and when. Those users can view the 
document as it was when checked out. 

3. Click Edit Document. The document opens. 
4. Edit the document as necessary, and then save and close it.  
5. From the Document dashboard part, click Check In.  

IMPORTANT: Your changes cannot be viewed by other users until you check it back in. 
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Replacing Non-Microsoft Office Documents, or Any Document 

Using Firefox/Safari 

If you are using a non-IE web browser, or you are working with a non-Office document, like a 
PDF, you cannot edit the file directly. You can download a local copy and then upload any 
changes as a replacement. 

1. In the Action column of the Document dashboard part, click View Document, then click 
Save. Choose a location for the document copy and click Save. 

2. Launch the appropriate application and open the document copy that you just saved. 

3. Edit the document as necessary.  
4. Save the edited document locally, and then return to GIFTS Online. 
5. In the Action column of the Document dashboard part, click Upload Replacement. The 

Edit Document Activity dashboard part appears. 
 

 
6. Click Browse and locate the edited document.  
7. Select the edited document and click Open. The document path appears in the field next 

to the Browse button. 
8. Enter any other information in the other Document Activity fields, and then click Save. 

The Document Activity page appears.  

NOTE: Click here for more information about working with Document Activities. 
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Uploading External Documents 

You can attach an external document file to an Organization or Request record in GIFTS Online. 

For example, suppose after receiving an online application from a grant-seeking organization, 
you call them to ask they send an Excel spreadsheet detailing their annual budget for next year. 
They send it to you as an email attachment. You can upload and link that document to their 
Organization record, or to the Request record for the proposal. 

To upload a document and link it to an Organization or Request: 

1. Go the Organization or Request edit form for the record to which you want to attach the 
file. 

2. In the New menu, click Document.  
3. In the Document - New form, fill in the fields as needed. 

 

4. Click Browse and locate the document. 
5. Select the document and click Open. The document's file name appears in the field next 

to the Browse button. 
6. Enter any other information in the other Document Activity fields, and then click Save & 

Close. The Document Activity page appears. 

NOTE: Click here for more information about working with Document Activities. 
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Working with Document Activities 

A Document Activity captures data about a document in GIFTS Online. The Document Activity 
can be accessed by searching Documents in the Full Search Query Builder. You can also access 
the Document Activity by clicking the date link in the related Documents list for Organizations, 
Requests, and Contacts. 

  

Document Activity Detail Page 

Title  

Across the top span of the page, the Title dashboard part shows the Title and file name of the 
document.  

Actions menu 

Available actions are detailed below. 

 

Document Activity 

This contains all the data about the document file. 

 

  

Actions menu 

The following Available Actions may be included on the Document Activity edit form: 

Edit Activity  Displays a standard Activity edit form where you can make changes to 
the Activity record. 

Delete Activity Deletes the document - that is, it deletes both the Document Activity 
and the document file. 

You are prompted for confirmation before the deletion is completed. Be 
sure you want to delete the Activity, as there is no way to cancel the 
deletion. 
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Change Contact  Displays a search page where you can specify the name of a new Contact 
for the selected Activity. If the Contact does not yet exist in GIFTS, you 
can click New to create a Contact record. 

Generate Letter 
Correspondence 

Displays a Generate Letter page where you can create a new letter. 

Generate Email 
Correspondence 

Displays a Generate Email page where you can create a new email. 

  

Document Activity Available Actions 

A combination of the following Available Actions may be included on the Document Activity edit 
form: 

Edit Activity  Displays a standard Document Activity edit form where you can make 
changes to the Document Activity record. 

Delete Activity Deletes the Document Activity record. (You are prompted for 
confirmation before the deletion is completed.) Be sure you want to 
delete the Activity , as there is no way to cancel the deletion. 

Change Contact Displays a search page where you can specify the name of a new Contact 
to be associated with the Document Activity. 

Generate Letter 
Correspondence 

Displays a Generate Letter page where you can create a new letter. 

Generate Email 
Correspondence 

Displays a Generate Email page where you can create a new email. 
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Editing Document Activity 

When you click Edit Activity in the Actions menu, the Edit Document Activity page appears. 

 

You can make changes to any of the available fields within the Edit Document Activity form. 
Click Save to save your changes to the Document Activity record. 

NOTE: If the document is currently checked out, the Browse button will not appear.  

NOTE: When you click Update, GIFTS Online will check the Letter File Name field. If you have 
entered or browsed to another file on your workstation or network, that document is uploaded 
to GIFTS Online, and the file name in the Document Activity record is altered accordingly. 
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About the Template Manager 

IMPORTANT: The Document Template Manager will only work on a Windows OS workstation. 

GIFTS Online users can now use the Template Manager feature to create and maintain their 
own correspondence templates without needing to contact MicroEdge. This includes printed, 
email, and write-up correspondence. 

NOTE: Combined email/letter templates can only be created in the Administrator Module. GIFTS 
Online only allows creation of separate templates for each type of correspondence. 

  

To access the Template Manager go to the Admin menu on the header and select Template 
Manager. 

  

IMPORTANT: If you wish to have access to the Template Manager, please contact MicroEdge as 
certain preferences and permissions need to be set for your user account(s). 

  

Installing the Document Template Manager 

The Template Manager is actually a separate application that must be installed on your 
workstation. 

  

1. When you first click on Admin > Template Manager a new browser window will open 
prompting you to install the Document Template Manager. 

 

2. Click the Install the Document Template Manager button. 

3. If a Security warning is displayed, click Install to continue. 
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4. The Template Manager will quickly be installed and a GIFTS Online Login screen will 
appear.  

5. Simply Login as usual to access the Document Template Manager. 

  

Accessing the Document Template Manager After Install 

From this point forward you will use the Document Template Manager icon  placed on 
your desktop to start the Template Manager. 

  

NOTE: If you attempt to use the menu option Admin > Template Manager again, a message will 
be displayed prompting you to use the icon on your Windows desktop instead. 

  

As an added measure of security, when you open the Document Template Manager, it will ask 
you to login again.  
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Updating Older Versions of the Document 

Template Manager 

If installed the Document Template Manager before July 1st, 2012 and have not used it since 
then, it must be uninstalled and reinstalled to update the trust certificate. 

IMPORTANT: If this is not done, you will get an error when attempting to log in to the GIFTS 
Online Document Template Manager. The message for this error will begin with text like 
“[TrustedApplications_CertificatesMustMatch]…” and indicates that the certificate marking the 
Template Manager as a trusted application has expired. 

On each affected workstation, you must first uninstall the current Document Template 
Manager: 

1. From the Start menu, select All Programs > Document Template Manager. The 
Document Template Manager login page opens. 

2. Right click on the login page. A menu opens. 
3. In the menu, select “Remove this application…” A confirmation message opens. 
4. Click Yes to uninstall Document Template Manager. 

Now you can reinstall the renewed GIFTS Online Document Template Manager: 

1. Log in to GIFTS Online. 
2. In the ribbon menu, select Admin > Template Manager. A new browser window opens, 

telling you that you must install the Document Template Manager. 
3. Click the Install the Document Template Manager button. A form opens, asking you to 

confirm you want to install. 
4. Click Install. Once the installation is complete, the Document Template Manager opens; 

log in using your GIFTS Online user ID and password to add and edit your templates. 

If you need additional support, or the steps above fail to resolve this issue, please contact the 
MicroEdge Technical Support team. 
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Letter Events 

Letter Events describe what type of record a correspondence is for.  

As an example, templates for the Affiliations Letter Event allow correspondence to be sent for 
Affiliation records. 

 

The following are Letter Events available for Correspondence: 

 Activities 

 Affiliations 

 Approval 

 Contacts 

 Declination 

 Organizations 

 Payments 

 Pending 

 Requirements 

 Write-up 
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The following Letter Events are available in the Template Library when the specified module is 
included: 

  

Available with Online Applications and Requirements Module 

 Application Write-up 

 Considered Applications 

 Pending Applications 

 Rejected Applications 

  

Available with Reviews Module 

 Reviews 

Available with Accounts Payable Module with Check Writer 

 Check Template 

  

The Template Manager Interface 

The Template Library contains all the templates in the system for your GIFTS Online site. 
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1. Letter Events – Displays a listing of Letter Events, when a Letter Event is selected, the 
templates for that event are displayed in the templates grid. Certain Letter Events will only 
display if the appropriate module is included in the gifts configuration file. 

2. Templates Grid – Displays a listing of all templates that exist for the selected Letter Event. 

3. Action Menu – This menu contains the following options: 

 Open Template 

 Open Merge Fields 

 Copy Template 

 Rename Template 

 Recreate Headers 

 Delete Template 

  

The Template Grid Columns 

The following information will display in your grid. 

Column Notes 

Template Name Displays the name of the template. 

Email Displays an icon indicating that this is an email template. 

Printed Displays an icon indicating that this is a print. 

Description Displays the description of the template. 

File Name Displays the filename of the template. 

Audit Displays the Create User\Create Date of the template. 

Displays the Change User\Change Date of the template. 
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Template Library Actions 

Once you select a specific library template, the following Actions become available. 

  

New Template - This action allows the user to create a new template. It is not available if more 
than one template is selected. 

 

Open Template - Opens the selected template in Microsoft Word (for printed letter templates) 
or the template editor (for Email templates). 

  

Open Merge Fields - Launches the Merge Field selection form where you can edit the merge 
fields included in the template. 

  

Copy Template - Saves a copy of the selected template. 

  

Rename Template - Allows users to change the name or description of the template. 

  

Recreate Headers - rebuild the header merge file for all the templates in a selected Letter event. 

  

Delete Template - Deletes the selected template from the correspondence library. 
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The Merge Field Form 

The following form is resizable and allows you to select which merge fields should be available in 
the template.  

NOTE: Microsoft Word templates have a limitation of 63 total merge fields allowed. The system 
includes eight standard merge fields in every template, which allows you to add a total of 55 
additional merge fields. 

  

 

1. The Category is selected in this section. Fields are available from associated records. 
Example: For an Approval template, the user can select the “Grantee Organization” 
category to merge data about the grantee organization. 

2. The Available Fields section contains a list of the merge fields available for the selected 
Category. Multiple fields can be selected and then included by clicking the Include button. 
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3. This section displays a list of all merge fields that have been included for use in the 
template. Multiple fields can be selected here and removed if desired. 

4. This section displays formatting options (if available) for the particular field selected in 
the “Included Fields” selection list described above. If no options are available, the 
section will say “No formatting options available.” The prompts in this section will appear 
horizontally instead of vertically listed (if there is more than one set of prompts). 

  

Merge Field Formatting Options 

Currency, Numeric\Decimal, Date, Coding Sheet, and Table merge fields can have special 
formatting. When one of these field types is included in the template, special prompts will 
appear that allow the user to format the data contained by that merge field. 

  

The heading for the group will change when a field is highlighted in the “Include these fields in 
the Template” prompt: 

Field Options – {Entity}: {Field Name} 

Example: 

Field Options – Request: Recommended Amount 

  

If the field selected does not have any special formatting options, then the following text will 
display in the group: “No formatting options available.” 

  

Currency Formatting Prompts 

 Hide Currency Symbol 

 Decimal Places 

 Show amount in words 

 Include grouping character 

  

Number/Decimal Formatting Prompts 

 Decimal Places 

 Include grouping character 

  

Date Formatting Prompts 

 Date Format 
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Coding Sheet Formatting Prompts 

Single Level Codes 

There are no formatting options for single level codes. 

  

Multi-Level Codes 

 Code level to display 

 Show parent codes 

 Delimiter 

  

Multi-Select Codes 

 Primary/Secondary Codes 

 Delimiter 

  

Table Formatting Prompts 

 Include Column Headers 

 Autofit Column Width to contents 

 Use Table Borders 

 Summarize by Grant Year 

 Show Approved Request Only 

 Include Request Fund 

 Include Request Type 
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The Template Editor 

When working with Printed Letter Templates, you will edit the template directly in a word 
processor.  

When working with E-mail templates, opening the template will invoke the following Template 
Editor form: 

 

  

Template Editor Sections 

 Email Subject 

 Email Heading 

 Email Body 

 Email Close 
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Insert Merge Field 

This button on the editor opens the Insert Merge Fields window which lets you select new 
merge fields to add to your template. 
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Generating Correspondence  

To initiate correspondence in GIFTS Online, you should access the edit form of the record that is 
related to the correspondence. For example, if you wish to send a letter to confirm receiving a 
payment, go to the edit form for the Payment record involved. 

In the Actions menu on the record’s edit form, look for the Generate Letter Correspondence and 
Generate Email Correspondence links. Click the appropriate link to begin creating 
correspondence. 

  

This section describes how to generate: 

 Generating Batch Correspondence 

 Generating Email Correspondence 

 Generating Letter Correspondence 

 Generating Write-ups 

  

Generating Batch Correspondence 

You can create a batch of correspondence for any group of records in the Requests, 
Organizations, Contacts, Payments, Requirements, Affiliations, and Activities Search Results 
pages. After you generate your correspondence, you can review and modify it before sending it 
to the email recipients or to your printer. 

NOTE: You can also generate write-ups for Requests in batch. 

Details on generating letters, emails, or write-ups are found in the linked help topics. Following 
are tips on finding and selecting the records you want to batch and generate correspondence 
for. 

 You can search for the records using Quick Search, Detailed Search, Recent Searches or 
Saved Searches. A narrower search will make it easier to target the records you want to 
generate a letter, email, or write-up for. 

 On the Search Results page, use the check boxes in the left column to select which 
records to generate correspondence for. 

 Select or clear the check box in the column header row to select or clear all records on 
the page. 

 You can't put records on different search results pages in the same batch. First click View 
All at the foot of the grid to get all the records on one page, then select records using the 
check boxes. 

 If you are generating letters for a batch of Requests, all selected Requests must be of the 
same disposition: pending, approved, or declined. (Write-ups can be generated for 
Requests with different dispositions, however.)  
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Batch Email Validations 

When performing a batch Email correspondence, the system will check all records selected and 
advise you of records where no email address exists. You can choose to skip these records when 
sending out the emails or cancel the batch process to correct the records first. 

The Correspondence Viewer will also advise you if the email for a specific contact is invalid and 
needs to be corrected. 

  

Generating Letter Correspondence 

You can create letter correspondence in GIFTS Online for a single record or for a batch of 
records. 

 For a single record, access its edit form. In the Actions menu on the record’s edit form, 
select Generate Letter. 

 For a batch of records, first search for the records, then select them on the Search Results 
page.  
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To create a letter using GIFTS Online: 

1. Click Generate Letter in the Actions menu of a single record's edit form or at the foot of 
the Search Results page. The Generate Letter Correspondence page appears. 

NOTE: If you are generating letters for a batch of Requests, all selected Requests must be 
of the same disposition: pending, approved, or declined. 

2. In the Template field, use the drop-down menu to select the template to use for the 
letter. If the letter will have more than one recipient, select the Create copies for CCs 
checkbox. 

IMPORTANT: If the template you select contains a merge field that you do not have 
permission to view or edit, the merge field will be left blank in the final merged letter. 

3. In the To field for a single letter, you can use the drop-down menu to select a primary 
recipient, and then enter a Salutation for the letter. (When generating for a batch of 
records, the primary contact for each selected record is used automatically. Each 
contact's default salutation is used, so the Salutation field does not appear when 
generating a batch.) 

4. Including CC recipients is different for single or batch generation: 

 For a single letter, select a recipient in the CC drop-down menu and click Add. 
Repeat this for each CC recipient. If you decide not to send a copy to a recipient 
who has already been added to the CC list, simply clear the checkbox next to the 
recipient’s name. 

 If you're generating letters for a batch, the CC field appears for Organizations, 
Requests, and Contacts only. It lists Affiliation Roles; for each selected record, 
Contacts affiliated by the selected Roles will have CC copies generated. 

5. In the Signer field, indicate the name of the person who will be the Signer of the letter, as 
well as that person’s Position in your organization. If the Signer is a person other than 
yourself, you may wish to add your name to the Preparer field. 

NOTE: Your entries in these fields will be saved along with your other user preferences, 
and will be used as default settings the next time you create a letter or an email message.  

6. In the Create activity record checkbox, you can indicate whether you wish to create an 
Activity record for the letter(s), as well as a Date and Notes for the Activity.  

7. Click Generate Correspondence to generate your merged letter or letters. When the 
letters have been completed, a link opening the letters appears at the top of the detail or 
Search Results page. Click the link to open the Word document. 

TIP: For batch correspondence, the link opens all letters in the batch in a single Word 
document. This is the most convenient time to print them. If you selected the option to 
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create Document Activities, you can print them later by going to each record's edit form 
to open and printing them one at a time.  

Generating Email Correspondence 

You can create email correspondence in GIFTS Online for a single record or for a batch of 
records. 

 For a single record, access its edit form. In the Actions menu on the record's edit form, 
look for the Generate Email Correspondence link. 

 For a batch of records, first search for the records, then select them on the Search Results 
page.  

 You may select up to 100 records of the same disposition (where applicable) when 
generating batch e-mails. If you exceed 100 records, a warning dialog will be displayed. 

 

To send email correspondence from GIFTS Online: 
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1. Click Generate Email in the Actions menu of a single record's edit form or at the foot of 
the Search Results page. The Generate Email Correspondence page appears. 

2. In the Email Correspondence section, use the drop-down menu to select the template to 
use for the email. If you would like to be notified when each copy of the email is read by 
the recipient, check the box to Request a read receipt. 

3. In the To field for a single email, you can use the drop-down menu to select a primary 
recipient, and then enter a Salutation. (When generating for a batch of records, the 
primary contact for each selected record is used automatically. Each contact's default 
salutation is used, so the Salutation field does not appear when generating a batch.) 

4. Including CC recipients is different for single or batch generation: 

 For a single email, select a recipient in the CC drop-down menu and click Add. 
Repeat this for each CC recipient. If you decide not to send a copy to a recipient 
who has already been added to the CC list, simply clear the checkbox next to the 
recipient’s name. 

 If you're generating emails for a batch, the CC field appears for Organizations, 
Requests, and Contacts only. It lists Affiliation Roles; for each selected record, 
Contacts affiliated by the selected Roles will have CC copies generated. 

5. In the Signer section, indicate the name of the person who will be the Signer of the email, 
as well as that person's Position in your organization. If the Signer is a person other than 
yourself, you may wish to add your name to the Preparer field. 

NOTE: Your entries in these fields are saved along with your other user preferences, and 
are used as default settings the next time you create a letter or an email message.  

6. In the History section, you can indicate whether you wish to create an Activity record for 
the email, as well as a Date and Notes for the Activity. You may also select the option to 
Save email text, which will save the subject line and body text of the message in the Long 
Notes field of the Activity record. 

7. Click Generate Correspondence to generate the email(s). When the generation has been 
completed, GIFTS Online displays your email message. 

8. Edit the email, if desired. You can review each email in a batch by clicking the Previous 
and Next buttons.  

NOTE: When reviewing a batch of emails, you can select the Skip check box to skip 
sending that particular email. When you click Send All, those emails will not be sent. 

9. To send a single message, click Send; click Send All for a batch of emails. GIFTS Online 
sends the message(s) and closes the browser window. 
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Using Quick Emails 

The Quick E-mail feature will give users an option to send a quick ‘Ad-Hoc E-mail’ when 
generating e-mails related to GIFTS Online records. 

The new functionality will be an alternative to the existing template email generation and will 
employ the user’s default desktop e-mail program, basically opening a new email in that system 
and populating the e-mail address(es) from the selected record(s) into the To field. 

Important Notes: 

 Only desktop installed email applications are currently certified for this enhancement. 

 Gmail is supported and can be implemented by installing and configuring the Google 
toolbar. 

 No activity records are created with this action. 

To use the Quick Email feature, do the following: 

1. Perform a search and select one or more records. 
2. Go to Actions > Generate Email. 
3. On the Perform Email Correspondence form, click on Quick Email. 

 

4. A new email will open using the default email application installed on your workstation. 

 If only one record was selected, the contact’s email address will populate the To 
field. 

 If multiple records were selected, the email addresses for all the contacts will be 
entered in the BCC field. 
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5. You can now enter your own Subject and body text as needed. 
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Setting Up Google Toolbar to Work with Quick Emails 

NOTE: The instructions in this section are optional and only apply if you wish to use Gmail as 
your default email client for ‘Mail to’ links. The instructions were created using Internet Explorer 
11. The steps needed for IE 9/10 may be slightly different. 

The following section describes how to optionally install Google Toolbar and configuring it to use 
Gmail as your email client for ‘Mailto’ links. 

1. While in IE, type toolbar.google.com into the address bar, then click on ‘Download Google 
Toolbar’ button. 

 

2. Install the toolbar by clicking on the ‘Accept and Install’ button. 
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3. When the install is complete, you will be prompted to restart the browser. Allow the 
restart by clicking on ‘Restart Now’. 

 

4. The next time Internet Explorer is opened, you should be prompted to enable the Google 
Toolbar. Click on the Enable button. 
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5. Once enabled, the Google Toolbar should be available in the upper right hand section of 
the window. From there, click on the Wrench icon which will allow you to adjust the 
toolbar options. 

 

6. In the Toolbar Options window, scroll to the Web-browsing tools section and select the 
‘Use Gmail for “Mail To” links option and Save the selection. 

 

7. As a final step, please allow pop-ups for your GIFTS Online site in the Google Toolbar. This 
will allow all of the features in GIFTS Online to work properly. 

To do this, log into GIFTS Online and in the Google Toolbar, expand the list of buttons and 
hover over the Pop-up blocker button which will expand the options. 
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Click on the option to ‘Always allow pop-ups’ from your GIFTS Online site. 

 

This completes the setup for using Gmail for email links when using Internet Explorer including 
email generation in the GIFTS Online Quick Email feature. 
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Generating Write-ups 

A write-up is a summary of a pending, approved, or declined Request. If someone at your 
organization still prefers to review proposals on paper - an unlikely scenario with the purchase 
of GIFTS Online! - you can generate write-ups for them instead. 

NOTE: Write-ups are only available for Request records. 

 You can create Request write-ups for a single record or for a batch of records. 

 For a write-up of a single Request, access its edit form. 

 For write-ups of a batch of Requests, search Requests and then select them on the Search 
Results page.  

 

To create a write-up or batch of write-ups: 

1. Click Generate Write-up in a Request edit form's Actions menu, or at the foot of a Search 
Results page. The Generate Write-up page appears. 

2. Using the Template drop-down menu, select the template to use for the write-up(s). 
3. Enable the Create Activity checkbox if you want to create an Activity record for the write-

up(s). Each Activity will include the Date, Notes, and Author you specify in their respective 
fields. 

4. Click Generate Write-Up to generate the write-up(s). When the generation has been 
completed, a link opening the letters appears at the top of the detail or Search Results 
page. Click the link to open the Word document. 
TIP: For a batch of Requests, the link opens all write-ups in the batch in a single Word 
document. This is the most convenient time to print them. If you selected the option to 
create Document Activities, you can print them later by going to each Request's edit form 
to open and printing them one at a time. 
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Printing Mailing Labels 

It is possible to create a letter template that allows multiple record addresses to populate to a 
single page using the Mailing_Labels merge field. 

The steps to create a Mailing Labels template are documented below: 

1. Create a new letter template. 
2. Go into the Mailings>Start Mail Merge option in Word and selected a form (one of the 30 

per page options) 
3. Change the orientation as needed for the printed labels. 
4. Insert the Letter_Mailing_Label field. 
5. Click on Update Fields in the Mailings toolbar which populated the page with the merge 

field preceded by a <<Next Record>> field. 
6. Save the template. 
7. When it is used in GIFTS Online, the labels for the selected records will fill the page. 
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About GIFTS Online Link to Outlook 

This feature allows you to send Outlook emails into GIFTS Online, where each email is saved as a 
Mail Activity record.  

In addition, you can store email attachments in GIFTS Online as documents associated with the 
Mail Activity. You also have the option to link each Mail Activity with a particular Request, 
Organization, or Contact in GIFTS Online. 

This feature is very helpful for keeping all your communications and documents submitted by 
grantees in one place. 

NOTE: To use this feature, you must first install the GIFTS Online Link to Outlook plug-in which is 
available for download from the PowerME Portal. 

  

This section contains the following topics: 

Installing Link to Outlook 

Where Is the Send to GIFTS Online Button? 

Configuring Outlook 

GIFTS Online Link to Outlook Preferences 

Using the GIFTS Online Link to Outlook Wizard 

Searching from the Link to Outlook Wizard 

  

Installing Link to Outlook 

The GIFTS Online Link to Outlook is a plugin which must be downloaded from the PowerME 
portal and installed on your workstation. 

NOTE: Outlook 2007, 2010, and 2013 are supported. There is a 32-bit(62mb) and 64-bit(68mb) 
version depending on the version of Outlook you have installed. 

To check which version of Outlook you have installed, do the following: 

1. In Outlook, go to the File tab. 
2. Click Help. 
3. Review the information displayed on the right panel under About Microsoft Outlook. 
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To install the plugin, do the following: 

1. Go to the PowerME Portal and download the correct plugin for your version of Microsoft 
Outlook. 

 GIFTSOnlineLinkToOutlook_32bit.zip 

 GIFTSOnlineLinkToOutlook_64bit.zip 

2. Unzip the downloaded file to an easy location to access. 
3. Exit Outlook if you currently have it running. 

NOTE: You can install the plugin with Outlook open, however, you won’t see the new 
button until you close and reopen Outlook. 

4. Access the GIFTS Online Link to Outlook folder and double-click on the Setup.exe file. 
5. Accept the license agreement and the install will begin. 
6. At the Welcome screen, click Next. 
7. The Select Installation Folder screen will be displayed. 

Review the default folder path. If desired, you may click Browse to choose a different 
location for the install. 

The Disk Cost button will give you a list of available drives and the space required for the 
initial install. 

At the bottom, choose who you want to be able to access this install of GIFTS Online Link 
to Outlook. 

If you select ‘Everyone’, all users who have access to the computer will be able to use the 
new feature. 

8. Click Next to continue. 
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9. At the Confirm Installation screen, click Next. The installation will take less than a minute. 
10. At the Installation Complete screen, click Close. 
11. Re-open your Outlook. 
12. The Send to GIFTS Online button should now be visible in your Add-In tab and email 

menus. 

  

Where Is the Send to GIFTS Online Button? 

Once the plugin is installed, there are three places within Outlook where a user accesses the 
GIFTS Online Link to Outlook button with the label ‘Send to GIFTS Online’. 

The Standard Toolbar 
After installing the plug-in, the ‘Send to GIFTS Online’ button appears with the MicroEdge daisy 
logo on the Add-Ins tab. 

After going to your Inbox or Sent Items folder and selecting any received or sent email(s), you 
can click this icon to send it to GIFTS Online. Clicking this opens the GIFTS Online Link to Outlook 
wizard. 

 

Received or Sent Email 
The same icon also appears in a sent or received email when it is opened. As before, it starts the 
GIFTS Online Link to Outlook Wizard. 

 

An Email Being Sent 
For any unsent message you are editing, you can click Send to GIFTS Online button to 
automatically send the message to GIFTS Online when the email is sent (opening the GIFTS 
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Online Link to Outlook Wizard). When the email is being edited, this button is an on/off toggle. 
The initiation of sending the email to GIFTS Online won’t happen until the message is sent. 

 

  

Configuring Outlook 

To make your work easier, there are a few things which must be configured in Outlook. 

Adding the MERECID Column to Outlook 

When an email gets exported via the plug-in to GIFTS Online, the ID of the matching Activity 
record in GIFTS Online will be stored in the email in Outlook as its MicroEdge Record 
ID(MERECID) value. If you wish to see the MERECID in Outlook you can add the MERECID column 
to your Outlook Inbox table. This will allow you to easily see which emails have already been 
exported to GIFT S Online. 

1. In Outlook, go to View > Add Columns, OR right click on a header in the email inbox table 
and go to View Settings.. and click the Columns button. 

2. From the drop-down menu, select User-defined fields in Inbox. 
3. Add the MERECID field to the right pane and position it in the desired order. 
4. Click OK and then OK again. 
5. The MERECID column should now be visible in your Outlook Inbox view. 

 

  

Logging Into GIFTS Online from Outlook 

When you choose to send an email from Outlook to GIFTS Online by clicking on the ‘Send to 
GIFTS Online’ button, you will first be asked to log in using your GIFTS Online credentials.  

NOTE: The login information will be remembered during the current Outlook session only. You 
won’t be asked to login again while you have that instance of Outlook running. You will be asked 
for credentials if you close and reopen Outlook and attempt to send an email to GIFTS Online. 
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You will also need to provide your GIFTS Online URL so that the web service knows which client 
site to access. 

The URL will be accepted with or without the http://, and/or with or without the .com or sub-
directories. 

For example, the following URLS are all valid entries to this field: 

 http://becky51.gogiftsonline.com 

 https://becky51.gogiftsonline.com 

 becky51.gogiftsonline.com 

 becky51.gogiftsonline 

 http://becky51.gogiftsonline.com/default.asp 

  

GIFTS Online Link to Outlook Preferences 

The Link to Outlook Preferences are accessed by going to Admin > Preferences in GIFTS Online. 

 

The following table describes what each option does: 

Option Description 

Allow Export of 
Attachments 

Indicates whether or not a ‘Download attachments’ option will be visible 
on emails in Outlook. If it is selected in the preferences, it will be visible 
and selected on emails in Outlook. The user will have the option to 
deselect when linking the email. 
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Option Description 

Default Export Option Selection here determines the default option when the user accesses the 
GIFTS Online Link to Outlook Wizard. Note that the user can override this 
selection in the GIFTS Online Link to Outlook Wizard.  

Options:  

• Match to existing Activity – selected by default. 

• Create new Activity – deselected by default.  

Message Storage Determines how messages are saved in GIFTS Online. This is the global 
setting. There is no option to override this setting in the GIFTS Online Link 
to Outlook Wizard.  

• Save messages in Activity Notes - When selected, each email’s message 
body will go into the long notes of the Mail Activity created by the upload. 

• Save messages as .msg files - When selected, the Outlook message file 
(.msg) will be saved in GIFTS Online and set as the Letter_File_Name of 
the Mail Activity.  

Default when linking to 
an Activity 

This is the selection that will default when you access the GIFTS Online 
Link to Outlook Wizard. The user can override this setting in the wizard. 
The default in this dialog is Existing Request(s).  

 The dropdown options are:  

• Existing Request(s) [default] 

• Existing Organization(s)  

• Existing Contact(s) 

• No Existing Record(s)  

When linking to an 
existing Activity 

When sending emails to GIFTS Online and linking to an existing Email 
Activity (based on matching logic described below), this setting will 
determine what should be done with the existing Activity (default is 
Overwrite): 

• Overwrite (Existing Activity will be deleted) – Will delete the existing 
mail Activity (and associated .msg file), as well as any Documents 
(attachments) of the matching Activity (if one is selected/found). 

• Create new (existing Activity will remain) – no attempt will be made to 
delete the existing activity or its associated external documents. A new 
one is created instead. 

• Ask user (user chooses to delete existing or not) – When exporting 
email(s), the user will be permitted to choose whether or not to delete 
the matching existing Activity and its attachments.  
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Using the GIFTS Online Link to Outlook Wizard 

The GIFTS Online Link to Outlook Wizard opens when you successfully log in via the Send to 
GIFTS Online button in Outlook. 

 

When exporting the selected message: 
NOTE: The default for this option is determined by the Preference settings. 

Match to existing Activity(ies) – with this option selected, the system will attempt to match the 
email selected with an existing Activity record by MERECID, Subject, or Email address of the 
Organization or Contact. 

When a single email is selected, any matches will be displayed in a grid below the Quick Search 
field. 

NOTE: Branch Security view rights will be applied, if enabled. 

Create new Activity – This will create a new ‘Mail’ Activity and associate it to a record you select 
using the search tools. If this is selected, The Link to menu will be enabled allowing you to pick 
from Request, Organization, Contact, or ‘no existing records’. 

The Link to Menu   
Depending the Linked To option selected, the system will attempt to match the email with an 
existing Activity record by MERECID or Email address and return the Request, Organization or 
Contact record in the list of results. 
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Option Description 

Existing Request(s) When you select this option, a grid appears with a list of Requests that are 
possible matches to the email item. 

Existing 
Organization(s) 

When you select this option, a grid appears with a list of Organizations that 
are possible matches to the email item. 

Existing Contact(s) When you select this option, a grid appears with a list of Contacts that are 
possible matches to the email item. 

No Existing Record No grid is displayed. 

 
Quick Search and Advanced Search 
If no matching records are automatically found, you may perform either a Quick Search or 
Advanced search from the Link to Outlook Wizard. 

TIP: More details about the search functions are available in the Searching from the Link to 
Outlook Wizard section. 

Once you have selected one or more records to export and link the email to, click Next to move 
to the Export Options form. 
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The table below describes the options available on this form: 

Field Description 

Contact This section shows the contact to which the activity will be linked. It will be hidden 
when exporting multiple messages. 

If needed, the Change button may be used to change the Contact. 

NOTE: This option is only available if a new Activity is being created. 

Organization This section shows the Organization to which the activity will be linked. It will be 
hidden when exporting multiple messages. 

If needed, the Change button may be used to change the Organization. 

NOTE: This option is only available if a new Activity is being created. 

Title Default will be the title of the matching Activity. Otherwise, blank. 

Keywords Default will be keywords of the matching Activity. Otherwise, blank 

Notes Default will be the notes of the matching Activity. Otherwise, “Email sent” (if 
sender is the current Outlook user) or “Email received” for a single message; blank 
in batch. 

Download 
Attachments 

Will not appear if preference to support attachments is not enabled or there is a 
single message selected and it has no attachments. Defaults to checked (if 
unchecked, external documents won’t be created for any attachments). 

Delete 
existing 
Activity 

This checkbox determines whether the original email activity (and its attachments) 
should be deleted when the message is exported. Will default to unchecked. Will 
only appear if the preference is set to “Prompt User” and the matching options 
selected in Step 1 may result in matching to an existing Activity record. 

Back Allows you to page back to the first page of the wizard. 

Finish Click to finish the export to GIFTS Online. 

Cancel Cancels the export and closes the wizard. 
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Once you click Finish, the email(s) selected will be exported to GIFTS Online and the following 
prompt will be displayed. 

 

Click OK. 

A progress log will also be displayed. You may Save or Print the log at this point for your records. 

 

Click Close. 
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Searching from the Link to Outlook Wizard 

Quick Search 

Depending upon the record type, this function will perform a search based on a limited number 
of field parameters as described below. Simply enter a keyword or ID/Reference number and 
click GO. 

Activities 
If the 'Match to existing Activity' option is selected at the top of the Link to Outlook form, 
Activities will be searched in the following manner: 

 Will do a “contains” search first on Letter Subject 

 Barring that, will do a “is” search on Request ID 

 Barring that, will do a “contains” search on Letter Keywords 

Contacts, Requests, or Organizations 
if the ‘Create new Activity’ option is selected for the export and a record type is selected from 
the Link to drop-down menu, the search will be performed in the following manner: 

Contacts • If a space is detected in the entered text, the system will split on the first space 
and do an “is” search of the piece before the space on Contact First Name and the 
piece after on Last Name.  

• Barring that, will do a “contains” search looking for entered text in Contact Last 
name field.  

Requests • Will do an “is” search first on Request ID.  

• Barring that, will do an “is” search on Request Ref Number.  

• Barring that, will do a “contains” search on Project Title.  

Organizations • Will do a “contains” search looking for matching text in Organization name 
fields.  
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Advanced Search 

Depending upon the record type, this function will create a search that runs across key fields 
until one or more matches are found. The following is a description of the options that you have 
when using the Advanced search functionality. 

The Advanced Search form has a limited number of fields which can be used to search for an 
existing record as shown below. 

1. Click Advanced. 
2. With the Search for Activities form open, select a field using the drop-down menu. 

 

3. Click Add to open the search parameter form. 
4. Depending on the field selected, you will have several parameters to choose from. 

 

5. Once you have selected a parameter, enter a keyword or number for the search and click 
OK. 

 

6. Your search filter will be displayed in the open text field. 
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7. If you select the search filter, you have the option to Edit or Remove it using the buttons 
at the bottom. Double-clicking a filter will also open edit mode. 

8. You can add multiple filters using the above steps. 

 

9. If two of the same field are added to the search, an OR operator will be inserted instead 
of AND. In the example above, two primary contact emails were added with OR in 
between. 

10. Click Finish to perform the search. 
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About Tax Status 

This chapter describes how to use Tax Status to verify and update tax status information for 
Organizations in GIFTS Online. It also describes how to search for tax exempt organizations in 
MicroEdge’s Tax Exempt Organization Database. 

NOTE: Tax Status requires an active subscription to MicroEdge’s tax information service. If you 
do not have a subscription, contact your sales representative for more information. 

Tax Status allows you to verify the tax status of one or more Organizations in GIFTS Online 
against MicroEdge’s Tax Exempt Organization Database. After verifying the tax status of one or 
more Organizations, you can update GIFTS Online with current tax status information. 

You can also use Tax Status to look up tax exempt organizations not in GIFTS Online. 

About MicroEdge’s Tax Exempt Organization 

Database 

MicroEdge’s Tax Exempt Organization Database is a database that contains the most current 
information on all tax exempt organizations. MicroEdge frequently updates this database with 
information from the IRS Exempt Organization Master Listing and the Canada Revenue Agency’s 
registered charities database. 

Setting Up Tax Status Codes 

GIFTS Online can only be updated with tax status codes that are found in its tax status code 
table. Before you use Tax Status, a Grants Manager must make sure that the tax status code 
values are up-to-date. 

When you verify an Organization’s tax status, a search is done on the tax status, and if found, 
the tax status codes of the Organization in GIFTS Online and MicroEdge’s Tax Exempt 
Organization Database are compared. 

Whenever you make an attempt to update with a code not found in GIFTS Online, you will be 
notified.  

A Grants Manager can add the missing code using the steps below, and you can then 
repeat the update. 

To set up tax status codes in GIFTS Online: 

1. From the Admin menu, go to Classifications.  
2. Scroll down the list of code tables and click on the Tax Status table. 
3. The Classification - Tax Status page is displayed. 
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4. Do one of the following: 

 To add a new tax status code, click New. 

 To update a tax status code already in the table, click on the edit (pencil) 
icon that appears next to the code when you hover the mouse cursor over 
it. 

5. Enter the Code for the tax status. 

NOTE: For a listing of all the tax codes and their associated descriptions and 
organization types, please refer to “Tax Status Codes” section. 

6. Enter the Description for the tax status. This is what is displayed in the Values list. 

NOTE: This description appears in the Tax Status section of the Tax Status menu in 
the Organization window and can be anything that describes the tax status. For 
instance, if the tax status code is 03, an accurate description might be 501(c)3. 

7. Repeat this process until all tax status codes are set up. 
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Tax Status Codes 

The following is a list of tax status codes and their associated descriptions and organization 
types. Your Grants Manager can use this table when setting up tax status codes. 

For more information, please see “Setting Up Tax Status Codes”. 

Tax 
Status 
Code 

Description Organization Type 

01 501(c)1 Government Instrumentality 

02 501(c)2 Title-Holding Corporation 

03 501(c)3 Charitable Organization 

Educational Organization 

Literary Organization 

Organization to Prevent Cruelty to Animals 

Organization to Prevent Cruelty to Children 

Organization for Public Safety Testing 

Religious Organization 

Scientific Organization 

04 501(c)4 Civic League 

Local Association of Employees 

Social Welfare Organization 

05 501(c)5 Agricultural Organization 

Horticultural Organization 

Labor Organization 

06 501(c)6 Board of Trade 

Business League 

Chamber of Commerce 

Real Estate Board 

07 501(c)7 Pleasure, Recreational, or Social Club 

08 501(c)8 Fraternal Beneficiary Society, Order or Association 

09 501(c)9 Voluntary Employees’ Beneficiary Association (Non-Government 
Employees) 
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Voluntary Employees’ Beneficiary Association (Government Employees) 

10 501(c)10 Domestic Fraternal Societies and Associations 

11 501(c)11 Teachers Retirement Fund Association 

12 501(c)12 Benevolent Life Insurance Association 

Mutual Ditch or Irrigation Company 

Mutual Cooperative Telephone Company 

Organization Like Those on Three Preceding Lines 

13 501(c)13 Burial Association 

Cemetery Company 

14 501(c)14 Credit Union 

Other Mutual Corporation or Association 

15 501(c)15 Mutual Insurance Company or Association Other Than Life or Marine 

16 501(c)16 Corporation Financing Crop Operations 

17 501(c)17 Supplemental Unemployment Compensation Trust or Plan 

18 501(c)18 Employee Funded Pension Trust (created before 6/25/59) 

19 501(c)19 Post or Organization of War Veterans 

20 501(c)20 Legal Service Organization 

21 501(c)21 Black Lung Trust 

22 501(c)22 Multiemployer Pension Plan 

23 501(c)23 Veterans Association Formed Prior to 1880 

24 501(c)24 Trust Described in Section 4049 of ERISA 

25 501(c)25 Title Holding Company for Pensions, etc. 

26 501(c)26 State-Sponsored High Risk Health Insurance Organizations 

27 501(c)27 State-Sponsored Workers’ Compensation Reinsurance 

40 501(c)40 Apostolic and Religious Organizations (501(d)) 

50 501(c)50 Cooperative Hospital Service Organization (501(e)) 

60 501(c)60 Cooperative Service Organization of Operating Educational 
Organization (501(f)) 
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70 501(c)70 Child Care Organization (501(k)) 

71 501(c)71 Charitable Risk Pool 

81 501(c)81 Qualified State-Sponsored Tuition Program 

92 501(c)92 4947(a)(1) - Private Foundation (Form 990PF Filer) 

 

F02 Private Operating Foundation 

F03 Private Operating Foundation 

F04 Private Non-operating Foundation 

F09 Suspense 

F10 509(a)(1) 

F11 509(a)(1) 

F12 509(a)(1) 

F13 509(a)(1) 

F14 509(a)(1) 

F15 509(a)(1) 

F16 509(a)(2) under 170(b)(1)(A)(vii) 

F17 509(a)(3) under 170(b)(1)(A)(viii) 

F18 509(a)(4) 

A Public Foundation 

B Private Foundation 

C Charitable Organization 

 



GIFTS Online 5.1 User’s Guide 

364 
 

Tax Status Lookup 

The Tax Status Lookup allows a user to search the IRS database for Organizations that do not 
currently exist in their GIFTS Online system. The Tax Status Lookup option is accessed from the 
‘Launch’ menu of GIFTS Online and does not require any Organization records to be selected. 
Simply go to Launch > Tax Status Lookup. 

 

NOTE: At least one criteria other than “Tax Status Source” must be entered. The Search button 
will be disabled until at least one other value is supplied. 
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Tax Status Lookup Results 

The following page displays the search results from the lookup. 

 

 

Actions Available 

Action Description 

Refine Search Returns user to the previous search dialogue. The previous search criteria will be 
pre-populated already. 

Printer 
Friendly 

Generates a temporary HTML page with the search results grid. 

Details The details link will launch a modal window that allows the user to see the values 
for the Organization in question. This will afford the user the opportunity to 
review the data that will be created. 

Add 
Organizations 

Will create Organizations records in the GIFTS Online database for the selected 
results. See Updates and Error Handling. 

Cancel Closes the results page. 
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Details 

Clicking Details link will display the following for each Organization: 

 

The data grid will show the following: 

 Field Name – The name of the field in the Organization Record 

 Value – The value with which the field will be populated 

The footer of the dialogue will display: 

 x / y records in the record set 

 Previous and Next to traverse the record set 

 Close button to close the dialogue 
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Tax Status Verify 

The Tax Status Verify option allows the user to verify the tax status of existing Organization 
records in their GIFTS Online system against the ME tax database. This action can be initiated 
from the Organization search results page or from within an Organization edit form itself. You 
can also use this feature in batch mode by selecting multiple Organizations first and then going 
to Actions > Tax Status Verify. 

  

Single Mode 

When Tax Status Verify is invoked against only a single record (either from an Organization Edit 
Form, or when only one record is selected out of many), there will only be two possible 
outcomes: ‘Matched’ or ‘Not Found’. 

 

If a match is found, you can click Details to view the Organization’s IRS information. 

 

If not found, you are given the option to refine your search. 

Yes – Opens the Tax Status Lookup form with the fields filled in where appropriate. 

No – Returns you the search results page or Organization edit form you were on. 
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The following actions are available on the results page: 

Action Description 

Printer Friendly Generates a temporary HTML page with the results grid. 

Details The details link will launch a modal window that allows the user to see the 
existing values and the new value that the record will be updated to. A 
checkbox column will allow the user to select which fields they would like to 
update.  

Update 
Organizations 

Will update Organization records in the GIFTS Online database for the 
selected records. 

Cancel Closes the results page. 

 

Multiple Records Mode 

Selecting multiple organizations on a search results page and then using the Tax Status Verify 
option will check all selected organization Tax IDs. 

A Tax Status Verification Summary will display showing how many Matched and Not Matched 
tax IDs were found. 

You can click the View results links to see a list of each. 
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Matched IDs: This consists of the Organizations whose GIFTS Tax ID and tax status matched the 
information in MicroEdge’s Tax Exempt Organization Database. 

 

NOTE: On the Results page, the Update Organizations button is disabled unless 1 or more 
organizations are selected. 

Not Matched IDs: If there were Organizations that were not found, you will have the ability to 
initiate a lookup search from this list. 

 

Action Description 

Printer 
Friendly 

Generates a temporary HTML page with the results grid. 

Lookup The lookup button will launch the Tax Status Lookup form for the selected 
Organization. The lookup form will open in a new window. The Tax Status 
Verification ‘No Results Found’ page stays open until user hits the close button. 

Close Closes the results page. 
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Updating Organization Information 

When verifying an Organization’s tax status, you can view the tax status fields that can be 
updated. You can then select the fields you want to update, and update them in GIFTS Online. 

Steps 1 and 2 below are optional and only necessary if you want to view or change the tax status 
fields to be updated. If you only want to update Organization information, go to Step 3. 

To view and update Organization fields: 

From the Tax Status Results - Matched list or the Tax Status Results - Not Matched list, click 
Details next to an Organization. The Update Details window is displayed. 

1. The Update Details window contains the following columns: 

Column Description 

Field The name of the field. Click the check box next to this field to select it, or clear 
the check box to clear it. 

Current The field information in GIFTS Online. 

New The field information in MicroEdge’s Tax Exempt Organization Database. If you 
select this field and update GIFTS Online, the information in this field 
overwrites the information in GIFTS Online. 

NOTE: Selected fields will be overwritten in GIFTS Online if you update this Organization. 
The fields which are selected by default are determined by your setup preferences. 

2. Choose one of options on the Update Details window: 

Option Description 

Print Prints the displayed information. 

Set Saves any changes and closes the window. To update GIFTS Online with the 
selected fields, go to Step 3. 

Cancel Closes the window without saving any changes. 

NOTE: For detailed information about the Tax Notes field, please refer to “Understanding 
Tax Notes Field Data,” Solution #1369 in the MicroEdge PowerME client portal. 

3. From the Tax Status Results window, click Update. This updates the selected 
Organizations with selected information from MicroEdge’s Tax Exempt Organization 
Database. If you do not update all the Organizations on the Tax Status Results window, a 
window is displayed indicating the number of Organizations that have been updated. 
Click View Results to return to the Tax Status Results window. 
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Looking Up Tax Exempt Organizations 

You can look up tax exempt organizations not in GIFTS Online at any time from the 
Organizations folder or while verifying Organizations’ tax status from the Tax Status Verify - 
Summary window. 

Looking Up New Tax Exempt Organizations 

You can look up tax exempt organizations in MicroEdge’s Tax Exempt Organization Database at 
any time. If you choose, you can add these organization to GIFTS Online. 

This feature does not check for duplicate or similar Organizations in GIFTS Online. If you add a 
tax exempt organization using this feature, make sure it is not already in GIFTS Online, or a 
duplicate Organization will be created. 

To look up a new tax exempt organization: 

1. From the main menu, choose Actions > Tax Status Verify. The Look Up Organization Tax 
Data window is displayed. 

 

2. Enter search criteria in the following fields: 

Field Description 

Name The name of the organization. Use the drop-down menu to select 
whether you are entering a whole or partial name. 

City The city where the organization is located. 

State/Province The state or province where the organization is located. 

Postal The postal code of the organization. 
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Tax ID The Tax ID of the organization. 

Source Select the section of MicroEdge’s Tax Exempt Organization Database to 
search, either IRS, Canada Revenue Agency, or both. 

3. Click Search. The Tax Status Lookup - Results window is displayed. 

 

The Tax Status Plus - Search Results window contains the following fields: 

Field Description 

Matching 
Organization 

The organization’s contact information in MicroEdge’s Tax Exempt 
Organization Database. 

Tax ID The Tax ID of the organization in MicroEdge’s Tax Exempt Organization 
Database. 

Public Charity? This field indicates whether or not the organization is a public charity. 

Tax Status The tax status of the organization in MicroEdge’s Tax Exempt Organization 
Database. 

See Details Click Details to view which fields will be added to GIFTS Online. 
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NOTE: GIFTS Online only displays the first 100 organizations found. If you need to refine 
your search criteria, click Refine Search. 

4. Choose from the following options on the Tax Status Lookup - Results window: 

Option Description 

Select All Selects all the organizations. 

Deselect All Clears all the selected organizations. 

Print Prints the displayed information. 

Add Adds the selected organizations to GIFTS Online. Before clicking this 
button, select the check box next to the organizations you want to add. 

To view the details that will be entered into GIFTS Online for the new 
Organization, click Details. 

Close Closes the window. 
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About Watchlists 

This functionality will provide GIFTS Online users with the ability to comply with the “voluntary” 
guidelines set forth by the Treasury Departments’ Office of Foreign Assets Control (OFAC). 

Users will be able to select via preferences the compliance lists to be used for the vetting of 
their organizations and contacts. Based on the compliance lists selected, WatchDOG would 
return any hits and these would be presented to the user for processing. The GIFTS Online user 
would in turn be able to review these “hits” and save information about each, including False 
Positives. Any organization that was researched and shown to be a “False Positive” could then 
be added to a “Whitelist”. Records included in the “Whitelist” would be excluded from future 
verifications until the time when and if any of the information in the white-listed record 
changes. 

Watchlists and GIFTS Activities 

Activity records are created when selected Organizations or Contacts are verified against 
Watchlists. When hits are found, the Due Date is set to 5 days from the current date. Users can 
search for, open, and update these Activities manually as they can for any other History Activity. 

  

Watchlist Setup and Configuration 

A new “Execute Watchlist” permission has been added to GIFTS Online, and initially granted only 
to the Grants Manager role.  

If a user’s role does not include this permission, the menu options referenced in this document 
will be hidden in the ribbon menu, effectively hiding those features from the user. 

NOTE:  The process creates an Activity record whenever a ‘hit’ is found on a Watchlist for an 
Organization or Contact records.  

Watchlist Preferences 

When a user decides to verify Organizations and Contacts against the Watchlists, there are 
several options that come into play, like which specific Watchlists to search, whether or not to 
also search certain related records, and what values need to be matched to be considered a 
‘hit’. 

These settings are accessed in the Manage Watchlists form by going to Admin > Manage 
Watchlists. 
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Prompt Description 

Lists   

Threshold To indicate a threshold value, enter a number (only .75-1.00 
allowed). The default threshold is set to .85. 

Lists To select a list for inclusion, click the check box next to the list name. 
Default Search Lists are: OFAC, BIS, OSFI, UNSL, FBI, Interpol, TEL 

Organization Search Options 

Match Organizations on Organizations will automatically be matched by Name, AKA, and 
Legal Name, so this option is checked and disabled. The client can 
choose also to match on City, State and Country. 

Note that in this and all cases, if the source field in GIFTS Online is 
blank, this is considered a positive match. 

For instance, if the Organization has City and State but no Country, 
and City and State match, the match is considered positive. But if the 
Organization does have a Country and it is different from the value 
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on the watchlist, the match is negative.) 

Include Parents and 
Subsidiaries 

If this flag is checked (which it is by default) not only will the selected 
Organization be searched, but also any other Organization related to 
it as either a Parent or Subsidiary. 

Included related Contacts The client can also choose to search related Contacts when they 
search the Organization.  

The client can choose by Role: 

Primary Contacts – the Contact related through the Organization's 
Primary Contact 

Employees – Contacts related to the Organization through an 
Affiliation record with a Contact 

Request Primary Contact – an indirect relationship using the 
Request's Primary Contact 

All Affiliated Contacts – since this option incorporates the three 
above, if this is checked, the above three prompts should be checked 
and disabled. Subsequently unchecking this option enables the other 
prompts and leaves them checked. 

Include ‘Closed’ Affiliations – if false, then only Affiliations with an 
empty or null To date will be included when evaluating the above 
relationships. If true, then all Affiliations will be considered. 

Defaults: Primary Contacts and Employees default to true; the rest of 
the options to false 

Match related Contacts on If the client is including any Contacts, they will automatically be 
matched on First Name and Last Name. 

Additional options allow the matching process to include Social 
Security Number and/or Birth Date. 

With Birth Date, the value will be considered a match if the value in 
the watch list is up to ‘x’ years earlier or a year later. (For example, if 
the value in the database is 6/1/1975 and the default value is left at 
1, then any date between 6/1/1974 and 6/1/1976 would be 
considered a match.) 

Contact Search Options   

Match Contacts on Same as described above for “Match related Contacts on”. 

Include Related 
Organizations 

The client has the option of choosing the Contact’s Primary 
Organization or All affiliated Contacts, with the same option to 
include Closed Affiliations as described above. 

Both options are selected by default; the option to include Closed 



GIFTS Online 5.1 User’s Guide 

377 
 

Affiliations defaults to false. 

Match Related 
Organizations on 

Same as the options for “Match Organizations on” described above. 

Command buttons: 

 OK – saves the user’s changes and closes the form 

 Cancel – closes the form without saving the changes. If there are unsaved changes, the 
user will be prompted with the standard dialogue: 

Save changes to Watchlists Preferences? 

Yes/No/Cancel 

Actions 

The available actions for Watchlists are the following: 

 Check Watchlists – Checks the selected Organizations or Contacts (and their related 
records, if desired) against the selected Watchlists, displays any ‘hits’, and gives the user 
the chance to mark them as ‘false positives’ or add their own notes 

 Review Watchlists - displays the results of any prior Watchlists checks for those records 

Both options will be available in the Actions menu of the Organization and Contact edit forms, 
and in the Search Results when the search returns Organization or Contact records. 

  

Check Watchlists 

This process checks the selected Organizations or Contacts against the watchlists selected in 
Preferences and creates special Activity records for each one with the ‘hit’ results. It is then up 
to the GIFTS Online user to review each hit and determine whether it is a true hit (meaning that 
person or institution is indeed on that watchlist) or a ‘false positive’, meaning that although the 
criteria matched the record in the database with one on the watchlist, they are not in fact the 
same. 

When the user clicks the Check Watchlist action, they are first asked to confirm their intentions: 
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If they click Yes, the process will run, and should be tracked by a progress bar. The system will 
evaluate each record (Organization or Contact) against each Watchlist selected in Preferences 
and do the following: 

 An Activity will be created for each Organization and Contact checked: 
o If there are no hits, the Activity will be created with a status of ‘Done’. 
o If there are new hits, the Activity will be created with a status of’ Open unless the 

Organization or Contact was previously marked as a false positive. In that case, the 
Activity is marked as done, with the text “Hits found. Marked false positive. See 
Long Notes.” in the Notes field. 

  

Check Watchlists - Summary 

At the conclusion of the process, the Check Watchlists – Summary form will display: 

 

Note that at this point the Activities have already been created and saved, and that the detail 
for Hits is displayed by default, and the detail for Non-hits is collapsed by default. 

Column Description 

Checkboxes Used to select individual records for the Printer-friendly version of the report or 
the More details option 

# of Hits The number of lists that returned occurrences of the Organization or Contact. 

Name The Name is the Organization Name value or the Contact Name (Last, First, 
Middle). 

Relationship The Relationship is the Contact Role for the Affiliation (joining the Contact to the 
Organization), if the related record for Primary Contact or Employee is selected. If 
Parent/Subsidiary is selected as an additional record it will display Parent or 
Subsidiary accordingly. 
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Note that in the case of Contacts, it is likely that more than one Affiliation will meet 
the criteria. The Role displayed should be the first one encountered: Primary 
Contact, then Employee, then the Role for any other Affiliations. 

ID ID is the Organization or Contact ID. 

The information in the tables is organized first by the record type being verified: each 
Organization or Contact included in the set is listed alphabetically. 

Any related records are presented as a subset beneath each main record.  

Note that in some cases, the related record may include a hit while the main record does not. In 
this case, the main record will be included for context even if it doesn’t ‘belong’ in that category. 

Two options will appear below the grid: 

 Printer-Friendly – see Printer-friendly. 

 Verify hits – see Check Watchlists - Verify Hits. 
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Check Watchlists - Verify Hits 

The watchlists check process retrieves much more detail than can be easily presented in the grid 
on the summary page. This link will open a popup that will provide these details only for the 
selected records in the grid, and provides the UI for the user to mark the hit as a false positive 
and/or add any notes to be appended to the Activity records. 

The selected records will open as a ‘batch’ – each page in the batch will display the details for a 
single record. Selected records with zero hits will be excluded from the batch. 

 

 Header – Organization Name or Contact Full Name ({record ID}) in GIFTS Online. 

 Activity Notes – a text box where the user can enter the text that will be appended to the 
Activity Notes about this hit, preceded by a carriage return. Existing Notes – either 
system- or user- defined – will not display and cannot be modified through this UI. If 
necessary, the text will be truncated to due to the field’s 255 character limit. 

 False positive – a checkbox, indicating that the hits do not concern the person or 
institution represented by the record in GO. In the database, this is represented by 
specifying a Done Date and Done User in the Activity record. Once this flag is enabled and 
saved, it cannot be unchecked from this interface, only directly from the Activity record 
(by marking the Activity as not done.) Records marked in this way add the entity to a 
“White List”, exempting it from future ‘hits’. 

 List – a list box listing the name of each watchlist returning a hit. Clicking on a list in the 
box populates the panel on the right with the specific information for that list. The first or 
only list is highlighted by default. 

 List info – the panel on the right lists the information gathered from the watchlist. Each 
data element will be preceded by its label name and a colon. Following this information 
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will be a grid of the Contact or Organization’s addresses, if any. (If there are no addresses, 
the grid should still display, just without any data in it.) 

Label Comments 

List Name of the list 

Entity # Value from the watch list uniquely IDing the entity matched. 

Name Value of the Organization or Contact Name 

Score Value that specifies the max match score of the entity 

Programs Text identifier for a list. An example they give is “Specially Designated 
national Terrorist” (sic). 

Remarks Data typically found here includes; DOB, Place of Birth and Citizenship. 

Aliases Any aliases 

 Navigation – navigation should mimic the navigation used in the edit form ‘batch open’, 
with a display of the current record and the number of records in the set, and Next and 
Previous controls. Each ‘page’ is associated with an Activity record, so the same feature 
to ask the user to save their changes when they click Next or Previous should be included 
as on the edit forms. 

 Printer-friendly – The printer friendly mode will generate an HTML version of the data 
grid. 

 Save – saves any change to the current Activity record but does not close the form 
Updates. 

o If the user has checked the “False positive” checkbox, the Activity will be updated 
with a Done Date of the current date and a Done User of the current user 

o If the user added any Notes, these will be appended, preceded by a carriage 
return, to the existing Notes supplied by the system. Since Notes has a 255 
character limit, the text defined here will be truncated if necessary. (No messages 
or warnings.) 

 Save & Close button – saves any change to the current and closes the form, returning the 
user to the Check Watchlists – Summary form. 
At this point, if any of the records have been marked as false positives, they should be 
moved from the open to the not open section, and the totals and grids updated 
appropriately. 

 Cancel – closes the form without saving any changes to the current Activity. The standard 
messaging will be included: 
Save changes to Watchlists Activity? 

Yes/No 
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Review Watchlists - Summary 

 

This process is mostly the same as the process for checking Watchlists in the first place, but 
instead of performing a new check and creating Activity records, it simply retrieves the Activities 
from the most recent check – in other words, the Watchlist Activity record with the most recent 
Create Date (any earlier Activities are ignored). 

 

The summary is very similar to the Check Watchlists – Summary, with the following exceptions. 

 Form title: Review Watchlists – Summary 

 Summary text: {#} {Organization(s) or Contact(s)} selected.  
Note that this is the number of selected Organizations or Contacts in the Search Results 
or Related Records grids. 

 Open summary: Hits are open or checks were not performed for # Organization and # 
Contact records.  
This section reflects not only the selected records, but any related records as determined 
by the Watchlists Preferences. 
If any record in the batch is not associated with any Watchlist Activity record, it is 
included in this category – we consider it open because we don’t know whether there are 
hits or not since it hasn’t been checked. (Note that the user cannot take any action on 
that from here.) 

 Not Open Summary: No hits are open for # Organization and # Contact records. 
This category includes all records where the most recent Watchlist Activity. 

 Grid columns: The grid in this view will include two additional columns: Last checked and 
Closed by. Last checked is the Create Date of the Activity record. Closed by is the Done 
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User ID of the Activity record. Note that a record that has never been checked will have 
no value in this column. 

Verify Hits and Printer-friendly version will function exactly as they do for the Check Watchlists 
process, with the exception that when the user closes the popups, they are returned here to the 
Review Watchlists Summary. 
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Working with Grantees Online 

NOTE: This help topic describes features found in the optional Online Applications and 
Requirements Module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

Online Applications and Requirements allows you to manage your entire grantmaking workflow 
online.  

This includes configuring your site preferences, creating application and requirement forms, 
visual elements on pages viewed by grantees, editing correspondence, and allowing grant 
seekers and your grantees to submit proposals and reports online. 

 Grant applicants can submit proposals to you electronically by completing an online 
application form. Applications that meet your preliminary requirements can be brought 
directly to GIFTS Online as pending Requests— without further data entry by your staff. 

 That kicks off your workflow. Later, grantees you've decided to fund can go online to 
submit reports and other information you've required. This information is submitted 
using an online form, and the Requirement record in GIFTS Online can be directly 
updated with the grantee's submission. 

Using GIFTS Online's online grant application features, you can: 

 Preview your online application forms. 

 Retrieve proposals submitted by online grant seekers. 

 Review the pending applications you've received. 

 Make decisions on whether to consider each proposal further. 

 Generate stage 2 applications for grant seekers whose first-stage submissions garnered 
your interest. 

 View historical applications, including ones you've rejected without creating a Request. 

To work with submitted applications and online grantee reports, it may help to understand 
these two process from the grantees' perspective. Click here to learn about application 
processes; an overview of online grantee reporting is here. 

  

Topics in this section: 

 Setting Site Preferences 

 Using the Forms Manager 

 Designing Online Forms 

 Retrieving Applications and Requirements 

 Processing Application Decisions 

 Publishing Online Requirements 

 Generating Reports 

 Managing Grantees 

 The Grantee Perspective 

 Online Grantee Collaboration 
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About Online Application Processes 

NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

Online grant application forms are set up for you as part of your initial GIFTS Online 
implementation. This form (or forms) capture the data most important to decision-making in 
your particular workflow. 

To place this in context, let's look at broad outlines of the two possible application processes 
you and grant seekers will work together to complete: a single-stage application process, or a 
two-stage application process. 

  

Single-Stage Application Process 

With a single-stage application process, your online form is designed to gather all needed 
information at once. You base your decision to fund using that information: 

1. The grant-seeking applicant accesses, fills out, and submits an online application. 
2. You retrieve the application (and any attached documents) to the Pending Applications 

staging area. 
3. You make an initial decision whether to look deeper into funding the project; you can 

reject the application or consider it, which creates a pending Request in GIFTS Online. 

You then move the new pending Request through your decision-making workflow. 

  

Two-Stage Application Process 

In a successful two-stage application process, the online grant seeker must fill out two different 
online forms. In the first stage application, the grant seeker enters enough information for you 
to decide whether you want to review the whole proposal. If you do, you can then ask the 
applicant to fill out the second, usually longer, application. 

1. The grant-seeking applicant accesses, fills out, and submits a first-stage online 
application. 

2. You retrieve the application (and any attached documents) to the Pending Applications 
staging area. 

3. You make an initial decision whether to look deeper into the project; you can reject the 
application or consider it, which creates a pending Request in GIFTS Online. 

4. You and other GIFTS Online users review the Request and decide whether or not to ask 
the applicant to provide fuller details on the proposal. If so, you then generate the stage 2 
application. 

5. At the same time, you can generate an email to notify the applicant. He or she can then 
log back in, complete, and submit the second-stage form. 

6. As before, you retrieve the application and either reject it or consider it. 
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 If you consider it, the existing Request is updated with the additional information 
from the stage 2 application. 

 If you reject it, that pending Request is automatically declined. 

Now with full details on the proposal, you can review and then approve or decline the Request. 

  

Generating Stage 2 Applications 

NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

A two-stage application process requires that an applicant fill out two online forms. The first-
stage application, if considered, creates a pending Request in GIFTS Online.  

If you want to hear more about the proposal in a second-stage application, you want to make 
sure that it's linked to the existing Request record. For that reason, generating the stage 2 
application begins from the selected proposal's Request edit form. 

1. Search for or navigate to the proposal's Request edit form. 
2. In the Actions menu, click Generate Stage 2 Application. The stage 2 form is now 

published to the applicant. 
3. You have the option to generate an email for the grant seeker, letting him or her know 

they can log in and complete the second stage of the proposal. 

About Online Grantee Reporting/Requirements 

NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

In GIFTS Online, reports and other obligations a grantee must fulfill as conditions of a grant are 
captured in Requirements. For example, your grant agreement may call for interim reports 
quarterly during a year-long project. You could add four Requirements, enter Progress Report as 
each one's type, and set their due dates according to the schedule. 

With GIFTS Online, however, you can complete the process online. Rather than update 
Requirements yourself, you can "publish" them to the grantees - that is, post them as online 
forms - and have grantees complete and submit these forms to fulfill their requirements online. 

Once retrieved, they will automatically update the Requirements. You can review the 
information they've provided and mark the Requirement done if their efforts are satisfactory. 

You can update these Requirements yourself if grantees submit information offline or via email. 

A broad outline of the online grantee reporting process follows: 

1. During initial setup of your GIFTS Online implementation, online Requirement forms 
fitting your needs are built. 

2. You will add Requirements to pending or approved Requests, specifying type, due date, 
and other key data.. For example, you might add a Grant Requirement calling for a 
Progress Report, due six months after the Project Start Date. 
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3. You publish the Requirement to the grantee. That is, you generate an online form which 
the grantee can log in and fill out. (It doesn't matter if the proposal originated offline - 
you can create an online account for a grantee if need be.) 

4. The grantee logs in, completes the form, attaches any required documents, and submits 
it. 

5. You retrieve their submissions and review the update Requirement records, then mark 
each done (or not). 

  

The Forms Manager 

The Forms Manager replaces the old View Forms action in GIFTS Online and can be accessed via 
Launch>Applications>Forms Manager. 

The Forms Manager page keeps a listing of available Active, Inactive, and Archived Application 
and Requirements forms. 

From this page, you are allowed to create new forms, edit existing forms, delete existing forms, 
or restore archived forms. 

 

The left panel allows the user to select which form category to display in the main listing area. 

Active Forms 
Clicking the Active button for Applications or Requirements will display a list of forms currently 
active for applicants to use. The only actions available for active forms are to Save a Copy, 
Deactivate, or Export the list. 

Inactive Forms 
Clicking the Inactive button for Applications or Requirements will display a list of inactive forms. 
The actions available for inactive forms include Open, Edit Properties, Save a Copy, Delete, 
Preview, Activate, or Export the list. 
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Archived Forms 
Clicking the Archived button for Applications or Requirements will display a list of forms that 
have been deleted from the Inactive list. The only actions available for active forms are to Save a 
Copy, Export the list, or Restore to the Inactive list. 

  

The Ribbon Menus 

There are three ribbon menus in the Forms Menu. 

 The New Menu 

 The Actions Menu 

 The Settings Menu 

  

Forms Manager: New Menu 

The options in the New menu of the Forms Manager are always the same no matter what type 
of form is currently selected. 

NOTE: There are no batch actions available. All actions shown are available only with a single 
selected record. 

New   

Application Form Opens Form Properties for editing. Upon setting form properties, 
the Form Designer displays for the new Application Form. 

Requirement Form Opens Form Properties for editing. Upon setting form properties, 
the Form Designer displays for the new Requirement Form. 

  

Forms Manager: Actions Menu 

NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

The Actions menu in the Forms Manager displays various options available to the user 
depending on the status of the form currently selected. 
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With no forms selected: 

Export 
This will export a list of the forms currently in the forms manager to an Excel spreadsheet.  

 

Option Description 

Title Adds a title to the top of the spreadsheet 

Include Column 
Headings 

Uncheck this box if you do not want column headings in the spreadsheet 

Export values 
without formatting 

  

Export Application 
Forms 

Defaults to the list currently displayed. You may choose to add Active, 
Inactive, and/or Archived. 

Export 
Requirements 
Forms 

Defaults to the list currently displayed. You may choose to add Active, 
Inactive, and/or Archived. 

  

With an Active form selected: 

Save a Copy 
This option will copy the selected form and allow you to save it under a new name in the 
Inactive list. This can be helpful for creating new forms which are very similar to existing forms 
and only require minimal modifications. 

View URL 
This option will only be available for Single and Stage 1 Application forms. 

This option displays the URL for the active form currently selected. 
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You may click on the link to go directly to the form and begin an application, or choose Copy to 
Clipboard to copy the link for use in another location such as a company webpage or document. 

Deactivate 
Clicking this option will automatically deactivate the form currently selected.  

IMPORTANT: There is no confirmation prompt for this action. The form is immediately 
deactivated. 

To deactivate a currently active form, do the following: 

1. Select the desired active form. 
2. Go to Actions > Deactivate. 
3. The system will advise you if there are any in-progress applications/requirements using 

the form and ask if you would like to allow them to be submitted. 

 

Click Yes or No as desired. Clicking Cancel will abort the deactivation process. 

4. Clicking No will display the default message the applicant will receive about the form 
being unavailable. The message can be edited directly here, if necessary. 

 

Click OK. 

5. A message will display stating that the form has been successfully deactivated. Click OK. 

Export 
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Clicking this option will export the current forms list to an Excel Spreadsheet. See above for 
more details. 

  

With an Inactive form selected: 

Open 
This option will open the currently selected inactive form in the Form Designer. 

Edit Properties 
This option will open the Edit Properties form. 

 

Option Description 

Title Required field. The form title appears in the browser’s tab at the top of 
the online form and on the Printer Friendly Version of the form. 

Description You may choose to write a basic description for the form, which will not 
be visible to applicants/grantees but will be used to identify the form in 
the Forms Manager. 

Suppress 
Organization fields 
from application 
forms 

If you are designing an application to be used by individuals rather than 
organizations, you should select this option.  

You have two options for handling applications from individuals: 

Use Contact Name to create Organization Record 

If you select this option, GIFTS will create a new Organization record for 
each applicant, and use the applicant’s name (Last, First Middle) as the 
Organization name. 
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Note: Each Organization created will have the same address as the 

Primary Contact. 

Attach applications to “Individuals” Organization 

This option will automatically associate all applications with a dummy 
Organization. To setup a dummy organization, please contact MicroEdge 
Professional Services. services@microedge.com 

Require Password To require applicants to enter a password, check this option and enter a 
password in the Password field below. The password must be 5-25 
characters, in any combination of alphanumeric characters, with no 
spaces. 

Require Account 
Login 

Applicants are required by default to sign in or create a user account 
before completing a single-stage application form. If you don’t want to 
require this of your applicants, uncheck this box. 

Populate Organization and Contact data from last submission. 

Check this option to populate a returning applicant’s application with 
Organization and Contact data from his or her last submission. You must 
first select Require Account Login to activate this field. 

Require applicants 
to enter a U.S. Tax 
ID 

If your application should be available only to applicants who can provide 
a Tax ID, check this option. 

The system can also check the Tax ID entered by potential applicants 
against the databases of qualified non-profit organizations maintained by 
the IRS and Canada Revenue Agency. 

Require Tax ID to be on file in the IRS database. 

If you will only accept applications from applicants whose Tax ID appears 
in the IRS or Canada Revenue Agency database, check this option. 

NOTE: If you require applicants to provide a Tax ID, the data received 
from the IRS database will pre-populate the Name, Legal Name, AKA, Tax 
Notes, and Tax Status fields on the application form, if you have chosen to 
include them. 

Site Required field. Defaults to the client's site.  

If you have Multi-SIDs enabled for your IGAM installation, this dropdown 
will provide you with a list of the Site IDs available to be assigned to this 
application form. 

CAUTION: Once you Activate a form, the Site ID cannot be changed. If you 
need an activated form assigned to another Site ID, you must use the 
Save a Copy menu option. This will create an inactive copy of the form 
and allow you to assign it to another Site ID. 

Stage Here you must indicate whether this is a single-stage form, a first-stage 

mailto:services@microedge.com?subject=GIFTS%20Online%20Inquiry
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form, or a second-stage form. This field does not display for requirement 
forms. 

Associated Stage  If you are creating a second-stage form, you must indicate which first-
stage form it should be associated with. This field does not display for 
requirement forms. 

TIP: You may associate more than one second-stage application with any 
first-stage application. Once you have reviewed the first-stage application, 
you may choose which of the associated second-stage forms you will ask 
the applicant to complete. 

Branch This option is visible if you have the optional Branch Security feature.  

The branch that you select will be assigned to applications that are 
submitted using this form.  

In IGAM, users will only be allowed to access forms for which they have at 
least view-only permissions.  

When a Request is created from an application, the branch to which the 
Request is assigned depends on the branch security model you are using. 

The two models are Decentralized data entry and Centralized data entry.  

❖ If you are using Decentralized branch security, the Request is assigned 
to the branch of the user who considers (or rejects, if Requests are 
created for rejected applications) the application.  

❖ If you are using Centralized branch security, the Request is assigned to 
the branch that you have specified here. Note: This field does not display 
for requirement forms. 

Spell Check 
Language 

Defaults to English(United States).  

You may change this to one of several options available: 

 English (United States) 

 English (United Kingdom) 

 English (Canada) 

 English (Australia) 

 French 

 Spanish 

Deactivation Date 
Set a date for the form to deactivate. Clicking in this field will open a 
calendar for you to select a date. 

Deactivation Time Set a time for the form to be deactivated from the menu options. 

Disabled if no deactivation date is set. 

Allow submission of Check this box to allow in-progress applications to still be submitted after 
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open applications the form has been deactivated. 

Disabled if no deactivation date is set. 

Deactivation 
Message 

In this field, you may change the message displayed to applicants when 
they attempt to access a deactivated form. 

Disabled if no deactivation date is set. 

Save a Copy 
This option will copy the selected form and allow you to save it under a new name in the 
Inactive list. This can be helpful for creating new forms which are very similar to existing forms 
and only require minimal modifications. 

Delete 
Clicking this option will delete the selected form and move it to the Archived folder. You will be 
prompted for confirmation. 

NOTE: Deleted forms in the Archived folder can be restored to the Inactive folder at a later time, 
if necessary. 

Previewing Application Forms 
NOTE: In order to preview your form, you must have an open connection to the Internet. 

This option opens the form in Preview mode. Previewing the form will give you a sense of the 
applicant's online experience.  

Please note, in Preview mode any field set to pre-populated with a value from GIFTS Online or a 
Stage 1 form will be blank. 

Activate 
This option will activate the currently selected inactive form. 

The activation prompt will provide you with the active form's URL which can be copied to other 
web pages or documents as needed. 

 

Export 
Clicking this option will export the current forms list to an Excel Spreadsheet. See above for 
more details. 
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With an Archived form selected: 

Save a Copy 
This option will copy the selected form and allow you to save it under a new name in the 
Inactive list. This can be helpful for creating new forms which are very similar to existing forms 
and only require minimal modifications. 

Export 
Clicking this option will export the current forms list to an Excel Spreadsheet. See above for 
more details. 

Restore 
To restore a currently archived form, do the following: 

1. Select the desired archived form. 
2. Go to Actions > Restore. 
3. At the confirmation prompt, click OK. 
4. At the successfully restored prompt, click OK. 

  

Forms Manager: Settings Menu 

The options in the Settings menu of the Forms Manager are always the same no matter what 
type of form is currently selected. 

Account Designer 

The Account Designer is used for changing the default settings and design for the Grant Request 
Login page, My Account page, and any new Application or Requirement forms created. 

NOTE: Design options selected in individual forms will take precedence over the default settings 
in the Account Designer. 

 

For more information, please refer to the Account Designer section. 
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View My Account URL 

This menu option displays the URL to the current user's specific My Account page. 

If you are using Multi-SIDs, you will be prompted to select a Site ID before displaying the URL. 

 

You may click on the link to go directly to the login page, or choose Copy to Clipboard to copy 
the link for use in another location such as a company webpage or document. 

  

The Account Designer 

The Account Designer is used for changing the default settings and design for the Grant Request 
Login page, My Account pages, and any new Application or Requirement forms created. 

It is also where many of your site preferences are set. 

TIP: It is recommended when working with the Account Designer to maximize your browser 
window. 

Accessing the Account Designer 

The Account Designer can be accessed from the Forms Manager via the Settings>Account 
Designer menu option. 

The Account Designer is divided into 3 panels. 

Left Panel: The left side panel displays various configuration options depending on the current 
Setting menu selection. 

Center Panel: The center or main panel serves as a WYSIWYG preview for the Login, Account, 
and Forms tabs. 

Right Panel: The right panel is initially collapsed by default and not shown. Its purpose is to 
display additional property settings when specific Links or Messages are selected on the left 
panel. If not in use, the panel can be hidden by clicking the Show/Hide arrow in the lower right. 

Command buttons 

All tabs will have Save, Save & Close, and Cancel buttons so that you can save your changes as 
your work on modifications. 
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The Login Tab 

This tab displays what the Login page will look like to applicants. 
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The Account Tab 

This tab displays what the My Account pages will look like to applicants. 
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The Form Tab 

This tab displays the default settings and design for all NEW Application or Requirement forms. 

NOTE: The design settings for each form can be modified using the Form Designer and will take 
precedence over the default settings shown here.  

 

  

Account Designer Settings: Properties 

This option displays general site Properties, Timeout Settings, and Security Settings. 

Properties:   

Site Name 'Default' is the default setting here. You may change it if desired. 

Allow HTML in forms Select this checkbox if you want to allow HTML code to be used 
in online forms. If this option is selected, HTML text will display as 
active links on forms. If the option is cleared, any HTML text on a 
form will display as regular text.  

NOTE: If this option is turned on after forms have already been 
created, the new preference will not be applied to existing forms 
until they are opened and saved again. 

Allow applicants and Required to enable Application and Requirement collaboration. 
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grantees to email drafts and 
submissions 

Allow applicants and 
grantees to transfer drafts 
and submissions 

Required to enable Application and Requirement collaboration. 

Allow applicants and 
grantees to manage viewers 

Required to enable Application and Requirement collaboration. 

Timeout Settings:   

Enable Timeout Checking this box enables the Timeout Settings features. 

Idle Minutes This is the amount time that must elapse without the applicant 
posting data to the server before the Idle Warning Text is 
displayed. 

Idle Warning Text This is the text displayed to the applicant along with the option to 
Continue or Exit. 

Timeout Minutes This is the amount of time that must elapse without the applicant 
posting data to the server or clicking Continue on the Idle 
Warning prompt before the system logs out of the account and 
displays the Timeout Text. 

Timeout Text This is the text displayed to the applicant after the session has 
been terminated. 

Security Settings: All passwords in GIFTS Online are case sensitive and a more 
stringent password policy will be enforced when applicants 
create passwords (either on first login, or after a password 
reset).  

Require Security Questions If checked, applicants will be required to answer three questions 
that will validate the account holder identity prior to sending a 
temporary password, either upon account creation or when a 
password is forgotten (which will also unlock the account). Upon 
account creation, applicants will be required to select questions 
and provide answers so that they may unlock their account if it 
becomes locked due to unsuccessful attempts. 

See How Security Questions Work below for more details. 

Passwords:   

Unsuccessful Attempts This will determine the number of password attempts available 
to an account holder until the account is locked out.  

See Account Lockout below for more details. 
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Minimum Length This will determine the minimum password length. This number 
must be between 5 and 25. 

Reuse After Entries This will determine how many times the password must be 
changed before it can be reused. 

Maximum Age (days) This is the number of days before a password will expire. 

 

How the Timeout Settings Work: 

The Idle Minutes is required to be less than the Timeout Minutes. Default times respectively are 
15 & 20 minutes. These fields cannot be set to zero. 

Example: Idle Time = 15 minutes, Timeout Time = 20 minutes 

This allows the applicant 5 minutes to see the Idle Warning and take action before the session is 
terminated. 

When the Idle Minutes time is reached, a prompt is displayed containing the Idle Warning Text 
and the option to Continue or Exit. 

 If Continue is selected, the timeout counter will be reset to zero and begin counting up 
again. 

 If Exit is selected, the session will be disconnected and the applicant will be taken to the 
login screen. 

 If no action is taken by the applicant, the system will continue to count up until it reaches 
the Timeout Minutes set and then display the Timeout Warning. Clicking OK will take the 
applicant to the account login page. 

Typing inside fields on the application does not reset the idle timer. In order to reset the idle 
timer, an action must be taken that saves data to the server. 

Actions that cause current data to be saved to the IGAM server include: 

 Going to a different page of the application using Next/Continue links, Page Number or 
Page Title links/tabs, or Chevron Progress Bar links. 

 Clicking Save & Finish Later. 

 Uploading Attachments. 

How Security Questions Work 

Once the option to require Security Questions has been enabled, existing accounts will be forced 
to enter answers to security questions at their next login. 

When an applicant attempts to login for the first time after the security settings have been 
changed the following will occur: 

 The applicant will be brought to the Change Password page and must enter a new 
password. The new password requirements will be applied. 

 If no security question responses have been previously provided, the applicant will be 
brought to the Security Questions page. 
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There are six sets of questions and answers that must be answered by the applicant. 

In the case of a forgotten password, the applicant will need to answer three of these questions 
to get their password reset. 

Once provided, the applicant will be directed to the page that required login. 

Account Lockout 

This enhancement tracks the number of unsuccessful attempts and prevents access to the 
account after the specified number of unsuccessful attempts. 

Once locked, the account may only be unlocked by resetting the password or if the applicant 
answers three security questions correctly. 

 If an applicant answers the three security questions correctly, the applicant will be sent a 
temporary password. 

 If the applicant cannot answer security questions correctly, the applicant must contact 
the Grants Manager to reset the password for the applicant's account email using the 
Reset Grantee Password option on the Online Applications menu. 
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Account Designer Settings: Links 

This option displays the list of all the various links and buttons available on the Online 
Applications pages. 

To see the available settings for each link/button, simply click on it in the left panel list. The 
settings available for that specific link/button will be displayed on the right side panel. 

NOTE: The order of the first four links (Contact Us, Help, Sample Documents, and Exit) can be 
reordered by dragging and dropping. They will then appear on applicant’s pages in the same 
order. 

The example below shows the settings for the Exit link on the right panel. 

 

The settings available for each link will vary depending on one selected. The table below 
describes the options which may be displayed. 

Setting Description 

Display 
Label 

This is the text displayed on the site page or form. 

Style If available, allows you to select between a Link or Button display. 

Link to For links that require a URL or Email address. 

Position Select the position for the link. Left, Right, or Standard. 

Duplicate to 
Top 

By default some links are only displayed on the footer area. Checking this box 
will also place the link in the header area. 
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Account Designer Settings: Emails 

This menu option displays the settings for automated emails sent by Online Applications. 

 

The left panel displays a list of all the email types. Simply click one of the email types to view its 
settings and default subject/body text. 

The From Display Name and ‘Reply To’ Email Address can be set here for each one of the 
emails. 

Clicking in the Subject or Body fields of any email will display available merge fields on the right 
side panel. 

To add a merge field, place the cursor in the location you want the merge field to appear and 
then double-click it on the right panel list. 

Requirement Retrieval Notification 

This email notification is sent to the staff owner when a Requirement they are assigned to is 
retrieved. 

The option can be enabled by selecting the Requirement Retrieval Notification email type and 
unchecking the Do not send notification checkbox. 

By default this option will be checked, meaning no email notification is sent. 
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Account Designer Settings: Design 

This menu option displays the settings responsible for much of the layout aspects of the site 
pages and forms. 

The Design tab of the Design Wizard allows you to manipulate the layout, colors, and text 
properties of your My Accounts and Application pages. 

These settings will also become the default settings for all new application and requirement 
forms created in the Form Design Wizard. 

 

The left panel is divided into four sections as described in the table below: 

Layout   

Horizontal Accent This default layout option consists of a colored header, a differently 
colored body area, and a menu bar separating the two. 

Vertical Accent This layout option will create an application/online requirement with a 
solid background color and an accent bar along the left-hand side. 

Graphical Background This layout option retains the menu bar, but the header and body 
areas are populated by a graphic of your choosing. In the center of the 
body area is a white area where your application/online requirement 
form prompts will appear. Uploading graphic files is discussed in the 
Graphics section. 

Include Content Frame Checking this box creates a frame around your entire form page. Note: 
In IE 9 or later and Firefox, this frame has a shadow effect. 
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Page Span This dropdown menu controls how your IGAM pages make use of 
onscreen space.  

Entire Page - forms will take up all the space available in the current 
window.  

Left, fixed width - forms will align to the left of the screen and be 
limited to the Page Width setting.  

Center, fixed width - forms will center on the current window and be 
limited to the Page Width setting. 

Page width This setting is only available if Page Span is set to Left or Center. The 
minimum setting is 1000 pixels. Entries less than 1000 will default 
back to 1000 pixels. 

HTML Please review the Custom HTML section for more details. 

Header Click Browse to add your own custom HTML to the area indicated. 

Footer Click Browse to add your own custom HTML to the area indicated. 

Left Panel Click Browse to add your own custom HTML to the area indicated. 

Right Panel Click Browse to add your own custom HTML to the area indicated. 

Colors See the Selecting Colors section for more details. 

Header Background   

Body Background   

Search Background   

Active Tab Background   

Inactive Tab 
Background 

  

Accent Bar   

Button Color   

Required Field Icon   

Icon Select an icon to display next to all required fields on your 
application/online requirement using the dropdown menu.  

Icon Color You may also choose the color of the icon. 

Apply   
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Selecting Colors 

CAUTION: You must to consider that changes made in Design panel will take immediate effect 
on the My Account and Account Login pages when you Apply. Care must be taken to avoid 
publishing HTML files that do not render correctly. 

In this section, you can override the system default settings for the colors on the 
application/online requirement.  

 

To select a new color, you may do any of the following: 

 Click one of the preset colors in the palette to the right. 

 Enter the desired color's hex value in the # field at the bottom. 

 Adjust the HSV and RGB values manually. 

 Move the color slide up or down as desired. 

 Or drag the small white circle around the left side color field. 

Click OK when ready to proceed. 

Some considerations regarding colors: 
❖ The column header color on the My Account page is controlled by the Accent Bar color. 

❖ If you have selected the Graphical Background layout option, the Header Background and 
Body Background fields will be disabled since the entire background (header and body) will 
consist of an imported graphic. 

❖ If you have chosen the Vertical Accent layout option, the Header Background color will be 
unavailable because the layout does not include a header. 

  

Custom HTML 

The Account Designer allows the use of HTML files to add custom header, footer, and side 
panels to your webpages and forms. This allows integration of your website elements into the 
IGAM webpages and forms to produce a seamless transition for your applicants. 

CAUTION: You must to consider that changes made in Design panels will take immediate effect 
on the My Account and Account Login pages when you Apply. Care must be taken to avoid 
publishing HTML files that do not render correctly. 

If you do not have a test environment with a test SID, there are two options: 
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❖ Remove any external facing links to My Account/Account Login, or links to published 
Applications that require account login/creation (disable forms), so that applicants do not see 
these pages while being edited. 

❖ Acquire a test configuration/test SID that will allow previewing and testing of all IGAM 
elements prior to publishing and making visible to applicants. 

NOTE: Existing forms will not display custom headers, footers or side panels unless edited, 
regardless of global settings. 

Any custom HTML header, footer and side panels defined in the Account Designer will become 
the default header, footer and side panel for My Account and Account Login pages as well as 
new Forms unless different files are specified in the Form Design Wizard. 

Since the custom header will replace the logo displayed, the presence of a custom HTML header 
file will disable the Logo, Logo Alignment and Logo Rollover Text fields. 

Creating an HTML Zip File 
The .html files and images (.gif or .jpg) must be contained in a .zip file for uploading. Each 
element (header, footer, left side panel, right side panel) must have its own .zip file. 

NOTE: The zip file must contain only the actual files; not a folder containing the files. 

Browsing for and Selecting a File  
Once a .zip file is selected, or if the path and file are manually entered, the path and file will 
appear below the text entry field and the Add button will become enabled. 

You must click the Add button for the file to be saved to the GIFTS Online server. 

GIFTS Online will validate the contents of each zip file to make sure there is a .html file. 

Image Guidelines  
Images must be in .gif or .jpg format. There are no guidelines regarding the size of the images as 
this will depend on your page width setting and personal website design preferences. 

HTML Files Guidelines  
The .html file for each element must be formatted in a specific way in order for IGAM to 
properly apply it to your webpages and forms. 

IMG tag src attributes in a panel html must look like this: 

<img src='/SID_value/Default.asp?SA=PI&IMAGE=Header\image.gif&IFID=0'/> 

The SID_value is your Site ID number or account (if multi-SID) and image.gif represents the 
filename of your image. 

The IFID must always be 0. 

Sample Header HTML Zip File  
Here is a simple zip file for a header. It contains only the required .html and image file. 

 

The html file contains just the path to the image file as defined above. 

<img src='/SID_1208/Default.asp?SA=PI&IMAGE=Header\USEF-Header1.jpg&IFID=0'/> 

The above HTML path is for Site ID 1208 and is pointing to the image filename USEF-
Header1.jpg. 
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TIP: Simple HTML files can be created very quickly in Windows Notepad by copying the example 
above and substituting your own Site ID and image filename. Then save the file with a .html 
extension. 

Cascading Style Sheet (CSS) Guidelines  
CSS included in a panel html should be formatted as follows: 

<link href="/SID_0001/Default.asp?SA=PI&CSS=Header\styles.css&IFID=0" type="text/css" 
rel="stylesheet" /> 

Instead of an IMAGE parameter, you must specify a CSS parameter. 

Remember to use an IFID parameter of 0. 

All the image references in the css file should then look like this: 

background: transparent url('/SID_0001/Default.asp?SA=PI&IMAGE=Header/image.gif&IFID=0') 
center left repeat-y; 

Here too you must remember to use an IFID parameter of 0. 

TIP: For Footer, Right or Left panel content, substitute ‘Header’ with Right, Left or Footer in the 
above path examples. 

  

Account Designer Settings: Header 

This menu option displays the Logo and Navigation settings. 
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Logo   

Upload Image Click to browse for an image to upload as a logo. 

Remove Image Click to remove the current logo image. 

Image Preview Displays the current logo image. 

Rollover Text Enter text here to be displayed when a user place their mouse over the 
logo. 

Logo Alignment Select the alignment for the logo in the header area. 

Navigation   

Navigation Style Select from Classic number tabs or Chevron style (shown above). 

Use Page Title for 
Navigation 

Checking this box will cause the page titles to be displayed at the top 
instead of page numbers on application/requirement forms. 

  

Account Designer Settings: Text 

This menu option allows you to select the font formatting options for your application and 
online requirements.  

 

Choose an element to edit from the Display Element list.  

You may change the Font, Size (relative or fixed), Alignment, Bold, Italic, and Color. 
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NOTE: Changes made to the Form Title will only be displayed in the Printer Friendly Version of 
the form. 

If you would like to make the selected element bold or italicized, select the appropriate 
checkbox.  

The last setting allows you to select the color of the font for the selected element in the same 
way you selected the colors of the application parts. 

  

Account Designer Settings: Messages 

This menu option displays a list of the system messages which may appear to a 
grantee/applicant. 

During the application process, certain conditions may occur which warrant that information 
and/or an error message to be returned to the applicant or grantee. There is default text 
associated with these messages, but you may choose to customize the messages in order to 
provide your applicants/grantees with more detailed information. 

 

Clicking the message type selects it and displays it’s text on the right side panel. 

The text can then be edited on the right panel and saved by clicking Apply. 
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The Forms Designer 

The Form Designer is GIFTS Online's tool for creating or modifying Application and Requirements 
forms. 

Clients can access their forms directly and change them as needed. 

  

Accessing the Form Designer 

The Form Designer window can be accessed in two ways: 

1. Select the New>Application or New>Requirements option from the Forms Manager. 

2. Select an existing Inactive form and either go to Actions>Open or double-click the form. 

  

Understanding the Form Designer Layout 

The Form Designer consists of 3 main sections: left panel, the middle or main section, and the 
right panel. 

 

 

Panel Description 

Left Panel The Left Panel by default displays a list of the fields available to be added the 
current form. It can also be set to display an outline of the form, or other 
elements. 

More details about changing this display can be found in the menu options 
table. 
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Middle Panel The Main part (middle) is where the form is displayed and can be edited. 

Sections can be added here to group related fields together. 

Tabs on the top of the main section represent different pages in the form. 

Right Panel The Right panel allows the user to edit highlighted field settings. 

Command Buttons 

The form has Save, Save & Close, and Cancel buttons so you can save your changes. 

NOTE: If the current form is active, your changes will not be reflected in any currently in-
progress applications. 

  

Field Selection and Relocating 

Many of the fields in the Form Designer will look similar to the one shown below. 

 

Panel Description 

Edit (gear) This button allows users to edit field properties by opening the right panel 
with associated settings. 

Delete This button allows users to delete a selected field. 

Resize corner 
(lower right) 

Dragging the bottom right corner of the field allows users to resize fields to 
desired size. 

Repositioning 
fields 

You can position fields in desired locations on the form by dragging and 
dropping. 

Help Text If you add Help text to a field, this icon will be displayed next to the field label. 

Spell Check When the spellcheck option is enabled on long text fields, this icon is displayed 
to the right of the field. 
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Forms Designer Menu Options 

The menu is presented in the style of the current GIFTS Online application. 

New   

Page This option adds a new page to the form and displays the page. This 
is presented as a tab in the form designer. 

Upon adding the page, the page is displayed and the page name is 
editable. 

  

The page name and page position – can also be adjusted after the 
section is inserted. 

Double clicking the tab name allows for editing the name. 

Dragging and dropping allows for adjusting page order. 

If more than one page is present, an X icon appears next to the 
page titles. This icon allows the user to remove the entire page. A 
confirmation is presented to you before allowing deletion. On 
hover over the X icon, a tooltip will display “Delete Page”. 

Section A section is a separation of fields that contains its own title and. 
This option adds an empty section to the bottom of the current 
page. This button is disabled if a section is already selected; a 
section cannot exist within another section. 

Actions   

Fields Hides the Outline panel and displays the Fields panel. 

Outline Hides the list of available fields left panel and displays the Outline 
panel. 

Activate/Deactivate Before a form is actually accessed by users, it must be activated. 
Until then, the form is inactive and will not be presented to users 
for data entry. 

The Activate option should be hidden if the form is already active 
and the Deactivate option should be hidden if the form is already 
inactive. 

Settings   

Properties Set various defaults for your new forms such as Title, Description, 
Language, and Authentication requirements here. 

Links Allows the editing of special links on the My Account pages. 

Emails Allows the editing of automated emails for Applications or 
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Requirements. 

Eligibility Allows you to configure the Eligibility Quiz, if enabled, which is 
displayed before the application. 

Attachment Allows the editing of the Attachments page, if enabled. 

Design Allows the editing on various layout aspects such as background, 
accent colors, and tab colors. 

Text Allow the editing of various aspects of text displayed including font, 
size, and color. 

Messages Allows the editing of default system messages such as Invalid 
Password or Successful Submission. 

  

Forms Designer Control Panels 

As discussed earlier, the Forms Designer has control panels on the left and right.  

  

Left Panel: Fields List 

The left panel by default displays a list of the fields available for adding to your form. 

If the panel is currently in Outline mode, you can change to Fields mode by going to 
Actions>Fields in the ribbon menu. 

  

The fields displayed are based on the category selected in the top menu. 

Field Type Category Menu 

Selecting a record type filters the list of available fields by that record type. Record types 
available are: 

 Organization 

 Organization Primary Contact 

 Request 

 Request Primary Contact 

 Text 

 Add Additional Contact 

Find search box 

Typing in this field filters the list of available fields by the entered text. If the field contains the 
text entered in the search box, it will appear in the list of available fields. When this box is 
empty, all fields are available. 

  

List of Available Fields 

Displays the list of fields that can be added to the form. 
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Left Panel: Outline View 

Available via Actions > Outline. 

This mode displays the form in its current state in a tree view. 

The tree is presented in a Page/Group/Field hierarchy. 

Clicking a field in the outline selects the field in the main window.  

Using the Find function highlights the fields in the outline window where the field name 
contains the text entered in the find box. 

  

Right Panel: Field Settings 

The right panel is typically used for setting field properties.  

When a field is selected, the right panel displays the properties for that field.  

This panel can be closed/hidden via a Close icon on the lower right. Once closed, an icon 
appears on the right side that reopens the panel. Clicking the appropriate Edit icon for a field 
also opens the panel. 

NOTE: The right panel only displays when an element has been selected. If no element is 
selected, it is hidden. 

  

Forms Designer Sections 

Clicking on a section of a form selects and highlights the entire section, inclusive of the fields 
contained. The Right Panel will open and display the section properties. 

Clicking the Section label allows for editing of the label. Edit and Delete buttons are displayed 
when the section is selected. 

Clicking Edit will either hide the right panel (if it’s open already) or show it (if it was hidden). 

It is possible to move an entire section via drag and drop. Once moved, any fields contained 
within the section are moved along with it. 

The Right Panel will show the following Section options: 

 Label 

 Title Color 

 Title Background Color 

 Group Background Color 

 Border Color 

 Border Width 

Clicking the Delete button presents the following prompt: 
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Forms Designer Labels and Fields 

Adding a Field 
To add fields, you can double-click on the field or drag the value from the left panel onto the 
form. Both the field and its label are added. By default, the label is positioned above the field 
and the field label is the name of the field with spaces replacing any underscores. Once added to 
the Form Editor, the field is no longer available to be selected (removed) from the left panel. 
The exception to this are items in the Text category (not fields, regular text), and long text fields. 

 

If a section is first selected, double-clicking a listed field adds the field to the bottom of that 
section. Otherwise, the field is added to the bottom of the page. When dragging and dropping, 
the field is added to the highlighted location where the field can be dropped. 

  

Field Selection 
Any field in the Form Editor window can be selected. Selecting the field highlights the label and 
field. Two icons appear alongside the field, one for Edit, and one for Delete. For coding fields, an 
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additional icon/button/text (Edit Code) appears that allows for setting of coding options. 
Selecting a different field/element deselects the current field and selects the one clicked. 

It is possible to edit more than one active field at the same time by holding down the CTRL key 
and clicking multiple elements. On the right panel, only properties shared by the selected 
elements (e.g. width) will be shown. 

  

Removing a Field 
Each field has a Delete button that appears when the field is selected. Clicking the Delete button 
deletes both the field and its associated label. 

  

Resizing Labels and Fields 
When a field is selected an arrow icon appears on the lower right that allows you to resize the 
field. With the exception of text fields, resizing can only occur horizontally. Text fields can be 
resized horizontally and vertically. It is not possible to resize a label. The label should 
automatically take up the width of the text within. 

  

Moving Labels and Fields 
Moving a label and field involves clicking on the field and dragging it to its new location. 
Dragging either the label or field moves both together. 

Labels and fields can be dragged and dropped to the following positions: 

 Blank page 

 Blank sections 

 Above or below an existing field 

 Above or below an existing section 

 To the left or right of an existing field 

In order to allow movement of a field to another page, upon dragging the field to the tab at the 
top of the Form Editor, the page for that tab displays. 

If a page is scrollable in any direction, dragging a field and hovering over the edge of the page 
for more than 1 second scrolls the page in that direction. 

  

Forms Designer Field Properties 

Selecting a field or its label brings up the Field Properties in the Right Panel. 

Double-clicking a label also allows a user to edit the label text. 

The Field Properties appears in the right panel on the screen. The window contains the field 
name and type as the header. The available field properties are dependent on the field type. 
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Field Type Properties 

Date • Label  

• Description  

• Help Text  

• Minimum Value (Date)  

• Maximum Value (Date)  

• Populate With (No Value/Set Value) Set Value provides a date control or a 
checkbox for Today’s Date  

• Radio button selection for Optional (Default), Required, Read-Only, Hidden  

• Require Verification checkbox  

• Verification Label  

• Verification Description  

Long Text • Label  

• Description  

• Help Text  

• Word Limit  

• Enable Word Count  

• Enable Spell Check  

• Include Question in GIFTS Online  
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• Populate With (No Value/Set Value) Set Value provides a textbox  

• Radio button selection for Optional (Default), Required, Read-Only, Hidden  

• Require Verification checkbox  

• Verification Label 

• Verification Description 

Text • Label  

• Description  

• Help Text  

• Enable Spell Check  

• Populate With (No Value/Set Value) Set Value provides a textbox  

• Radio button selection for Optional (Default), Required, Read-Only, Hidden  

• Require Verification checkbox  

• Verification Label  

• Verification Description  

Attachmen
t 

• Label  

• Description  

• Help Text  

• Word Limit  

• Allowed File Types  

• Radio button selection for Optional (Default), Required, Read-Only, Hidden  

• Require Verification checkbox  

• Verification Label  

• Verification Description  

Number • Label  

• Description  

• Help Text  

• Minimum Value (Number)  

• Maximum Value (Number)  

• Populate With (No Value/Set Value) Set Value provides a textbox  

• Radio button selection for Optional (Default), Required, Read-Only, Hidden  

• Require Verification checkbox  

• Verification Label  
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• Verification Description  

Currency • Label  

• Description  

• Help Text  

• Minimum Value (Currency)  

• Maximum Value (Currency)  

• Display decimals separately  

• Populate With (No Value/Set Value) Set Value provides a textbox  

• Radio button selection for Optional (Default), Required, Read-Only, Hidden  

• Require Verification checkbox  

• Verification Label  

• Verification Description  

Checkbox • Label  

• Description  

• Help Text  

• Alignment (Above/Right)  

• Populate With (No Value/Set Value) Set Value provides a textbox  

• Radio button selection for Optional (Default), Required, Read-Only, Hidden  

• Require Verification checkbox  

• Verification Label  

• Verification Description  

  

Forms Designer Editing Codes 

When selecting a code field, an additional icon/button/text (Edit Code) appears that allows for 
setting of coding options. The Code Properties appears as a modal window centered on the 
screen. The window contains the Coding Sheet - Code Table name as the header. The top of the 
window contains settings particular to this field. Two columns are displayed side by side below 
the settings, Available Codes and Displayed Codes. 

The Available Codes section contains a Find filter and a list of fields that can be displayed. The 
find filter filters the selection of Available codes by the text entered. Double clicking on a field or 
dragging and dropping it adds the field to the Displayed Codes section. An icon is displayed to 
add all fields. The Displayed Codes section shows fields that are displayed on the Form. Each 
selection contains an icon to the right that allows the user to remove the field. An icon is 
displayed to remove all fields. 

This popup will have the standard OK and Cancel buttons. 
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Show Lowest Level 
If turned on, “Nested List” is automatically disabled. 

Nested List 
If turned on, “Show Lowest Level” is automatically disabled. 

Include Percentages 
If turned on, an additional numeric box, and “%” text appears next to each selection. 

 

  

Forms Designer Logo/Header 

When a new form is created, the header of the page will display the text ‘No Logo’. 
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If selected, settings will be shown in the right panel to Upload an image. Accepted file types are 
.jpg and .gif. Once a file is selected, the Form Editor displays the uploaded picture file and 
selects it. 

Clicking on the logo selects the logo as described in Field Selection. Clicking the Edit Properties 
button displays the following settings in a right panel. 

 Logo Path and File Name (Read-Only) 

 Alignment [Left/Center/Right] 

 Rollover Text 

 Upload files button 

 Delete Logo button 

Clicking the Delete Logo button removes the picture file and displays a NO LOGO image in its 
place. 

  

Forms Designer Navigation Bar Settings 

Form navigation is shown underneath the logo (Chevron or Classic Tabs). 

While in Form Editor mode, the links in the navigation cannot be clicked. Clicking the navigation 
selects the element without the Delete button. 

 

Clicking the Edit button displays the following settings in in the right panel. 

• View Style [Chevron/Classic] – default is Chevron. 

• Use Page Title for Navigation [On/Off] 

 When this option is Off, navigation will display “Page 1, Page 2” etc. instead of the name 
of the page. When On, the navigation will use the name of the page instead. 

 Min 1 char, Max 100 chars 

Navigation Styles 
Classic 

Displays page navigation in a table as links.  

Example: 

 

Chevron 

Will display navigation in a table separated by number and arrow images.  

Example: 
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Forms Designer Settings Menu 

The Settings menu in the Forms Designer gives you access to various configuration options for 
your forms. 

Please note, any changes made to the settings are displayed in the Form Editor. 

  

Options include: 

 Properties 

 Links 

 Email 

 Eligibility 

 Attachments 

 Design 

 Text 

  

Settings: Properties 

• Form Title 

• Description 

• Form Language/Spell Check Language 

• Form Type (Application, Scholarship, or Requirement) 

• Stage (and Associated Stage 1 if Stage 2 is selected), Enabled if Form Type=Application 

• Site ID (For Multi-SID) 

• Branch 

• Suppress Organization fields from application form 

• Authentication 

o Require password to access form 

o Require Account Login (default On) 

Populate Organization and Contact data from last Submission (default On) 

o Require applicants to enter a U.S. Tax ID 

Require Tax ID to be on file in the IRS database 

• Additional Contacts 

o Organization Primary Contact is required 

o Request Primary Contact is required 

o Add (Action, creates a pop up window that creates an additional Contact type 
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o Edit 

o Remove 

  

Settings: Links 

Allows the editing of special links on the page.  

By default, a new form will not have any links. 

The links available to edit are predetermined. 

To add a link, add the URL to the Link To setting. 

The Left Panel lists of the various links on the page. Clicking on the link type highlights and 
selects the link (or the position of where the link would appear in its default position) and opens 
the link properties. If the link is on a different page than what is currently shown in the Form 
Editor, the page is switched to the one where the link resides and the link is selected. 

Links cannot be dragged and dropped. 

 

When a link is selected, the properties of the link are displayed on the right panel.  

Available options for the link are: 

 Display Label 

 Link To 

 Style 

  

Settings: Email 

Allows the editing of automated emails for Applications or Requirements. 
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The Left Panel displays the list of automated emails that can be edited. Once selected, the form 
editor will display the message in an editable text box. 

A button is included that allows the user to add merge fields. 

 

  

Settings: Eligibility 

The Eligibility Quiz, if enabled, is displayed before the application. 

Once clicked, the right panel displays Quiz Settings. Once “Enable Eligibility Quiz” checkbox is 
checked, the Quiz page is added as a tab, and is also available in the Outline View. 

The Quiz is not shown in the navigation bar in the main panel. 

The quiz page is always set as the first tab, and cannot be moved. 
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Quiz Menu Actions 
New 

 New Page - Add a new quiz page 

 Add Question - Adds a new question to the Form Editor and selects it. 

Questions are displayed in the main section. Questions can be dragged and dropped above or 
below each other using the same logic as dragging and dropping fields (without the ability to 
drop to the right)- and moves the entire Question and associated Answers. Selecting a question 
highlights it and displays an Show Properties and Remove button. 

Once a question is selected, the right panel will display the Edit Question Properties. 

  

Right Panel Quiz Settings 
Quiz Settings are shown in right panel anytime there is no question selected in the Quiz main 
panel. Also shown when Settings>Quiz is selected in menu. 

Enable Eligibility Quiz: Checking this box creates a new page with different available actions 
than a normal page. Anytime this special page is selected, the Quiz settings are shown in place 
of the fields list. Fields cannot be added/moved to this page 

Display only one question per page: Checking this box adds a page separator between 
questions. This can be represented by a dotted line between questions 

Allow quiz takers who fail to access this application: selecting this box will allow applicants who 
failed the eligibility quiz to still access the application. 

Text to display to applicants that fail the quiz: Default text is shown below. 

Your responses to the quiz questions have indicated that your proposal most likely does not 
meet our funding guidelines. 
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Settings: Attachments 

Accessible via Settings>Attachments in top ribbon menu.  

 

Once clicked, the right panel displays Attachment Settings.  

Once “Enable Attachment Page” checkbox is checked, the Attachments page is added as a tab 
and is also available in the Outline View.  

The attachment page is always set as the last page, and cannot be moved. 

Main Edit Window 
Attachments Page Text 
Attachments page text is a selectable element. On initialize, it displays NO TEXT. When selected, 
Attachment Page Text right panel is displayed 

Upload Text 
Displays the following: 

 Upload 

The maximum size for all attachments combined is <Maximum Size> MB. Please note that files 
with certain extensions (such as “exe’, “com”, “vbs”, or “bat”) cannot be uploaded. 

Define Attachments Checkbox 
When checked, the drop down box, Add, and Remove buttons are enabled 

Defined Attachments List 
Drop down box of defined attachments. To add an attachment, click on the Add button. To Edit 
an attachment, select the attachment by selecting it in the drop down box. To remove an 
attachment, select the attachment in the drop down box and click remove. A confirmation 
message should display “Do you want to remove <Attachment Name>?” OK/Cancel 
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Adding or selecting a defined attachment displays the Defined Attachment Properties right 
panel. 

Right Panel 
Attachment Settings 
Attachment settings is shown in right panel anytime there is no active selected element in the 
Attachments main panel. Also shown when Settings>Attachments is selected in menu. 

Enable Attachments Page:   
Checking this box creates a new page with different available actions than a normal page. 
Anytime this special page is selected, the Attachment settings are shown in place of the fields 
list. Fields cannot be added/moved to this page 

Maximum Size:  
Enter the maximum size allowed for the attachment in megabytes(mb). 

Recommenders (Only enabled if a blind attachment is added to the attachments list) 

 # Required 

 # Not Required 

Adding a recommender in either the Required or Not Required box adds a Recommenders Page 
to the Form Editor. 

Example of recommenders page with 1 required, 2 not required set: 

 

Attachment Page Text 
[Textbox] When the attachment page text element is selected in main panel, a text box is 
displayed in the right panel. Changes to this textbox will replace the text in Attachment Page 
Text in main panel. 

Defined Attachment Properties 
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When clicking Add in the defined attachments list on the main panel, the right panel displays 
the options for adding the attachment. The same panel displays options to edit an existing 
defined attachment when the drop down element is selected, and displays the element selected 
in the drop down box. 

[Textbox] Attachment Name 

 Populates the drop down box 

[Checkbox] Required 

 When checked, option in drop down box displays (Required) next to the name 

[Checkbox] Blind 

 When checked, option in drop down box displays (Required) next to the name 

[Textbox][Add Button] File Type 

 Allows the user to type in a file type and click Add or press enter to add to the File Type 
List 

[Listbox] [Edit Button] [Remove Button]List of Allows File Types 

 Listing of File Types added 

 File types editable by double clicking in list or selecting the file type in list and clicking edit 

 File types deletable by selecting file type in list and clicking delete 
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Settings: Design 

This menu option allows you to configure the following: 

Layout 

 [Radio Button] Horizontal Accent 

 [Radio Button] Vertical Accent 

 [Checkbox] Include Content Frame 

 Page Span [Entire Page/Left, Fixed Width/Right, Fixed Width] [Page Width: Pixels] 

 Background File [Browse][Remove] 

 HTML 
o Header [Browse][Remove] 
o Left Panel [Browse][Remove] 
o Right Panel [Browse][Remove] 
o Footer [Browse][Remove] 

Colors 

 [Color Picker] Header Background 

 [Color Picker] Accent Bar 

 [Color Picker] Body Background 

 [Color Picker] Search Background 

 [Color Picker] Active Tab Background 

 [Color Picker] Inactive Tab Background 

 [Color Picker] Button Color 

Required Field Icon 

 Icon 

 Color 

  

Settings: Text 

This menu option allows you to configure the following: 

Selecting the Text Display Element highlights the affected text in the Form Editor. 

Display Element 

 Form Title 

 Page Title 

 Header 

 Notes 

 Question Label 

 Question Description 

 Question Value 

 Error Message 

 Highlighted 
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 Navigation Active 

 Navigation Inactive 

 Button 

Font [List of Fonts] 
Size 
Alignment 
Bold 
Italic 
Color 
Required Fields 

 Icon 

 Color 

  

Creating a Grantee Account 

NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

Online grantee accounts are created by grant seekers when they first access and submit online 
grant applications. Grantees then use these same accounts to log in and access online 
Requirement forms. 

In some cases however you will need to create a grantee account in GIFTS Online yourself. If you 
want to publish a Requirement to a grantee or grant seeker who has no online account, you'll 
have to add it yourself. 

To create a grantee account: 

1. Search for or otherwise navigate to the Request edit form for which you want to create 
an account. 

NOTE: Grantee accounts are linked to Requests in GIFTS Online. The Requirements for 
that Request can then be published to that account. 

2. In the Actions menu, click Create Grantee Account. The Create Grantee Account window 
opens: 

 

NOTE: If the link does not appear in the Actions menu, a grantee account is already linked 
to the Request. While a grantee account can be linked to many Requests, each Request 
can only be linked to a single account. 
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3. Enter the email address of the person for whom you want to create an account. (The field 
will default to the email address of the Request Primary Contact, but you can change it.)  

4. Re-type it in the Confirm Email field and click OK. 

The window closes and message notifies you that an email with the login information has been 
sent to the email address you entered. 

NOTE: If there is already a grantee account for the email address, GIFTS Online will not create a 
second. Rather, the system offers you the option to link the Request to that existing account. 

Once linked, you can publish Requirements for this pending or approved Request to that 
grantee account. 

  

Resetting a Grantee's Password 

Resetting a Grantee's Password 

If an applicant or grantee forgets his or her password, or if you want to simply reset a grantee’s 
password, you can use the Reset Grantee Password link on the Online Applications menu. 

To reset a grantee's password: 

1. Click Reset Grantee Password. 
2. Enter the Email Address and New Password for the grantee. 
3. Click Submit. The grantee’s password is reset and an automated password update 

message is sent to the grantee that contains a temporary password. The grantee must 
change it when they login. 
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Transferring an Account 

An entire account can be transferred from one user to another. This includes all of the in-
progress and historically submitted applications and reporting forms.  

From the Launch > Applications popup menu, select Transfer Account. 

 

The Transfer Account form will allow you to enter the email address of the current user and the 
email address of the new user. 

NOTE: The Site field is only visible to clients with Multi-SIDs enabled. 

 

Click OK. 

  



GIFTS Online 5.1 User’s Guide 

435 
 

Working with Applications 

NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

GIFTS Online allows you to receive grant applications from applicants online. Grant seekers can 
submit proposals to you electronically by completing an online application form(s), created for 
you specifically by MicroEdge Services.  

Using GIFTS Online's online grant application features, you can: 

 Preview your online application forms. 

 Retrieve proposals submitted by online grant seekers. 

 Review the pending applications you've received. 

 Make decisions on whether to consider each proposal further 

 Generate stage 2 applications for grant seekers whose first-stage submissions garnered 
your interest. 

 View historical applications, including ones you've rejected without creating a Request. 

  

Launch: Applications 

To access the Online Applications and Requirements functions in GIFTS Online, go to the Launch 
> Applications menu. 

Available only to the Grants Manager users, this menu option gives you access to the various 
Online Applications functions listed below. 
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Retrieving and Managing Applications 

The Retrieve and Manage Applications button allows you to view all pending applications and 
retrieve any new applications. For more information about Pending applications, click here. For 
more information about Retrieving applications, click here.  

  

Retrieving Submitted Requirements 

The Retrieve Submitted Requirements button retrieves any online Requirement forms grantees 
have submitted. For more information about Online Grantee Reporting, click here. 

  

Viewing Historical Applications 

Click this button to view online grant applications you have considered or rejected in the 
Applications History page. For more information about historical applications, click here.  

  

The Forms Manager 

The Forms Manager button allows you to access the Forms Manager where you can view, 
manage, and create application and requirement forms. It is also the gateway to the Account 
Design Manager where site preferences may be set. 

For more information, see:  

 The Forms Manager   

 The Account Designer 

 The Forms Designer 

  

Resetting a Grantee's Password 

If an applicant or grantee forgets his or her password, or if you want to simply reset a grantee’s 
password, you can use the Resent Grantee password link. 

To reset a grantee's password: 

1. Click Reset Grantee Password. 
2. Enter the Email Address and New Password for the grantee. 
3. Click Submit. The grantee’s password is reset and an automated password update 

message is sent to the grantee that contains a temporary password. The grantee must 
change it when they login. 

  

Retrieving Applications and Attachments 

NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

Submitted applications are stored on MicroEdge's application server. In order to view and 
process these applications, you need to retrieve them first. 
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Retrieved applications remain on the Pending Applications page until you reject them or 
consider them and turn them into pending Requests in GIFTS Online. 

To retrieve applications: 

1. From the home page, go to Launch > Applications and click Retrieve and Manage 
Applications. The Pending Applications page opens. 

2. Click Retrieve. If there are applications on the server, a message informs you of the 
number of applications, and asks if you want to retrieve them. 

3. Choose one of the following options: 

 Click Yes if you want to retrieve the applications and their attachments. The 
applications and all attached files will be brought in. 

 Click No to leave the applications and their attachments on the server for retrieval 
at a later time. 

If you click Yes, the files are downloaded and the dialog box summarizes the results of the 
retrieval. 

  

After you retrieve applications, you can review them and their attachments, then make the 
decision to consider them further, or reject them outright.  

  

 

  

Retrieving & Managing Applications 

NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

You can view the Pending Applications page by clicking Retrieve & Manage Applications from 
the Launch > Applications menu.  
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The Pending Applications page is where you manage all pending applications submitted to you 
by grant applicants. Here you can view the applications and any attached files, then make your 
decision on whether to further consider the proposal. 

The image below displays the Pending Applications page. 

 

 Refresh: This button allows you to check for new applications. For more information, click 
here.  

 Duplicate Check: This button allows you to perform duplicate checking on pending 
applications; it helps you link data in the application to an Organization and Contacts 
already entered in GIFTS Online. For more information, click here.  

 Consider: This button allows you to consider any selected applications. If you consider an 
application, it becomes a Pending Request in GIFTS Online. For more information, click 
here.  

 Reject: This button allows you to reject any selected applications. For more information, 
click here. 

 Search: This button allows you to search for pending applications. For more information, 
click here.  

 Show All: Click this link to show all available pending applications.  

  : Click this icon to view the application. 

 : Click this icon to view the application attachments. A menu opens, listing each file; 
click the link to open it. 

Searching for Applications 

NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

You can search for pending applications in the Pending Applications page.  

Open the Pending Applications page by going to Launch > Applications on the homepage and 
then clicking Retrieve and Manage Applications. 

To search for applications, click Search. The Search Pending Applications window appears. 
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To search for pending applications: 

1. From the Pending Applications page, click Search. The Searching Pending Applications 
window appears. 

2. Enter search criteria in the text boxes on the right side of the Search Pending Applications 
window that correspond to each field in the window. 

3. Use the drop-down menu next to each field to select search parameters, such as 
"contains all words", "begins with", or "contains exact phrase."  

4. If you want to add more fields to the search criteria, click Add More Fields. Select the 
checkboxes next to the additional fields you want to add to the search criteria, and then 
click OK.  

NOTE: You can add the same field more than once. If you add the same field to the search 
criteria more than once, the related fields will have an 'OR' relationship, meaning that the 
search results will contain pending applications that contain any of the search criteria for 
that field.  

TIP: Click the 'X' icon next to each field you do not want to add to the search. Click Clear 
All to remove all search fields from the window.  

3. Click OK. All pending applications meeting your search criteria appear.  

TIP: Click Reset to remove all search criteria from all text boxes.  

Processing Applications 

NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

On the Pending Applications page, you can open submitted applications and review attached 
documents. Once you know whether or not you'd like to further consider funding the proposal, 
you follow this process to implement your decision. 

If you'd like to consider the proposal: 

1. Perform duplicate checking. 
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A considered single or first stage application creates a pending Request; it can also create 
an Organization or one or more Contacts. To prevent creating duplicate Organizations or 
Contacts, you must first perform duplicate checking. If an Organization or Contact 
submitted as part of the application already exists in GIFTS Online, you can update that 
record, rather than create a duplicate one. 

NOTE: Second stage applications do not create a new Request, but rather update the 
Request created by the considered first-stage application. 

2. Consider the application. 

The application moves to the Applications History page; in GIFTS Online, a Request is 
created (or updated in stage 2); Organization and Contact records may also be created or 
updated. 

  

If you don't plan to consider the proposal, you can reject it instead. Duplicate checking is not 
required to reject an application. These applications and their attachments move to the 
Applications History page. 

About Linking Applications with GIFTS Online 

NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

In GIFTS Online, each Request is associated with an Organization and a Primary Contact. Before 
you consider an application—and turn it into a Pending Request—you can link it to existing 
Organizations, Contacts, and Requests in GIFTS Online. 

You are required to attempt to link an application with Organizations and Contacts in GIFTS 
Online before you can consider it. This is done through the Duplicate Check function on the 
Pending Applications page.  

  

Click here for instructions on performing linking. 

  

Duplicate Checking Applications against GIFTS Online 

NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

Why Duplicate Check Organizations and Contacts? 
NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

When you consider an application, the new Pending Request that is created in GIFTS Online 
must be associated with an Organization and a Primary Contact. If GIFTS Online created a 
unique Organization and Contact record for each application you considered, your database 
would soon be cluttered with duplicate Organizations and Contacts. 
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To avoid this, GIFTS Online lets you check for duplicates. If found, you can link an applicant’s 
organization and contact(s) to existing Organizations and Contacts. The Request that is created 
when you consider the application is automatically associated with the linked Organization 
and/or Contact. 

If you are unable to establish links—because no matching Organizations or Contacts were 
found—a new Organization and/or Contact is created when you consider the application. 

NOTE: When overwriting Organization and/or Contact information, an Update Activity is 
automatically created for the Organization or Contact record in GIFTS Online. This Activity 
contains both the old and updated information. 

Click here to start linking applications. 

How to Check for Duplicates 
To check for duplicate Organizations and Contacts and then link applications to them: 

1. Enable the checkbox next to the applications that you want to link in the Pending 
Applications dashboard part, and then click Duplicate Check. The duplicate check page 
opens. 

 

2. In the Organizations section, select the checkbox next to the applicant's organization you 
wish to link to an Organization in GIFTS Online. 

3. Select the Organization to which you want to link the applicant to in the Link to drop-
down menu or click the eyeglass icon to search for another Organization. The Link to 
drop-down menu contains all Organizations based on the Organization matching logic. To 
find out more about this matching logic, click here.  

NOTE: Select 'Create new' if you want to create a new Organization for the applicant.  

TIP: If you click the eyeglass icon, enter the Name, AKA, Sort As Name, Legal Name, ID, or 
Tax ID of the desired Organization, and then click the eyeglass icon. All Organizations 
containing your search criteria appear. Click the name of the Organization to select it. 

4. Enable the Update checkbox to overwrite the linked Organization fields in GIFTS Online 
with the corresponding application fields during the consideration process. This updates 
the following fields if they are included on the application: Address, City, State, 
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Zip/Postal, Country, Phone, Extension, Fax, Email, WWW Address, and Organization 
Annual Budget. 

NOTE: Blank application fields do not overwrite corresponding GIFTS Online fields. 
However, if the application form contains Phone information but not Extension 
information, any Extension information for the associated GIFTS record will be erased. If 
this feature is used to overwrite an Organization’s Address, all Contacts associated with 
the Organization that share the same Office Address as the Organization will have their 
Office Address overwritten. However, if this feature is used to overwrite a Contact’s 
Office Address, the Primary Organization associated with the Contact will not have their 
Address overwritten, and will no longer share their Office Address with the Contact. 

5. In the Contacts section, select the checkbox next to the applicant you wish to link to a 
Contact in GIFTS Online. 

6. Select the Contact to which you want to link the applicant to in the Link to drop-down 
menu or click the eyeglass icon to search for another Contact. The Link to drop-down 
menu contains all Contacts based on the Contact matching logic. To find out more about 
this matching logic, click here.   

NOTE: Select 'Create new' if you want to create a new Contact for the applicant. 

TIP: If you click the eyeglass icon, enter the First Name, Last Name, ID, or Primary 
Organization Name of the desired Contact, and then click the eyeglass icon. All Contacts 
containing your search criteria appear. Click the name of the Contact to select it. 

7. Enable the Update checkbox to overwrite the linked Contact fields in GIFTS Online with 
the corresponding application fields during the consideration process. This updates the 
following fields if they are included on the application: Home/Office Address, 
Home/Office City, Home/Office State, Home/Office Zip/Postal, Home/Office Country, 
Home/Office (Main) Phone, Home/Office (Main) Extension, Home/Office Fax, Mobile, 
Pager, and Email.  

NOTE: Blank application fields do not overwrite corresponding GIFTS Online fields. 
However, if the application form contains Phone information but not Extension 
information, any Extension information for the associated GIFTS Online record will be 
erased. If this feature is used to overwrite an Organization’s Address, all Contacts 
associated with the Organization that share the same Office Address as the Organization 
will have their Office Address overwritten. However, if this feature is used to overwrite a 
Contact’s Office Address, the Primary Organization associated with the Contact will not 
have their Address overwritten, and will no longer share their Office Address with the 
Contact. 

8. When you are done linking Contacts, click Link. You are asked to confirm that you want to 
save your links. 

9. Click Yes. If you are linking a batch of applications, a process log summarizes your links.  

  

Contact Matching Logic 
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NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

When you attempt to link the applicant’s contact information with Contacts in GIFTS Online, 
GIFTS Online matches the contact’s First Name, Middle Name, Last Name, and Telephone 
Number. 

If the Organization ID... ...and the First Name, Middle 
Name, and Last Name... 

...then... 

matches or is not yet linked match the Contact is considered a match. 

matches or is not yet linked do not match the Contact is NOT considered a 
match. 

does not match match the Contact is NOT considered a 
match. 

does not match or is not 
yet linked 

do not match the Contact is NOT considered a 
match. 

Organization Matching Logic 
NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

When you attempt to link an applicant with Organizations in GIFTS Online, GIFTS Online matches 
the applicant organization’s Tax ID, name, state, and postal code with Organizations using the 
following logic: 

If the Tax ID... ...and the Name and 
State... 

...then... 

matches or is 
not supplied 

match the Organization is considered a match. 

matches do not match the Organization is considered a match. 

is not supplied do not match the Organization is NOT considered a match. 

does not match match the Organization is considered a match. 

does not match do not match the Organization is NOT considered a match. 
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Considering Applications 

NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

Applications which you have linked to GIFTS Online can now be considered and become Pending 
Requests containing the date from the application. From that point on, you manage the 
application as you would any other Request in GIFTS Online. Considered applications are 
removed from the Pending Applications page and maintained in the Applications History page. 

To consider an application or applications: 

1. Click the checkbox next to the application(s) in the Pending Applications page and click 
Consider. The Consider Applications window appears. 

2. Enter the following Request information, which will be added to the new Request created 
from the application: 

Type: Most grant makers use only the standard Type of 'Cash Grants.' Other grant 
makers, particularly corporate giving programs, may have additional Types, such as 'In-
Kind' or 'Matching GIFTS.' This field is required. 

Status: The status of the Request. 

Staff assigned to request: The staff member responsible for the new Request. 

Meeting Date: The date of the meeting during which the new Request will be reviewed. 

Generate Correspondence: Click this checkbox if you want to generate correspondence. 
For more information, click here. 

3. Click Consider. 
4. Review the process log to see a summary of the results. The Request ID's of the new 

Requests are listed in the process log. If you have already linked these applications to 
Requests, the Request ID's of the updated Requests are listed. 

  

Rejecting Applications 

NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

If an application does not meet your funding requirements, you can reject it. Rejected 
applications are removed from your workflow and transferred to the Applications History 
dashboard part. You can record a Rejection Reason and generate rejection correspondence. 

To reject an application or a batch of applications: 

1. In the Pending Applications page, click the checkbox next to the application(s) you want 
to reject, and then click Reject. The Reject Applications window appears. 

2. Enter the following information for Rejected application(s): 

 Reason for rejection: Reason for Rejection is a coded field.  
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 Comments: Any additional notes you want to make regarding this rejected 
application. 

 Generate Correspondence: Enable this checkbox to generate correspondence. For 
more information, click here.   

NOTE:  If you are rejecting a batch of applications, the rejection information you provide 
is applied to all applications in the batch. 

3. Click Reject. The rejected applications are transferred to the Applications History 
dashboard part. A process log summarizes the results. 

  

Generating Correspondence 

NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

You have the option to generate email correspondence when you consider or reject an 
application.  

1. Consider or reject an application, and enable the 'Generate Correspondence' checkbox. 
The Generate Email Correspondence window appears. 

2. Enter the following information for the email correspondence: 

 Job Title: The job title of the correspondence. This is for reference purposes only.  

 Template: Select the email template.  

 Request a read receipt: Enable this checkbox if you want to receive a copy of the 
email correspondence.  

 To: Enter the email address(es) of the person(s) who will receive this email. 
Separate multiple email addresses with commas. If you are generating 
correspondence for more than one application, this field cannot be edited and the 
following message appears: 'Applicant's address will be used.' 

 Salutation: The email salutation, such as "Dear applicant." 

 Signer: The staff member who signs the correspondence.  

 Position: The signer's position. 

 Preparer: The initials of the staff member preparing the correspondence. 

 Create Activity record: Enable this checkbox if you want to create an Email 
Activity.  

 Date: Today's date. 

 Notes: Enter any additional information.  

 Save email text: Enable this checkbox if you want to save the text you entered in 
this window for future correspondence. 

3. Click Generate Correspondence. The email is sent to the recipient(s). After the 
correspondence job has been run, it appears in your Job Status log.  
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The Applications History 

NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

The Applications History popup contains all historical applications, both applications that have 
been considered and those that have been rejected. 

From the Launch > Applications menu on the homepage, select View Historical Applications.  

 

This page contains the following buttons and fields. Note that columns will only have data in 
them if the fields were included in your online application form(s). 

 : Click this icon to view the application. 

 : Click this icon to view the application attachment. 

 Disposition: The disposition of the application (Considered or Rejected). 

 Disposition Date: The date when the disposition was assigned to the application. 

 Organization: The organization's address. 

 Contact: The primary contact person's name, title, telephone numbers, and email 
address. 

 Request Amount: The amount of the request. 

 Project Title: The name of the project. 

 Primary Program Area: The program under which the applicant organization or proposed 
project falls, such as 'Education' or 'Health and Human Services.' 

 Application ID/Request ID/Form ID: Applications generated from the same form are 
assigned sequential Application ID numbers. When an application is retrieved, it is also 
assigned a Record ID to identify the record. The Form ID identifies the online application 
form from which the application was generated. The Application ID and the Form ID 
together comprise an ID that is unique among all other applications in the system. 

 Title: The title of the application form.  

 Search: This button allows you to search for pending applications. For more information, 
click here. 

 Show All: Click this link to show all available pending applications. 
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Generating Stage 2 Applications 

NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

A two-stage application process requires that an applicant fill out two online forms. The first-
stage application, if considered, creates a pending Request in GIFTS Online.  

If you want to hear more about the proposal in a second-stage application, you want to make 
sure that it's linked to the existing Request record. For that reason, generating the stage 2 
application begins from the selected proposal's Request edit form. 

1. Search for or navigate to the proposal's Request edit form. 
2. In the Actions menu, click Generate Stage 2 Application. The stage 2 form is now 

published to the applicant. 
3. You have the option to generate an email for the grant seeker, letting him or her know 

they can log in and complete the second stage of the proposal. 

Request/Payment Status Update to My Account Page 

NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. Please disregard this section if your GIFTS Online system does not 
include this module. 

This option, available through MicroEdge Services (services@microedge.com), allows for the 
updating of Request and/or Payment statuses to the My Account pages of all your applicants. 
This gives your applicants access to the status of their Requests and lets them see if a Payment 
has been scheduled.  

 

 

NOTE: The new statuses are updated on a nightly basis to the applicant My Account pages. 

For more information, please contact MicroEdge Services at services@microedge.com. 

mailto:services@microedge.com?subject=GIFTS%20Online%20Request/Payment%20Status%20Updates
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Working with Online Grantee 

Reporting/Requirements 

NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

Requirements in GIFTS Online capture information about the obligations you may impose as 
part of your agreement with a grantee. For example, your grant agreement may call for interim 
reports quarterly during a year-long project. You could add four Requirements, enter Progress 
Report as each one's type, and set their due dates according to the schedule. 

You can update these Requirements yourself if grantees submit information offline or via email. 

With GIFTS Online, however, you can complete the process online. Rather than update 
Requirements yourself, you can "publish" them to the grantees - that is, post them as online 
forms - and have grantees complete and submit these forms to fulfill their requirements online. 

The process for getting grantee reports online follows: 

1. First, you will add Requirements to pending or approved Requests, specifying type, due 
date, and other key data. 

2. From the Requirement's edit form, you then publish it to the grantee and send an email 
telling them how to log in and complete the form. 

3. The grantee logs in, selects the form, completes it, attaches any supporting documents, 
and submits it. 

4. You periodically retrieve Requirements from all grantees. The system updates 
Requirements with information from the grantee and updates the Received Date. 

5. You can then review the data and files the grantee has sent and, if they meet your 
approval, mark the Requirement done. 

  

Publishing Requirements to Grantees 

NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

When you publish a Requirement to a grantee, you post an online form which s/he can then log 
in, complete, and submit. Note that the grantee must have an online grantee account set up to 
log in and access Requirements. 

Online Requirement forms are set up by MicroEdge Services as part of your initial system 
implementation. Grants Managers can preview these forms just as they can online grant 
application forms. 

NOTE: With the Form Design Wizard, you can also make your own Requirements forms or 
modify existing ones as needed. 

These forms are usually designed to work with a particular Requirement Type. For example, 
GIFTS Online comes "out of the box" with Requirements forms for Progress Report and Final 
Report. However any Requirement can be published if you have at least one online Requirement 
form active. 
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To publish a Requirement to a Grantee: 

1. Search for or otherwise navigate to the edit form for the Requirement you want to 
publish. 

2. In the Actions menu, click Publish to Web.  

NOTE: If there is no online grantee account associated with the Request this Requirement 
is tied to, you will be asked first to create an account for the grantee. The Publish to 
Grantee window will open once that step is complete. 

3. In the Publish to Grantee window, select the online Requirement form you want the 
grantee to complete. 

 

4. Select the Generate Correspondence check box to generate an email to the grantee 
notify them of the online form you want them to complete. 

NOTE: If you clear the check box, you can still generate an email later. 

5. Click the OK  button. The online Requirement form is now published. 

If you selected the Email Grantee? check box, the email generation window opens, allowing you 
to email the grantee about the newly available online reporting form. 

  

Retrieving Requirements 

NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

Grants Managers can retrieve Requirements completed and submitted by grantees from their 
home page.  

Go to Launch > Applications on the homepage and select Retrieve Submitted Requirements. 

By default, the page is set to show Requirements Received This Week. Based on your GIFTS 
Online implementation, the time period might be "this month" or "this quarter," for example. 

To retrieve the latest Requirements submitted, click the Retrieve Grantee Submissions icon in 
the toolbar: 
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IMPORTANT: The retrieve action will bring in all submitted Requirements, not just those 
associated with grants for which you are responsible. 

When an online grantee form is retrieved, the Requirement record from which it was published 
is updated. Requirement fields are updated with data provided by the grantee (based on which 
fields you included on the form). Any attached documents are linked to the Requirement and 
may be managed from the Request or Organization edit form. 

  

The Requirements Received 

NOTE: This help topic describes features found in the optional Online Applications and 
Requirements module. If your GIFTS Online system does not include Online Applications and 
Requirements, you may disregard this information. 

The Requirements Received popup lists reports and other Requirements submitted online by 
your grant seekers and grantees.  

The columns contain the following information: 

Type Shows the Requirement Type, such as Payment Receipt or Final Report 

Received Date The date on which you retrieved the submission. By default, the dashboard 
part sorts Requirements with the more recently received Requirement first. 

Organization The grantee Organization's name. 

Project Title The Project Title of the Request with which the Requirement is associated. 

Staff The staff person entered as the proposal owner on the Request. 

Publish Date The date on which you published the Requirement to the grantee. 

 

You can perform the following actions:  

 Click any record in a table dashboard part to display that record. 

 Click any column heading to sort the table dashboard part records by that column.  

 When the number of records in a table dashboard part exceeds the dashboard part 
length, the records are paginated. You may click Next, Previous, or a record count range 
(such as 6-10) to view those records. 

 Click View All to expand the dashboard part to view all matching records. 
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 Click the Report Options icon, , to view the Search Results for the records in the table 
dashboard part. This allows you to change the View, or export the records to Excel, 
among other tasks. 

 Click the Printer icon, , to display a printer-friendly version of the records in the table 
dashboard part. 

 Resize any column in a table dashboard part by hovering over it with your mouse until 
your cursor becomes a double arrow (<->), and then left-clicking your mouse and resizing 
the column. 

 

Online Applicant Collaboration 

GIFTS Online Applications and Requirements includes several collaboration features allowing 
applicants to easily share their in-progress application and reporting forms with other users. 

Enabling Sharing of Applications and Requirements 

Sharing of Request and Requirements by applicants can be enabled in the Accounts Manager by 
a Grants Manager/Administrator. 

New Grantee Concepts with Sharing Enabled 

Grantee functionality changes will center around two new concepts: “owners” and “viewers.” 

OWNER: The owner has exclusive rights to edit, save, or submit an application or requirement. 

 The current owner will be allowed to transfer each application or requirement to a 
different owner. The new owner must accept the transfer. 

 The owner can grant View-only rights to any number of other users; a read-only version 
of the application or requirement will be listed on the other users’ Grantee Portal. 

 The owner can see a list of all “viewers” and take view rights away from any of them. 

VIEWER: “Viewers” will see applications and requirements owned by others listed in their 
Grantee Portal, and can view read-only copies until view rights are taken away by the owner. 

All users can select a filter on his or her Grantee Portal to show or hide items that s/he does not 
own via the Hide Viewer Only Applications/Requirements checkbox. 

Additional Grant Maker Functionality 

In addition, Online Applications will grant the following capabilities to grant makers: 

The grant maker can transfer an application or requirement to a different owner from GIFTS 
Online. 

When publishing a Requirement to the web, the grant maker may choose whom to publish it to: 

 the current application owner 

 the Requirement contact 

 or any Contact affiliated with the Request 
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Collaboration Options and Actions 

Once enabled, the following features will become available to your applicants/grantees. 

On the Applications and Requirements pages the applicant will notice the following new 
options. 

 

 

Option/Action Description 

Hide Viewer Only 
Applications 

Checking this box will immediately hide all applications for which 
the current user is a Viewer. 

Accept All Transfers Clicking on this link will accept all pending transfers. 

Decline All Transfers Clicking on this link will decline all pending transfers. 

My Role This column added to the Applications & Requirements pages 
shows the status of the current user for each Request or 
Requirement listed. 

Owner The current user is the owner of the Application/Requirement. 

Owner (Pending Transfer) The current user has a Request or Requirement being 
transferred to them. 

Viewer The current user is a Viewer of the Application/Requirement. 

Viewer (Pending Transfer) The current user has a Request or Requirement being 
transferred to them as a Viewer. 
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Action The following options will be available under the Action column: 

Transfer to new owner – Enabled only if the current user is the 
Owner. Tooltip will state ‘Transfer to new owner’. Clicking this 
icon will open the Transfer Ownership form. 

Manage Viewers – Enabled only if the current user is the Owner. 
Tooltip will state ‘Manage Viewers. Clicking this icon will open 
the Manage Viewers form. 

Delete – If the current user is the owner, the Delete option will 
be available for In-progress Applications. Not available for 
Requirements. 

Email a Copy – Tooltip will state ‘Click to email a copy of this 
application.’ Clicking this icon opens a new email form. Viewers 
will have an option to Send to Owner and additional email 
recipients if desired as well as attach a copy of the application to 
the email. Owners will have an option to Send to Viewers 
instead. 
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Transferring Ownership 

The current owner of an Application or Requirement can transfer ownership to another by 
clicking the Transfer to new owner icon in the Actions column on their My Account page of the 
Grantee Portal. 

 

You can enter an email address and then click the Check Email button to see if the account 
already exists or not. Click Transfer to immediately send the transfer request to the new owner. 

NOTE: This transfer process does not apply to New Requirements/Stage 2 applications until they 
are opened and become In-progress. 

If the account exists, a notification of ownership transfer will be sent to the new owner. 

If the account does not exist, a new Grantee Account will be created and notification will be sent 
to the new owner using the current Create Account email type. In addition, the notification of 
ownership transfer email will be sent separately. 

The current owner retains ownership when s/he clicks Transfer until the new owner accepts the 
transfer. On the Applications Page in the Grantee Portal, under the column My Role, the 
application is updated to ‘Owner (Pending Transfer)’ and on mouse-over of the text ‘Pending 
Transfer’ with the new email address is displayed as a tooltip. 

When there is a Pending Transfer, the email that the ownership is being transferred to will be 
displayed to the right of the title ‘Transfer Owner’, in the form of ‘To xxx@email.com’. If there is 
no pending transfer, there will be no email displayed to the right of the title. 

If the current owner clicks Transfer while the status is still on Owner (Pending Transfer), the new 
transfer will overwrite the previous transfer. The application is removed from that owner’s 
applications page in the Grantee Portal and the process continues with the newer owner. 
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The new owner of the application will see the application/requirement listed next time they log 
in to the Grantee Portal with a Check icon (Accept) or X icon (Reject). During the time before 
accepting, the new owner is made a Viewer of the application. 

If accepted by the new owner, no confirmation is displayed. The old owner becomes a Viewer of 
the Application or Requirement. 

Cancel and Cancel Current Transfer 

If the Cancel button is clicked, the Transfer to new owner page will close and will revert back to 
the main Applications or Requirements page. 

If the Cancel Current Transfer button is clicked, the current pending transfer to the new 
potential owner will be canceled and will no longer be pending transfer. The Transfer to new 
owner page will close and will revert back to the main Applications or Requirements page. 

Accepting or Declining Transfers 

A user can either accept or decline transferred applications/requirements individually or all at 
once. 

The Actions column will have the actions to accept or decline a transfer individually. The links to 
accept or decline in batch is at the top of screen, right under the “Hide Viewer Only 
Applications” checkbox. 

If the Accept/Decline All Transfers link is selected, a prompt will appear to confirm the choice. 

If the user clicks Decline, the system will email the current owner(s) that the application transfer 
has been declined. 

Deleting Applications 

A trashcan icon will be available on In-Progress lists for owners. 

Clicking the trashcan icon will cause the system to prompt the user for a confirmation. Once the 
user clicks Yes, the application is deleted and will no longer be visible to assigned Viewers. 
Current 
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Managing Viewers 

To access the Manage Viewers interface, click the Manage Viewers icon for a specific 
Application or Requirement in the Actions column. 

 

The owner of an Application or Requirement can: 

• Add new Viewers 

• See the current Viewers List 

• Remove people from the Viewers List 

• Modify the email notice sent to new viewers 
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Once a user has a view rights, s/he enjoys them until the current owner removes that access. If 
one owner makes someone a viewer, then transfers ownership, that viewer can still view. 

NOTE: Viewing rights do not carry over from Stage-1 applications to Stage-2 applications when 
they are generated. 

Adding Viewers 
Current owners can add one or more Viewers by entering valid email address(es) and clicking 
Add Viewer(s). Multiple email addresses must be separated by commas. The new Viewer(s) will 
be added to the Viewers List at the top with ‘(New)’ to the right of the email. 

NOTE: If a viewer is added that doesn’t have an account, the system will create a new account 
for them. The new viewer will be listed with the following status: newuser@microedge.com 
(New, New Account will be created). 

IMPORTANT: The applicant must click the Update button to save their changes and send out the 
notification to the new viewer(s). 

Removing Viewers 
To remove one or more Viewers from an Application or Requirement, the owner can check one 
or more check boxes to the right of the viewer(s) and click the Remove button. 

NOTE: There is no notification sent to a Viewer when View access is removed. The Application or 
Requirement will simply no longer appear in their account. 
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Transferring a Request in GIFTS Online 

GIFTS Online users can use the Transfer Grantee Account option is available in the Action menu 
for both Requests and Requirements. 

NOTE: This action is unavailable if the Request or Requirement does not have an account 
associated. 

In order to transfer a Request to another owner, the user must select a Request from the 
Workspace or have one opened. 

 

NOTE: Batch transferring of multiple Requests is not available. However there is a Transfer 
Account option in the Applications popup menu that will transfer an entire account from one 
user to another. This includes all of the in-progress and historically submitted applications and 
reporting forms. 

When you choose the option, a form similar to the one below opens: 
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The current grantee owner will be displayed in the Current Grantee’s Email field. This is a read 
only field and cannot be edited. 

The grant maker can enter, and then confirm, a new e-mail address. Ownership of the selected 
request transfers to the account of the e-mail address provided. 

If the Include all Related Requirements checkbox is checked, all requirements associated to the 
request will also be transferred. If a requirement associated with the application has already 
been transferred to a ‘New’ owner, that requirement will be included in the transfer. 

The Include all Related Requirements checkbox does not appear if the selected record is a 
Requirement or if the Request does not have any associated Requirements. 

If Generate Correspondence is checked, after clicking OK the Generate Correspondence Wizard 
will open where you can select from one of the available templates. 

The primary contact for the organization will be the default recipient. The main purpose of this 
is to notify the primary contact of the organization that ownership is being transferred for one 
of the Requests/Requirements within their organization. 

If an email template is chosen, additional existing contacts/affiliations in GIFTS Online may be 
included. 

NOTE: It is recommended that a ‘Transfer’ correspondence template be created in the 
Document Template Manager for both the Requests Pending/Approval categories as well as 
Requirements with the intention to be sent to an organization’s primary contact or other 
contacts/affiliations notifying them of the transfer. 

  

Transferring a Requirement in GIFTS Online 

GIFTS Online users can transfer a Requirement to another owner. To do this, the user must 
select the Requirement or have the record opened before accessing the Transfer Grantee 
Account option. Multiple Requirements can be selected. 

NOTE: All selected Requirements must have already been published and have a Grantee 
Account associated to them. The Transfer Grantee Account action will be unavailable if any of 
the selected Requirements does not have an account associated. 

When the Transfer Grantee Account option is selected, you will be able to enter a different 
email address to send the Requirement request to: 
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The batch process transfers all selected records to the given e-mail address, even if selected 
records have different associated accounts. 

A Process Monitor screen will display with all successes, errors and details provided. 

If Generate Correspondence is checked, after clicking OK the Generate Correspondence Wizard 
will open where you can select from one of the available Requirements templates. 

The primary contact for the organization will be the default recipient. The main purpose of this 
is to notify the primary contact of the organization that ownership is being transferred for one 
of the Requests/Requirements within their organization. 

If an email template is chosen, additional existing contacts/affiliations in GIFTS Online may be 
included. 

  

Transferring Accounts in GIFTS Online 

GIFTS Online users can transfer all of the records associated with an existing user account to 
another using the Transfer Account option. This includes all of the in-progress and historically 
submitted applications and reporting forms. 

From the Launch > Applications popup menu, select Transfer Account. 

 

The Transfer Account form will allow you to enter the email address of the current user and the 
email address of the new user. 

NOTE: The Site menu is only visible if your site has Multi-SIDs enabled. 
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Click OK. 
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The Accounts Payable (A/P) Module 

This chapter describes your options for using the optional GIFTS Online Accounts Payable (A/P) 
Module.  

The optional GIFTS Online Accounts Payable (A/P) Module allows you to process your payments 
in two ways: 

1. A/P Link: Exchange payment information between GIFTS Online and your accounting 
system using import/export functionality. 

2. Check Writer: Select pending payments to merge into a check template and print directly 
to your own check stock. 

About the A/P Module 

The GIFTS A/P Module provides a variety of options that you can use to share your GIFTS 
Payment information with your accounting department or to print checks for your grant 
payments.  

A/P Export & Import 

You can use the A/P Export option to generate export files that contain your Payment data. 
These files can be imported into your accounting software, which is used to generate invoices 
and checks.  

NOTE: The AP Export/Import process now allows you to select between the Standard or 
Quickbooks layouts. 

After your checks have been cut, you can export the payment data out of your accounting 
system and use the A/P Import option to import your check data back to GIFTS Online. Then 
your Payments are updated with check info. 

A/P Check Writer 

The Check Writer option in the Accounts Payable Module allows you to print Payment data in 
the right places on your own check stock. 

The Check Writer feature will update Payment records with their new Paid status and a check 
number reference. 

  

Changes to Payments 

After the A/P Module is added to your site, the following changes will be noticeable depending 
on whether you selected A/P Link or Check Writer: 

A/P Link Changes 

 On the Payment Edit Forms, the subtitle will display the export date. 

 In the Query Builder for Payments, the following fields will be available as search criteria: 
o Export to AP Date 
o Export to AP User 
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o Import from AP Date 
o Import from AP User 

 In Views, the above fields will also be available to be used as columns. 

 The Payment Status column will also display "Exported" if a record has been exported. 

Check Writer Changes 

 On Payment Views the Payee/Reference column will display the Check No if one has 
been issued. 

 On Payment Edit Forms, a Check Number field will be available in the Paid section. 

 In the Query Builder for Payments, the following fields will be available as search criteria: 

 Bank Name 

 Check Number 

  

How the A/P Link Transfers Data 

The GIFTS Online Standard A/P link exports Payment information from GIFTS Online to your 
accounting system by means of an ASCII text file.  

Once this information has been processed by your accounting department, the relevant check 
data (check number and check date) can then be imported back into GIFTS. Most accounting 
packages can produce a file that conforms to the Standard GIFTS Online A/P Import layout. 

You can mark the GIFTS Payments as ‘Paid’ during either the export or the import phase, 
according to your preference.  

The following graphic illustrates the general flow of information from one system to another, 
starting with GIFTS. 

 

For more information about using the standard export and import layouts, please refer to 
“Using the Standard A/P Link”. 
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NOTE: It is not necessary to export GIFTS Online Payment information in order to import check 
information from your accounting system. However, the GIFTS Online Payment ID is a required 
field in the import file. If you do not export data from GIFTS, it will be necessary to track GIFTS 
Online Payment IDs in your accounting system. 

  

Exporting Payment Data 

You can use the standard ASCII or Quickbooks file generated by the GIFTS Online Export 
Payments feature to export your Payment information to external accounting software or 
check-writing software.  

 Refer to “Standard Payment Export File Layout” for a description of the ASCII file format.  

 Refer to “Quickbooks Export File Layout” for a description of the Quickbooks file format. 

In order to export Payments, you should be familiar with the GIFTS Online procedures for 
searching for and selecting Payment records.  

You can also use Workspace Views to modify the content, format, and sort order of Payments in 
the A/P Module.  

For more information regarding these functions, please refer to the GIFTS Online User’s Guide.  

  

Standard Payment Export 

Follow the instructions below to use the Standard Layout for Payments export:  

1. Log in to the GIFTS Online.  
2. Search for the Payments you desire to export using Quick Find, Full Search, or Related 

lists.  
3. Select the Payments that you wish to export.  
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4. Click the Actions > Export to A/P ribbon menu option to open the Export to A/P window. 

 
5. The selected payments will automatically be checked for any issues and a status will be 

displayed in the lower half of the window. The check boxes for Ready, Warnings, and 
Errors can be used to show or hide records with those statuses. 

6. If there are any Payments which are invalid, make a note of them and then click the 
Remove Invalid Payments link on the bottom left to remove them. 

7. Click the Browse button and then enter a File Name for your export file. Be sure to select 
a Save location for the file which will be easy to find later. 

8. Click Save to return to the Export to A/P window. Notice the filename is now displayed in 
the File Name field. 

9. Select if you want the Payments marked as Paid or not. If you would like them marked as 
Paid, select if you want it to be on the Export Date or the Scheduled Pay date. The Export 
Date can be modified using the date field/icon. 

10. Click Export to continue. 
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11. After completing the export, the system will display a list of the processed records and 
their status. 

12. Click OK to complete the Export process and return to the GIFTS Online Workspace. 

Re-Exporting Payments 

You can re-export a batch of previously-exported Payments, allowing you to:  

 Reflect changes made to the Payments since the original export  

 Use different Payment export options 

To do so, simply select the same Payments as a previous export and perform the Export to 
A/P process again. 

The system will warn that the Payments were previously exported on XX/XX/20XX date, 
however, once a File Name is entered you will be able to use the Export button. 

  

Standard AP Export File Layout 

The standard Export file consists of a single-line header section, a detail section that lists each 
payment separately, and a single-line footer section that summarizes the file contents. Each 
payment appears on a single line in the detail section. Each line within the file is separated by a 
CR (carriage return) and LF (line feed). The fields within each line are separated by tabs. 

Header  

The header section includes the following fields: 

Field Description 

Title The following text: CHECKS EXPORT FILE 

Current Date mm/dd/yyyy. 

Current Time hh:mm:ss format (military time). 

Details 

For each Payment, the detail section includes the following fields: 

Field Description 

Payment_ID The ID of the exported Payment. 

Request ID The ID of the associated Request. 

Project Title Description of associated Request, taken from the Project Title field. 

Fund ID Fund_Donor_ID from the Payment record. 

G/L Account ID GL_Account_ID from the Payment record. 

Schedule Date Schedule_Date of the Payment in mm/dd/yyyy format. 
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Payment Amount Amount of the Payment, including decimal point. 

Payment Note Notes from the Payment. 

Payee Organization The Legal Name of the Organization associated with this Payment. 

Payee Contact Name Name of the Contact associated with this Payment. 

Address 1 First line of Organization address. 

Address 2 Second line of Organization address. 

Address 3 Third line of Organization address. 

City City of Organization. 

State Two-character state code of Organization. 

Postal Code The postal code of Organization (as many as nine characters). 

Country Country of Organization. 

G/L Account Code The code, as defined in the Code Table, of the GL Account ID associated 
with the Payment. 

G/L Account 
Description 

The description, as defined in the Code Table, of the GL Account ID 
associated with the Payment. 

Organization Vendor 
# 

The vendor number of the Organization associated with the Payment. 

Footer  

The Footer section includes the following fields: 

Field Description 

Label The following text: END OF FILE 

Number of Payments Total number of payments exported. 

Total Payment 
Amount 

Sum of all payment amounts exported. 
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Example Export File 
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QuickBooks Payments Export 

Exporting Payment information with the QuickBooks format produces an ASCII file which clients 
can then import to their accounting software. 

Export form with QuickBooks file format: 
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QuickBooks Settings 

There are certain settings that will affect the data that is exported in a QuickBooks formatted 
file.  They may be set or changed by the client during the Export in the Settings.   

NOTE: The settings button is only visible when the user has selected QuickBooks as the export 
File Format.  

If there are values set for these fields such as the Balance Sheet Acct and the Expense/Income 
Acct settings, they should show when the user opens the Settings window. When the user 
updates these settings, the client’s AP Module QuickBooks preferences are also updated.   

 

The table below describes the fields available here. 

Field Notes 

Balance Sheet 
Account 

Field for users to enter their Balance Sheet Account. This will populate to the 
Export file.   

Expense/Income 
Account 

Field for users to enter their Expense/Income Account. This will populate to 
the Export file.   
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Use for all Payee 
organization name 
fields in the export 

Radio buttons with Legal or Name.   

If Legal is selected, the organization’s legal name will populate to the export 
file where we populate the organizations’ name.   

If ‘Name’ is selected, the value in the organization’s Name will populate. The 
default is ‘Legal’. 

Include Payment ID 
in Memo Field  

(required for import) 

Check box, defaulted to checked. When checked, the payment ID is passed in 
the MEMO field of the export file. If this is unchecked, no value will be passed 
in the MEMO field. 

Include 
Organization’s Name 
as the first line of the 
address block. 

Check box, defaulted to checked.  When checked, in the export file the 
organization’s name populates to ADDR1.  If unchecked, the ADDR1 begins 
with the first line of the Organization’s address block. 

Note that these 
values will be stored 
in your Preferences 
for future exports. 

Informational text to let the user know that making changes here will update 
their preferences and will appear in future exports so they don’t have to 
enter them each time. 

Save Saves user’s changes to the database (updates their preferences), closes 
window and takes them back to the Export dialog. 

Cancel Closes window and takes user back to the Export dialog.  If user has made 
changes, prompt user to save. 

 

QuickBooks A/P Export File Layout 

This section details the ASCII file format for exporting Payments data compatible with the 
QuickBooks import facilities. 

The Export file consists of a header section containing three lines, as well as a detail section that 
lists each payment separately with three lines per payment (a Transaction record, a Distribution 
record, and an End Transaction record). 

Each line in the file is separated by a CR (carriage return) and LF (line feed). The fields within 
each line are separated by tabs. 

Header Rows 

The first three lines of the file are a header that includes the names of the fields in the 
Transaction, Distribution, and End Transaction records. The following is the exact format of 
these first three lines: 

!TRNSTRNSTYPEACCNTAMOUNTDATEMEMOTOPRINTNAMEADDR1ADDR2ADDR3ADDR4ADDR5 

!SPLSPLIDTRNSTYPEACCNTAMOUNTDATEMEMO 
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!ENDTRNS 

  

Transaction Record 

The following fields comprise the Transaction record that precedes each Payment or Payment 
group contained within the ASCII file. Data that appear in quotes (“”) are literal values that 
always reside in the field. 

Field Name Description Sample Data 

!TRNS “TRNS”, indicates that a transaction is beginning. “TRNS” 

TRNSTYPE “CHECK”, indicates the transaction type. “CHECK” 

ACCNT The Balance Sheet Account entered into the A/P Module 
preferences. 

Checking 

AMOUNT The Payment Amount, prefixed by a minus sign (-). For 
Payments grouped by Request, this is the total amount of 
the Payment in the group. 

-30000.00 

DATE The Schedule Date of the Payment, in mm/dd/yy format. 
For Payment groups, this is taken from the earliest 
scheduled Payment in the group. 

10/15/00 

MEMO The values in this field populate based on the ‘Include 
Payment ID in Memo Field (required for import)’ setting 
on the export dialog.   

If it is checked (true) - This field is populated with 
“(*GFW=[Payment ID])”. [The Project Title of the Request 
with which the Payment or Payments are associated.]   

If it is unchecked, the values in this field will be the 
Project Title of the Request. 

(*GFW=345)General 
Operating Support 

TOPRINT Y “Y” 

NAME In the QuickBooks Preference/Settings, if the user has the 
‘Use for all Payee organization name fields in the export’ 
radio button as ‘Legal’, this field populates with the Legal 
name of the payee Organization.  

In the QuickBooks Preference/Settings, if the user has the 
‘Use for all Payee organization name fields in the export’ 
radio button as ‘Name’, this field populates with the 
Organization Name of the payee Organization.  

If the Name is longer than 40 characters, it is truncated. 

Jeter College of Dentistry 
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Changes are noted in the process log. 

ADDR1 In the QuickBooks Preference/Settings, if the user has the 
‘Include Organization’s Name as the first line of the 
address block’ set to checked/true, populate this with the 
Organization’s Name (legal or name, depending on the 
name setting/preference). 

If this is set to unchecked/false, populate this with the 
first line of the organization’s address block.  

Jeter College of Dentistry 

ADDR2 The first line of the Organization’s address block unless 
the preceding field ADDR1 used that value, then populate 
this with the second line of the Organization’s address 
block. 

133 South Form Rd. 

ADDR3 The second line of the Organization’s address block unless 
the preceding field ADDR2 used that value, then populate 
this with the third line of the Organization’s address 
block.  

Hillsborough Hall 

ADDR4 The third line of the Organization’s address block unless 
the preceding field ADDR3 used that value, then populate 
this with the fourth line of the Organization’s address 
block.  

Raleigh, NC 27607 

ADDR5 The fourth line of the Organization’s address block unless 
the preceding field ADDR4 used that value, then populate 
this with the third line of the Organization’s address 
block.  

If the address block is longer than four lines, GO ensures 
that the line containing the city, state, and Postal code 
are inserted here. 

  

 

Address Fields 

As many as 3 lines are taken from the “Address” field of the Primary Address associated with the 
Organization. The last line of the address must always be in the format: 

[City], [State_Province_Code] [Zip_Postal_Code] 
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Distribution Record 

The following fields comprise the Distribution record for each Payment or Payment group 
contained within the ASCII file. Data that appear in quotes (“”) are literal values that always 
reside in the field. 

Field 
Name 

Description Sample Data 

!SPL “SPL”, indicates the distribution record is beginning. “SPL” 

SPLID   1 

TRNSTYPE Indicates the transaction type. “CHECK” 

ACCNT The Expense/Income Account entered into the A/P Module 
preferences. 

Contributions 

AMOUNT The Payment Amount. For Payments grouped by Request, this is 
the total amount of the Payments in the group. (The amount is 
not prefixed by a minus sign.) 

30000.00 

DATE The Schedule Date of the Payment, in mm/dd/yy format. For 
Payment groups, this is taken from the earliest scheduled 
Payment in the group. 

10/15/00 

MEMO The values in this field populate based on the ‘Include Payment 
ID in Memo Field (required for import)’ setting on the export 
dialog.   

If it is checked (true) - This field is populated with 
“(*GFW=[Payment ID])”. [The Project Title of the Request with 
which the Payment or Payments are associated.]   

If it is unchecked, the values in this field will be the Project Title 
of the Request. 

(*GFW=345)Gen
eral Operating 
Support 

 

End Transaction Record 

The following field comprises the End Transaction record for each Payment or Payment group 
contained within the ASCII file. Data that appear in quotes (“”) are literal values that always 
reside in the field. 

Field 
Name 

Description Sample Data 

!ENDTRNS “ENDTRNS”, indicates that the transaction is ending. “ENDTRNS” 
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Example Export File 

!TRNSTRNSTYPEACCNTAMOUNTDATEMEMOTOPRINTNAMEADDR1ADDR2ADDR3ADDR4ADDR5 

!SPLSPLIDTRNSTYPEACCNTAMOUNTDATEMEMO 

!ENDTRNS 

  

TRNSCHECKChecking-30000.0010/15/00(*GFW=[Payment ID])General Operating SupportYJeter 
College of DentistryJeter college of Dentistry133 South Form Rd.Hillsborough HallRaleigh, NC 
27607 

SPL1CHECKContributions10/15/00(*GFW=[Payment ID])General Operating Support 

  

Quicken Payment Format 

Support for the Quicken file format was added to GIFTS Online in version 5.1 and is available in 
the File Format drop-down menu of the Export to A/P form. 

Export to A/P form with Quicken file format selected: 
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Quicken Format Settings 

There are certain settings that will affect the data that is exported in a Quicken formatted file. 
They may be set or changed during the Export by clicking Settings. 

NOTE: The Settings button is only visible when the user has selected Quicken as the export File 
Format. 

If there are values set for these fields such as the Balance Sheet Acct and the Expense/Income 
Acct settings, they should show when the user opens the Settings window. When the user 
updates these settings, the client’s AP Module Quicken preferences are also updated. 
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The table below describes the fields available here. 

Field Description 

Default Category Determines the value that will populate to the ‘Category’ field in 
the Export form. Users can override there. Defaults to blank 

Use for all Payee organization 
name fields in the export 

• Legal – When this is selected, the Organization’s Legal Name 
(database field is Legal_name in the Organizations table) will 
populate to the sections of the Export file that populate with the 
Organization’s name value (sections with the prefixes of P and A 
if the client opts to include the Organization’s name in the 
address field in their Settings). 

 • Name – When this is selected the Organization’s Name 
(database field is name in the Organizations table) will populate 
to the sections of the Export file that populate with the 
Organization’s name value (sections with the prefixes of P and A 
if the client opts to include the Organization’s name in the 
address field in their Settings). This is the default selected option. 

Include Payment ID in Memo 
Field (required for import) 

This selection determines the default client setting for the field 
in the Export form when the user has selected Quicken as their 
export format. Users can override this default setting in the 
Export form. It is selected by default. 

Include Project Title in Memo 
field 

This determines whether the Project Title will be included in the 
Memo field of the Quicken export file. It is deselected by default. 

Include Organization’s Name as 
the first line of the address 
block 

This selection determines whether the first line of section A of 
the export will contain the Organization’s name. This is 
deselected by default. 
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Quicken Export Options 

When the Quicken file format is selected on the Export to A/P form, then following options 
become available: 

 

Payment Date Options 
Mark Payments ‘Paid’ as of: Select if you want to have the payments successfully exported 
marked as ‘Paid’ in GIFTS Online. The date options to allow you to set the date to use as the Paid 
Date when the payment is marked as Paid in GIFTS Online. 

 Export Date: Default selected and is followed by a date formatted field with the current 
date populated. Users can edit the Date. 

 Schedule Date: When selected, the payment’s Scheduled Date from its record will be 
used as the Paid Date. 
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  Both Export and Schedule Date radio buttons are disabled if Mark Payments ‘Paid’ as of 
is not selected. 

Other Options 
Do not mark Payments ‘Paid’: When selected, the Payments included in the export will not be 
marked as ‘Paid’ in GIFTS Online. 

Include Payment ID in Memo Field (required for import) 

When selected, the Payment ID is populated to the M field in the export file. This is required if 
you intend to import back into GIFTS Online from Quicken as this ID will indicate which GIFTS 
Online record to update. 

Group Payments by Request Payee 

This new optional field is specific for Quicken exports. 

NOTE: The default setting is determined by the client’s preferences set up in the Admin.exe. 

When selected, the export record will group first by grants, then by payees and then by 
payment address any grants for which more than one Payment has been included in the export 
so that the payments are combined into a single check in Quicken. 

So if a request has four payments included in the export and the user elects to group them, if 
they have a common payee and address, they are grouped into one record in the export but if 
any have different payees or addresses they will be grouped separately in the payment file so 
there will be separate records for each of the request’s payees with distinct payment addresses. 
If this option is not selected, individual checks are generated for each specific Payment, even if 
those Payments are attached to the same grant. 

Quicken Category 

This new optional field is specific for Quicken exports. 

The default value comes from what is defined in the Quicken settings. 

The value here should be the Quicken Category to which the payments should be assigned in 
Quicken. Users should be sure to type the Category name exactly as it appears in Quicken. If 
users are exporting a batch of payments, all payments will be assigned to the category entered 
here. Payments to be assigned to different categories should be processed in separate batches. 

Export Information Section 

The section at the bottom of the page gives information about the export. 

A summary of the value of the export will show reading “[# of Payment files being exported] 
Payments worth $[Total value of all Payments being exported].” 

Check boxes showing how many payment records are Ready for Export, Have Warnings 
(warnings will appear in the payment export process monitor at the bottom of the page), and 
have Errors (Errors will appear in the payment export process monitor at the bottom of the 
page. 

Export button 

It is disabled when there is no value in the File Name field. 

Clicking it initiates the Export process which includes: 
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 Checking for errors 

 If no errors the export file is created and the payment record is updated. 

Cancel button 

Clicking it closes the Export Form and cancels any export action. 

  

Quicken AP Export Layout 

This section details the ASCII file that is created by GIFTS Online when payments are exported. 
Quicken uses the .QIF file extension to recognize the ASCII file as a Quicken data file. 

 The .QIF file begins with the following single line header: !Type:Bank 

 Each transaction consists of the following – each row contains a Prefix and Data (no space 
separation). If the data is static, it is contained in quotation marks. 

 Transactions in the file end with the character ^ in the last row. 

Prefix Data 

D If the user is not grouping payments, and the user has chosen to mark the payments 
as ‘Paid’ based on a specified Export Date, this date appears here; otherwise, the 
current date is used (mm/dd/yyyy format).  

T The Payment Amount or sum of all the Payment Amounts in the group, if grouping 
by organization. The amount is formatted to two decimal places and preceded by a 
hyphen. 

N Print 

P The first 40 characters of the Organization Name. If the Organization name is greater 
than 40 characters, the name should be truncated (in the same manner that is done 
in the Standard and QuickBooks export for this field). 

M This field will include the Project Title if the client’s preference is set to include that 
in the Memo field and the Payment ID if they have chosen to include on the Export 
form. The Project Title, if present, directly follows the M and is followed by the 
Payment ID in parentheses (if included). Neither value is required. If the user has not 
chosen to include the Payment ID or the Project Title in the Memo field, there will 
be no value following the M. If the user has chosen to group payments by Requests 
and to include the Payment ID in the Memo field, this field contains the 
Transaction_ID from the grouped payment records that was added upon export 
followed by a comma and the first Payment ID included in this group. Note that this 
is true even if they only have one payment selected for the group.  

A Payment Address. The address consists of as many as five lines, each preceded by 
the indicated prefix. If the user has chosen to include the Organization name as the 
first line of the address is the Organization name, populate the first line or Legal 
Name depending on the Client’s preference setting. This allows as many as three 
lines for the street address, while the last line should consist of the City, State, and 



GIFTS Online 5.1 User’s Guide 

480 
 

Prefix Data 

Postal Code. Note that even for grouped payments in the export record, the address 
populates with the payment address from the first payment address (payment with 
the lowest ID). 

L The entry from the Category text box from the export form. 

 

Sample .QIF Export file: 

!Type:Bank 

D01/16/2014 

T-87500.00 

NPrint 

PRyan School of Medicine 

M203 

ARyan School of Medicine 

A142 Pennington Ave. 

AOlin Hall 

ALos Angeles, CA 34253 

LGrants 

^ 

D01/16/2014 

T-87500.00 

NPrint 

PRyan School of Medicine 

M204 

ARyan School of Medicine 

A142 Pennington Ave. 

AOlin Hall 

ALos Angeles, CA 34253 

LGrants 

^ 
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Importing Payment Data 

After a check has been cut, you can use the Payment Import feature to import check number 
and check date information from your accounting system into GIFTS Online. The Payment 
Import updates existing Payment records with the imported check number and check date 
information; it does not create Payment records.  

In order to use this feature, your accounting system must be able to generate a standard GIFTS 
Online ASCII file; this format is defined in “Standard Payment Import File Layout”. 

CAUTION: Before performing any import, make sure that you have a backup of your GIFTS 
Online database. In case of problems, it may become necessary to restore the backup in order 
to continue working. 

To import payment information from an ASCII file: 

1. From the GIFTS Online Launch menu, select Import A/P Data. 

 
2. Click the Browse button and select the file you wish to import. 
3. Click Open to return to the Import A/P Data window. The system will automatically check 

the data in the import file to make sure the payment ID, Dates and Amounts match 
existing Payment records. 

4. Once all warnings and errors are cleared, click the Import button to continue. 
5. The Import A/P Data window will display a Payment successfully imported message for 

each record. 
6. Click OK to complete the process. 
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The following will be updated depending on the import file type: 

Standard A/P Import File: 

 The date, time will be taken from the header lines of the import file and displayed. 

 The # of checks and total amount will be taken from the footer line of the import file and 
displayed. 

QuickBooks A/P Import File: 

 The date range will be taken from the second header line of the import file and displayed. 

 Time will be hidden and its label suppressed. 

 The # of checks will be calculated by counting the number of transactions in the import 
file and displayed. 

 Total amount will be calculated from the detail section of the import file by adding up the 
AMOUNT fields and displaying the sum as a positive number. 

Standard A/P Import File Layout 

The standard Import file consists of the following sections in a text file. 

Header 

The header section includes the following fields: 

Field Description 

Title The following text: CHECKS IMPORT FILE 

Current Date mm/dd/yyyy. 

Current Time hh:mm:ss format (military time). 

Details 

For each Payment, the details section includes the following fields: 

Field Description 

Payment_ID The ID of the payment that was exported from the GIFTS Online 
system. 

Payment Amount Amount, including decimal point. 

Check # The check number. 

Payment Date mm/dd/yyyy format. 

Organization Vendor # If the Organization associated with a Payment does not have a Vendor 
Number in GIFTS Online, this optional field is used to update the 
Organization’s Vendor Number with the number assigned by your 
accounting department. 
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Footer 

The footer section includes the following fields: 

Field Description 

Label The following text: END OF FILE 

Number of Payments Total number of payments included in the file. 

Total Payment Amount The sum total of the amount of the payments included in the file. 

 
Example Import File 
  

CHECKS 
IMPORT 
FILE 

02/21/2012 11:47:04     

32097 1260.00 0015587 02/19/2012 91564 
32096 300.00 0015588 02/19/2012 13870 
END OF 
FILE 

2 1560.00     

  

QuickBooks A/P Import File Layout 

This section details the ASCII file generated by the “GIFTS Export” report that users create in 
QuickBooks. 

The Import file consists of a two-line header section, a detail section that lists each payment on 
a separate line, followed by a single-line footer section. Each line in the file is separated by a CR 
(carriage return) and LF (line feed). The fields within each line are separated by tabs. 

Header Rows 

The first line of the file is a header that consists of an empty field followed by fields containing 
the name of each field in the transaction records. The following is the exact format of this first 
line: 

TYPEDATENUMNAMEMEMOACCOUNTCLRSPLITAMOUNT 

The second line consists of the date range selected in the QuickBooks report, followed by ten 
blank fields.  The date range in the header is not required. The format for the date range is 
mm/dd/yyyy-mm/dd/yyyy. The following is an example of the second line: 

01/01/2012-12/31/2012 

Detail Rows 

For each Payment, the detail section includes the following fields: 

Field 
Name 

Description Sample Data 

[left Blank.   
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margin] 

TYPE NOTE: This field is not used during import. 

Indicates the transaction type. 

CHECK 

DATE Check date, in mm/dd/yyyy format. If the Payment is marked 
as Paid during the import, this is imported to GIFTS Online as 
the Payment Date. 

10/13/2012 

NUM The Check Number, which is imported into the appropriate 
Payment record or records. 

0006454 

NAME NOTE: This field is not used during import. 

The legal name of the payee Organization. If the name in GIFTS 
Online was longer than 40 characters, it was truncated when it 
was exported to Quick Books. 

Jeter College of 
Dentistry 

MEMO NOTE: This field is only used to get the Payment ID, otherwise 
it is not imported. 

The values in this field populate based on the ‘Include 
Payment ID in Memo Field (required for import)’ setting that 
was set on the export dialog. 

If set to checked (true) - This field is preceded by 
“(*GFW=[Payment ID])”. The Project Title of the Request with 
which the Payment or Payments are associated. 

If set to unchecked (false) this value will be blank and the 
records will error out. 

(*GFW=345)General 
Operating Support 

ACCOUNT NOTE: This field is not used during import. 

The QuickBooks Account Number entered into the A/P 
Module preferences. 

1234-567-8 

CLR NOTE: This field is not used during import. 

Can indicate whether the check has cleared. 

  

SPLIT NOTE: This field is not used during import. 

Identical to the ACCOUNT 

1234-567-8 

AMOUNT The Payment Amount, prefixed by a minus sign (-). For 
Payments grouped by Request, this is the total amount of the 
Payments in the group. 

-30000.00 
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Footer Row 

The last line is identical to the second line of the header.  As with the date range in the header 
row, the date range is not required in the footer row but if there is a date range in the header, 
there must be one here as well because the two rows need to match exactly. 

  

Example Import File 

TYPEDATENUMNAMEMEMOACCOUNTCLRSPLITAMOUNT 

01/01/2012-12/31/2012 

CHECK10/13/20120006454Jeter College of Dentistry(*GFW=345)General Operating 
Support1234-567-8-30000.00 

CHECK11/10/20120006487Jeter College of Dentistry(*GFW=345)General Operating 
Support1234-567-8-30000.00 

01/01/2012-12/31/2012 

  

Verifying a Quickbooks Import File 

When a file is selected, GIFTS Online must detect the import file type and confirm all lines in the 
file match the appropriate layout and that the data is correct and can be used to update the 
appropriate field in Payment records. 

If any errors are found, a process log opens detailing each line in error. 

GIFTS Online reads the first line of the import file to decide on the file format. If the first line 
exactly matches the QuickBooks header first line format, then import process proceeds to parse 
it as a QuickBooks A/P import file layout.  

The QB header is specified in QuickBooks Header Row section of this document.  

The exact text to match is below: 

TYPEDATENUMNAMEMEMOACCOUNTCLRSPLITAMOUNT 

If the first line does not exactly match the text above, the import process assumes a standard 
A/P import file format. 

  

Quicken AP Import File Layout 

The following section describes the Quicken Import process. 

Import Form 

GIFTS Online will recognize that the file is from Quicken when it parses the file and will attempt 
to import the file and will expect it to be in the format as outlined in section below. 

Once you attempt to import, a process log in the Import Form displays the progress of the 
import, listing the status of each payment and explaining why any individual payments were not 
imported. 

When the import is complete, the Check Number field of each Payment record will have been 
updated with the Check Number from the Quicken transaction record. 
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If you chose to mark the payments as ‘Paid’, GIFTS Online will have also changed the Status of 
each payment to ‘Paid’ and updated the Payment Date with the date of the Quicken transaction. 

Quicken QIF Import File 

This section details the format expected for a .QIF file from Quicken to be imported into GIFTS 
Online. 

 The first line of the file is: !Type:Bank 

 The file consists of one or more Quicken transactions and each transaction consists of 
multiple data elements. Each data element appears on a separate line, preceded by a 
single character that indicates the nature of the data. 

 Each transaction with in a file ends with the “^” character on a separate line. 

 Each transaction must consist of at least one of the following data elements: 

Prefix Data 

D Payment Date. The date of the transaction, in mm/dd/yy format for years prior to 
2000, and in mm/dd’yy format for year 2000 or later.  

T Payment Amount. The amount of the transaction, preceded by a hyphen. 

N Check Number (the check number of the transaction). The value here should update 
in the Payment record (payments.check_number). If payments were grouped all 
payments in the group should update with this number. 

M The Payment ID which matches up to the Payment ID when exported from GIFTS 
Online. Used to match this transaction to the GIFTS Online Payment or Payments 
that were originally used to create the transaction. The system should check this 
field for a value in parentheses with a comma (like “(84,21)” as this will indicate that 
this was a group of payments rather than an individual payment. If there were 
grouped payments, the Transaction_ID will be the first number in parentheses in this 
field (following the title if that was included). The system should find all payments 
with this ID in the Transaction_ID field of their payment records in order to 
determine which records are updated upon import.  

 

If any transaction has less than the above data, or if the transaction’s Payment Amount is not 
preceded by a hyphen, the transaction is ignored by the GIFTS Online import. Note that the .QIF 
file may include additional data for each transaction that is not used by GIFTS Online. The 
extraneous data is ignored and does not affect the import. 
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Sample .QIF Import File 

NOTE: There is extra information in this file that would be ignored during the import. Rows 
preceded by U, P, and L will be ignored. 

!Type:Bank 

D1/16’14 

U-87,500.00 

T-87,500.00 

N1003 

PRyan School of Medicine 

M203 

LCategory 

^ 

D1/16’14 

U-82,000.00 

T-82,000.00 

N1004 

PRyan School of Medicine 

M204 

LCategory 

^ 
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Check Writer 

The Check Writer option in the Accounts Payable Module allows you to print Payment data in 
the right places on your own check stock. 

The Check Writer feature will update Payment records with their new Paid status and a check 
number reference. 

Since checks must ID the bank account from which the funds will be drawn, the system also 
includes bank account records, each with a check register listing checks printed. 

Check Writer customers will therefore have access to the following: 

Bank Accounts 

The system will allow you to add multiple bank accounts, capturing basic information like name, 
account number, bank routing number, and so on. 

GIFTS Online will maintain a check register for each Bank Account that details the checks that 
have been issued from the account. The register also indicates which checks have been voided, 
providing a complete record of the activity on the account. 

NOTE: This function is for historical tracking only and in no way interacts directly with your 
financial institutions. 

Check Templates 

Through the use of Check Templates in the Document Template Manager, you will be able to 
arrange Payment merge fields on a page and then configure settings like margins, fonts, and 
font size so your checks will turn out perfectly. 

To make sure all elements are nicely aligned, an option to test print is available. 

Roles and Preferences 

Access to Bank Accounts and the ability to print checks will be restricted in GIFTS Online to those 
in the Grants Manager role, as they are responsible for processing Payments. 

Enabling the Check Writer Feature 

To enable the Check Writer feature, you must email a request to MicroEdge at 
services@microedge.com. 

Current Accounts Payable (A/P) module clients will have the option of choosing between using 
the A/P Link or Check Writer option. 

As part of implementation, MicroEdge will set up the A/P module for new clients to use either 
Check Writer or the A/P link. 
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Bank Accounts 

To print checks, you will need to create the bank account(s) from which your checks will be 
drawn. GIFTS Online will maintain a sort of “check register” for each account, which will detail 
the checks that have been issued from the account. The register also indicates which checks are 
void, providing a complete record of the activity on the account. 

You will be able to access Bank Accounts using a new Manage Bank Accounts option on the 
Admin menu. 

 

 

This window provides access into all the functions of Bank Account maintenance: 

• Bank Accounts are listed in alphabetical order by Description. 

• Clicking the Description (left column, in blue) navigates to the Bank Account Edit Form where 
you can edit the Bank Account details and view the check register. 

• The right column shows the account number for the Bank Account. 

• The Add Bank Account link opens a new Bank Account Edit Form. 

• Clicking the Printer-friendly Version link displays the bank accounts list in new browser 
window which can be easily printed. 

The Bank Account Edit Form 

The Bank Account Edit form will look similar to the form below and allow you to enter/modify 
the following settings: 

Setting Description 

Related List Located on the left panel, this area will list all Payments or Checks for 
the currently displayed bank account. 

Description A short name for the bank account. (50 chars max) 
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Account Number The account number printed on the check stock. (50 chars max) 

Routing Number The bank routing number printed on the check stock. (50 chars max) 

Bank Name The name of the bank. (50 chars max) 

Default Check 
Template 

The check template to use for this bank account. 

Next Check Number The next check number to start with. 

Inactive Checkbox Check this box to make the bank account inactive. 

Save & Close Save your changes and close the edit form. 

Save Save your changes. 

Cancel Close the edit form without saving changes. 

 

 

Deleting Bank Accounts 

NOTE: If you are creating a new bank account, this option will not be available. 

To delete an existing bank account: 

1. Open the bank account’s edit form. 

2. Click the Delete menu option. 

3. A prompt will ask you to confirm the deletion. Click Yes to continue. 

4. If transactions have been process for this bank account, another prompt will be displayed. 

5. Click Yes again to confirm the deletion or No to cancel out of the process. 
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Related Lists on Bank Account Edit Forms 

The following Related records will be available on the Bank Account Edit Form: 

 Payments – will display the standard Related Payments grid 

 Checks – click to display the check register list with the following columns: 
o Date 
o Status 
o Amount 
o Check # 
o Payment ID 
o Organization/Contact 

Printing the Check Register 

When viewing the Related Checks list, you can generate a view for printing by clicking the 
Printer-friendly Version button in the Actions menu. This will open a new browser window from 
where you can easily print the list. 
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Check Templates 

A new correspondence category called Check Templates will available in the Document 
Template Manager. Multiple check templates can be created in the Document Template 
Manager. 

 

Creating a New Check Template 

To create a new check template: 

1. Select the Check Templates category on the left pane. 
2. Use the New > New Template menu option. 

NOTE: You may also use the New Template from Default option if you would like to start 
from a Great Plains or Quickbooks Pro default template. 

 

3. Enter a Template Name, Description, and verify the number of Checks Per Page. 
4. Click OK to move on to the Merge Fields: Check Templates form. 

NOTE: If you chose a default template, the Merge Fields selection form will be skipped. 
Jump to step 8. 
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5. Select a category from the drop-down menu in the upper left corner and then locate the 
fields you wish to have available as merge fields on the template. 

6. Select a field and click Include to move it to the list on the right. 
7. Repeat steps 4 and 5 as necessary. 

The categories of merge fields available for check templates are the same as for 
Payments including all the related record types. 

In addition, the following merge fields will be available once the template is opened in 
Word: 

• Account Number 

• Bank Name 

• Description 

• Routing Number 
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8. Click OK when done and Microsoft Word will open your new template. 
9. You can now set up/modify the check template to fit your check stock. Issues to keep in 

mind include dimensions, margins, which fields to merge in, customized text, images, and 
position of all those elements. 

 

10. Save the template when done and close Word. Your new templates will be listed on the 
main Document Template Manage page. 

Modifying Existing Check Templates 

There are several ways to modify existing check templates: 

Action Description 

Double-click a listed 
template 

This action will directly open the template in Word for editing. 

Select a template and 
then click Open 
Template 

Same response as above. 

Select a template and 
then click Open 
Merge Fields 

This will open the Merge Fields: Check Template form with the merge fields 
for the selected template listed and allow you to add or delete fields as 
needed. 

Select a template and 
then click Copy 
Template 

This action will open the Copy Template form which allows you to copy the 
existing template and save with a new name. You will have the option to 
include Header Only or Header and Text. 

Select a template and 
then click Rename 
Template 

This action will open the Rename Template form which allows you to modify 
the Name or Description. 

Recreate Headers   

Delete Template This action will delete the selected template after you select Yes at the 
confirmation prompt. 
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Printing Checks 

To print the payment checks, the following must be done: 

1. Perform a search for Scheduled Payments. 
2. Select one or more Payments from the search results page(s). 
3. Go to Actions > Produce Checks. 

 

4. On the Produce Checks form: 

a. Select the Bank Account. 

b. Modify the Check Date if necessary. (defaults to the current date) 

c. Select a different Check Template if necessary. 

d. Check the box if you want to Test template alignment. 

i. If printing on blank paper, leave on Do not update next check number. 

ii. If using actual check stock for the test, select Test on check stock. 

e. Enter the Next Check Number according to your current check stock. 

f. If your template accommodates multiple check positions, enter the number of the First 
Check Position you wish to start printing on. 

g. Note any Warnings or Errors listed at the bottom. 

i. To remove invalid payments, click the Remove Invalid Payments link at the 
bottom of the list. 

h. Click Produce Checks to continue or Cancel to close the form. 
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5. A prompt will popup asking “Are you sure you want to proceed?” Click Yes to continue or 
No to cancel the process. 

 

6. When complete, a Produce Checks progress log will be displayed. 
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7. Note any Warnings or Errors which may be listed. Don’t click OK yet. 

NOTE: The Reprint Checks button will be discussed on the next page. 

8. On the bottom of the screen, you will note an orange popup message asking if you would 
like to open the new check document. Click Open to see the merged Payments on the 
check template you selected. 

 

9. The produced check document will be opened in Word where you can then print to your 
check stock. 

10. If the checks printed correctly, you can now close the check document and click OK on 
the Produce Checks log. 

11. Notice your Payments now have a status of Paid and a Check No referenced in the Payee 
column. 
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Reprint Checks 

1. If a problem occurred during the printing process, you have the option to use the Reprint 
Checks button on the Produce Checks log form. 

2. Clicking Reprint Checks will display following the fields on top: 

a. First Failed Check – enter the number for the first check that you want to reprint. 

b. First Check Position 

c. Reuse Check Numbers – check this box if you caught an error before printing on the 
check stock and want to regenerate the merged check document. Checking this box will 
disable the Next Check Number field below. 

d. Next Check Number – if some or all of the actual check stock were used in the initial 
printing, you can enter a new starting check number here. 

 

3. Fill in the fields as needed and then click the Print button to regenerate the check document. 

4. Open the new document and Print it on the check stock. 
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About the GIFTS Online Blueprint 

Module 

GIFTS Online Blueprint is a comprehensive set of tools which have been built using the new 
GIFTS Online interface to help create custom fields and forms which can be used to personalize 
your GIFTS Online system using your own language and terminology through the system and 
tailoring of the experience of each of your users. 

You can access the Blueprint tools by going to the Admin menu and clicking Blueprint. A 
submenu will be displayed allowing you to access each specific tool. 

NOTE: This option will only be available to Grant Managers. 
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The Custom Fields Manager 

The Custom Fields Manager is the tool used to create and modify custom fields, custom 
calculated fields, and URL links. 

This tool can be launched from the Admin > Blueprint > Custom Fields from the ribbon menu. 

The Custom Fields page will open and look similar to the following: 

 

The left panel lists all the Record Types you may choose from. Simply click on a record type to 
see a list of existing custom fields for that specific Record Type on the main area to the right. 

  

Adding a Field 

IMPORTANT: Please note there is a limit of 500 custom fields per record type. It is 
recommended, however, to keep your custom fields to under 250 per record type as higher 
numbers may impact form loading performance for your applicants and users. 

To add a new field, go to New > Field on the upper right menu to open the Adding Field form. 

 



GIFTS Online 5.1 User’s Guide 

501 
 

The table below describes the various types of fields which can be created: 

Field Type Description 

Text Holds any text information up to a limit of 255 characters. If you 
want, you can make the character limit smaller. 

Long Text Holds any text information up to a very high limit. (The precise limit 
varies among different client/server and file server systems, but in 
every case it is many tens of thousands of characters.) If you want, 
you can designate a specific character limit. 

Small number, no decimal Permits integers between zero and 255. 

Medium number, no decimal Permits integers between -32,768 and 32,767. 

Large number, no decimal Permits integers between -2,147,483,647 and 2,147,483,647. 

NOTE: Please do not use Small, Medium, Large number types if the 
field is to be used for currency values as an error can occur if a 
currency symbol is entered. 

Currency Permits numbers with two decimal places and a currency symbol. 

Number, with decimal Permits numbers with as many as four decimal places. 

Date Permits dates in the following format: mm/dd/yyyy) 

Values Holds a value from a list that you define. During data entry, users can 
choose from the values you enter, much in the same way that users 
choose from lists of classifications in coded fields like Request Status 
and Request Type. 

If you choose this field type, you must also enter the available values. 

NOTE: This type field can only hold a maximum of 255 characters. 
Anything over 255 characters will be truncated when you save. For a 
longer list of values, it is recommended to use a code table instead. 

True/False Permits a “Yes/No” or “True/False” response. On the data entry 
screen, it appears as a check box. A selected check box indicates 
“True”; a cleared check box “False.” 
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Adding a Calculation Field 

IMPORTANT: Please note there is a limit of 500 custom fields per record type. It is 
recommended, however, to keep your custom fields to under 250 per record type as higher 
numbers may impact form loading performance for your applicants and users. 

To add a new field, go to New > Calculation on the upper right menu to open the New 
Calculation form. 

 

Clicking the Insert Field link will display a list of all the current Currency, Date, or Number fields 
which can be added to the formula.  

NOTE: You will need to add mathematical symbols (+, -, *, or /) between field variables 
manually. SUM and AVG functions are also allowed but must be in all CAPS. SUM() or AVG() 
Example: SUM(Field1, Field2, Field 3) or AVG(Field1, Field 2, Field 3) 
 
Alternatively, you may also use the Add operator instead of SUM.  
Example: {Field_1}+{Field_2}+{Field_3} 

  

  

Adding a URL Link 

IMPORTANT: Please note there is a limit of 500 custom fields per record type. It is 
recommended, however, to keep your custom fields to under 250 per record type as higher 
numbers may impact form loading performance for your applicants and users. 

To add a new field, go to New > URL on the upper right menu to open the Adding URL (New) 
form. 
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The Insert Field link will display a list of all fields for the selected Record Type and allow you to 
add one or more to the URL. 

  

Editing and Deleting a Custom Field, Calculation, or URL 

All custom fields, calculations, or URLs are listed with an Edit pencil icon and Delete icon in the 
right side of the grid. 
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If clicked, the pencil opens the Editing Field form: 

 

Notice the field name is displayed in parenthesis on top and only OK and Cancel buttons are 
available. 

CAUTION:  

 Changing the data type of a field may cause loss of data if the data types are 
incompatible.  

 Deleting a custom field will remove the field and all of the historical data stored in the 
field from the system. There is no undo. 
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The Fields Library 

The Fields Library allows you to access a list of all fields currently available in the system (both 
Standard and Custom)for all record types in order to manage custom labels, help text, and make 
certain fields hidden or required. 

This tool can be opened from the Admin > Blueprint > Fields Library. 

 

  

Selecting the Labels to Personalize 

In order to personalize field labels to match your organization’s terminology, do the following: 

1. Select the Record Type on the left panel for the field you wish to customize. 
2. Optionally, the Region menu can be used to set this session’s changes for a specific 

region of the world. 
3. Scroll down the list until you find the standard label for the field you wish to change. 
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4. Enter your desired custom label in the Custom Label entry field.  

 
5. Click the Save button at the bottom of the screen. 
6. Repeat this process as necessary for other fields. 

  

Configuring Different Region Sets 

The Region menu in the lower left panel allows you to configure custom labels and settings for 
users who have their Windows Operating System set to a specific region.  

 

All regions currently available in the Windows Region settings will be available on this menu. 

 When first accessed, the user’s current region will be the selected Region.  

 On subsequent visits, the system will remember the last Region used. 

Example: This can allow GIFTS Online users of the same organization in the United States, Spain, 
France, and the UK to see four different sets of custom labels for various fields. 
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Hiding a Field 

You can hide some fields in the system using the Hidden checkbox to the left of the standard 
field label.  

 

Simply check the Hidden checkbox and click Save. 

NOTES:  

 If the field is currently flagged as Hidden, the Custom Label entry field will be disabled. 

 If the field is made Hidden in the future, all other settings for that field will be reset. 

The following field types cannot be made hidden and will have a disabled checkbox: 

 System Required 

 Coding Sheet Codes 

Adding Tool Tip Style Help Text 

Tool Tip style help text can also be assigned to specific fields using the Help Text entry field.  

 

This will display a blue  icon next to the field when used in a form. 

Placing the mouse cursor over this icon will display the Help Text. 

 

The Help Text entry field allows for short help information. For a larger area to type in, click the 

Edit  icon to open an entry form popup. 
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Making Specific Fields Required 

To make specific fields required, check the Required box to the right of the Standard Field Label. 

 

The following field types cannot be made required: 

 System Required – these fields will be checked but disabled. 

 Boolean (True/False)  

 Web Clippings   

 Calculated Custom Fields 

 Coding Sheet Codes - Coding Sheet codes can be made required by contacting 
services@microedge.com 

  

Resetting One or All Fields 

Don’t like the changes you made to a field? Simply click the Reset icon to return to the last saved 
state. 

 

To reset all fields back to the last saved state, click the Reset All icon in the lower right corner. 

 

  

mailto:services@microedge.com
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The Forms Library 

The Forms Library is where you will create new Record Forms (Data Entry Forms) or modify 
existing forms.  

Custom Record Forms can be created and assigned to individual users, groups of users, or for 
different giving programs (Request Types), allowing the data entry/processing experience to be 
personalized to meet each user’s needs. 

This tool will be launched from the Admin > Blueprint ribbon menu item.  

After selecting Blueprint, select Forms Library from the popup menu displayed to open the 
Forms Library. 

 

  

Ribbon Menu Options 

The Actions menu will vary depending on whether a form is selected or not.  

Menu option Description 

New Form This option is always visible. 

Will open the new form selection popup asking for a Name, Record Type, 
Request Type (if Request record type is selected), and a form to base the initial 
design on. 

System-default forms are available as an option when creating a new form to 
use as a base.  

NOTE: Modifications to system forms must be saved to a new form name. 
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Your other options are to start with a Blank form or another existing custom 
form as a base. 

Open If one or more forms are selected, this option will be visible. 

Click this will open the form(s) selected in edit mode. 

Assign To If one form is selected, this option is visible. 

This option allows you to assign the form to specific users or groups of users. 

 

There are several selections available in the Options menu: 

Menu option Description 

Export or Print Export the currently displayed columns on the screen to an Excel spreadsheet. 

Print Displays the currently displayed columns in a new browser window which can 
then be printed.  

Add to Dashboard Set the form to be displayed on a specific dashboard.   

Report Takes you to the Report Designer with the current columns from the screen 
already defaulted into the report. 
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The Forms List 

The main area of the Forms Library displays a list of existing forms dependent on the Record 
Type selected: 

 

 

Column Description 

Select Box Check the box to select the form. 

ID Displays the form’s ID number. 

Name Displays the name of the form. 

Active Displays the form’s status. Inactive forms will state No. 

Assigned 
Groups 

Displays the groups assigned to the form. 

Assigned Users Displays the individual users assigned to the form. 

Request Type Only displayed if the Request record type is selected. 

Review Stage Only displayed if the Review record type is selected. 

Audit Displays the Created and Last Changed Date along with the username. 



GIFTS Online 5.1 User’s Guide 

512 
 

How Do I Modify an Existing Form? 

To modify an existing form, do the following: 

1. Go to the Blueprint Forms Library. (Blueprint > Forms) 
2. Click on the Record Type for the form. 
3. Locate the form you wish to modify in the main list and select it. 
4. Double-click the form listed or go to Actions>Open to open the form in edit mode. 
5. Make the modifications necessary and click Save and Close. 

  

The Form Design Window 

The form window includes all of the options available for creating or modifying a data entry 
form. 

 

Header Information 

The header area in the upper left shows the following information: 

 Record Type 

 Name of Form – will say (new) if the new form has not been saved yet. 

 Status of form – Active or Inactive 

 Request Type – only on Request forms 

 Assigned Groups/Users 
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Actions Menu 

Actions Menu Description 

Details Clicking on this will open a form displaying the name of the form. It will 
allow you to change the name if necessary. 

Activate To make the form usable by other users, you must Activate the form.  

Deactivate You can also Deactivate a form if you wish to take it off-line. 

Assign To Assign the form to one or more Users or one or more Groups. 

Report Generates a report for the currently open form showing all fields, 
custom labels, and standard labels used.  

Delete Deletes the form if the popup confirmation is accepted. 

 

The Add Fields List 

On the right side of the form edit page is the Add Fields List. 

To limit the fields which are listed, you can uncheck one or more of the three filter checkboxes 
at the top. Default is for all three to be selected.  

 

The Find field can be used to quickly find a field you want to add to the form. 

Once a desired field is found, simply drag it from the list to the main form area and drop it on a 
designated drop point or gold line underneath an existing field. See Moving a Field section for 
more details. 

The Main Form Area 

The main form area in the middle displays your form exactly as it will appear to users in GIFTS 
Online. 

In this area, you can: 

 Add new fields from the fields list 

 Modify existing labels and fields on the form 

 Move existing fields as needed 

 Remove existing fields from the form 

 Expand or Collapse fields 
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NOTE: The Wire Transfer section that is available on the Request, Organization, and Payment 
forms includes special functionality and has to be maintained as an entire block. The field labels 
and prompts cannot be modified in this section. 

The Sections List 

The right panel contains options for adding new sections, editing existing sections, moving 
sections up or down, and removing sections. 

 

  

Adding a Section 

Use the +Add button to add a new section to your form. 

Section Action Icons 

Each section listed will have the following action icons next to it.  

 

Icon Name Description 

 
Edit Section Click this icon to open the section’s edit form. 

  

 Move Section 
Up/Down 

Sections can be re–ordered by clicking the up or down arrows 
associated with the section. 

The up arrow is disabled for the first section on the form; likewise, the 
down arrow is disabled for the last. 

 Delete Section You can remove a section at any time. All Labels and Prompts are 
removed along with the section. 

You will be required to confirm your intentions and will be warned 
that there is no undo for this action. 
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The Edit Section Form 

 The Disposition Type menu allows you to designate specific sections on Request Forms 
for a specific disposition or all dispositions. 

 Instructional text can be included at the top of each section. 

 

  

Adjusting the Field Width 

The default number of columns in GIFTS Online is one column. This means each field is displayed 
on its own row. 

With a Blueprint custom form, this can be modified so that a specific row has multiple fields on 
it.  

Additional columns are useful when you want to include more than one entry field on the same 
row. 

For example: Project Start and End Dates or City, State, Zip Code 

NOTE: It is recommended to have a maximum of three fields in a row.  

The width of a field can be adjusted by moving your mouse cursor over the double line between 
two fields. When the cursor turns into a double arrow, click and hold the left mouse button and 
drag the column side to the desired width.  

 

NOTE: The actions of adding and removing fields will change the widths of the fields remaining 
to distribute them evenly, so a good tip is to make manually adjusting the column widths the 
last thing done. 
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Moving a Field  

Existing fields can be moved by dragging and dropping. Simply click on a field and slowly drag it 
to the desired location.  

As you start to drag a field away from its current location the form displays drop location 

markers  to the left and right of all the current fields on the form.  

 

If you drop the field onto one of these markers, the field will be placed in that location on the 
same row. 

In the example below, Reference No was placed to the right side of the Status field. 

 

To move a field so it takes up an entire new row by itself, drag the field to the space between 
two existing rows. A gold bar will become visible to show where the field will be placed. 

In the example below, the Status field is being moved between Branch ID and Type. 
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Removing a Field from a Form 

To delete a field, simply click on the field and then press the Delete button on your keyboard.  

A confirmation message will be displayed. Click Yes and the field is removed. 

 

  

Editing a Field 

Editing a field with Blueprint is easy. 

Simply select the field in the form and all of the related settings are displayed for modification 
on the lower right panel. 

 

IMPORTANT: Changes are not permanent until you SAVE. If you don’t like the changes you’ve 
made to a form, click Cancel and then select No on the prompt to Save. 
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Assigning Custom Forms to Users 

Once you have custom forms built for your GIFTS Online users, it is a very simple process to 
assign them to specific users. 

The same process is also used to remove custom forms from specific users. 

  

To modify existing form assignments, do the following: 

1. Open the Forms Library. 
2. Select the form you wish to assign to or unassign from a user.  
3.  Go to Actions>Assign To in the ribbon menu to open the Assign to Users/Groups form. 
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4. On the Assign to Users/Groups form, select either individual users on the left side list or 
groups on the right side list. 

 
5. Optionally. you can uncheck specific users or groups that no longer need access to the 

custom form. 
6. Checking the Show Select List box on top of either panel will limit the displayed list to 

only the ones chosen. 

 
7. Click Save. 
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The Budget Module 

If your organization works on one or more annual budgets, the optional GIFTS Online Budget 
Module allows you to enter your pre-planned giving budget at the beginning of each year and 
then track your actual giving against this budget as the year progresses. 

NOTE: The GIFTS Online Budget module is optional; your GIFTS Online system may not include 
the features described in this and the following help topics. 

Each annual budget, like that of most grant makers, is arranged in a series of tiers. At the top 
tier you have your total budget amount, which gradually breaks down into further and further 
detail. Some grantmakers may have simple budgets with only one or two tiers; others may have 
more complex budgets with five or six tiers. 

If you need to take time to review key terms in managing and using Annual Budgets in 
GIFTS Online, click here for definitions of key terms. 

If you're ready to review the budgeting process, it is summarized below: 

 Before the new fiscal year starts, you set up your annual budget according to the 
allocations approved by your board or company. 

 Once your allocation is complete and the fiscal year begins, you will open the budget. 
Users may now appropriate funds from the budget to cover Payments. 

 During the year, you can track progress toward budgetary goals right on your 
GIFTS Online home page.  

 Annual Budgets offer flexibility during the giving year, allowing you to review and make 
changes as needed. 

 At year's end, you can close the budget to prevent further appropriations. 

  

Budget Module Glossary 

NOTE: This help topic describes features found in the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

GIFTS Online Annual Budgets are designed to reflect real-world budgeting processes. However, 
because terminology may vary from organization to organization, we provide this glossary to 
help you understand the major concepts and important terms used in GIFTS Online. 

  

Annual Budget Stages 

There are three stages in the life cycle of one year's Annual Budget. In each stage, there are 
different key activities and tasks. 

Planning Stage 

If you are like most grant makers, you probably begin planning next year's budget two to four 
months before the current fiscal year ends. 
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During this time, you get estimates on how much you'll have to give, then work to determine 
how that money will be distributed to different programs, geographic areas, regional offices, 
and so on. 

When you add a new Annual Budget, it starts in Planning stage. The main activity at this time is 
called allocating the budget. By allocating, we mean specifying the amount that will go to each 
division, each program, and each grant you already know you will give during the year. 

We call the records which capture these specifications "budget items." More information about 
the different types of budget items follows in this glossary. 

Open Stage 

When the allocation is complete and the fiscal year starts, you will open the Annual Budget for 
the year. 

Once the budget is in Open stage, GIFTS Online users can appropriate funds from the budget to 
cover Payments. "Appropriate" here means taking money from a specific budget item for use to 
cover a specific Payment. Those funds can no longer be used to cover a different Payment. 

Budget appropriation is the main activity during the Open stage of a budget. Additional tasks 
involve maintaining budget accuracy, allowing you to record the changes that often happen 
during a giving year. 

Closed Stage 

Once the fiscal year ends and you have appropriated funds for all the Payments you have made 
during the year, you will close the Annual Budget. 

Once a budget is closed, no one can appropriate funds for additional Payments. This preserves 
your record of how you met your budgetary and giving goals during that year. 

  

Budget Structure Terms 

 In Annual Budgets, you can allocate funds to very broad categories, then further allocate each 
category to more specific categories, and so on. 

This creates a budget structure which we refer to as hierarchal. For example, in this budget 
excerpt, we see a budget hierarchy with three levels. 

 

Northeast Region is on the top level. The money in for that region has been further allocated to 
four items on the next level: New York, New York VPs, Boston, and Boston VPs. Further, New 
York VPs total has been allocated to the three vice presidents themselves.  
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In addition to talking about a budget having a hierarchy and levels, GIFTS Online will refer to 
child and parent items. The budget item labeled "M. Piazza" is a child of New York VPs. By the 
same token, Northeast Region is the parent of the four items below it in the hierarchy. 

  

Budget Item Types 

The Annual Budget total amount is allocated to budget items during Planning stage. There are 
three different types of budget items in GIFTS Online. Understanding the purpose of each is key 
to using the budget. 

  

Category 

A Category is an amount of money allocated to a specific fund, program, or purpose, but not to 
any specific organization. 

Users do not appropriate funds directly from Categories; Categories must always have child Line 
Items and Reserve Funds for that purpose. 

Categories may also have child Categories. In fact, this is the main purpose of Categories; they 
are how you build your budget hierarchy. In our screen shot above, all the items shown are 
Categories.  

It may help to think of each Category as a budget in itself. It seems in our example that each 
VP gets his or her own giving budget for the year. Categories in the budget hierarchy mirror how 
funds are really distributed in this corporate structure, and the total amount for each 
VP Category reflects how much Piazza, Williams, and Parker have to give respectively. 

Line Item 

A Line Item is a dollar amount assigned to a specific Organization. Only Payments to the Line 
Item's specified Organization can be appropriated from the Line Item. 

Typically, you will add a Line Item and allocate funds to it with a specific grant in mind. Many 
corporate giving programs, for example, give to many of the same organizations year after year. 
Adding Line Items during Planning stage sets aside budget funds for each such grant. 

Reserve Fund 

A Reserve Fund is often a “left over” dollar amount in a given Category that is not allocated to a 
specific Organization. 

Throughout the year, users appropriate these funds to cover Payments for new discretionary 
grants. Reserve Funds can be added to the top level of an Annual Budget, or as the children of 
Category at any level of the hierarchy. 

  

Viewing Budgets 

NOTE: This help topic describes features found in the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

In order to access your Annual Budgets, simply go to Launch > Budget in your GIFTS Online main 
menu. 
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The Annual Budgets page opens, listing all Annual Budgets and, for each budget, its top level 
Categories and Reserve Funds: 

 

  

Actions on This Page 

Here you can: 

 Click Add Annual Budget to set up a new Annual Budget for another fiscal year. 

 Click the print icon  to print the list of Annual Budgets. 

 View the closed, open, or planning stage budget by clicking its year in the Year in column. 

  

Annual Budget Information 

The body main body of the page provides information about all your Annual Budgets. 

Year The fiscal year of the Annual Budget. 

The color of the font in each year row indicates the Budget's status: Red for 
closed budgets, green for open, blue for budgets in planning. 

Description The Description of each top level Category or Reserve Fund in the year's Annual 
Budget. 

Status Indicates whether the budget is closed, open, or in planning stage. 
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Current The current amount of the Annual Budgets and each top level Category and 
Reserve Fund. 

Hover your mouse pointer over this icon  to see a budget or item's original 
amount. The “original” amount is the amount of the budget or Category when 
the budget was initially opened; the total can change later if budget items are 
adjusted or added. 

Paid This is the total of Payments for approved Requests which have 1) been 
appropriated from the top level item and/or its descendants and 2) have a status 
of Paid, Void, or Refund. 

Committed This is the total of scheduled/contingent/hold Payments for pending and 
approved Requests which have had funds appropriated from the top level item 
and/or its descendants. 

Balance Available balance of the budget or top-level item. The formula follows: 

Current – Paid – Committed = Balance  
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Setting Up a Budget 

NOTE: This help topic describes features found in the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

To add a new budget, navigate to the Annual Budgets list and click the link to Add Annual 
Budget. The new Annual Budget page opens: 

 

NOTE: During planning and open stages, you can modify some of the budget settings you enter 
here. 

To add the new budget, enter the settings described below and click Create Annual Budget. The 
Annual Budget planning page opens. 

  

Fiscal Year 

Select the fiscal year for which you want to set up an Annual Budget.  

NOTE: You can only have one Annual Budget for a fiscal year. 

  

Amount 

Enter the total of the year’s budget (required). 
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Planning and Open Budget Options 

The following options affect how the budget works during planning and open statuses: 

Require user to confirm 
before increasing budget 
total during planning stage 

Select this check box if you have a firm idea what your total 
annual budget will be. During allocation, users won't be able to 
increase the total without first confirming the change. 

This allows you to do "bottom up" budgeting; you can enter the 
amounts of different Categories and have it add up to see what 
the total budget is. 

Allow budget item amounts 
to be adjusted 

Select this check box to allow budget items' amounts to be 
adjusted during open stage. Allowing Moving Budget Items 
allows the total budget amount to be increased or decreased 
during the giving year. 

Allow movement of budget 
items in the hierarchy 

If cleared, you cannot move budget items from one parent item 
to another when the Annual Budget is open. 

Note: Moving items around in budget tiers is always allowed 
during planning stage. 

Reserve Fund Allocation Setting 

Each Reserve Fund in an Annual Budget can be set either to allow a negative balance or not. 

During budget allocation, when "New reserve funds should default to allow negative balances" 
is selected, new Reserve Funds are set to allow this. It can be changed in each case; this sets the 
default. 

  

Assign Authorized Users? 

Select this check box if you want to employ authorized user permissions during the budget year.  

Authorized users can be established for Categories and Reserve Funds. (Each Line Item takes its 
authorized users from its parent Category.) Only authorized users assigned to a budget item will 
be able to access the item for Payment appropriation and funds transfers, affording a higher 
level of control and security. The Budget Summary dashboard part will only display budget items 
to which the user is authorized. 

If you choose to use the feature, you must then decide how it should be employed: 

All users are authorized for 
unassigned items 

This option works well if you have a relatively small number of 
budget items you need to restrict to certain users. 

By default, new budget items you add during allocation or open 
stage will be open to all users. Only if you specify authorized 
users will all other users become unauthorized. 

No users are authorized for If you plan to keep tight control on all or most of your budget, 
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unassigned items specifying in each case who may use an item, select this option. 

No one will be able to use a budget item until you add them as 
authorized users. 

 

TIP: Assign authorized users to Categories  before adding child items. By default, a new Category 
or Reserve Fund will take on its parent Category's authorized users. (Line Items always assume 
their parent Category's authorized users.) If you have a branching budget and a clear delineation 
of who may use each branch, enter the authorized users first, then allocate further. 

  

Budget Appropriations 

Many grantmakers have several giving programs, not all of which are tracked within the budget. 
For instance, you may have a Cash Grants program that is part of the budget, but also an In Kind 
program for non-monetary gifts that are not tracked within the budget. 

GIFTS Online allows you to exclude those Payments that are not relevant to your budget. In 
order for a Payment to require budget appropriation, both its Request's Type and its Payment 
Type must be selected here. 

1. First, select the Request Types whose Payments may hit the budget. 
2. Then, of those Payments, clear any Payment Types that you do not want to hit the 

budget. 

  

Setting Authorized Users 

NOTE: This help topic describes features found in the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

Each annual budget may be set up to use the authorized users feature. The authorized users 
feature allows you to establish authorized users for Categories, Line Items, and Reserve Funds. 
Only authorized users assigned to a budget item will be able to access the item for Payment 
appropriation and funds transfers, affording a higher level of control and security. The Budget 
Summary dashboard part will only display budget items to which the user is authorized. 

 Assigning authorized users for Categories is a help with data entry. By default, a new 
Category or Reserve Fund will take on its parent Category's authorized users. (Line Items 
always assume their parent Category's authorized users.) If you have a branching budget 
and a clear delineation of who may use each branch, enter the authorized users to 
Categories as you add them, then allocate further. 

 Each Reserve Fund you add defaults to having the same authorized users as its parent 
Category (except when adding top level Reserve Funds). However, you can add or remove 
authorized users, making each Reserve Fund's list different if needed. 

 Line Items take the authorized users assigned to their parent Categories. The list cannot 
be modified in different Line Items. 
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Assigning Users to Categories and Reserve Funds 

When adding or editing a Category or Reserve Fund, click + Authorized Users to expand the 
section. 

The panel on the left lists GIFTS Online users with permission to appropriate funds for 
Payments. To specify someone as an authorized user, select his or her user name and click Add. 
The user name moves to the right panel, which lists authorized users. 

You can remove someone from the list as well; select them in the right panel and click Remove. 

TIP: If you have a long list of users, use the search box to narrow it down. Enter part or all of the 
user name and click the binoculars icon; the list of users in the left panel is filtered to users who 
match. 

Effect of Adding Authorized Users 

The authorized user option in the Annual Budget setup has two settings; the effect of adding a 
first authorized user depends on that setting: 

Setting Result 

All users are authorized 
for unassigned items 

By selecting authorized users, you prevent all other users from 
appropriating or transferring the funds. 

If you don't add any authorized users, everyone can appropriate these 
funds. 

No users are 
authorized for 
unassigned items 

Only the authorized users you add can appropriate or transfer these 
funds.  

When you use this setting in your budget setup, it's important to add 
authorized users to all items. 

TIP: You will probably want to make sure to add them to top-level 
Categories before further allocating those Categories, to save time. 

Budget Module Branch Security 

NOTE: This feature is only available to Budget Module customers with Branch Security enabled. 

GIFTS Online checks the group(s) the current user is assigned to in order to determine which 
branches they have full or read-only access to, which in turn affects what is displayed on the 
pages. 

• When the default <All> branch menu open is selected, only categories and funds for which the 
current user has full or read-only branch access will be displayed. 

• The branch menu options will be limited as well to only those branches the current user has 
full or read-only access to. 

• When creating child reserve funds or line items, the branch field will be limited to the parent 
sub-category. 
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Budget Summary Dashboard Part 

This change in how budget items are displayed is also reflected in the Budget Summary 
dashboard part. Users will only be able to view the items for which they have full or read-only 
branch access. 

  

Allocating the Budget 

NOTE: This help topic describes features found in the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

Once you have created a new budget, you can distribute funds among your various Categories, 
Line Items, and Reserve Funds. Categories allow you to build the hierarchy of your budget tiers. 
Reserve Funds and Line Items are used to cover Payments during the budget year. 

Since the GIFTS Online Annual Budget is organized into a series of tiers, you must begin 
allocating funds at the top tier of your budget, and work downwards: 

 

  

Topics in this section: 

The Annual Budget Planning Page 

Adding a Category 

Adding a Line Item 

Adding a Reserve Fund 

Moving Budget Items 

  

The Annual Budget Planning Page 

NOTE: This help topic describes features found in the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

When you first add a new budget, this page appears blank - after all, you haven't had a chance 
to allocate the budget to any Categories or other budget items. 

However, to understand what you see on this page, we'll start with budget allocation already in 
progress: 
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Actions from This Page 

The following actions can be taken from this screen. 

Add a Top Level 
Category / Reserve 
Fund 

You can add new top-level Categories and Reserve Funds. 

NOTE: Line Items cannot be added to the top level of an Annual Budget. 

To add sub-Categories, Reserve Funds, or Line Items under a particular 
Category, access its Category menu and select the correct option. These 
are described below. 

Sort Top Level Items Sorts top level items: First, all top level Categories are listed in alphabetical 
order, followed by Reserve Funds in alphabetical order. 

Open Budget Once budget planning is complete and you have allocated the budget total 
to Categories, Reserve Funds, and Line Items, you must open the budget. 

Once the Annual Budget is open, users can begin appropriating funds from 
it to cover the Payments scheduled for that fiscal year. 

Modify Budget Setup You can change the settings you put in place when adding the Annual 
Budget. 

Delete Budget You can delete an Annual Budget while it's in planning status. 

 Clicking these icons will (respectively) expand or collapse all Categories in 
the body of the page below. 
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Clicking this icon will export the budget to Excel. 

  

Budget Information on This Page 

The body of the page shows all Categories in the budget, showing each one's place in the budget 
hierarchy. Top level Reserve Funds are also shown. 

This view allows you to see the "big picture" of your Annual Budget as you plan and allocate it. 
Under each Category, you can drill down to view and edit child Line Items and Reserve Funds 
you've already added. 

Description 

(No label) 

The Description of each Category or top level Reserve Fund. 

Note that each Category can be expanded to show its child Categories. In 

addition, clicking this icon grants you access to the Category or Reserve 
Fund actions, listed below. 

Budgeted Total amount allocated to the Category (or top level Reserve Fund). 

This field is editable. During planning stage , you can change the Category 
or top level Reserve Fund amount without opening the budget item edit 
form. 

Allocated Shows the amount from the Category’s budgeted amount that has been 
further allocated to Line Items, Reserve Funds, or sub-Categories.  

This column (and the next) are blank for top level Reserve Funds; Reserve 
Funds cannot be allocated to child items. 

Unallocated Shows the amount left in the Category for child Categories, Reserve Funds, 
or Line Items. 

It is the Budgeted amount minus the Allocated amount. 

  

Category Actions 

You can work with Categories in a planning budget by clicking   to open its menu. In the menu 
you will find the following options: 

Edit Opens the Category edit form. 

Delete Deletes the Category (and all its child items). 

Add Child Category Click to add a Category as a child of the selected Category. Moving Budget 
Items 

Add Child Reserve 
Fund 

Click to add a Reserve Fund as a child of the selected Category. 
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Add Child Line Item Click to add a Line Item as a child of the selected Category. 

Sort Child Items Sorts the Category's child items: First, all child Categories are listed in 
alphabetical order, followed by Line Items, then Reserve Funds. 

View Details Opens the Category details window, allowing you to view and edit the 
Category's child Line Items and Reserve Funds. 

  

Reserve Fund Actions  

You can work with top level Reserve Funds in a planning budget by clicking   to open its menu. 
In the menu you will find the following options: 

Edit Opens the Reserve Fund edit form. 

Delete Deletes the top level Reserve Fund. 

 

Adding a Category 

NOTE: This help topic describes features found in the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

A Category is an amount of money allocated to a specific fund, program, or purpose, but not to 
any specific organization. Categories are further allocated at the next level of the budget. Users 
cannot appropriate funds from Categories to cover Payments; rather, they allow you to build the 
hierarchy of your budget tiers, then add child Reserve Funds and Line Items to cover Payments. 

To add a Category: 

1. Open the new Category page by: 

 Clicking the Add Top Level Category link on the planning or open budget page. 

 Selecting the Add Child Category menu item next to the would-be parent 
Category. 

The new Category page opens: 
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2. Enter a Description for the Category. 
3. Enter either an Amount or a % of Parent Category (or budget total). GIFTS Online will 

recalculate the second field when you edit the first. 

NOTE: When the budget is open, a new Category amount is $0.00 and cannot be edited 
here. This is because GIFTS Online does not allow unallocated amounts in open budgets. 
(Unallocated amounts in an open budget can't be used to cover payments and risk being 
forgotten rather than given.) If you need to add a Category to an open budget, add it with 
an amount of zero and then add Reserve Funds and Line Items to it as needed. The total 
of those child items will become the Category amount. 

4. Enter Appropriation Filter codes, which default from the parent Category. When 
appropriating funds for Payments, users can narrow their choices of budget items by 
these filters. (Since users don't appropriate directly from Categories, these settings will 
serve as the default for child Reserve Funds and Line Items you add.) 

NOTE: If your GIFTS Online system employs the optional Branch Security feature and this 
is a second level Category, you will be required to select a Branch. Children of the 
Category will all inherit the same branch. If the Category is being added to a lower level of 
the budget hierarchy, it will inherit its parent Category's branch. 

5. Click + Authorized Users to assign authorized users to the Category. This link will not 
appear if your Annual Budget was not set up to employ the authorized users feature. 
Click here for more information on adding and using authorized users. 

6. To save the new Category, you can click Add and return to the Annual Budget page. If you 
want to add another sibling Category under the same parent, click Save and Add New: 
The Category is saved, and the form refreshes, allowing you enter details for the next 
Category. 
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Adding a Reserve Fund 

NOTE: This help topic describes features found in the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

A Reserve Fund is often a “leftover” dollar amount in a given Category that is not allocated to a 
specific Organization. Throughout the year, users appropriate these funds to cover Payments for 
new discretionary grants. Reserve Funds can be added to the top level of a budget, or as the 
children of Category at any level of the hierarchy. 

To add a Reserve Fund: 

1. Open the new Reserve Fund page by: 

 Clicking the Add Top Level Reserve Fund link on the planning or open budget page. 

 Selecting the Add Child Reserve Fund menu item next to the would-be parent 
Category. 

The new Reserve Fund page opens: 

 

2. Enter a Description for the Reserve Fund. 
3. Enter either an Amount or a % of Parent Category (or budget total). GIFTS Online will 

recalculate the second field when you edit the first. 

4. Select Allow a negative balance if you want to give users the option of appropriating 
amounts for Payments greater than the Reserve Fund's available balance. This will cause 
the Reserve Fund's balance to "go negative." 

5. Enter Appropriation Filter codes, which default from the parent Category. When 
appropriating funds for Payments, users can narrow their choices of budget items by 
these filters. For example, the Reserve Fund in our example will not be available for 
appropriation if the user 1) chose to filter by Program Area and 2) the Request's Program 
Area (level 1) was other than Arts and Culture. 
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NOTE: If your GIFTS Online system employs the optional Branch Security feature and this 
is a first or second level Reserve Fund, you will be required to select a Branch. If the 
Reserve Fund is being added to a lower level of the budget hierarchy, it will inherit its 
parent Category's branch. 

6. Click + Authorized Users to assign authorized users to the Reserve Fund. If authorized 
users were set up for the parent Category, those users are set here by default, but change 
be changed.  

NOTE: This link will not appear if your Annual Budget was not set up to employ the 
authorized users feature. Click here for more information on adding and using authorized 
users. 

7. To save the new Reserve Fund, you can click Add and return to the Annual Budget page. If 
you want to add another sibling Category under the same parent, click Save and Add 
New: The Category is saved, and the form refreshes, allowing you enter details for the 
next Category. 

  

Adding a Line Item 

NOTE: This help topic describes features found in the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

A Line Item is a dollar amount assigned to a specific Organization, often used for grants that are 
given annually. Throughout the year, users appropriate these funds to cover Payments for those 
planned grants, or even new grants for the Organization. Line Items can be added as the 
children of Category at any level of the hierarchy. 

To add a Line Item: 

1. Select the Add Child Line Item menu item next to the would-be parent Category. The new 
Line Item page opens: 
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2. Each Line Item must be linked to single payee Organization; enter search criteria in the 
Select Organization window and in the search results click the name of the payee 
Organization. The Organization information appears in the form: 

 

3. Enter a Description for the Line Item. 
4. Enter either an Amount or a % of Parent Category. GIFTS Online will recalculate the 

second field when you edit the first. 

5. Enter Appropriation Filter codes, which default from the parent Category. When 
appropriating funds for Payments, users can narrow their choices of budget items by 
these filters. For example, the Line Item in our example will not be available for 
appropriation if the user 1) chose to filter by Payment Type and 2) the Payment Type was 
other than Charitable Contribution. 
NOTE: If your GIFTS Online system employs the optional Branch Security feature and this 
is a second level Line Item, you will be required to select a Branch. If the Line Item is 
being added to a lower level of the budget hierarchy, it will inherit its parent Category's 
branch. 

6. To save the new Line Item, you can click Add and return to the budget page. If you want 
to add another sibling Line Item under the same parent, click Save and Add New: The 
Line Item is saved, and the form refreshes, allowing you enter details for the next Line 
Item. 

NOTE: If your Annual Budget is set up to employ the authorized users feature, you may note 
that there is no opportunity on Line Items to assign those users. In GIFTS Online, Line Item 
authorized users are set in the parent Category. That is, Line Items which are all children of the 
same parent Category will share the same authorized users, which were set when you added the 
parent Category. 

NOTE: Click here for more information on adding and using authorized users. 

  

Moving Budget Items 

NOTE: This help topic describes features found in the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

Budget Categories, Line Items, and Reserve Funds can be moved from one parent Category in 
the budget hierarchy to another during planning stage.  

When the budget is open, these same movements can be made if your budget setup allows it. 
The preference to "Allow movement of budget items in the hierarchy" must be turned on or 
budget items are locked into their place during open status. 

NOTE: Once the Annual Budget is closed, the budget hierarchy is locked and you can no longer 
move items. 
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You can move budget items by dragging and dropping them. Position the mouse point over the 
Category icon , hold down the mouse button, drag it to its new location, and release the 
mouse button. 

  

If you want to move a Reserve Fund or a Line Item to a different parent Category, you will need 
to view the budget item under its current parent first; then you can drag the Line Item icon  or 
Reserve Fund icon  to the a different Category. (Reserve Funds you can also drag to the top 
level.) 

  

Opening a Budget 

NOTE: This help topic describes features found in the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

When your budget planning is done, you are finished allocating Categories to Line Items and 
Reserve Funds, and the new fiscal year is ready to start, you will open the Annual Budget. 

When the Annual Budget is open, users can appropriate funds for Payments scheduled for the 
budget year.  

IMPORTANT: Review your budget allocations carefully before opening the Annual Budget. You 
can bring an open budget back to planning status, but only if no Payments were appropriated 
from it while open. 

To open the Annual Budget: 

1. On the Annual Budget planning page, click Open Budget. 

GIFTS Online checks to make sure all funds in the budget total and in all Categories is 
further allocated to Reserve Funds and Line Items. (Unallocated amounts are not allowed 
in open budgets: They can't be used to cover payments and risk being forgotten rather 
than given.) 

2. If unallocated funds in Categories or in the budget total are found, GIFTS Online will 
create a Reserve Fund for the unallocated amount (within that Category, or at the top 
level of the budget hierarchy). GIFTS Online first summarizes these potential changes: 
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Review this information carefully before proceeding. 

TIP: Click the  icon to print this page for further offline review. Click Cancel here if you 
want to consider any changes before proceeding. 

3. Click Open Budget to proceed. Any Reserve Funds summarized above are created, and 
the open Annual Budget page for the year opens. 

  

Maintaining the Open Budget 

NOTE: This help topic describes features found in the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

During the budget year, you and other GIFTS Online users are appropriating funds for Payments 
and tracking progress toward giving goals. But your budget may change during the year, and to 
keep an accurate record of what's happening with your giving, there are several tweaks and 
changes you may need to make during the year. 

The following topics are covered in this section: 

The Annual Budget Open Page 

Viewing Line Items and Reserve Funds 

Viewing Appropriations 

Editing Budget Items 

Adding New Budget Items 

Transferring Funds 

Adjusting Budget Item Amounts 

  

The Annual Budget Open Page 

NOTE: This help topic describes features found in the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

You can access an open budget from the Annual Budgets list by clicking the budget year. 

Budget maintenance tasks during the open budget year start from this page. You can also get a 
summary or detailed view of the current state of your budget, specific items, and so on. 
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Actions on This Page 

The following actions can be taken from this screen. 

Add a Top Level Category / 
Reserve Fund 

You can add new top-level Categories and Reserve Funds 
during open status. 

Sort Top Level Items Sorts top level items: First, all top level Categories are listed 
in alphabetical order, followed by Reserve Funds in 
alphabetical order. 

Return to Planning An open Annual Budget can be taken back to planning 
status if no Payments have appropriated funds from it. 

Once a Payment has been appropriated from the budget, 
this link will not appear. 

Close Budget At the end of the giving year, you can close the budget to 
prevent further appropriations from it. 

Modify Budget Setup You can change the settings you put in place when adding 
the Annual Budget. 

 Clicking these icons will (respectively) expand or collapse all 
Categories in the body of the page below. 

 
Clicking this icon will export the budget to Excel. 

NOTE: For each Category, there are additional actions you can take by opening the Category 

menu ; these options are described below in Category Actions. 
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Budget Information on This Page 

The body of the page shows all Categories in the budget, showing each one's place in the budget 
hierarchy. Top level Reserve Funds are also shown. 

This view allows you to see the "big picture" of your open Annual Budget, and your progress 
toward giving goals. You can drill down to the see the Line Items and Reserve Funds of any given 
Category, then see the payment appropriations for each of those in turn. 

Description 

(No label) 

The Description of each Category or top level Reserve Fund. 

Note that each Category can be expanded to show its child Categories. In 

addition, clicking this icon grants you access to the Category actions, listed 
below. 

Current The current amount of the Category (or top level Reserve Fund). 

Hover your mouse pointer over this icon  to see a item's original amount. The 
“original” amount is the amount of the Category or top level Reserve Fund when 
the budget was initially opened; the total can change later if budget items are 
adjusted or added. 

Paid This is the total of Payments for Requests which have 1) been appropriated from 
the top level item and/or its descendants and 2) have a status of Paid, Void, or 
Refund. 

Committed This is the total of scheduled/contingent/hold Payments for pending and 
approved Requests which have had funds appropriated from the top level item 
and/or its descendants. 

Balance Available balance of the budget or top-level item. The formula follows: 

Current – Paid – Committed = Balance  

  

Category Actions 

You can work with Categories in an open budget by accessing the Category menu icon.  

Edit Opens the Category edit form. 

Add Child 
Category 

Click to add a Category as a child of the selected Category. 

Add Child 
Reserve Fund 

Click to add a Reserve Fund as a child of the selected Category. 

Add Child Line 
Item 

Click to add a Line Item as a child of the selected Category. 
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Sort Child 
Items 

Sorts the Category's child items: First, all child Categories are listed in 
alphabetical order, followed by Line Items, then Reserve Funds. 

View Details Opens the Category details window, allowing you to view the Category's child 
Line Items and Reserve Funds. 

 
  

Viewing Reserve Funds and Line Items 

NOTE: This help topic describes features found in the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

To view a Category's child Line Items and Reserve Funds, open the Category menu  and select 
View Details. The window opens: 

 

TIP: When this window is open, you can select a different Category in the main budget page in 
the background; the details window will update to show children of the newly selected 
Category. 

Description 

(No label) 

For Reserve Funds, the Description is listed; for Line Items, the 
Organization Name and Description appear. 

Clicking  grants you access to the budget item actions, listed below. 

Current The current amount of the Category (or top level Reserve Fund). 

Hover your mouse pointer over   to see a item's original amount. The 
“original” amount is the amount of the item when the budget was initially 
opened; the total can change later if budget items are adjusted. 

Paid This is the total of Payments for Requests which have 1) been appropriated 
from the item and 2) have a status of Paid, Void, or Refund. 

Committed This is the total of scheduled/contingent/hold Payments for pending and 
approved Requests which have had funds appropriated from budget item. 

Balance Available balance of the budget item. The formula follows: 

Current – Paid – Committed = Balance  
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Budget Item Menu 

During open stages, actions which can be taken on Reserve Funds and Line Items are shown in 

the budget item menu, accessed by clicking this icon:   During open stage you can: 

 Edit the budget item. 

 Adjust Budget Item Amount 

 Transfer Funds to or from the budget item 

 View Appropriations made for Payments 

TIP: Line Items and Reserve Funds can also be viewed by drilling down in the Budget Summary 
dashboard part.  

  

Viewing Appropriations 

NOTE: This help topic describes features found in the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

When the budget is open or closed, you can drill down and see individual appropriations made 
against each Line Item or Reserve Fund in your budget. 

1. Open the budget page for the open year. 
2. Find the Category which is the parent of the Line Item or Reserve Fund you want review. 

In the Category menu , select View Details to see its child budget items. The budget 
details window opens. 

3. Now open the menu for the budget item you want to review and click View 
Appropriations. The appropriations window opens. 

The following data about each appropriation is provided: 

Organization The name of the payee Organization. 

Project Title The Project Title of the Request associated with the Payment. 

Amount The appropriation amount (which equals the payment amount). 

Date/Time The date and time on which the appropriations was made. 

TIP: Appropriations can also be viewed by drilling down in the Budget Summary dashboard part.  
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Editing Budget Items 

NOTE: This help topic describes features found in the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

Categories, Line Items, and Reserve Funds can be edited. To access budget items for editing 
during open status: 

 For Categories, navigate to the planning or open budget page and select Edit from the 
Category menu. 

 For Line Items and Reserve Funds, you need to identify their parent Category, then open 
the budget details for that Category. In the budget details window, you can then open the 
menu for the item and select Edit. 

  

Adding New Budget Items 

NOTE: This help topic describes features found in the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

During the budget year, you may want to add new budget items. For example, you belatedly 
decide to fund a particular organization this year; while waiting for their proposal, you may want 
to add a new Line Item linked to their Organization record. 

NOTE: Budget items cannot be deleted from an open budget. 

Adding a Category, a Line Item, or a Reserve Fund works the same way during open status as 
during planning. 

  

Moving Budget Items 

NOTE: This help topic describes features found in the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

Budget Categories, Line Items, and Reserve Funds can be moved from one parent Category in 
the budget hierarchy to another during planning stage.  

When the budget is open, these same movements can be made if your budget setup allows it. 
The preference to "Allow movement of budget items in the hierarchy" must be turned on or 
budget items are locked into their place during open status. 

NOTE: Once the Annual Budget is closed, the budget hierarchy is locked and you can no longer 
move items. 

You can move budget items by dragging and dropping them. Position the mouse point over the 
Category icon , hold down the mouse button, drag it to its new location, and release the 
mouse button. 

  

If you want to move a Reserve Fund or a Line Item to a different parent Category, you will need 
to view the budget item under its current parent first; then you can drag the Line Item icon  or 
Reserve Fund icon  to the a different Category. (Reserve Funds you can also drag to the top 
level.) 
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Transferring Funds 

NOTE: This help topic describes features found in the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

Even grantmakers with the strictest of budgets often have to move funds within their annual 
budget during the course of a fiscal year. For instance, more or less money may be needed in a 
Line Item than anticipated. To address these changes, users with access to the Annual Budgets 
can transfer money between items in a budget. 

NOTE: Funds can only be transferred within a budget year; you cannot transfer funds from one 
year to another. 

 You will select two budget items - a source and destination for the funds - and the amount to 
transfer. This will not affect the overall budget total; you're moving money, but within the 
established total. 

To transfer funds: 

1. Go to open Annual Budget page for the year in which you want to transfer funds. 
2. Open the budget details of the Category which is the parent of either the source 

("from") budget item or the destination ("to") item. 

3. In the budget item's menu , select Transfer Funds. The Transfer Funds window opens: 

 

4. Determine the amount to transfer by either entering the amount in the first currency 
field (negative numbers are allowed) or by entering the new total you want for the first 
item in the second currency field. Each field will recalculate automatically based on what 
you type in the other. 

5. Click the binoculars to search for the Reserve Fund you want to transfer funds from. The 
Select a Reserve Fund window opens:  
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The top panel shows the budget hierarchy. Select a Category and its child Reserve Funds 
are listed in the lower panel. Click the link for the Reserve Fund or Line Item to serve as 
the second budget item. The item is then shown in the second position in the Transfer 
Funds window.  

 

6. Enter the staff person who is authorizing this transfer (your user name is the default). You 
can add Notes as well. 

7. Click Transfer Funds to complete the transfer. 
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Adjusting Budget Item Amounts 

NOTE: This help topic describes features found in the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

During planning stage, the amounts of budget items can be edited at will. When the budget is 
open, increasing or decreasing a Line Item or Reserve Fund's amount needs to be audited more 
carefully. 

To adjust a budget item's amount during open stage: 

1. Go to open budget page for the year in which you want to adjust an item. 
2. Open the budget details of the Category which is the parent of the Line Item or Reserve 

Fund you want to increase or decrease. 

3. In the budget item's menu , select Adjust Budget Item Amount. The Adjust Budget Item 
Amount window opens: 

 

4. Enter the new Amount for the budget item. 

NOTE: The new Amount cannot be lower than zero, or the Appropriated amount, 
whichever is greater. 

5. Enter the staff person who is authorizing this transfer (your user name is the default). You 
can add Notes as well. 

6. Click Save. GIFTS Online will ask you to confirm that you want to adjust the amount, 
which it notes will affect the overall budget total. You can continue or cancel. 

  

Closing the Budget 

NOTE: This help topic describes features found in the optional Budget Module. If your 
GIFTS Online system does not include the Budget, you may disregard this information. 

At the end of the fiscal year, once your payout for the year is complete, you can close the 
Annual Budget. 

After the budget is closed, users will no longer be able to appropriate funds for payments from 
it. Make sure your Payments scheduled for the fiscal year have already been appropriated 
before closing the Annual Budget. 

The close the budget, click the Close Budget link on the open budget page. GIFTS Online asks 
you to confirm; click Yes and the closed budget page opens: 
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NOTE: The screen shot above is a bit unrealistic - you will certainly have a much lower balance 
left at the end of each budget year! If you do close the budget year with a balance still available, 
you can re-open the budget and use the funds, but only for payments within the same budget 
year. Otherwise the balance will remain unused. 

  

Actions on This Page  

Sort Top Level Items Sorts top level items: First, all top level Categories are listed in 
alphabetical order, followed by Reserve Funds in alphabetical 
order. 

Re-open Budget After closing the Annual Budget, you may discover Payments 
schedule for the budget year which you didn't appropriate 
funds for. 

You can re-open the budget; the Annual Budget goes back to 
open status, allowing further appropriations or changes to 
appropriations. 

 Clicking these icons will (respectively) expand all Categories in 
the body of the page below, or collapse all. 

 
Clicking this icon will export the budget to Excel. 
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Viewing Budget Details 

Categories and top level Reserve Funds are displayed on the closed Annual Budget page; you 

can view each Category's child Reserve Funds and Line Items by open the Category menu  and 
selecting View Details.  
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